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1.  Copyright Notice
© Copyright 2020 Esko Software BV, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are
the property of Esko Software BV. The material, information and instructions are provided
on an AS IS basis without warranty of any kind. There are no warranties granted or extended
by this document. Furthermore Esko Software BV does not warrant, guarantee or make any
representations regarding the use, or the results of the use of the software or the information
contained herein. Esko Software BV shall not be liable for any direct, indirect, consequential or
incidental damages arising out of the use or inability to use the software or the information
contained herein.

The information contained herein is subject to change without notice. Revisions may be issued
from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system,
or published, in any form or in any way, electronically, mechanically, by print, photoprint,
microfilm or any other means without prior written permission from Esko Software BV.

This document supersedes all previous dated versions.

PANTONE
®
 Colors displayed in the software application or in the user documentation may

not match PANTONE-identified standards. Consult current PANTONE Color Publications for
accurate color. PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. ©

Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to
distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or
Software shall not be copied onto another disk or into memory unless as part of the execution
of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org).
All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk
Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP
are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign,
PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the
United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark
Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BV

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com
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2.  Getting Started with Esko Plato

2.1.  Welcome to Esko Plato

Esko Plato™ is a powerful tool for the creation of print-ready layouts. It provides a robust
set of automatic and interactive tools to create even the most complex step-and-repeat
arrangements. Plato has features such as Input, Output and SmartMarks in common with Esko
PackEdge.

The fundamental purpose of Plato is to automate the creation of production-ready printing
plates. Speed, productivity and ease-of-use are all essential to providing the best possible
product for your customer.

As Plato offers different modules, your system may not have all the features described in this
publication. If necessary, contact your Esko salesperson for information about purchasing
features not installed on your system. The two main modules are:

Esko Plato for Labels
Esko Plato is a software application for Intel-based PC’s dedicated for highly productive and
interactive Step and Repeat work. Plato comes as a feature-rich basic application with the
option to add a number of Label workflow specific tools like SmartLayout. This is an estimation
module that will fill a given page size with a minimum of waste. You are presented with a range
of possible sheet layouts with immediate feedback about waste and overrun percentages,
based on the desired quantities of each individual one-up. The Layout algorithms are designed
to reduce the risk of human mistakes. This will guarantee continuity towards the end process
of the printing workflow, making this very productive in large format offset or gravure label
workflows.

Esko Plato for Cartons
In a folding carton or corrugated workflow, the die-cutting tools are usually manufactured
simultaneously with the pre-press workflow. In other words: the sheet layout is determined by
the converter, not by the prepress department. To make sure that the graphics are stepped up
to the exact specifications of the converter, Plato comes with a module to open Manufacturing
files as generated in ArtiosCAD. With the “print items” option, Plato will even look for the
corresponding graphic files, thus highly automating the stepping task for a carton workflow. A
wide variety of additional tools to finish the sheet layout are available in Plato: adding Station
Numbers, adding print control strips in a dynamic fashion (SmartMarks), adding Ink Eaters
etc… Final output is guaranteed consistent with the die shape and is ready for final output on
proof or film.

2.2.  Starting Esko Plato

To start Plato, log on to your system if necessary and then do the following:
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1. Click Start, then point to Programs.
2. Point to the Esko folder and then to PackEdge-Plato 10.1.
3. Click the version of Esko Plato that you have installed.
4. The startup screen will appear.
5. The plate document window will replace the startup screen.

Or you can also simply double-click the desktop icon. 

2.3.  Concepts and ideas in Esko Plato

• Stations and Layouts

• View Modes

• Typical workflows

• Document window elements

• Entering information

• External Files

• Calculator

2.3.1.  Stations and Layouts

The primary objects that you create in Esko Plato are stations and layouts. A station is the
object that you want to repeat on a plate. You may have several copies of the same station or
of different stations in one layout.

You may already be familiar with this concept. Sometimes the terms 1-up (the non-repeated
object) and layout are used to indicate stations and plates. In ArtiosCAD, a design file is the
equivalent of a station and a manufacturing file is the equivalent of a plate.

• What is a station?

• What is a layout?

What is a station?
A station can contain a graphic, a die shape, a mask and station marks. You are not required
to have a die shape, a mask and station marks in your station. All stations should contain a
graphic, but Esko Plato has the notion of ‘empty stations’ which are stations without a graphic
(see further). The concept of empty stations is designed to allow you to assemble plates before
the final graphics become available (cost estimating purposes). In a normal workflow, empty
stations will be replaced by the actual stations before making plates.The graphics used in a
station can either be a (Normalized) PDF file or an Esko GRS file. You can import a die shape
from a CAD file or you can create simple dies yourself. All the items that you include in a
station will be repeated on your plate. Although stations can be created and manipulated from
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the Sheet View, you edit stations in the Station View.The definition of a station is embedded
inside the plate file. Optionaly stations can be saved as separate files (for re-use in other
plates).

Station objects consist of:

• a reference to a graphics. In case of an empty station this will be a rectangle with a dummy
color, simply for viewing.

• a die shape. This is the shape on which the actual stations will be cut.
• a bleed mask. This is a gross mask that cuts away all irrelevant graphics. Most of the time,

the bleed mask is generated by spreading the die shape over a certain distance.

Advanced attributes are:

• station / strip number definitions
• SmartMarks / geometry marks

The definition of a station (i.e. all attributes enumerated above) is enclosed in the PLA file. In
case a station is used in another PLA file, the definition of that station could be copied into
a STA file. The PLA file, however, will continue to use the internal definition.Apart from the
enumerated attributes, a station can also possess a number of SmartLayout characteristics as
e.g. ordered quantity. SmartLayout characteristics are not stored inside the STA file.

What is a layout?
A layout contains a plate size, a sheet size, a sheet-to-plate offset, any number of stations, and
marks. The stations contained in a layout may be multiple instances of the same station, single
instances of different stations, or some intermediate mix (a combination layout). As plates
can be recto/verso, Esko Plato can create the back of a plate layout from the front for two-
sided printing. When Esko Plato creates the back side of the plate, the position of the stations
is mirrored for accurate front-to-back alignment. The back side of the stations is automatically
inserted to create the printing on the back side. Esko Plato maintains a link between the
front and back side of a plate: moving stations on the front side will move the corresponding
stations on the back side accordingly.

2.3.2.  View modes

Esko Plato has two view modes:

• The Sheet View shows the plate, the sheet, and all the stations that have been placed. In this
view, you can switch between the front and the back of a plate.

• The Station View focusses on the individual station.

Switching between those views can be done in one single session.

Sheet View
In the Sheet View, you can assemble the layout by stepping up a number of copies of one or
multiple stations. How to step and repeat depends very much on your workflow. In the Sheet
View, dedicated dialogs and tools will support different workflows. Common to all workflows are
the setup dialog, where plate and sheet sizes are defined, and the station dialog, which gives
an overview of all stations used in a layout.
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Station View
In the Station View, you are basically working on one side of a station. As stated earlier on, a
station can contain graphics, a die shape, a mask and station marks.The Station View offers all
functionality to create and manipulate these objects:

• import graphics
• create a die shape
• align graphics and die shape
• create a mask (based on the die shape)
• add station marks
• add station numbers
• ...

2.3.3.  Typical workflows

Your first task when starting a new plate layout is to determine which of Esko Plato's workflows
you need to use. The workflow that you choose will determine how to start building your plate
layout. Esko Plato supports different workflows: a CAD-based, SmartLayout and Grid-based
Layout Workflow. The fundamental difference between the CAD-based layout on the one hand
and the SmartLayout or Grid-based layout on the other hand is that in CAD-based layouts
the position of the stations is dictated by the CAD layout whereas in the other workflows, the
position of the stations can be defined manually (manual workflows).

The process of creating a plate is usually a logical progression. First you define the sheet and
plate size. Next, you create the stations that you plan to include on the plate. You can either
use the Station dialog box or the Station View to create stations containing graphics, dies,
masks, and station marks. Finally, you add stations and marks to the plate to create a file that
is ready for printing.

When creating a new plate or layout, the central dialog for the chosen workflow will
automatically be opened. Chosing a particular workflow does not limit the available tools. You
will still be able to use grid-based stepping after choosing a CAD based workflow.

Tip:

The Layout Assistant provides some info on the different workflows. As a result a new layout will
be created and the Setup dialog box will be opened.

• The CAD Workflow: The CAD Workflow uses an imported CAD file as the basis of the plate
layout. First the imported CAD file defines the sheet size, and the placement and orientation
of the stations. Next stations are assigned to the CAD layout. The last step is to add the
plate marks to the plate and sheet.

• The Grid-based Workflow: In a Grid-based layout, stations are stepped in blocks where both
the number of repetitions in vertical and horizontal direction and the step distances can be
specified numerically.

• The SmartLayout Workflow: In a SmartLayout workflow, a new layout will be calculated based
on the ordered quantity and the given sheet size will be filled with a minimum of waste. You
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are presented a range of possible sheet layouts with immediate feedback about % waste
and overrun, based on the desired quantities of each individual one-up.

• A manual workflow does not use an imported layout. Instead, you create your stations and
then place and arrange them on the sheet.

• Esko Plato also offers you the possibility to combine workflows.

2.3.4.  Document window elements

The different views all contain a display area and a number of toolbars: see toolbars.
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1. The display area is where you do your work. You can think of it as a blank printing plate
on which you are assembling your layout. The white area is the plate, the blue rectangle
indicates the borders of the sheet. The size and position of these are defined when you
create a new layout.

2. The Tools toolbar contains the interactive tools. Some tools are only available in 1 view
(Station view or Sheet View).

3. 'File & Edit' offers you the standard save and edit functionality.
4. View Selector
5. Side indicator tells you which side of the sheet you are working on; front or back and allows

to switch from front to back and vice versa.
6. Preview Selector indicates the selected preview.
7. Zoom: indicates the zoom factor.
8. Show Trim & Media box: allows you to switch the visualization of the trim and media box

on or off.
9. Show values / formulas: adjusts the visualization of formula-enabled fields. You can opt to

either show the formula definition or the corresponding value.
10.The Station Selector allows you to select a station in the Station View.

Tip:

Click the station button to open the Station dialog box.

11.Layout type indicates the selected workflow: grid-based, CAD, SmartLayout or manual.

Tip:

Click the layout button to open the appropriate Layout dialog box (Grids, CAD, or
SmartLayout).

12.Crosshair Position
13.Current Orientation / Current Unit: the orientation and unit can be changed in the

Defaults tab of the Preferences dialog box. Orientation, units and server name together
make up the Status Bar.

Note:

The menu bar contains commands that are available in the current module. Not all commands
in all menus may be available. Availability depends on the options purchased and the active
tool.

Note:

All the toolbars can be opened via the Window menu > Toolbars.

Tip:

The Workspace Layout Manager allows you to make some predefined workspaces of the user
interface dialog boxes and switch from one to another in one single click.
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Tip:

All toolbars of the Window menu can either be used as docked tools or as proper dialog boxes.

2.3.5.  Entering information

Many of the dialog boxes expect you to enter information. You usually do this by typing on the
keyboard. To edit a value in a dialog box, click the field and enter a new value. Clicking a field
once selects the entire contents of the field. Clicking a field twice will insert the cursor into the
existing value in the field and allow you to edit it.

There are two other ways to work with dialog boxes that you may not have seen before:

• Dragging numbers

• Using smart edit fields

Dragging numbers
Esko Plato allows you to drag a number between two dialog boxes. Sometimes, you might
want to use a value from one dialog box in another. For example, you might want to take some
measurements from within your document and then use that measured value as an entry in
the Transform dialog box.

To drag a number from one dialog box to another:

1. Click and drag the number that you want to use. The cursor turns into the pointing hand
icon.

2. Drag the number to the edit field of another dialog box and release the mouse button. The
value is copied from the first dialog box to the second.

Using smart edit fields
Many of Esko Plato's dialog boxes contain smart edit fields. You can recognize smart edit fields
by their display: they always contain the current units label after the value in the field.

 

 

Smart edit fields have two important properties. First, you can change the current units used to
display the field's value at any time. Second, you can use the smart edit field to calculate a new
value for the field.

To change the current units that are used to display the field's value:

1. Click the field to select its contents. Everything in the field is selected.
2. Type the units that you would like to use. Type "in" for inches and "mm" for millimeters.
3. Press [Enter]. The field's value is now displayed in the units that you typed.

The field will continue to use the unit of measure that you chose until you change it again. Note
that other fields in the same dialog box will be displayed in the previous units until you change
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them. To change the default units used throughout the application, see the Defaults tab in the
Preferences dialog box.

To use the smart edit field to calculate a new value:

1. Click the field twice to insert the cursor after the unit of measure. If the cursor is not in the
right place, use the arrow keys to move it after the unit of measure.

2. Type the calculation that you'd like to make. For example, if the field currently contains "10
mm" type "+5" to add 5 mm to this value.

3. Press [Enter]. The new value for the field is calculated and displayed. In the example above,
the new value will be "15 mm" (10 mm + 5 mm).

You can use these two features together, too. For instance, if the smart edit field contains "10
mm", you can add 2 inches to this value by typing "+2 in". The resulting value will be "60.8 mm",
10 mm + 50.8 mm (2 inches in millimeters).

2.3.6.  External Files

Esko Plato uses files as external references. External files are linked to the actual files located
on your disk. This means that the high resolution data contained in many graphics files is never
included in your plate or station files. Examples of external files are graphics used in stations,
and image marks.

The use of external files has two advantages. First, because the real data of the external file is
not included in the document, Esko Plato's native plate files are very small. Second, because
Esko Plato refers to the external files on disk, stations and plates that use these files are always
up-to-date. Changes made to the external files are updated automatically.

Caution:

Note that whereas all graphics used in stations are external references, the station
definitions themselves (the link to graphics, die shape, mask, station number, trapping
layer, etc…) are stored inside the plate file.

Tip:

When inks are changed in external files, PLA files should be opened and saved.

2.3.7.  Calculator and Parameter Formulas

Esko Plato offers you the possibility to use parameters to build expressions or formulas.

• What are parameters?

• What are predefined parameters?

• Using the Calculator

• How to add a parameter to the parameter(s) in the Formula line?

• Using the Calculator parameter buttons
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What are parameters?
Parameters represent properties of a step and repeat job. Every parameter has a unique
name.Parameters can be used to build expressions, the so-called formulas. These expressions
can be used to define most settings of a step and repeat job. E.g. the parameter called
‘PlateHeight’ represents the vertical size of the plate. You can define the vertical size of the
sheet by the formula ‘PlateHeight - 100mm’. In doing so, the vertical size of the sheet will be
100 mm smaller than the vertical size (height) of the plate.

Formulas can be used in different input fields:

• Layout Setup: all fields marked with ‘fx’.

• Grids: offset, count, step and angle fields.Fields that support formulas can be visualized in 2
modes: either show the formula definition or show the corresponding value. When moving
the mouse over the field, both the definition and the value will be shown in balloon help.

To visualize the parameter formulas, activate Show formulas in the Layout Setup dialog box.

What are predefined parameters?
Esko Plato has a list of predefined parameters. These parameters can be visualized in 2
formats, either as technical parameters or as localized parameters. Technical formulas
correspond with the way in which formulas were visualized in QuickStep. Localized formulas
provide a more readable format.The 'Formulas' option in the Defaults tab of the Preferences
dialog box offers you the possibility to switch between technical and localized parameters.
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When using parameter values, you are allowed to combine both localized and technical
formatting.

Technical
ParameterLocalized
ParameterExplanation

VPLATEFIT PlateHeightFit vertical plate size

HPLATEFIT PlateWidthFit horizontal plate size

VPLATE PlateHeight vertical plate size when fitted around all
objects in on a plate (so including stations
but also SmartMarks and geometry marks)

HPLATE PlateWidth horizontal plate size when fitted around all
objects in on a plate (so including stations
but also SmartMarks and geometry marks)

PLATETOP PlateTop position of the top of the plate

22



2Plato

Technical
ParameterLocalized
ParameterExplanation

PLATELEFT PlateLeft

PLATEBOTTOM PlateBottom

PLATERIGHT PlateRight

GRIPPER Gripper

VSHEET SheetHeight vertical sheet size

HSHEET SheetWidth horizontal sheet size

VSHEETFIT SheetHeightFit vertical sheet size that fits around all grid
blocks

HSHEETFIT SheetWidthFit horizontal sheet size that fits around all grid
blocks

VSHEETOFFSET SheetOffsetHeight vertical offset of the sheet relative to the
plate

HSHEETOFFSET SheetOffsetWidth horizontal offset of the sheet relative to the
plate

SHEETTOP SheetTop top position of the sheet relative to the plate

SHEETLEFT SheetLeft left position of the sheet relative to the plate

SHEETBOTTOM SheetBottom bottom position of the sheet relative to the
plate

SHEETRIGHT SheetRight right position of the sheet relative to the
plate

NROFINKS NumberOfInks number of non-technical inks (technical inks
will not be printed)

AREATOP AreaTop

AREALEFT AreaLeft

AREABOTTOM AreaBottom

AREARIGHT AreaRight

NROFGRIDS NumberOfGrids total number of grids

# per grid:

Grid-related formulas are followed by a grid number.

Technical
ParameterLocalized
ParameterExplanation

VLABEL LabelHeight vertical size of non-rotated job
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Technical
ParameterLocalized
ParameterExplanation

HLABEL LabelWidth horizontal size of non-rotated job

VGAP GapHeight

HGAP GapWidth

VSTEP StepHeight vertical step size, from center point to center
point

HSTEP StepWidth horizontal step size, from center point to
center point

VCOUNT VerticalRepetitions

HCOUNT HorizontalRepetitions

GRIDVSIZE GridHeight vertical size of the grid (top-bottom)

GRIDHSIZE GridWidth horizontal size of the grid (left-right)

TOP Top top position of the grid relative to the sheet

BOTTOM Bottom bottom position of the grid relative to the
sheet

LEFT Left left position of the grid relative to the sheet

RIGHT Right right position of the grid relative to the sheet

ANGLE Angle rotation angle

VSIZE StationHeight vertical size of bounding box of rotated job

HSIZE StationWidth horizontal size of bounding box of rotated
job

A parameter can represent:

• A value.A value can be either a plain value or the result of a formula.

GRIDVSIZE1 is a parameter. GRIDVSIZE1 could either be the plain value 25 or the formula
VSTEP1 * VCOUNT1 equal to 25.

• A grid parameter.A repetition chart may be composed of several grids. If a repetition
chart is composed of two jobs, there will be two grids. Each grid has its own number. Each
predefined grid parameter is assigned a number that corresponds to the job of the grid you
are currently working on.

The VSIZE parameter of the first job is called VSIZE1. The VSIZE of the second job will be
called VSIZE2 as this parameter refers to the job in the second grid.

• A logical relationship between parameters.The parameter VSTEP1 may amongst others
depend on the parameter VSIZE1.

Example VSTEP1=(VSIZE1 +10).
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Using the Calculator
To activate the Calculator right-click any formula-enabled input box.The Calculator allows you
to compose complex mathematical formulas using numeric values and/or the parameters. You
can use predefined parameters, define new parameters, modify existing parameters or remove
parameters that you have created previously.

Advantages of the Calculator:

• It has a wide input field, which makes it easier to display long formulas.
• You can create formulas without having to enter parameter names. You can simply select

them by clicking the parameter in the parameter column.

How to add a parameter to the parameter(s) in the Formula line?
1. Right-click any formula-enabled input box to activate the Calculator. The input field that is

connected to the calculator will be marked with a red rectangle.
2. Put your cursor in the formula line and click once. The cursor appears at the position you

clicked.
3. Click the required category of parameters in the left-hand column and select the required

parameter or value from the parameter list from the right-hand column. Either click ‘Insert’
or double-click the parameter.

4. The value from the calculator will be transferred to the selected input field when pressing
ENTER or when clicking another input field.

Using the Calculator parameter buttons
Apart from the standard parameters, Esko Plato offers you the possibility to create, modify or
remove customized parameters.

• Add a new parameter

• Modify a parameter

• Remove a parameter

Add a new parameter

1. Right-click any formula-enabled input box in the Layout Setup or Grids dialog box. The
Calculator appears.

2. Select the category ‘Custom’ from the left-hand column.
3. Click 'New'. The Add dialog box appears.
4. Enter the name of the new parameter in the Name input box.
5. Enter the parameter formula or parameter in the Formula input box.
6. Select the type of parameter you want to define from the Type drop-down list.
7. Click 'Add'. The new parameter or parameter formula is checked for errors and is added to

the parameter list of the Calculator.
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Modify a parameter

1. Right-click any formula-enabled input box from the Layout Set or Grid dialog box. The
Calculator appears.

2. Select the category ‘Custom’ from the left-hand column.
3. Click 'Modify'. The Modify dialog box appears.
4. Select the parameter you want to modify from the Name input box.
5. Modify the parameter formula in the Formula input box.

Caution:

The standard predefined parameters, that come with Esko Plato, cannot be altered.

6. Modify the type by accessing the Type drop-down list.
7. Click 'Modify'. The modified parameter is now checked for definition errors and the

parameter will become available in the parameter list.

Remove a parameter

1. Right-click any formula-enabled input box in the Layout Setup or Grids dialog box. The
Calculator appears.

2. Select the category ‘Custom’ from the left-hand column.
3. Click 'Remove'. The Remove dialog box appears.
4. Select the name of the parameter you want to remove, from the Name input box. The

parameter appears in the Name input box and its formula in the Formula input box.

Note:

You can only remove parameters you have previously defined and which are not longer
used in the current repetition.

Caution:

If a parameter is still in use in the current repetition, the Remove dialog does not
allow you to select it.

5. Click 'Remove'. The parameter is removed from the Calculator parameter list for this
repetition.

2.3.8.  Shuttle

Shuttle allows to connect to an EskoArtwork server: Automation Engine 10, Nexus or Odystar.
It allows to submit the current job to a workflow queue, and to monitor jobs running on the
server.

All Shuttle functionality can be found in File > Shuttle
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A full explanation on Shuttle can be found in the Shuttle documentation, available on the
EskoArtwork Documentation DVD.

2.3.9.  Studio

Studio offers a 3D viewing environment where designers can see their artwork applied
instantly on the packaging. It also includes navigation and alignment tools, and by writing a 3D
PDF file from Studio, designers can share their ideas with clients for review and approval.

Studio reduces time-consuming mock-ups, spots design-errors faster and takes away the
guesswork from 2D flats.

For folding carton or corrugated packaging, the shapes can be supplied by ArtiosCAD or Score!.

The Studio tools in Plato can be found in Production > Studio Designer

2.3.10.  Common data resources

The application needs access to the following Data Resources for correct working:

• Fonts data (in folder bg_data_fonts_v040)

• Color Engine Database (CMS) (in foder bg_data_cms_v010)

• Custom data (in folder bg_data_custom_v010)

• SmartMarks data (in folder bg_data_marks_v010)

• Dot gain Compensation Curves (DGC) (in folder bg_data_dgc_v040)

The location of these Data Resources can be found from one of the following places:

1. Central Data Resources.

Central Data Resources will be used if the application is connected to an Automation Engine
Server. The Common Data Resources need to be installed on the Automation Engine server.

2. Remote Data Resources

The Data Resources are used from a remote system in the network. The Common Data
Resources need to be installed on this remote computer. This is an ideal setup when 2 or
more stand-alone applications (i.e. not connected to an Automation Engine server) need to
share the same Data Resources.

3. Local Data Resources

The Data Resources are used from the current system. The Common Data Resources need
to be installed on the current system.

4. Application embedded Data Resources.

A minimal set of Data Resources is embedded in the application. When none of the above
Data Resources is found, the embedded Data Resources will be used. Thise embedded Data
Resources can not be shared between different applications

You can set the Central Data Resources in the Preferences: see Server and Resources on page
336
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Note:

If the Central or Remote Data Resources are not available during startup of the application (for
example the server is not running), the application will fall back on the Local Data Resources
or, if the Local Data Resources are not installed, on the embedded Data Resources.
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3.  Working with Plate Files
This section will provide you with the basics of creating plate files. You will learn how to define
new plates and their parameters. You will also learn how to import CAD layouts for your plate
and how to create, save and use templates to automate your work.

• Creating, opening and saving plates

• Creating Layouts

• Using a CAD file for plate layout

• Using Templates

3.1.  Creating, opening and saving plates

When you create and save a plate layout from Esko Plato, you create a layout file. You can save
your plate files wherever you like. Esko Plato will maintain its links to the external files that
the plate uses. You might like to arrange your plate files into folders that contain the plate file
itself and the graphics used in the stations. It is up to you to decide what works best for your
company. A plate file is always saved with a pla (or pdfpla) extension. So, saving a file with the
name "3Up" will save a file on your disk with the name "3Up.pla", if the graphics that you used
are .grs files. Plate files always have the Esko Plato plate file icon
 

 

• Creating a new layout

• Saving a layout

• Saving a layout with a different name

• Opening an existing layout

• Changing the sheet or plate size

3.1.1.  Creating a new layout

When you create a new layout, you need to feed Esko Plato with vital information as e.g. the
size of the plate, the size of the sheet and the position of the sheet on the plate. You can do
this in the Layout Setup.

This information will often change for plates with different types of printing processes, plates
and presses that you use during production.If you often create the same size of plates and
sheets for the same press, you can automate the creation of a plate file by using Templates.
See Using Templates for more information.
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Note:

What is the difference between a PDFPla and a PLA file?A PLA file contains references to GRS
files, a PDFPLA file contains references to PDF files. The first type of file that you place on a new
plate determines the kind of files you can place after that. Placing a GRS file first means that
you cannot place PDF files later on, placing a PDF or a normalized PDF file first means that you
cannot place GRS and STA files later on. The mixing of the file types GRS and/or STA with PDF
and normalized PDF is not supported.

To create a new layout file:

1. On the File menu, click 'New Layout' and select the type of layout you want to create. The
Layout Setup dialog box will appear:

 

 
2. Fill in the fields in the dialog box to suit your production needs. Refer to the chapter 'Layout

Setup' for detailed information about each field.
3. Click 'OK' to create the new layout. Clicking 'Cancel' will close the Layout Setup dialog box

without creating a new plate.

Your new plate is shown in the document window. The white area is the plate, the blue line
shows the sheet and its position on the plate.

30



3Plato

Tip:

Configure the CTRL+N shortcut to your favorite layout workflow (Edit menu > Preferences >
Shortcuts).

3.1.2.  Saving a layout

Once you have created a plate, you need to save it. When you save a plate, and you haven’t yet
specified a name for the layout in the Layout Setup dialog box (you left it to untitled), you will
be prompted to enter a file name and the location where you would like to save it.

It is good practice to save your work at frequent intervals. Thus you know that the file is up-to-
date and that your work has been saved.

To save a plate file:

1. On the File menu, click 'Save Layout'. The Save dialog box appears:

 

 

2. Enter a name for your plate file.
3. Indicate in which directory you would like to save the file.
4. Click 'Save' to save the contents of your file. Clicking 'Cancel' will close the Save dialog box

without saving your file.
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Now that your new file is saved with the name that you gave it, you can save it at any time by
clicking the File menu and clicking Save. You can also use the keyboard shortcut CTRL+S to save
the file as you work.

3.1.3.  Saving a layout with a different name

To save an existing file with a new name:

1. On the File menu, click 'Save Layout as'.
2. Type a name and choose a location for the file.
3. Click 'Save' to save the file with the new name.

You can use Save As to create a copy of an existing file before you make major modifications.
Then you can always go back to the original version of the file if you need to.

3.1.4.  Opening an existing layout

You often want to open an existing plate file to make changes to it or to finish a plate that you
had started earlier. Use 'Open Layout' to open an existing layout file for editing or printing.

To open an existing plate:

1. On the File menu, click 'Open Layout'. The Open dialog box appears:
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2. Locate the file that you would like to open and select its name.
3. Click 'Open'. Clicking 'Cancel' will close the Open dialog box without opening an existing file.

You can only have one plate file open at a time. If you already have a file open when you click
'Open', the current file will be closed. If you have any unsaved changes, you will be asked if you
want to save them first.

3.1.5.  Changing the sheet or plate size

You might need to make changes to the sheet or plate size of an existing layout for a last
minute change.

To change the sheet or plate size of an open file:

1. On the File menu, click 'Layout Setup'. The Layout Setup dialog box appears.
2. Turn to the Plate&Sheet tab to check the values of the file.
3. Edit the fields that you need to change.
4. Click 'OK'. Clicking 'Cancel' will close the Layout Setup dialog box, leaving the current plate

with its previous values.

Esko Plato will monitor the position of the stations relative to the sheet when you change size.
When moving the sheet-to-plate position, the stations will remain fixed relative to the sheet
edge. When moving the sheet, the stations will remain fixed relative to the plate edge. An
exception is made for grid objects. As all grid objects have offsets relative to the sheet edge,
changing the sheet dimensions will cause these objects to move with the changed sheet size.

3.2.  Creating Layouts

• Layout Assistant

• Grid-based workflow

• CAD workflow

• SmartLayout workflow

• Manual workflow

• Combining workflows

3.2.1.  Layout Assistant

The Layout Assistant provides some info on the different workflows. As a result a new layout
will be created and the Setup dialog box will be opened.
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3.2.2.  Grid-based workflow

A grid-based layout may turn out to be a very easy and practical method if you have to print
labels or do straightforward step-and-repeat jobs. You can then organize various one-ups in
several grids whereby Esko Plato’s set of tools should help you to make optimal use of the size
of the sheet.

1. Go to File > New Layout > Grid-based Layout... The Layout Setup dialog box will pop up.
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2. The General tab of the Layout Setup dialog box offers you the possiblity to determine some
general settings. If your Esko Plato is connected to an Automation Engine server, you can
specify in which Automation Engine Job the new layout will be created.It indicates the Job
File Format in which your job will be created: PDF or GRS.It invites you to give a name to
your layout. Note that templates are at your disposal. You can select one by toggling on ‘Use
Template’ and selecting one from the drop-down list.

The Shrink values are relevant only to particular printing processes such as flexography,
in which case the plate tends to expand as it is wrapped around the press cylinder. Screen
registration is relevant only to Esko FlexRip users. When activated, the origin of the
screening will be reset for each station. In doing so, it is garanteed that exactly the same
screening will be applied for each station. When deactivated, screening will be done
continuously throughout the complete job.

3. The Plate & Sheet tab allows you to specify the dimensions of your plate and sheet.

 

 

To facilitate this procedure, you have a number of formulas at your disposal, which you can
activate by clicking the ‘fx’ symbol to the right of each entry field. When you click ‘fx’, the
Calculator pops up.

4. As soon as you have entered all relevant values (or formulas), the Grids dialog box appears.
It serves as the central dialog box for all further actions.
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5. Add stations by clicking the 'Add Station' icon For more information, please refer to the

chapter 'Adding a station' or check the function overview in 'Grids'.
6.

Clicking the grid info button , will open the Grid Settings dialog box.

 

 

The Settings dialog box gives you the opportunity to create an even more complex layout on
the sheet, since you can alter geometry, gaps between the various stations, stagger them or
distribute them in various ways. You can also determine ‘Die Shape’ and ‘Bleed’.

For more information, please refer to the chapter 'Creating a Repetition' or check the
function overview in 'Grid Settings'.

3.2.3.  CAD workflow

The CAD Workflow uses an imported CAD file as the basis for the layout. The CAD file will
determine the number and placement of the stations on the plate. It may also determine the
sheet size and the masks that are used for the stations that the CAD file defines.
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The CAD Workflow is a structured workflow. Esko Plato considers an imported CAD file as its
guide to creating the plate layout. Because an imported CAD layout defines the final cutting
and folding of a layout, it is not editable in Esko Plato.This means that you will not be allowed
to scale or rotate an imported CAD layout. In addition, you cannot change the arrangement or
number of the stations defined in the CAD layout. If you need to make these types of changes,
you should edit the original CAD file and use the new file in Esko Plato.

There are some parts of an imported CAD layout that you can change. These include the plate
and sheet size, the location of the layout on the sheet, and the stations that are assigned to
each location on the plate. You can also adjust the mask and bleed sizes of a station to suit
your company's needs.

Please remember that it is also possible to release the CAD form from your layout in order to
make changes interactively. Once released, the CAD form cannot be connected to your CAD
form again.

The basic steps to create a plate layout from a CAD file are:

1. Go to File > New Layout > CAD Layout... The Layout Setup dialog box will pop up.

 

 

2. Go to the Plate & Sheet tab and select the appropriate plate or enter the plate size
manually.

Note:

In a CAD workflow, the sheet size will be extracted from the manufacturing file. The sheet
size is taken from the CAD file when importing the CAD data. The sheet size can still be
modified later on via the Layout setup dialog box.

3. Click OK.The workspace indicating your plate and paper will appear, as well as the CAD
dialog box that will allow you to load a CAD layout.
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4.
Click the 'Add CAD Layout' icon .The Import CAD Data dialog box will pop up.

5. Browse to your CAD file and click 'Open'.
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6. The CAD layout is loaded.Select the station (or all stations) to which you want to assign the
graphic(s).

 

 

Tip:

You can switch to the Station View in case it is necessary to align the graphics to the die
object.

7. You have now a set of tools at your disposal to further finetune the layout. Please refer to
the chapter 'Tools'.

In the Station View, you can use the Create Bleed Mask tool  to specify a certain amount
of bleed.
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3.2.4.  SmartLayout workflow

‘Smart Layout’ is an advanced layout tool that was developed primarily to facilitate the work of
operators who have to execute jobs that will be cut by means of a guillotine-cutting device, and
who wish to be able to integrate parameters related to order specificities and overrun.Thanks
to the SmartLayout option you can optimize the distribution of different labels on your sheet
automatically and it takes but a few seconds. It uses different optimizing methods depending
on your workflow, it offers dynamic feedback on suggested layouts and operator (inter)actions,
e.g. run length, waste, overrun, …

1. Go to File > New Layout > SmartLayout. The Layout Setup dialog box will appear:
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2. The General tab of the Layout Setup dialog box offers you the possiblity to determine some

general settings. If your Esko Plato is connected to an Automation Engine server, you can
specify in which Automation Engine Job the new layout will be created.It indicates the Job
File Format in which your job will be created: PDF or GRS.It invites you to give a name to
your layout. Note that templates are at your disposal. You can select one by toggling on ‘Use
Template’ and selecting one from the drop-down list.

The Shrink values are relevant only to particular printing processes such as flexography,
in which case the plate tends to expand as it is wrapped around the press cylinder. Screen
registration is relevant only to Esko FlexRip users. When activated, the origin of the
screening will be reset for each station. In doing so, it is garanteed that exactly the same
screening will be applied for each station. When deactivated, screening will be done
continuously throughout the complete job.

3. The Plate & Sheet tab allows you to specify the dimensions of your plate and sheet.
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To facilitate this procedure, you have a number of formulas at your disposal, which you can
activate by clicking the ‘fx’ symbol to the right of each entry field. When you click ‘fx’, the
Calculator pops up.

4. As soon as you have entered all relevant values (or formulas), the SmartLayout dialog box
appears. It serves as the central dialog box for all further actions.

 

 
5. Add stations by clicking the 'Add Station' icon Please refer to the chapter 'Adding a

station' for more information.
6. For each station, enter the ordered quantity in the 'Ordered' column. This number is

expressed in thousands (‘K’). 'Placed' indicates the number of times this station is placed in
the current layout. This number is read-only.

7. You can specify the amount of overrun for each station individually by entering a value in
the Station Properties dialog box.For more information, please refer to the chapter 'Station
Properties'.
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8. Click Search. The SmartLayout tool will order the selected stations on your sheet in the
best possible way in terms of ordered quantity, overrun, waste... The amount of overrun is
indicated in actual numbers and as a percentage of the ordered quantity.‘Search’ creates
a new layout , removing all stations that were placed on the layout before activating the
function. A number of layouts will be suggested. The one that is visualized is regarded as
the most ideal one. Of course, you can at any time opt for another layout by using the step
buttons.

This is an example of a possible layout.

 

 
9. Click the ‘Options’ button to further refine your layout.
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Fill Direction allows you to determine in which directions the sheet should be filled.

First Cut determines the direction in which the first cut will be made, either horizontally or
vertically.

Fill Mode enables you to determine whether you want ‘Minimal Overrun’, ‘Minimal Waste’,
‘Strips Only’ or ‘Complete Strips’.

Enter a Maximum Waste percentage.

Determine gutter height and width.

For more in depth information, please refer to the chapter 'Search Options'.

3.2.5.  Manual workflow

A manual workflow does not use an imported layout. Instead, you create your stations and
then place and arrange them on the sheet. Esko Plato has a robust set of tools that assist
you in this process. You use the Step-and-Repeat, Transform and Align tools to build the
layout yourself, or you can use SmartLayout to automatically build a layout. Once you have
designed your layout, you finish the plate the same way that you do when using the CAD
Layout workflow: by adding marks to the sheet and plate and printing the layout.

The basic steps to create a layout manually are:

1. Create a new layout.
2. Create the stations that will be used on the layout.
3. Place and arrange the stations on the layout.
4. Add marks to the sheet and plate.
5. Print your layout to proofs, films, or plates.
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The manual workflow is a fairly unstructured workflow. You can place as many stations as you
like on the layout and arrange them to fit your production needs.

3.2.6.  Combining workflows

Esko Plato allows you to combine workflows, if you need to. So, you can import a CAD layout
and add loose stations via 'Place Station...'. There may be workflows where this is needed. But
remember that the final layout still might have to be pre-trimmed to enable die cutting and
folding.

3.3.  Using a CAD file for plate layout (optional)

Esko Plato can open a CAD file to define the plate layout. When you open a CAD file, you
are using the CAD Layout Workflow. This workflow defines the number and locations of the
stations that are on the plate. It may also contain a sheet size and masks with bleeds for the
stations. If these features are in the CAD file, Esko Plato will use them in your layout.

• Supported CAD file formats

• CAD Layout or CAD 1-up?

• Importing a CAD layout

• Using Print Item names

• Flipping a CAD layout to print side

• Importing a different CAD layout

• Releasing a CAD layout

3.3.1.  Supported CAD file formats

Esko Plato imports CFF2, DDES, DXF and ArtiosCAD Manufacturing and Design file formats. The
CFF2 and DDES CAD file formats are industry standards. Most CAD systems support at least
one of these file formats.

Esko Plato knows how to import the native file formats of ArtiosCAD directly. A layout file in
ArtiosCAD is called a manufacturing file; a 1-up or single file is called a design file.

Importing CFF2 files
CFF2 import supports the existing CFF2 files: a CFF2 file describing a layout places stations with
a rotation combined with a mirroring (negate).The problem is that the CFF2 specification does
not specify exactly in which order the rotation and negation have to be performed and results
differ depending on the sequence. Some CAD vendors have chosen to rotate first and then
negate (e.g. Artios), others do it the other way around (e.g. Elcede).

Click ‘Setup’, the CFF2 Import dialog box pops up.
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Mapping allows you to map CFF2 line attributes (line type, aux line type, pointage) onto line
types (ArtiosCAD style). Please refer to the chapter 'DXF Import' for more information.

CAD styles: please refer to the chapter 'CAD styles' for more information.

Click the Search for Print Item check box if you want Esko Plato to search for a graphic that
matches the Print Item name in the CAD file. Esko Plato will look for a graphics file (GRS/STA/
PDF/PDFSTA) that has the same name in the directory where the CAD file is located. If no
matching file is found, a browser will appear and ask you to locate the missing file.

In case the supplied CFF2 file has undergone a ‘common knife removal’ optimization, the
option ‘reconstruct common cutting lines’ can be used to try to reconstruct common cut
lines. This is needed if you want to use the cut lines as the basis for mask creation (Create
Bleed mask in Station View and adjust masks in Sheet View). When this option is activated, cut
lines from adjacent designs and from the layout level will be used to complete the cut lines
from the different designs.

By enabling Use Sheet Size from CAD File, you can have the Sheet Size of the open Layout
changed to the Sheet Size of the CAD file.

If the Use LL/UR values option is enabled, the exact LL and UR values (Lower Left and Upper
Right) as defined in the CFF2 file are used to define the sheet size, regardless of the position of
the CAD design itself.

If the Use LL/UR values option is disabled, the bounding box of all structural lines is used.
However, in that case you can include the LL/UR box in the bounding box by enabling the LL/
UR values contribute to sheet size option in the Mappings.

DXF Import (Drawing eXchange Format)
Click 'Setup', the DXF Import dialog box pops up.
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Click 'Mappings' to check or modify the selected mapping.

 

 

1. In the preview area, one sees the result of the current settings on the selected file. (Cut
lines are visualized in red, crease in green and bleed lines in blue).

2. The mapping rules allow to map DXF layer names, DXF line styles and DXF color numbers
onto line types (ArtiosCAD style). The mapping rules are a simplified version of the tune
options from ArtiosCAD. Use the mapping rules to indicate which DXF elements will be
imported as cut, crease or bleed lines. The mapping rules are scanned from top to bottom,
as soon as a DXF element matches a rule, the action corresponding with this rule (ignore or
import as cut, crease, bleed) will become effective.

3. Units: As the DXF file format does not have any indication of the units used in its
coordinates, the correct unit must be defined.

4. Design side: Select InSide or OutSide. Esko Plato always reads CAD data in ‘outside’ mode. If
the CAD data was designed from the inside, the CAD data will be flipped around the vertical
axis.
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Tip:

It is very likely that different suppliers of DXF files will use different conventions. Some might
use different layers to distinguish between cut and crease lines, some might use different
colors. Suppliers of DXF files should be able to indicate how the DXF file is structured. It is good
practice to save mapping rules as customized setting for each supplier.

3.3.2.  CAD Layout or CAD 1-up?

There are two types of CAD files: layout files and 1-up files. Layout files often contain several
stations that are repeated on a sheet or board. 1-up files contain a single station without any
repeat information.

ArtiosCAD has two separate formats for these two different types of files, but CFF2 and DDES
do not. This difference is important: you can import layout files into a plate but you cannot
import 1-up files into a plate. You can, however, import 1-up files into the Station View.

How do you know if your CAD file contains layout information or 1-up information? You can't
easily determine this, but Esko Plato knows the difference. If you try to import a CFF2, DXF or
DDES file that only contains a 1-up into Esko Plato, you will see an error message telling you
that the file is not a layout file.

Note:

Layout CFF2 = subroutined CFF2

Layout DXF = DXF with BLOCK command

Note:

When trying to import a CFF2 or DXF file that is seen by Esko Plato as a 1-up CAD file, a
message will be displayed. However, it is still possible to import the file. In some cases (for
instance when common knife removal has been applied), CAD files might have lost their
structure which makes it impossible for Esko Plato to extract the position of the stations. After
loading these CAD files, you will have to manually align the graphics on the CAD lines.

3.3.3.  Importing a CAD layout

You import a CAD layout file into a plate file:

1. On the File menu, click 'Import CAD Data'. The Import CAD Data dialog box appears:
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2. Select a file type.
3. Locate and select the file you want to import. A preview of the contents of the file appears

in the File Info area of the Import CAD Data dialog box.
4. Setup opens the CAD Import dialog box that allows you to do mappings, select or create a

certain CAD style or search for print items. Esko Plato will then search for stations that match
the names of the Print Items listed in the CAD file and will automatically place them in the
layout.

5. Click 'Open'. Clicking 'Cancel' will close the Import CAD Data dialog box without importing
the file.

The CAD layout is imported into your plate. A lot happens when you import a CAD layout. Here
is an overview:

• The cut and crease lines that are in the CAD file are imported in the colors and line widths
as set in the selected CAD style file.

• If a sheet size is defined in the CAD layout and it does not match your current sheet size, the
sheet in your plate is changed to the new size.

• If the sheet size defined in the CAD layout is larger than the plate size in your plate, the
plate is enlarged so that the sheet still fits on the plate.

• If you chose to search for Print Items, Esko Plato searches for stations (or GRS files) whose
name is the same as those listed in the CAD file. If a matching file is not found, a Browse
dialog box will appear to ask you to locate the missing file(s).

• If you chose not to search for Print Items, your layout file now contains a set of "empty"
stations or stations that have no graphics. You can select one of these stations by a simple
click.

Note:  When importing an MFG file, you can choose to import it as "Reference Lines" in the
CAD Import setup window. By doing so, the MFG file will not be imported as CAD but only as
reference lines, in a separate "CAD Reference " layer. Importing the MFG file will have no other
influence on your open document.
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If you need to make adjustments to the sheet or plate size, you can use the Layout Setup
dialog box to override the values from the CAD layout. See Changing the sheet or plate size.

3.3.4.  CAD Styles

A CAD Style changes the appearance of the imported CAD lines.

You can define new styles, and edit or delete existing ones.

To create a new CAD style:

1. Click 'New...'

 

 

2. The 'New CAD style' dialog box pops up, a default configuration is displayed. You can edit
this configuration to fit your needs.

 

 

3. Enter a name.

Click 'New...'.
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4. The 'New Line Style' dialog box pops up.

 

 

Choose a Line type from the drop-down list.Choose an ink for this line type.Define a line
width. You can also decide to make it a dashed line by clicking the toggle.

Press [Enter] to add the Line Style to the CAD style.
5. The new Line Style is added. You can edit existing Line Styles by selecting them and clicking

'Modify...'.

Click 'OK' to add the new CAD style to the CAD Style dialog box.
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Note:

You can use ‘Other Structural’ as a wildcard on the last line. This will handle all structural lines
types that were not explicitly mentioned in the table of line styles.

3.3.5.  Using Print Item names

Esko Plato can search for and automatically place stations based on the Print Item names
contained in the CAD file. The following rules are used for searching:

1. Esko Plato looks in the current directory for PDFSTA files that have the same name as the
Print Item name specified in the CAD file. The current directory is the one that contains the
CAD file. If a PDFSTA file is not found, go to Step 2.

2. Esko Plato looks in the current directory for PDF/GRS files that have the same name as the
Print Item name specified in the CAD file. If no PDF/GRS file is found, go to Step 3.

3. A File Browser is opened for you to locate the missing file. Choosing a file adds a new
directory to the search list. Now there are 2 search directories : the original one where the
CAD file is located, and a new one where you located a file with the File Browser. Go to Step
4.

4. Look in both search directories for the remaining files. If no file can be found, the File
Browser appears again asking you to locate the missing file.

This browsing and searching loop continues until all the Print Items specified in the CAD file
are found. If all Print Item names can be matched with either (PDF)STA or PDF/GRS files in the
directory that contains the CAD file, then the File Browser will never appear and the layout will
be automatically created.

These search rules will choose an (PDF)STA file before choosing a PDF/GRS file. For example, if
the Print Item name is "job1" and the current directory contains an STA file named "job1.sta"
and a GRS file named "job1.grs", the STA file will be assigned. A Station file will always be
selected before a GRS file because they contain more information.

With these search rules, your layout may have all (PDF)STA files assigned, all PDF/GRS files
assigned or may have a combination of both (PDF)STA and PDF/GRS files.

3.3.6.  Flipping a CAD layout to print side

CAD files can show the cutting and creasing information in two orientations: Die Side and Print
Side. Die Side displays the layout as it would look if you were looking at the cutting die itself.
This is a mirror image of the printed sheet. Print Side shows the layout as it would look if you
were looking at the printed sheet. The Print Side orientation is the one you want to use for
Esko Plato because it is in the same orientation as your graphics.

You may have CAD files that show Die Side. If this is the case, you will need to "flip" the CAD file
over so that you can work with the Print Side.

To flip a CAD layout to print side:

1. Make sure that you have a CAD layout file in your plate. If you do not have a CAD file in the
plate, the command will be disabled.
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2. On the Tools menu, click 'Flip CAD to Print Side'. The CAD file is flipped over to print side.

3.3.7.  Importing a different CAD layout

You can only have one CAD layout on a plate at a time. If you have a CAD layout in your plate,
the Import CAD Data command is disabled. If you want to replace it with different CAD layout,
you need to delete the current one in the plate.

3.3.8.  Releasing a CAD layout

In a CAD Layout Workflow, the stations that are assigned to the imported CAD layout are tied
together. The stations cannot be moved away from their positions in the CAD layout or one
another. However, there may be times when you need to make adjustments to the locations
of the stations with respect to one another. The Release CAD Layout command provides this
feature. You can remove the CAD layout and "free" the stations by selecting 'Release CAD
Layout' on the Tools menu.

This command will delete the imported CAD layout but keep the stations in their current
positions. In reality, you are changing your workflow from the CAD Layout Workflow to the
Manual Layout Workflow.

It is a good idea to use this command only after you have most of your layout done. For
example, if you don't have the right position for the layout and need to move it after this
command, you'll have to select all the stations to keep them together.

Release CAD Layout tips

• You should use this command only if you really need to . After deleting the CAD layout, the
stations can be freely moved with respect to one another. So, it's possible for mistakes to
occur that make it impossible to die cut the layout later.

• You should have the basic features of your layout set correctly prior to using this command.
At the very least, make sure that the plate size, sheet size, sheet offset and layout position
are correct.

• If you release the CAD layout and make adjustments to the position of the stations, you
should use the Adjust Masks tool after you have made these adjustments. Otherwise, the
masks may no longer be correct if the stations have moved.

3.4.  Using Templates

You use templates to automate the layout setup, CAD layout and marks features that you
often use. If you regularly create layouts for a particular press or customer, you should use a
template.

• What is a template?

• Creating a template

• Saving a template

• Using a template
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3.4.1.  What is a template?

A template is nothing more than a layout file that has been saved as a template. When you
save a layout file as a template, the following features are saved:

• sheet size, plate size and sheet offset
• marks attached to the plate and sheet
• CAD layout, if one is present in the plate file
• Stations that are currently placed on the layout

You assign or place new stations onto the template and then save it to create a finished layout.

The workflow for using templates is:

1. Create a layout file. Add plate and sheet marks; add a CAD layout if desired.
2. Save the file as a template.
3. Select the template when starting a new layout.
4. Add stations to complete the layout.
5. Save as a Esko Plato layout file.

3.4.2.  Creating a template

To create a template, you need to create a layout file that contains all the layout information
for a particular press. To automate as much as possible, your template should include marks
too. Then all the layouts created will be the same.

3.4.3.  Saving a template

When you save a layout file, you can choose to save it as a template. This is how templates get
created.

To save a template:

1. On the File menu, click 'Save Layout As'.
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2. Select 'Plate Template' from the 'Save as type' list.
3. Click 'Save'.

The extension of the saved template files is either .plt or .pdfpla.

Caution:

Templates are always saved in Esko Plato's template directory, regardless of
which directory you choose. If you need to delete a template, you will need to
remove it manually from \Esko-Graphics\bg_data_custom_v010\dat\plt OR \Esko
\bg_data_custom_v010\dat\plt for new installations.

Click 'Setup...' to open the set plate template options:

• Saving a layout as a Plate template

• Saving a layout as a PDFPLA file

• Saving a layout as a PLA file

Saving a layout as a Plate template
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Display ImageThis option allows you to set the type of display image that will be included in
the file. Choices are: No Display , Thumbnail (200 x 200 pixels) or Display image (preview of
72 dpi), which creates a low resolution preview that can be used when the file is placed as an
external file.

SelectYou can export your entire job or a part of it.

• All - saves the entire job
• Red Selection - saves objects selected in red only
• Current Layer - saves the currently active layer only
• Current Page - saves the current page

Inks and Colors

• 'Clean up unused colors' automatically removes all unused inks.
• 'Clean up unused inks and colors' automatically removes all colors and inks that are not

used in the job.
• 'Save unused inks and colors' saves unused inks and colors.

Composed textComposed text is non-editable text. It can be converted to editable text by
clicking it when you are in text edit mode.

Save unused StationsCheck the box if you want to save stations that have not been used in
your design. By default, unused stations will not be saved.

Saving a layout as a PDFPLA file
When working in PDF mode, you can save your layout as a PDFPLA file.

 

 

Display ImageThis option allows you to set the type of display image that will be included in
the file. Choices are: No Display , Thumbnail (200 x 200 pixels) or Preview & Thumbnail (72 dpi),
which creates a low resolution preview that can be used when the file is placed as an external
file.

SelectYou can export your entire job or a part of it.

• All - saves the entire job
• Red Selection - saves objects selected in red only
• Current Layer - saves the currently active layer only
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• Current Page - saves the current page

Inks and Colors

• 'Clean up unused colors' automatically removes all unused inks.
• 'Clean up unused inks and colors' automatically removes all colors and inks that are not

used in the job.
• 'Save unused inks and colors' saves unused inks and colors.

Composed textComposed text is non-editable text. It can be converted to editable text by
clicking it when you are in text edit mode.

Export to Scope 3 Compatible fileCheck this box if you want your Normalized PDF file to be
Scope 3 compatible.

Save unused StationsCheck the box if you want to save stations that have not been used in
your design. By default, unused stations will not be saved.

Include CAD info for Digital Flexo Suite: This allows to include staggered cutting & CAD paths
in the PDFFLA file. All stroked technical lines can then be forwarded into the LEN file, so that
Digital Flexo Suite can pick these up. This can be used for example to plot the die lines on a
carrier sheet out of Digital Flexo Suite. See also Staggered Cutting on page 165

Saving a layout as a PLA file
When working in GRS mode, you can save your layout as a PLA file.

 

 

Display ImageThis option allows you to set the type of display image that will be included in
the file. Choices are: No Display , Thumbnail (200 x 200 pixels) or Display image (preview of
72 dpi), which creates a low resolution preview that can be used when the file is placed as an
external file.

Hide Technical InksWhen selected, technical inks will be stored in the file but will not be
visible as exposable inks for the Esko FlexRip.

SelectYou can export your entire job or a part of it.

• All - saves the entire job
• Red Selection - saves objects selected in red only
• Current Layer - saves the currently active layer only
• Current Page - saves the current page

Inks and Colors

• 'Clean up unused colors' automatically removes all unused inks.
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• 'Clean up unused inks and colors' automatically removes all colors and inks that are not
used in the job.

• 'Save unused inks and colors' saves unused inks and colors.

Save unused StationsCheck the box if you want to save stations that have not been used in
your design. By default, unused stations will not be saved.

3.4.4.  Using a template

Once a template is saved, it will become available in the Layout Setup dialog box when you
create a new layout. To use a template, click the 'Use Template' checkbox and select a template
from the list.If QuickStep templates are present on your system, they will also be included in
the list.
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4.  Working with Stations
Arranging stations on the plate is the primary purpose of Esko Plato. This section will provide
you with the basics of working with station files. You will learn a.o. how to create stations, how
to add them to the plate, how to adjust areas where two stations overlap and how to number
stations.

• Creating, editing and saving a station
• Using a CAD file to create a station
• Adding stations to the plate
• Working with empty stations
• Adjusting overlapping stations
• Nesting Stations
• Numbering stations

4.1.  Creating, editing and saving a station

The Station View is a view dedicated to editing a station that you want to use on your plate. You
can easily switch between the Sheet View and the Station View by clicking the view icons in the
View Selector.

The definition of a station is embedded inside the Esko Plato file. So it is not needed to save
your stations. There is however a possibility to save a station file. This is only necessary in case
you want to use this station in other Esko Plato files. Important to note is that the only external
references that Esko Plato uses are the references to the graphics files. Even if you load a STA
file in the Sheet View, the contents of the STA file (i.e. the definition) will be embedded inside
the Esko Plato file. In other words, it will keep the link to the graphics file but there is no link to
the STA file.For a clear definition of a station, please refer to the chapter 'What is a station?'

A station file is always saved with a STA - or PDFSTA (in the case of Normalized PDF graphics)
extension. So, saving a file with the name "3Up" will save a file on your disk with the name

"3Up.sta". Station files always have the station file icon 

• Creating a new station
• Creating a new station in a CAD workflow
• Editing an existing station
• Using Select Die Shape
• Saving a station

4.1.1.  Creating a new station

You can create new stations by clicking the ‘Add station’ button  in the Grids, Station or
SmartLayout dialog boxes. In all cases a file browser will pop up to select the required graphics.
A new station will be created using the (external reference to the) graphics and a die shape on
the trim box of the graphics. The first 2 approaches will place the station as a 1 by 1 grid block
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on the plate.The ‘Add empty station’ button  can be used to create a new empty station
with a size that can be specified.

Tip:

You can take any entry from the Station dialog box and drag it onto the document window. This
will place the station as a 1 by 1 grid block (except when working in a CAD layout). Afterwards,
the station can be altered either from the Grids or Station dialog box (setting the die shape and
bleed mask) or from the Station View. Once a station is on the plate, you can use the controls in
the Grid dialog box, the Transform tool and the Align tool to define your layout.

Note:

Importing a CAD layout will create new (empty) stations for each design that is found in the
CAD file.For more information, please refer to the chapter 'Creating a new station in a CAD
workflow'.

In the Manual Workflow, you do not start with a CAD layout file. You need to create a new
station file and place it on the plate to start building the layout yourself.

4.1.2.  Creating a new station in a CAD workflow

In the CAD Workflow, you start by defining a plate and importing a CAD file to create a layout.
When you import a CAD file, "empty" stations are created. You then need to create station files
to assign to these empty stations. To create a station file for a CAD layout:

1. Import a CAD layout file into your plate.
2. Select an"empty station that you want to assign a station file to.
3. On the View Selector, click ‘Station View’.

The Station View will be activated and the 1-up CAD design for that station is loaded.

You can now complete the station with a graphic, a mask, station marks and station numbers.
When you return to the Sheet View, the new station definition is assigned to the CAD layout
everywhere this same 1-up CAD design is used.

Tip:

Select Stations in Filled Mode  as it makes them easier to select.

4.1.3.  Editing an existing station

Regardless of which workflow you are using, you can always edit an existing station. To edit an
existing station on the plate:

1. Select the station that you want to edit (either on the plate or in the Station dialog box).
2. Click the Station View icon on the View Selector toolbar.
3. Edit the station in the Station View mode and switch back to Sheet View mode.
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When you return to Sheet View mode, the changes to the station are updated in the plate.

Other ways to edit existing stations:

• Use the ‘die shape’ and 'bleed' columns in the Grids or Stations dialog box.
• Use the Station Properties dialog box.

4.1.4.  Using Select Die Shape

Use 'Select Die Shape' on the Station menu to modify the default die using several different
methods. You can modify the default die on the basis of the trim size of the graphic or you can
use the graphics' contours as the default die. 'Select Die Shape' is only available if a graphic has
been imported into the station.

You can create a rectangular die shape by using the option Custom Size. Simply specify the
required height and width of the die shape.

 

 

You can fit the die to the trim size of an imported graphic. Esko applications, like PackEdge,
call the trim size the Borders. Desktop applications often call the trim size the Page Size or the
Document Size. If your graphic has the correct trim size to use for the die, the Select Die Shape
dialog box can create the station's die from the trim box of the graphic.
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To create a die from the trim size of an imported graphic:

1. On the Station menu, click 'Select Die Shape'.
2. Select the Graphic's Trim Box (Borders) from the list.
3. Click 'OK'.

The station's die is modified to match the trim size of the graphic.

You can also choose to use specific contours in the graphic as the die. You can use the other
options in the list to choose the contours that you want to use. Use Objects marked with
label Die to use the contours that have the Esko PackEdge annotation "Die". Use 'Objects
using ink' to use contours that use a specific ink in the graphic. These options will copy the
stroked contours from the graphic into the station.
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To create a die from contours marked with the Esko PackEdge "Die" annotation in an imported
graphic:

1. On the Station menu, click 'Select Die Shape'.
2. Select the objects using 'Objects marked with annotation Die'.
3. Click 'OK'.

If you are using a CAD design in your station, the die shape options are not available. You
cannot change the die size of a station with a CAD design. The station's size is always set to the
bounding box of the die in this workflow.

Select Outline of all objects to create a die shape around objects that have no die shape
in the original file. The new die shape will be created around the union of all objects in that
particular file. You can specify a particular offset which will make your die shape a little bigger
and you can indicate the shape of the corners.
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4.1.5.  Saving a station

To save a station, click 'Save Station' on the Station menu. Note that saving a station is only
needed if the station needs to be used in another Esko Plato file. Station definitions are
embedded inside the files.

To save a station file:

1. On the Station menu, click 'Save Station'. The Save dialog box appears:

 

 

2. Type a name for your station file.
3. Locate the directory where you would like to save the file.
4. Click 'Save' to save the contents of your file. Clicking 'Cancel' will close the Save dialog box

without saving your file.

4.2.  Using a CAD file to create a station

A CAD file can be used to create the die shape for your station. There are different ways to
import CAD designs (1-Up). When importing a CAD layout in the Sheet View, empty stations are
created which will have the 1-up CAD design as die shape. Also, when creating a new station
when clicking the Add Station button in the Grids or Stations dialog box and selecting a CAD
design, an empty station will be created which will have the CAD design as die shape.The
design can also be imported from a CAD file from within the Station View.

• CAD designs automatically from Esko Plato
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• Importing a CAD design

• Importing a different CAD design

4.2.1.  CAD designs automatically from Esko Plato

When you import a CAD layout into a plate, "empty" stations are created for each 1-Up design
in the layout. If you select one of the "empty" stations and switch to the Station View, the
station object is opened and the CAD design for that station is displayed. You then complete
the station by adding a graphic, a mask and any marks that are required.

4.2.2.  Importing a CAD design

Another way to create a station from a CAD layout is to import a 1-up design directly into the

Station dialog box. Click the Add Empty Station button  in the Grids or Stations dialog
box. Check ‘Based on file’ and select the required CAD file using the ‘Select File’ button. This
creates an empty station with the CAD file as die shape.

 

 

The next step is to select graphics for this station. The reverse sequence is also possible: create
a station and afterwards, switch to the Station View and use Import CAD Data to create the die
shape.

1. On the File menu, click 'Import CAD Data...'. The Import CAD Data dialog box appears.
2. Select a file type.
3. Locate and select the file you want to import.
4. If the selected file turns out to be a layout file (MFG file), an extra dialog will pop up to

enable you to select the CAD design from the layout.
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This dialog box lists all the 1-up designs that are contained in the CAD layout you selected.
The names of the designs are listed on the right. You can choose the design that you want
by selecting its name from the list. The preview window on the left previews each of the
designs as you select them.

5. Click the Search for Print Item checkbox if you want Esko Plato to search for a graphic that
matches the print item name in the CAD file. Esko Plato will look for a graphics file (GRS/
STA/PDF/PDFSTA) that has the same name in the directory where the CAD file is located. If
no matching file is found, a browser will appear to ask you to locate the missing file.

6. Select the design you want and click 'OK'.

The design you selected is imported into your station.

If any other die is currently in the station, even if it is a manual die, it will be replaced by the
imported CAD design die. The station's size is set automatically to the same size as the new die.

4.2.3.  Importing a different CAD design

You can only have one CAD design in a station at a time. If you want to replace a CAD design
with a different one, click Station > Import CAD Design... The existing CAD design will be
replaced by the new one.If you import a new CAD design and the existing one contained a
bleed mask, the mask will only be updated when switching to the Plate View.

4.3.  Adding stations to the plate

Above you learned how to create new stations. Esko Plato automatically assigns or places the
new stations on the current plate. But there are times that you may want to add an existing
station to a new plate. In this workflow, you need to assign or place the station yourself. You
may also want to replace a station that is currently on your plate with a different station. This
section tells you how to use these important functions.

• Adding a station

• Assigning a station

• Placing a station

• Replacing a station
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4.3.1.  Adding a Station

Click the Add Station icon  The Add Station dialog box opens.

Tip:

You can select multiple files.

Click 'Open' to add your station to the dialog box. Depending on the workflow chosen, this will
be the SmartLayout, Grids or Station dialog box.

 

 

When the station is placed, you can right-click the station or select 'Station Properties...' from
the top-right pop-up menu in the SmartLayout, Grids or Station dialog box to view and adjust
the station properties.

Click the Add Empty Station icon  to add an empty station. An empty station is a dummy
station that you can replace with an actual station later on. You would do so when you are
designing a layout before having received the actual graphics. However, in that case, you would
need the exact measurements of the future graphics, as Esko Plato will ask for them in the
Place Empty Station dialog box:
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Use the ‘based on File’ option together with the the ‘Select File’ button if you want to create an
empty station based on an existing file. This offers 2 possibilities:

1. select an existing graphics file (grs or normalized PDF). In this case, the size of the selected
graphics will be used as the size of the empty station.

2. Select a CAD file. In this case, the CAD data will be used to define the die shape of the empty
station and the size of the station will match the bounding box of the CAD data.
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4.3.2.  Assigning a station

Most of the time, you will be creating new plates and stations starting from a layout. But if you
have an existing station that you want to use with a new CAD layout, you will need to assign
the station yourself. When assigning a station to a layout, the station is analyzed for a die
object in a CAD structure (the CAD file loaded in a STA or GRS file). A dialog box is displayed
indicating whether the CAD files match.If you have a CAD layout file in your plate and already
have created a station file, you assign the station to the layout. To assign a station:

1. Import a CAD layout file into your plate.
2. Select an empty station to assign the existing station file to.
3. On the Station menu, click 'Assign Station to Design'. The Assign Station dialog box appears:
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4. Select the type of file that you would like to assign.
5. Select the file that you want to assign.
6. Click 'Open'.

The Assign Station dialog box closes. The station file you selected is assigned to all locations in
the CAD layout where the same 1-up CAD design is used. If you want some locations to use a
different station file, use the "Replace by..." command. See Replacing a station.

4.3.3.  Placing a station

The Place Station command is used to add an existing station to a plate in the Manual Layout
Workflow. This command will place an existing station in the lower left corner of the sheet. This
is the default situation. The orientation can be set in Edit menu > Preferences > Defaults. Once
a station has been placed in the layout, you can use the Transform and Align tools to create
your own layout.

To place a station:

1. Create a new layout.
2. On the Station menu, click 'Place Station'. The Place Station dialog box appears:
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3. Select the type of file that you would like to assign from the 'Files of type' list.

Tip:

It is possible to make a page selection. The default is to select page 1 of a PDF file (as well
for the front as for the back side). When creating the back side, Plato will automatically
select the next page of the PDF file.

4. Select the station file that you want to place.
5. Click 'Open'.

4.3.4.  Replacing a station

You may want to replace certain stations on your plate with a different station. For example,
you might want to replace stations in a plate layout that you did earlier with a new version. Or
you may want to replace specific stations to create a combination layout .

To replace a station:

1. Select the station(s) to be replaced.
2. On the Station menu, click 'Replace by...'. Click 'Replace Station' to browse to an already

existing station or select a station directly from the drop-down list.

 

71



4 Plato

 
3. Select the type of file that you would like to assign from the 'Files of type' list.
4. Select the new station file to use.
5. Click 'Open'.

The stations that you selected are replaced with the new station. Any stations that were not
selected for the Replace Station command remain the same.

4.4.  Working with empty stations

Working with empty stations allows you to create layouts even when the graphics aren't
available yet. Only the size needs to be known.

When a layout has been generated, empty stations can be replaced by the actual stations,
by using the 'Assign Station' or 'Replace Station' functions. While doing so, a check will be
performed based either on the CAD design (in case of CAD based layout) or on the size (of
the empty station against the chosen graphics file).Another way to replace empty stations is
using the Station properties dialog box. Simply browse to the real graphics. Note that this is the
equivalent of replacing graphics in the Station View.

The station properties dialog box allows you to assign dummy colors to both the actual files and
the empty stations. For 'real' stations this color is only used in the 'dummy colors' mode. For
empty stations, a designer ink, representing the chosen color is added.

When replacing a station, the inks used by the old station are automatically cleaned up (if no
longer used). As such, the dummy inks created when assigning colors to empty stations will
automatically be cleaned up when the empty stations get replaced by the actual files.

4.5.  Adjusting overlapping stations

In production, your plate layouts may have stations that partially overlap one another. For
example, if your stations include a bleed and they are placed on the layout so that they have
a common cut, the bleeds between the stations will overlap. The Adjust Masks tool is used to
adjust overlapping stations. The command searches the plate for overlapping stations and
presents each overlap to you as an overlap record. You decide how the overlap areas should
be adjusted. Decide once and Esko Plato automatically applies your decision to all areas where
the same overlap occurs.
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• Using Adjust Masks

• Splitting an Overlap Record

• Resetting masks

• Checking the status of masks

• Adjust Masks tips

4.5.1.  Using Adjust Masks

The Adjust Masks dialog box covers the SmartFlaps™ functionality. It assists you to intelligently
adjust overlapping graphic masks on the plate. SmartFlaps™ suggests by default to split masks.
Once a decision has been made, it is applied to all similar mask occurrences over the entire
plate.

The Adjust Masks tool will create new masks that are applied to the stations on the plate. The
stations' original masks are not altered.

To use Adjust Masks:

1. On the Tools menu, click 'Adjust Masks'. The Adjust Masks dialog box appears:

 

 

2. You can either opt for a quick adjust, or choose to adjust the masks manually.
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When choosing Quick Masks, the masks will be split based on the size of the adjoining
panels/flaps: large panels are automatically bleeding into smaller ones, asuming that
smaller panels are the invisible flaps. The example underneath shows an example: the dark
blue panel at the bottom is spread into the light blue glue strip.
 

 

The masks are not updated in real-time but they will be updated just before saving the file.
To force an update of the Quick Masks, you can use the ‘Adjust Mask’ dialog box.

The status of the masks will be indicated in the Status bar. If the masks are not up to date, a
warning will be displayed.
 

 

Manual masks (SmartFlaps™) allows you to decide on the overlap direction and bleed limit.
3. If you choose to adjust the masks manually, click the 'Scan...' button. Esko Plato will scan

all the stations on the plate looking for overlaps. Depending on the number of stations on
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your plate and their complexity, this scanning may take some time. Once Esko Plato has
completed the scanning, the overlap records are displayed in the Adjust Masks dialog box.

The document window is zoomed to display the first overlap. The area where these two
particular overlaps occur will be displayed normally. The area outside the overlap is
dimmed. One of the stations will be labeled "A" and the other will be labeled "B".

When you choose to bleed 1 station into the other (A into B or B into A), you can define the
maximum bleed per overlap situation.

 

 
4. Examine and set the correct mask for each record. By default, Esko Plato chooses the Split

option for each record. If you want all the masks to split between the dies, you do not need
to examine each record; you can simply choose 'OK'.

5. When you have examined and set all the overlaps, click 'OK'.

The Adjust Masks dialog box closes and new masks are applied to the stations on the plate.
The decision that you made for each record is applied to all instances where that particular
overlap occurs on the plate. When you use Adjust Masks, you only need to tell Esko Plato your
mask decision once. Esko Plato knows all the locations where that decision should be applied.
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Tip:

You can indicate your prefered way of masking by selecting 'Manual' or 'Quick' in the Defaults
tab of the Preferences dialog box. Selecting an option in the adjust mask dialog will change the
setting for the current file.

4.5.2.  Splitting an Overlap Record

There may be cases in which you need to treat part of an overlap one way and the other part in
a different way. Since a single record is modified by a single decision, you cannot do this unless

you cut the overlap into two pieces. You use the Split Overlap tool  to create two different
records from a single record.

In the following example, the two tuck flaps need to be underneath the two main panels. Since
there is one overlap that needs to be treated in two different ways, this overlap needs to be
split.

You use the Adjust Masks tool, as shown above, to split one overlap record into two records. To
split an overlap:

1. Locate the overlap record you want to cut.
2. Click the Split Overlap tool. The tool is selected in red as a one shot tool; the cursor turns

into scissors.
3. Click and drag in the document window where you would like to split the overlap record.

The record is cut into two different records.
4. Set the mask decision for each record.

The record is split into two records, which can be adjusted independently. The two records will
follow each other in the list. You can split an overlap record as many times as you want. Simply
select the Split Overlap tool again to make another cut.

4.5.3.  Resetting masks

When you use the Adjust Masks tool, new masks are applied to the stations on the plate. You
can remove these masks by selecting 'Reset Masks' on the Tools menu.

When you remove masks from the stations in the plate, the stations revert to using their
original masks as they were created in the Station View. The Reset Masks command is disabled
if there are no modified masks on the current plate.

4.5.4.  Checking the status of masks

How do you know if your masks are up to date? Esko Plato will display masks information in
the Status bar.If the masks are not up to date, a warning will be displayed.
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After adjusting, the Quick Masks status will show:
 

 

In fact, you can end up in one of these situations:

1. Masks: up to date!This situation occurs when masks are generated by one of the methods
mentioned above: "Quick Adjust" or "Manual Adjust". As long as no stations are added or
moved, this status will not change.

 

 

2. Quick Masks: please adjust!This situation occurs when masks were generated via "Quick
Adjust". In case stations were added or moved the masks are possibly no longer up to date.

 

 

3. Manual Masks: please check!This situation occurs when masks were generated via
"Manual Adjust". In case stations were added or moved the masks are possibly no longer up
to date.

 

 

To bring the masks up to date, go to the Adjust Masks dialog box by clicking the icon or the
underlined text in the status bar
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or by selecting 'Adjust Masks' on the Tools menu.

Remarks:

• Masks should be adjusted on both sides of the plate. Only the status of the mask on the
current plate side is shown!

• When the masks are not up to date and a user wants to save his work, a warning will be
displayed.

In case a plate uses the "Quick Adjust" way:

 

 

In case a plate uses the "Manual Adjust" way:

 

 

4.5.5.  Adjust Masks tips

• If you click 'Cancel', the Adjust Masks dialog box is closed and no masks are adjusted.
• When you use the Adjust Masks tool, new masks are created for the stations on the plate.

The new masks are used in the plate only; the original station file and its mask remains
unmodified.

• Adjust Masks uses the die outlines and the station masks to make adjustments on the plate.
Therefore, it is a good idea to use the mask tool in the Station View to create a mask. If your
station doesn't have a mask, Esko Plato doesn't have this information and can only use the
bounding box of the station to create the new masks.

• In order to see the 'A' and 'B' labels, make sure the 'Show selection in preview' option is
switched on in the View tab of the Preferences dialog box.
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4.6.  Nesting stations

The Esko Plato toolbar boasts a Layout tool  The main purpose is to facilitate stepping and
repeating one and the same station in a particular area of the sheet. However, this tool also
enables you to create a more intricate and advanced layout whereby labels or even folding
cartons can be positioned in such a way that a maximum of space is used within the given
area. This is called nesting.

Note:

The Layout tool takes into account the shape of a station. This implies that the shape of the
station is correct prior to using the Layout tool. You can adjust the shape via the Properties
dialog box.

To nest stations, perform the following steps:

1. Add a station to your sheet.
2. Right-click the station (depending on the ‘Origin’, that will be in one of the corners of your

sheet) and go to ‘Properties Station’ or click the Grid Settings button
 

 
in the Grids dialog box.

3. a. In the Station Properties dialog box, go to the Trimming tab, and select ‘Trim box’ or 'Die
Cut/ArtiosCut' from the ‘Die Shape’ list.

 

 

b. In the Grid Settings dialog box, select ‘Trim box’ or 'Die Cut/ArtiosCut' from the ‘Die
Shape’ list.
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c. A third way is to select ‘Trim box’ or 'Die Cut' in the 'Die Shape' column of the Grids or
Stations dialog box.

 

 

4. Finally, select the Create Layout tool and nesting mode from the fly-out toolbar and draw a
rectangle in which a vertical and horizontal repetition of the station in question will appear,
but whereby the stations are organized on the sheet in such a way that they are fitted into
one another.

 

 

4.7.  Numbering Stations

Use the Number Stations command to assign station numbers to the stations in your layout.
You must have a station number in your station for the numbers to be displayed on the plate.
You can add a station number to a station at any time. The actual numbering of the stations
takes place in Esko Plato.

Station numbers of 1 station all have the same number. Strip numbers are continuous
numbers over all stations.

For more information on the tool, please refer to the chapter 'Place Station / Strip Number tool'.
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• Using the Place Station / Strip Number tool

• Numbering stations automatically

• Numbering stations manually

4.7.1.  Using the Place Station / Strip Number Tool

The Place Station Number tool is used to set the parameters for a station number and to place
the number on the station.

To create a station number:

1.
Click the Place Station / Strip Number button  on the Tools toolbar to activate the
Station Number dialog box:

 

 
2. Set the parameters for the station number you want to add to your station. You can also

add a pre- and suffix to the station number.
3. Once the 'Place Station Number' tool is selected and you move the mouse over the

document the following pointer will be shown 
4. Click the position where you want the station number to be added. The cursor is changed

into  (station number) or  (strip number). You can add as many station numbers
as you want. However, every number will have the same value when added to the plate.

5. When you have placed all the numbers you want, click any other tool on the toolbar.

A station number always displays as a "0" in the Station View:
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When a station with a station number is placed or assigned to a plate, the numbers are
automatically replaced with unique numbers. The unique numbers in the plate have the same
placement and parameters as the placeholder that you added to the station.

Tip:

• The Ink list in the Station Number dialog box contains the inks that are used currently in
the station. The list also contains some special options for creating a white station number
(Knockout), a station number that prints in all inks (Registration), and a station number that
prints in the Darkest ink. Registration and Darkest choices will automatically update if the
inks in your station change.

• You can edit a station number by double-clicking on the number in the document window.
The Station Number window will appear showing you the number's current parameters.

• When you create a station number, a layer named "Station Number" is automatically
created. This layer is a special layer that is a non-printing layer. The layer is made non-
printing so that the station number placeholders do not appear on the plate.

• A selected number can always be moved by using the arrow keys, even if the Transform tool
is not active.

Please refer to the chapter 'Number Stations...' for more information on the various options.

4.7.2.  Numbering stations automatically

Esko Plato includes 16 possible number orders from which you can choose.

1. On the Tools menu, click 'Number Stations...'. The Number Stations dialog box appears:
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2. Indicate where you want to start numbering and specify a direction. Enter a start number if
necessary. Numbers will appear on the stations of the layout.

Caution:

When numbering stations, the position of the center of the label is taken into
account.
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3. When you have selected the order you want for the numbers, click 'OK'.

4.7.3.  Numbering stations manually

If one of the automatic orders is not what you need, you can define your own Custom Order.
With Custom Order, you indicate the number for each station by clicking it. You continue
clicking stations until all stations have been numbered. While Custom Order allows you to pick
any order, it can be a long task to select every station in a large, complex layout.

To number stations with a custom order:

1. On the Tools menu, click 'Number Stations'.
2. Enter a start number if necessary.
3. Click the 'Custom Order' button.

 

 

4. Click each station to set the order. You can undo the last choice by clicking 'Undo'. You can
reset all the numbers and start over by clicking 'Reset'.
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5. When you have numbered all the stations, click 'OK'.

You must click all stations to complete the custom numbering. The Number Stations dialog box
indicates which number you need to pick next.

Number Stations tips

• When using 'Number Stations', the document display is set to cross view to make it easier
to see the numbers. When you exit the Number Stations dialog box, your original display
mode is restored.

• The Number Stations tool is disabled when there are less than two stations on the plate.
• Stations can be numbered even if they do not contain a station number. If you add a

station number to the station in the Station View mode later, the numbers will appear
automatically.

• You can use the zoom, pan and display mode tools to get a better view of the plate.
However, using other tools or commands will cancel the Number Stations tool
automatically.

4.8.  Using PDF files as stations

When you place a PDF file directly in Plato, you are not using a station file (STA). Because PDF
files contain less information than PDFSTA files, some of Plato's commands work differently
than they do with station files.

• Die and Mask of a PDF file on page 86

• Adjust Masks with PDF files on page 86
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• Number Stations with PDF files on page 86

4.8.1.  Die and Mask of a PDF file

When a PDF file is used as a station, the Borders of the PDF file are used as the Die and the
Margins of the PDF file are used as the Mask. Therefore, all commands that use the Die and
Mask, like Step-and-Repeat, Align, Transform, and Adjust Masks, will use these Borders and
Margins.

4.8.2.  Adjust Masks with PDF files

The Adjust Masks command deserves a special note. Because the Borders and the Margins are
simple rectangles, the Adjust Masks command does not have a complex mask for irregularly
shaped stations. If your PDF file has an irregular shape, like a folding carton or an odd-shaped
label, then Adjust Masks will use the Margin rectangle as the Mask. This is sufficient for those
cases when you choose the Split option in Adjust Masks to split between the dies.

However, if you select the A over B or B over A options, then the mask of one station is used to
clip the mask of another station. If the masks are simple rectangles, as in the case of PDF files,
then one station simply cuts a rectangular hole in the other. This may not be what you want for
irregular shapes. For these jobs, you will need to make a station file that contains a complex
mask in the Station Editor to get the right overlaps.

4.8.3.  Number Stations with PDF files

The Number Stations command will work identically regardless of whether a station is a
PDFSTA or PDF file. However, since PDF files do not contain Station Numbers, no number will
appear in the layout. Only PDFSTA files that contain a Station Number placeholder will display
numbers in the layout. If you need station numbers to appear, you must create a station file
(PDFSTA).

4.9.  Using GRS files as stations

When you place a GRS file directly in Plato, you are not using a station file (STA). Because GRS
files contain less information than STA files, some of Plato's commands work differently than
they do with station files.

• Die and Mask of a GRS file

• Adjust Masks with GRS files
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• Number Stations with GRS files

4.9.1.  Die and Mask of a GRS file

When a GRS file is used as a station, the Borders of the GRS file are used as the Die and the
Margins of the GRS file are used as the Mask. Therefore, all commands that use the Die and
Mask, like Step-and-Repeat, Align, Transform, and Adjust Masks, will use these Borders and
Margins.

4.9.2.  Adjust Masks with GRS files

The Adjust Masks command deserves a special note. Because the Borders and the Margins are
simple rectangles, the Adjust Masks command does not have a complex mask for irregularly
shaped stations. If your GRS file has an irregular shape, like a folding carton or an odd-shaped
label, then Adjust Masks will use the Margin rectangle as the Mask. This is sufficient for those
cases when you choose the Split option in Adjust Masks to split between the dies.

However, if you select the A over B or B over A options, then the mask of one station is used to
clip the mask of another station. If the masks are simple rectangles, as in the case of GRS files,
then one station simply cuts a rectangular hole in the other. This may not be what you want for
irregular shapes. For these jobs, you will need to make a station file that contains a complex
mask in the Station Editor to get the right overlaps.

4.9.3.  Number Stations with GRS files

The Number Stations command will work identically regardless of whether a station is a STA
or GRS file. However, since GRS files do not contain Station Numbers, no number will appear
in the layout. Only STA files that contain a Station Number placeholder will display numbers in
the layout. If you need station numbers to appear, you must create a station file (STA).
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5.  Working with Graphics
Esko Plato was designed to be a replacement for analog step-and-repeat machines. These
machines step and expose a film for each item (a station) onto a larger piece of film that is
used later to expose the printing plates. Plato uses graphics the same way that a step-and-
repeat machine does: imported graphics are assumed to be digital film, ready for stepping.

Esko Plato is capable of doing quite some things a regular step-and-repeat machine cannot.
However, like a step-and-repeat machine, Plato assumes that the graphics files are completely
ready for imaging. This means that the graphic files should be of the correct size and have the
correct content. For this reason, graphics are not directly editable in Plato.

• About importing a graphic
• Replacing a graphic
• Importing an ArtPro file
• Importing a PostScript file
• Importing a PDF file
• Importing an EPS file
• Importing an Illustrator file
• Importing an EPF file
• Positioning a graphic
• Editing a graphic in Esko PackEdge

5.1.  About importing a graphic

When you import a graphic into the Station View, you can position and rotate the graphic just
like you can with a piece of film. However, you cannot scale the graphic in the Station View.
Scaling a graphic violates the digital film idea and can distort certain features of the graphic,
like trapping.

Graphics are always imported as external references. These external references provide the
high resolution display of the graphic and contain both size and ink information. Plato uses
these features to build station objects.

Station objects use graphics in native Esko-Graphics file formats. Plato can also import many
desktop graphic file formats which are automatically converted to an equivalent Esko-Graphics
native file format before being placed in the station.

Options windows for importing graphics files

Some file formats have special features that can be accessed by their Options window. The
Options window for each imported graphic file type is discussed in the sections below.

You import a graphic into a station by choosing the appropriate file type, selecting the file, and
setting options in the Options window, if necessary. The default options for each file type have
been chosen carefully so you should change these options only when you really need to.

All of the Options windows for the file types have two useful buttons: the Reset button and the
Customized Settings button.
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• Reset - The Reset button resets all the options that you may have changed in the Options
window to their default values.

• Customized Settings - The Customized Settings button allows you to save the current
settings so that they can be used later. You can also save the settings as your own default.
This feature is very useful for those file types that have many options that you modify each
time you import a graphic of a particular file type.

5.2.  Replacing a graphic

There are two ways to replace a graphic in a station with a different graphic.

1. You can use ‘Replace by Graphics File’ in Station View to discard an existing graphic and put
a different one in your station.

2. You can use the Station properties dialog box to replace the graphics.

'Replace by Graphics File' will delete the current graphic and place a new graphic in the station.
The new graphic is placed, based on the information of the current graphic in the station,
which implies that the new graphic will have the same position and rotation as the graphic
that it replaces. The center of the graphic is aligned with the center of the current die. If this
position is not correct, you can move or rotate the graphic with the Transform and Align tools.

Tip:

This feature is useful for changes that require a new graphic, while all the other parts of the
station need to remain exactly the same.

To replace a graphic:

1. On the Station menu, click 'Replace by Graphics File'. The Replace Graphic dialog box
appears:
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2. Select a file type.
3. Locate and select the file you want to use.
4. Click 'Setup...' to open the options window for the file type you selected.
5. Set any options that are required.
6. Click 'Open'. The graphic is converted to the Esko-Graphics native format, if necessary, and

is placed in the station file.

Or you can:

1. Open the Station dialog box.
2. Select the station.
3. Open the station Properties dialog box of the station.
4. Click 'Browse' to browse to a new graphics file.

Tip:

If the new graphic uses different inks than the current one, you may need to clean up the inks
that have now become unused. For more information, please refer to the chapter 'Inks'.

5.3.  Importing an ArtPro file

With the ArtPro import filter you can import an (Esko)Artwork ArtPro file into Plato directly. The
ArtPro files must have file extension .ap or .art.

Additional options appear in the ArtPro Import dialog.
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Search for missing images in:

Use this to search for missing images in a specific folder.

Note:  The images are searched: in the place referenced in the links, next to the input file, in
the folder defined in this dialog.

Embed all images

Use this to embed all images in the file.

Add non-printable layers

Use this option to include all layers, including the non printing layers.

Folder Mapping:

When the ArtPro file contains links to images that reside on a Mac OS-based file server, you
can mount the drive of the Mac OS server on the Plato (Windows) workstation and use the
Folder Mapping feature in the Export ArtPro to Normalized PDF task to keep the the references
to the images working in the normalized PDF.

To map folders from the ArtPro file to the Normalized PDF file:

1. Click Add.
2. In the Client column, type the drive name on the Mac OS system.
3. In the Server column, type the drive letter that is used to mount the Mac OS drive on the

Plato machine.

Example: In our ArtPro file, the path of an externally linked image is:
Intel_Mac:images:image1. We mount the Intel_Mac drive of the Mac OS file server on
our Windows-based Plato system, using the G:\ drive letter. To allow Automation Engine to
automatically locate the images on the Mac OS file server when exporting the ArtPro file, we
use the Folder Mapping feature to map "Intel_Mac" to "G:/".
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Limitations
There are some limitations when importing ArtPro files in Plato.

• When you import an ArtPro file into Plato, you will notice that the graphic visualisation of
both documents is the same, but the document structure is not.

Example: Linked ArtPro files and external ArtPro CT files will be embedded, and certain
special objects in the ArtPro file will have been degraded to normal objects.

Where possible, links to external images will be maintained.
• Step and Repeat or externally linked files in ArtPro to non-normalized PDFs and PostScript

files cannot be imported.
• Objects that do not have screening information in the ArtPro file get the following defaults:

• frequency 120
• dotshape: simpledot (round)
• angles C: 15, M: 75, Y: 0, B: 45 and any others: 45

• Inks from the PANTONE and Visualizer ink book are recognized. All other (custom) inks are
loaded from the ink book "designer" in Plato.

• Ink attributes "opaque", "varnish" and "normal" are kept. Ink attribute "Technical" (Die) is
not kept.

• Nexus screening is not allowed. For Extended Nexus screening, only use angle/ruling.
• The font is subsetted and embedded. This results in real text in Plato. When you import an

ArtPro file, two-byte fonts are always vectorized.
• Where possible, images keep their links. This is the case for most Tiff, jpeg and PSD

files, and also for mapped images. Some image formats are not supported by or are
incompatible with Esko software. This is the case for DCS images, PSD with multiple alpha
channels and Tiffs with extra channels which are often generated by ArtPro PS/PDF import.
These images are either embedded or they generate a .ct file on Esko software.

• Artlink updates are disabled.
• Barcode information is not kept, nor is the link to BAG and ARD files when the ArtPro file is

imported.

5.4.  Importing a PostScript file

You can import PostScript files and use them as a graphic in your station. PostScript files are
converted to GRS/PDF files. Composite and separated PostScript files can both be imported.

The Options window for importing PostScript and PDF contain the same features. The Options
for Illustrator and EPS contain some, but not all the same features as the PostScript Options
window. All the features of the PostScript Options window will be described here. The features
that are used in PDF, Illustrator and EPS files refer to this section.

Clicking 'Setup...' in the Replace Station dialog box opens the PostScript Options window. The
Options window contains tabs to fine-tune the import of PostScript files.

• Pages

• Color Management

• Inks

• Overprint

• Images
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• Page Size

• Other

• Output

5.4.1.  Pages

Some options of the Pages tab are used by Esko Software Suite applications other than Esko
Plato. Some options are disabled, as shown below:

 

 

Select All Pages or specify a Range of pages.

Split up a multipage fileTo divide the original multipage PostScript file into smaller parts. You
define the amount of pages to open (of the specified pages or range). What you need to know:

• Each part is stored as a separate GRS/`Normalized PDF file. It is either stored locally or
stored in the output directory .

• Each part is stored with the name of the imported PostScript file followed by _001, _002,
_0001_001... or it gets the output name.

Split up a multipage fileCheck the box to divide the original multipage PostScript file into
smaller parts. You define the amount of pages to open (of the specified pages or range). What
you need to know:

• Each part is stored as a separate Normalized PDF file. It is either stored locally or stored in
the Output Directory.

• Each part is stored with the name of the imported PostScript file followed by _001, _002,
_0001_001... or it gets the Output Name.

Merge Tiled CT files to one CTSome ArtPro files have tiled CTs, those are CTs which are
actually divided into a number of little CTs (tiles). Some jobs are so large that there are
thousands of these little CTs. Select this toggle to merge the tiles into one CT to improve
editability of the Esko native file and to optimize further processing. This option is default
selected, it doesn't matter if you import a file with no tiled CTs.
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Note:

When errors occur when a PostScript file is imported (e.g. a font is not found), the Merge Tiled
CTs to one CT will not be performed.

Merge Separated PostScript file to Composite pageMerges separated single-page and multi-
page PostScript files to a composite file.

Optimize Merged PostScript File This option optimizes the merged PostScript file. This is
useful when you need to edit the imported PostScript file. This option becomes available when
'Merge Separate PostScript File to Composite Page' is activated.

Note:

When errors occur when a PostScript file is imported (e.g. a font is not found), the Optimize
Merged PostScript File will not be performed.

PasswordYou can enter a password for protected PDF files.

5.4.2.  Color Management

 

 

• Destination Color Space

• Spot Colors

• RGB

• CMYK and Gray
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Destination Color Space
Here you define what color space the opened/imported document will have.

Color Space

• CMYK
• Grayscale

Destination ProfileChoose a color profile from the drop-down list. Currently only CMYK and
Grayscale profiles are supported, you can choose between standard ICC profiles and Esko
Kaleidoscope profiles.

The 'Use PDF Output intent if available' toggle: in some PDF files, the PDF Output intent is
defined (e.g. PDF/X-3). If you want to use the color space as defined in the output intent,
use this toggle. If you selected the toggle for a file without PDF Output intent, the chosen
Destination Profile will be used.

Rendering Intent

• Relative (No Background): Use this option if you do not want any background simulation.
Any color that falls outside the range that the output device can render is adjusted to the
closest color that can be rendered, while all other colors are left unchanged.The white point
of the source will be mapped on the white point of the destination process. This rendering
intent takes into account the ability of the human eye to adapt to the surrounding white.

• Absolute (Background): Any colors that fall outside the range that the output device can
render are adjusted to the closest color that can be rendered, while all other colors are left
unchanged. The white point is preserved.

• Perceptual: This will result in no background simulation (white of reference color space is
mapped on white of destination color space). In other words, if certain colors in an image
fall outside of the range of colors that the output device can render, the picture intent
will cause all the colors in the image to be adjusted so that the every color in the image
falls within the range that can be rendered and so that the relationship between colors is
preserved as much as possible.Use this option if you don't care too much about an exact
color match but you want the pictures at least to look nice on your proofer. It will give a
visually pleasing result. If the gamut of the source is wider than the proofer, the entire
gamut is shrunk so that it fits inside the gamut of the proofer.

• Saturation: Use this option if you care especially about saturated colors. It preserves the
saturation of colors in the image at the possible expense of hue and lightness.

Set Document ProfileA Document Profile is the color space of the process inks used in the
document.

• Always: you can 'tag' a Normalized PDF file with its Document Profile. This means that
the file 'knows' what its Document Profile is, which may make further color conversion
throughout a workflow more correct.

• Never: Document Profile is not set.

Spot Colors
PANTONE Inks

• Keep All: No PANTONE inks will be converted to process inks.
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• Convert All: All PANTONE inks will be converted to process inks.
• Keep list: All PANTONE inks will be converted except those listed in the Inks tab.

Method

• Use Destination Profile: PANTONE and Designer inks will be converted using the selected
Destination Profile. This gives the most accurate color reproduction.

• PANTONE Solids to Process (Euroscale). PANTONE inks will be converted to process inks
according to a fixed conversion table provided by PANTONE. The result is independent of
the selected Destination Profile. This assumes the Euroscale print conditions.

• PANTONE Solids to Process (SWOP). PANTONE inks will be converted to process inks
according to a fixed conversion table provided by PANTONE. The result is independent of
the selected Destination Profile. This assumes the American SWOP print conditions.

Designer Inks

• Keep All: No Designer inks will be converted to process inks.
• Convert All: All Designer inks will be converted to process inks.
• Keep list: All Designer inks will be converted except those listed in the Inks tab.

RGB
RGB will always be converted to process inks during import.

RGB MethodSelect one from the drop-down list

• Source to destination profile: the user needs to specify both the Source Profile (RGB) and
the Destination Profile (CMYK or Grayscale).

• With Link profile: the user specifies a Kaleidoscope Device Link Profile. this Link Profile
implicitely determines the Source and Destination profiles.

Source Profile / Link ProfileSelect one from the drop-down list.

Objects with RGB Profile tagsThe RGB objects in a PostScript or PDF file may be tagged with a
Color Profile.

• Convert using the RGB Profile tags: The user may choose to use that Color Profile as a
Source Profile (overruling the Source / Link Profile selected above).

Tip:

In strictly controlled workflows, the embedded tags are probably accurate, so this option
may be preferable.

• Ignore tags: the embedded Color Profile will be ignored, the Source / Link Profile defined
above will be used during conversion of RGB objects.

CMYK and Gray
The CMYK objects in a PostScript or PDF file may be tagged with a Color Profile. The color
percentages of untagged objects will always be preserved. For tagged objects, users have a
choice:

• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the percentages
will be those of the object's color.
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• Convert, preserve appearance: the objects' color profile will be taken into account; this
means that their color values will change.

The Gray objects in a PostScript or PDF file may be tagged with a Color Profile. The color
percentages of untagged objects will always be preserved. For tagged objects, users have a
choice:

• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the percentages
will be those of the object's color.

• Convert, preserve appearance: the objects' color profile will be taken into account; this
means that their color values will change.

5.4.3.  Inks

The Inks / Separations tab depends on the output type you selected in the Color Management
tab. If you choose CMYK Composite or Composite, the Inks tab will be visible, if you choose
separated output, the Separations tab will be visible.

 

 

Use rulings, angles and dot gain compensation from PostScript file if availableIf the
PostScript file contains rulings, angles and dot gain compensation, these will be used when this
toggle is selected, other settings in this tab will be overruled.

Apply Screen Swap TableSelect a screen swap table from the drop-down list.

Inks (double-click the fields to edit)

Autoload Ink Settings from Job SetupIf Job parameters were defined, you can use this toggle
to make sure these inks are used. If you do not click this button, you are free to edit the ink

97



5 Plato

settings. The default values as defined at the bottom are used for ink attributres that are not
set in the ink settings of the job setup.

Default values, used when a ruling, angle or dotshape is not specified.Enter the default
values for ruling angle and dotshape, the system will take these values when they are not
specified elsewhere (i.e. in the PostScript file, or in job Parameters, ...).

5.4.4.  Overprint

 

 

Strict overprint behaviorCertIn (the Esko input module) will honor the overprint parameter
100% according to the rules mentioned in the "PostScript Language Reference" (in case of
PostScript / EPS /AI import) and "PDF Reference Manual" (in case of PDF). This option *must*
be set when the user wants to process test files like the Altona test suite or other test suites
which verify overprint behavior correctness. This toggle controls how zero percentage inks are
handled when reading composite files. When 'Strict overprint behavior' is switched on all zero
percentage inks of a color are kept and correspondingly affect the overprint behavior. When
'Never strict overprint behavior' is selected, all zero percentage inks are removed.

• Never strict overprint behavior: all zero percentage inks are removed
• Always strict overprint behavior: CertIn will honor the overprint parameter 100% according

to the rules mentioned in the "PostScript Language Reference" (in case of PostScript / EPS /
AI import) and "PDF Reference Manual" (in case of PDF).

• Only strict overprint behavior for PDF: CertIn will honor the overprint parameter 100%
according to the rules mentioned in the "PDF Reference Manual" (in case of PDF).

Overprinting default is non-zero overprintingPrevents overprinted objects with zero CMYK
values from knocking out CMYK objects beneath them.

PostScript OverprintTo set the overprint mode that the conversion needs to apply when
importing the file.

• Convert into Opaque: Ignores any overprint of your job.
• Convert to Darken (Esko): Converts all overprint present in your PostScript job to Darken.
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• Keep Postscript Overprint: All PS overprint present in the job is imported correctly. (This is
the default setting.)

Note:

The preferred setting is 'Keep PS Overprint'. This will result in faster conversion when
outputting the job to PS/EPS/PDF.

Pure BlackTo set the overprint mode for objects containing 100% black only. Possible Pure
Black overprint modes in the drop-down list:

• As Other Colors: As it is defined in the job.
• Force Opaque (masking): Forces Opaque for objects in 100% black and knocking out all

underlying inks.
• Force >Postscript Overprint: Forces PostScript overprint for objects in 100% black.
• Force Darken (Esko): Forces Darken for ALL objects in 100% black. The black color is printed

on top of other colors, instead of erasing the color underneath.

Caution:

There are two problems:

• Sometimes ink saturation can occur.

100% black text on a 100% red (this is, 100% magenta and 100% yellow)
background, results in three inks printed at 100%.

• Black is best handled as knockout for flexo, since it is better to add a small
trapping region than to make the complete black region overprint.

Rich BlackSet the paint mode for objects containing 100% black and at least one other ink.

• As Other Colors: As it is defined in the job.
• Force Opaque (masking): Sets the overprint mode to opaque for all objects containing 100%

black and at least one other ink.
• Force Postscript Overprint: Keeps the PostScript overprint for objects in 100% black and at

least one other ink (overprint objects stay in overprint and opaque objects stay opaque).
• Force Darken (Esko): Forces Darken for all objects in 100% black and at least one other ink.

WhitePossible White paint modes to select from the drop-down list:

• Opaque: Forces all objects in white to Opaque.
• Keep PostScript Overprint: Keeps the PostScript overprint for objects in White (overprint

objects stay in overprint, opaque objects stay opaque)

5.4.5.  Images
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Embed all imagesAll images become internal images.

Link External Images (OPI, DCS, Helios, ...)Force the system to look for referenced images.

Fail if not FoundActivate this option if you do NOT want the system to continue importing /
normalizing your PostScript file when it cannot find an image. When this option is not activated
the imported (E)PS file will appear on screen but without the missing images.

Search for Preconverted FilesThis option forces the system to look for the GRx, CT or LP
equivalent for the original EPS file. If this equivalent is not found, it will use the EPS in stead.

Optimize DCS LineWorkWithout linework DCS optimization, the result after conversion of
linework DCS files can be difficult to edit. However, it will be correct when viewed in extended
preview or RIPped. 'Optimize DCS Linework' will do an additional operation to combine the
elements on each DCS plate to a composite and a more editable result.

ImagesAvailable options are:

• Use Most Recent: forces the system to use the existing images of a previous conversion of
the same job.

• Reconvert: forces the system to regenerate the images on-the fly.

Use MasksAvailable options are:

• PS Mask: Forces the system to take the PS mask present in the PS file. The mask available
in the external image is discarded. If no PS mask is present in the PS file, no mask will be
taken.

• External Mask: if any, PS Mask otherwise: Forces the system to take the mask present in the
external image. The PS mask is discarded. If the external image has no mask, but there is a
PS mask available in the PS file, this PS mask will be taken.
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• External Mask: if any, no mask otherwise: Forces the system to take the mask present in the
external image. The PS mask is discarded. If the external image has no mask, no mask will
be taken.

• No Masks: The PS mask and the mask of the external image are discarded.

• Joined External and PS Mask: Forces the system to join the available PostScript mask in the PS
file and the available mask in the external image.

Search directoriesTo specify a list of directories in which to look for referenced images. Use
the buttons 'Add' and 'Remove' to optimize the Search Directories list. Clicking opens the
directory selector. You can browse to the correct directory and click 'OK' to add the directory to
the Search Directory list.

Path TranslationTo define an understandable link for paths from a platform to another
platform. The Path Translation dialog box opens, it has three columns:

• From Platform: Use the drop-down list to select a platform from which the files are to be
retrieved: NT, Macintosh, Unix or VMS

• From path: Specify the syntax of the path(s) of the platform you want to retrieve files from.
e.g.

Mywork:PostScript:job1

• To Path: Define the syntax of the paths so that the destination platform understands. e.g.

Mywork/PostScript/job1

If you were to go from Macintosh to NT, the path translation could look like this:

 

 

You can do the same for files: File Translation.
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5.4.6.  Page Size

 

 

Page SizeThe default page size is PS Page Size. PS Page Size is the page size found in the
selected PostScript file for import. The drop-down list displays all possible options (Custom,
A5,...).

Reader's Spread To determine how the PostScript file, which has reader's spread format, must
be opened.

• Single Page: Forces the reader's spread in the PostScript file into single page output.
• Double Page: Forces PS File into reader's spread format. When the PostScript file contains

no reader's spread info, the single pages will be set as double pages.

OffsetThe original offset is bottom left. Specifying a positive vertical/horizontal offset moves
your PostScript file upwards/to the right in relation to the bottom/right border. Specifying a
negative vertical/horizontal offset moves your PostScript file downwards/left in relation to the
bottom/left border.

Scale vertical To enter the vertical scale percentage. 100% is the original size of the
PostScript file.

Scale horizontal To enter the horizontal scale percentage. 100% is the original size of the
PostScript file.

Rotate Forces the system to rotate the PostScript File with the specified angle. The origin
for rotation is bottom left. Possible angles in the drop-down list:

• 0: No rotation is to be performed.
• 90: Forces to rotate over 90 degrees counterclockwise
• 180: Forces to rotate over 180 degrees.
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• 270: Forces to rotate over 270 degrees counterclockwise.

5.4.7.  Other

 

 

Substitute Missing FontsRoman fonts by: choose a default replacement font for the missing
fonts for this job on your system.Japanese fonts by: choose a default replacement font for the
missing fonts for this job on your system

ImagesImport 1-bit images as:

• Embed: Images become internal black and white bitmaps.
• Linked file: Images are imported as external referenced LP files.
• Contours: Images are contourized during import of the (E)PS file.

CT display images Choose Yes to create a display image for the generated CT files on-the-fly.

Output file display imagesThis option is activated when 'Split Up a MultiPage File' was
activated. Select the type of display from the drop-down list: None, Thumbnail, Image.

Miscellaneous

Device resolution (xxx ppi)Device resolution is the resolution used internally by CertIn
during the normalization. Normally the produced output is not dependent of this internal
resolution but in some rare cases like when converting RIP test strips or device specific tests it
is important that this value is the same resolution of the final RIP device which will be used to
print output.

Virtual Memory LimitThe default value for the virtual memory is 50MB. The limit is set to 1
gigabyte.

Convert text to contourswill contourize all text.
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Note:

Conversion might increase the file size.

Workaround Options

Skip ImagesCheck this box to open the EPF file without linking to external images or
converting embedded images.

Preserve Quark trappingForces the system to keep the trap strokes made by QuarkXpress.

Disable optimizationsVignettes recognition and optimization for Photoshop Multitone
images are performed (whenever possible) when this option is not activated. Sometimes
after updating your DTP applications, Esko can no longer perform the optimization and the
conversion of the (E)PS file might fail. Switching this option ON will allow you to import the
(E)PS file.

Show PS commentsAll PS comments present in the (E)PS file are displayed on screen.

Disable OPIThis option is valuable when you are importing (E)PS files of QuarkXpress
containing high resolution Tiffs files for which the option 'Include tiff, omit ...' or 'Include all'
was activated. In this case, when importing such a file and if Link External Images (page 5) is
activated, the matching for the TIFF files will surely fail. It fails because at the time the (E)PS file
was generated OPI commands were also inserted for the TIFF files. Therefore, the system will
try to link to images for the Tiff files. To overcome this, activate Disable OPI.

Show external images searchesDisplays the path(s) in which the system has found and linked
to external images.

Optimize Illustrator Patterns into PostScript patternsIllustrator writes patterns in
a different way than PostScript does, default behavior is that Illustrator patterns will be
optimized. Normally this speeds up the further processing (less linework in your file)
sometimes, though, the optimization itself may take some time.

Use PostScript rules for color conversionCheck this box to make sure that all color
management will happen using PostScript rules, in stead of BGCMS. Most options in the Color
Management tabsheet will be greyed out.

Recognize ArtScreen (lpi-angle)Check this box and the application will try to recognize
screens that are created in ArtPro applications and swap them to Esko-Graphics screens. If a
(E)PS or PDF file with an unknown ArtScreen is imported, an error will be generated.For more
information, please refer to the ScreenFilter user manual.

5.4.8.  Output

The Output tab is used to specify the name and directories for converted PostScript files.

 

104



5Plato

 

Available options on the Output tab are:

Output NameSpecify an output name for the files created during conversion. If no name is
specified, the original PostScript file name is used.

Output DirectorySpecify the directory where the converted files should be saved. If no
directory is specified, the converted files are saved in the current working directory. Note: If an
Image Directory is specified, generated CT images will be saved in the image directory and will
not be saved in the Output Directory specified here.

Image Creation PathIf, during normalization, extra image data is created, you can indicate
here where these images should be written. If no output directory is specified, then CT images
generated during the conversion will be saved in the current working directory.

Fit Media Box (margins)Check this box to automatically fit the margins to the bounding box of
all the objects in the file.

Show ReportThis option displays valuable information during the import of PostScript files.
Information about errors, linked images, search directories,... is displayed.

Keep LayersKeeps the Illustrator layer information. This will only work for Illustrator 8 files. It
will not work for native Illustrator 9 files (or higher). When normalizing PDF 1.5 files (or higher),
the 'Keep Layer' option will also preserve the PDF layers.

Limit Filename Length to Maximum 31 characters.Check this box if you want to make sure
your imported files can be seen/read from/by all Apple operating systems (CTs that are kept on
a Windows share but might be edited on a MAC for instance).

5.5.  Importing a PDF file

The Options window for importing a PDF file contains the same features as those for
PostScript. There are two differences between PostScript and PDF import:

• On the Pages tab, a password field is available. If the PDF file is password-protected, you
must enter the password so that Esko Plato is able to convert the PDF file.

• Flatten PDF transparencies and layersCheck the box to import PDF files as in Scope 3 (and
lower). All transparencies and layers will be flattened.If not checked, a normalized PDF file
will be created that contains all typical PDF features (like transparencies and layers).
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See Importing a PostScript filefor complete descriptions of the import options.

5.5.1.  Importing multipage PDF files

When importing multipage files (without normalization), it is now possible to specify that every
other page should be treated as verso graphics. Example below will create 5 stations by loading
page 1, 3, 5, 7 and 9, page 2, 4, 6, 8 and 10 will be used as the verso graphics for these stations.
 

 

5.6.  Importing an EPS file

The Options for importing an EPS file contain some, but not all the same features as the
PostScript Options window. In particular, the Pages and the Page Size tabs do not appear.
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See Importing a PostScript file for complete descriptions of the import options.

5.7.  Importing an Illustrator file

The Options for importing an Illustrator file contain some, but not all the same features as the
PostScript Options window. In particular, the Pages and the Page Size tabs do not appear.

See Importing a PostScript file for complete descriptions of the import options.

5.8.  Positioning a graphic

When you import a graphic, the center of the graphic and the center of the die are aligned with
one another. If this position is not correct, you will need to position the graphic in the Station
View using the Transform and Align tools.

A graphic can be moved and rotated to precisely position the graphic in relationship to the
die. However, you cannot scale a graphic. The scaling feature of the Transform window will be
disabled whenever a graphic is included in a selection. If the Scale option of the Transform tool
is used on a selection that includes a graphic, scaling will also be disabled.

Tip:

When placing a GRS file in a CAD workflow, Esko Plato will analyze the GRS file and look for die
objects. If a die object is found, the GRS will automatically be rotated and moved so that the die
object is centered on the current CAD file.

5.9.  Editing a graphic in Esko PackEdge

PackEdge can be started up from within the Station View to edit a graphic used in a station.
Esko PackEdge must be installed on the same computer for the two applications to exchange
files.

To edit a graphic in Esko PackEdge:

1. In Sheet View, select the station that contains the graphcis to be edited.
2. On the Station menu, click 'Edit Graphics File...'.

Esko PackEdge is started and the graphic file is opened for editing. Make any changes you like
and save the file.

For this command, you must have a graphic in your station. If no graphic is present, 'Edit
Graphics File' is disabled.
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6.  Working with Esko Plato Tools
Using the tools in Esko Plato to organize and layout a plate

• Arranging Objects
• Creating a Repetition
• Creating two-sided plates
• Managing Inks
• Trapping

6.1.  Arranging Objects

In the previous chapters you learned how to work with stations. You can start with a CAD
layout and assign stations to the layout. You can also place stations in the manual layout
workflow. You also know how to adjust overlapping stations and how to number stations.

The rest of Esko Plato's tools help you to complete your plate layout. You can organize your
work by using Layers. You can transform objects on the plate using the Transform and Align
windows. And you can create a layout using the Step-and-Repeat tools. These tools are the
subject of this section.

• Using Layers
• Using To Front/To Back
• Using Group/Ungroup
• Group into Grid
• Using the Transform Window
• Using the Align Window

6.1.1.  Using Layers

Esko Plato uses the concept of layers to build a file. Layers can be used in stations as well as in
plates. You can use layers to organize the objects in your document. Esko Plato automatically
creates some layers for you, but you can edit these layers or add your own. You can also create
special layers, known as grid and markup layers. You can turn the display of layers on and off,
lock layers, indicate that layer must not be printed and rearrange the order of layers.You can
use multiple layers to keep similar objects together. For example, you might want to put all
your marks on one layer and all stations on another. The Layer Browser helps you create and
organize layers.

Objects in a station can be placed on layers to make them easier to organize and edit. Similarly,
objects in the plate can be placed in different layers too.

You can have as many layers as you want. You can also name layers to help you remember
what objects are on them and to make it easier for someone else to pick up where you left off.
You can also rearrange the order of layers.

108



6Plato

• Types of layers

• Adding an object layer

• Deleting layers

• Changing the name of a layer

• Changing the order of layers

• Moving objects to a different layer

• Using a Grid Layer

• Using a markup grid layer

• Automatically created layers

Types of layers
Esko Plato supports three types of layers: object layers, grid layers and markup grid layers.
Object layers contain objects in the plate. Grid and markup grid layers contain grids and guides
to help you position objects.

Adding an object layer
Even though Esko Plato makes some layers automatically, you will want to create your own
layers. You can create your own layers and name them. To create a new object layer:

1. Open the Layer Browser by clicking 'Layer Browser' on the Window menu.
2.

Click the Add Layer button 

A new layer appears. The new layer is selected and becomes the active layer.

Deleting layers
You may want to delete a previously created layer. When you delete a layer, the layer and all
objects in that layer are deleted. You can delete any layer with the Delete Layer button. To
delete a layer:

1. Open the Layer Browser by clicking 'Layer Browser' on the Window menu.
2. Select the layer you want to delete.
3.

Click the Delete Layer button 

The selected layer is deleted. You cannot delete the last object layer in a document.

Changing the name of a layer
You can change the name of layers to make their contents easy to remember. To change the
name of a layer:

1. Select the layer that you want to change.
2. Click the name of the layer. The name becomes an edit field.
3. Type in the name for the new layer.
4. Press [Enter] on the keyboard to save the new name.
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Changing the order of layers
One of the nice things about using layers is that it makes it easy to move groups of objects in
front of or behind others. You can change the order of the layers whenever you like and as
often as you like. So, you can move objects on top of other temporarily and then easily move
them behind again. To change the order of layers:

1. Click and drag the layer to a new location in the list. The location that the layer will be
moved to is highlighted.

2. Release the mouse button.

The layer is moved to the new location in the list. Objects in the layer now appear on top of
objects on lower layers.

Moving objects to a different layer
To move objects from one layer to another, you use the Cut and Paste commands. When
you use the Cut (or Copy ) commands and then use Paste, the object is placed on the same
location. To move an object to a different layer, you cut the object from its current layer, select
a new layer and paste it into the new layer. To move an object to a different layer:

1. Select the object(s) you want in a different layer.
2. On the Edit menu, click 'Cut'.
3. Make another layer the Active Layer by selecting it.
4. On the Edit menu, click 'Paste'.

The object is placed in the new layer on the same location from which it was cut.

Using a Grid Layer
Grid layers contain evenly spaced guides that can be used to align objects. You can specify the
spacing of a grid layer. You can also create multiple grid layers, each with a different spacing.
You can then turn these layers on and off as you need them.

To create a grid layer:

1. Open the Layer Browser by clicking Layer Browser on the Window menu.
2.

Click the Add Grid Layer button  The Grid dialog box appears:

 

 

3. Enter the spacing for the grid in the vertical and horizontal step fields. For a square grid,
enter the same number in each step field. You do not have to enter the same number in
both fields; entering different numbers creates a rectangular grid.
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4. Enter the start position of the grid in the offset fields. The default start position of the grid
is at the current origin. However, you can enter a different start position by entering values
other than 0.

5. Click the close box on the Grid dialog box.

The grid layer is added to the Layer Browser. The grid appears in the document window as grey
lines on the plate. Depending on the grid size and your current zoom level, it may be hard to
see the grid. Like other layers, you can change the order of grid layers in the Layer Browser. If
you want to work with the grid layer behind all your objects, move the grid layer to the back. If
you want your grid layer to appear on top of all objects, move it to the top. You can also name
a grid layer. If you want to work with multiple grid layers, it is a good idea to name them so that
you can easily identify each one.

Using a markup grid layer
A markup grid layer is a layer with guides that you can place wherever you want. The guides
can be placed numerically or interactively. The guides on markup grid layers are displayed in
blue.

If you place a guide interactively, Esko Plato creates a markup grid automatically. If you want to
create guides numerically, you need to create a markup grid first and then enter the locations
of the guides that you want to create.

To create a guide interactively:

1. Click and drag a guide from either the vertical or horizontal ruler.
2. Release the mouse button to create the guide.

If the Layer Browser is open, you will see that Esko Plato has created a markup grid for this
guide if there was none.

You can also create a markup grid numerically. You use the Mark-up dialog box to enter the
exact location that you would like for the guide. You can also use the Mark-up dialog box to
fine-tune the position of a guide that you created interactively. Finally, opening the Mark-up
dialog box makes it possible to select, move and delete guides.

To create a markup grid numerically:

1. Open the Layer Browser by clicking Layer Browser on the Window menu.
2. Click the Add Markup Grid Layer button

 

 
The Mark-up dialog box appears:

 

111



6 Plato

 

3. Select the tab for vertical or horizontal guides based on the type of guide you want to add.
4. Enter the position for the guide in the field below.
5. Press [Enter] to add the guide.
6. Click the appropriate button to position the guide relative to the top-left corner of the sheet

 

 
, or relative to a crosshair
 

 

The guide you added is selected in the document window. When the Mark-up dialog box is
open, you can select, move and delete the guides interactively from the document window. To
delete a guide, select it and press [Delete].

Automatically created layers
Esko Plato can create some layers for you automatically. For example, a layer "CAD Layout"
will be created when you import a CAD layout into the plate. All the crease and cut lines for
the CAD layout are placed in this layer.A “Station” layer will also be created when you place or
assign stations on the plate. All stations are placed in this layer.

112



6Plato

You are not restricted to using these layers. They are created to help you organize your work.
Other objects can be placed in these layers too. For instance, you can place marks in the
Station layer.

6.1.2.  Using To Front/To Back

Four commands on the Arrange menu help you order the objects in a layer. These are: To
Front, Forward, Backward, and To Back.

To move an object to the top of all other objects on the current layer:

1. Select the object(s) that you want in front.
2. On the Arrange menu, click To Front.

To move an object one step up within the current layer:

1. Select the object(s) that you want to move forward.
2. On the Arrange menu, click Forward.

To move a object one step down within the current layer:

1. Select the object(s) that you want to move backward.
2. On the Arrange menu, click Backward.

To move an object to the bottom of all other objects on the current layer:

1. Select the object(s) that you want in the back.
2. On the Arrange menu, click To Back.

Remember that these commands move objects forward and backward in a layer. If you use
these commands to bring an object to the front and there still may be objects in front of it, the
front objects are located in a different layer.

6.1.3.  Using Group/Ungroup

You can group individual objects into groups to manipulate and modify a group as a single
object. You can also create a group that is composed of other groups, or a group that is a
combination of individual objects and groups.

To group objects:

1. Select the objects that you want to group.
2. From the Arrange menu, click Group.

To ungroup objects:

1. Select the grouped object you want to ungroup.
2. From the Arrange menu, click Ungroup.

To Group an object into a Grid:

1. Select the objects that you want to group to a grid.
2. From the Arrange menu, click Group into Grid. Esko Plato will try to detect a grid pattern in

the selected stations.
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Group and Ungroup Tips

• Grouping objects will rearrange the objects automatically so that no other objects are
situated in-between.

• Grouping objects in different layers will place the grouped object in a single layer.
• Ungrouping objects places the individual objects in the same layer, in the same order as

previously in the group.

6.1.4.  Group into Grid

Use ‘Group into Grid’ to sort and analyze the red selected stations for a grid based step-and-
repeat pattern. Depending on the position of the stations, one or more grid blocks (see the
Grid dialog box) will be generated.

6.1.5.  Using the Transform Window

You can transform objects numerically with the Transform window. To transform object
interactively, use the Transform tool. The Transform window provides two features. First, the
Transform window provides you with information about the currently selected object. This
information includes the location, size, rotation and scaling of the selected object. Secondly,
the Transform window allows you to numerically transform an object by changing this
information.

You numerically transform objects by selecting them, choosing a current point if necessary,
and entering specific values in the Transform window. To move an object to a specific location:

1. Select the object.
2. In the Transform window, select the current point that you want to locate.
3. Type a new location into the 'Location' fields.
4. Press [Enter] to make the change.

The current point of the selected object is moved to the vertical and horizontal location that
you entered.

To enter a specific height and/or width for an object:

1. Select the object.
2. Type the height and/or width for the object in the Size fields.
3. Press [Enter] to make the change.

The selected object is scaled to the size that you entered for the height and/or width.

To rotate an object by a certain angle:

1. Select the object.
2. Type an angle for the object in the Angle field.
3. Press [Enter] to make the change.

The selected object is rotated to the angle that you entered. By default, rotations of objects
occur around the center of the object. If you want the object to rotate around a different point,
you need to move the point of origin. See Moving the point of origin.
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To scale an object as a percentage of current size:

1. Select the object.
2. Type a percentage in the vertical and/or horizontal Scale fields.
3. Press [Enter] to make the change.

The selected object is scaled to the percentage(s) that you entered into the Scale fields. You can
scale an object proportionally by entering the same percentage in both fields. You can scale an
object non-proportionally by entering a different value in the each field.

6.1.6.  Using the Align Window

You use the Align window to align objects to the center of the sheet or to a single other object.
Two of the functions of the Align window align objects to the center of the sheet. The other
functions of the Align window align objects to one another.

Aligning objects to one another uses both red selection and green selection. A green selection
is a "locked"; a red selection is moved to align with the green selection.

Like the Transform window, the Align window uses the die of the current selections, if there is
one, to align the objects.

• Aligning objects with the Align Window

• Aligning in the Station View

Aligning objects with the Align Window
You align objects with the Align window by selecting objects and pressing the appropriate
button. To align an object to the center of the sheet:

1. Select the object that you want to align.
2. Press the one or both of the 'Align to Sheet' buttons in the Align window.

Pressing both buttons one after the other aligns the object to the exact center of the sheet.
Pressing only one of the buttons aligns the object in that direction only.

To align two objects by the same attribute:

1. Select the object that you want to align to.
2. Press [Insert] to make the selection green.
3. Select the object that you want to align.
4. Press the appropriate Align by Attribute button in the Align window.

Pressing more than one button after another performs multiple alignment commands. For
example, pressing 'Align Middle' followed by 'Align Center' will align the exact center of the red
selection to the exact center of the green selection.

To align two objects edge to edge:

1. Select the object that you want to align to.
2. Press [Insert] to make the selection green.
3. Select the object that you want to align.
4. Enter a Gap in the appropriate field, if desired.
5. Press the appropriate Align Edge to Edge button in the Align Window.
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The Align Edge to Edge commands use the nearest opposite edge to determine which way to
move the red selection. Before using these options, arrange the objects so that the edges that
you are aligning are in the relationship that you want. You don't have to be entirely accurate
(or even close), Esko Plato just needs to be able to clearly identify which edges that you want to
align.

Align Window Tips

• The Align Window uses one object that is locked (the green selection) to align the other
objects. It is a good idea to have the green selected object in the right location before
starting with the Align options.

• After using the Align commands, you can still move the objects around the sheet and plate.
But, if you want these objects to preserve their relationship with one another, you have to
make sure that you select and move them together. A good way to maintain the alignment
parameters is to use the Group command immediately after. Then the objects that you
aligned will always be selected and moved as a single object.

• The Align commands also work with multiple selections. This makes it easy to align several
objects at one time, with a single command.

Aligning in the Station View
The Align window also works in the Station View. However, the 2 centering features of Align do
not center objects on the sheet, since a station has no sheet. Instead, these 2 options center an
object on the current die. You should also remember that Align works with all types of objects
in both the Sheet and the Station View. So, you can use Align to align a graphic or a SmartMark
with the current die.

6.2.  Creating a Repetition (Grid-based Step & Repeat)

You use Esko Plato's Step-and-Repeat command to repeat objects on the plate. You can set up
the number of repeats and whether these repeats have gaps or gutters in between them. You
can also add head turns and staggers to the repetition to create an entire layout. Step-and-
Repeat can be used on any type of object, so you can repeat stations and Geometry Marks.

• Repeating objects with the Grid dialog box

• Step-and-Repeat examples

• Step-and-Repeat with Stagger example

• Step-and-Repeat with Distribute example

• Two-sided plates

6.2.1.  Repeating objects with the Grid dialog box

You step-and-repeat an object by double-clicking the grid number in the Grids dialog box and
entering the parameters you want. The basic Step-and-Repeat command is described below.
To see Step-and-Repeat examples, see the next section. To Step-and-Repeat a station:

1. Click 'Grids' on the Window menu to open the Grids dialog box.
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2. Create a station on an empty grid line. Click 'Click to add' and select a station from the menu
or click 'Add Station...' to browse to a new station.

3. Enter the number of repeats.
4. Enter a gap amount.

The result is a group of stations. This group carries the Step-and-Repeat settings that were
used to create it. To modify the settings of the group, double-click the group to open the Grid
Settings dialog box with the original parameter settings.When you ungroup a Step-and-Repeat
group, these setting will be lost, the system will ask for a confirmation.
 

 

After ungrouping, the individual stations can be manipulated.

6.2.2.  Step-and-Repeat examples

• Example one
• Example two
• Example three
• Example four

Example One
• Position: lower left corner at (0,0).

Tip:

Change the Origin (0,0) in the Edit menu > Preferences > Defaults.

• Gap: no gaps between rows, no gap between columns
• Direction: Up and Right
• Head Turn: No Head Turn
• Number of Rows: 3
• Number of columns: 4
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Select the Station and click the Info button. The Grid Settings dialog box appears.

 

 

This is a basic step and repeat. A single station is repeated into a 3X4 grid. The grid has no
gutters; the dies of each station abut one another. No head turn is used.

 

 

Example Two
• Position: center at (10, 20)
• Gap: No gap between rows, no gap between columns
• Direction: Up and Right
• Head Turn: Head turn on row
• Number of rows: 3
• Number of Columns: 4
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Select the Station and click the Info button. The Grid Settings dialog box appears.

 

 

The dialog box positions the station prior to repeating. The station is repeated in a 3X4 grid.
The grid has no gaps. A head turn is used on each row.
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Example Three
• Position: center at (10, 20)
• Gap: 15 mm gap between rows, no gap between columns
• Direction: Up and Right
• Head Turn: No head turn
• Number of rows: 3
• Number of Columns: 4

 

 

Select the Station and click the Info button. The Grid Settings dialog box appears.

 

 

The dialog box positions the station prior to repeating. The station is repeated in a 3X4 grid.
The grid has a 15 mm gap between rows; no gap between columns. No head turn is used.
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Example Four
• Position: center at (90, 120)
• Gap: No gap between rows, 15 mm gap between columns
• Direction: Up and Right
• Head Turn: Head turn on row
• Number of rows: 3
• Number of Columns: 4

 

 

Select the Station and click the Info button. The Grid Settings dialog box appears.

 

121



6 Plato

 

The dialog box positions the station prior to repeating. The station is repeated in a 3X4 grid.
The grid has no gap between rows, a 15 mm gap between columns. A head turn is used on
each row.

 

 

6.2.3.  Step-and-Repeat with Stagger example

• Position: center at (10, 20)
• Gap: No gap between rows, 15 mm between columns
• Direction: Up and Right
• Head Turn: No Head turn
• Number of rows: 3
• Number of Columns: 4
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• Stagger: Stagger Columns 3 times
• Up & Down and Continuous staggering disabled
• Stagger amount: 35% of height

 

 

Select the Station and click the Info button. The Grid Settings dialog box appears.

 

 

The dialog box positions the station prior to repeating. The station is repeated in a 3X4 grid.
The grid has no gap between rows, a 15 mm gap between columns. No head turn is used.
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6.2.4.  Step-and-Repeat with Distribute examples

Example 1

Type: Single Cuts, no Gap, no Stagger.

 

 

Example 2

Type: Distribute Gaps between Stations, no Gap, no Stagger.
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Example 3

Type: Distribute Gaps, no Gap, no Stagger.

 

 

Example 4

Type: Continuous Around, no Gap, no Stagger.
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Example 5

Type: Continuous Across, no Gap, no Stagger.

 

 

Example 6

Type: Continuous Across and Around, no Gap, no Stagger.
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Example 7

Type: Continuous Around, no Gap, Stagger Columns 50%.

 

 

6.3.  Two-sided Printing

• Two-sided plates
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• Two-sided stations

6.3.1.  Two-sided plates

Esko Plato can create the back of a plate layout from the front for two-sided printing. You use
the Turn Front to Back and Tumble Front to Back commands on the Tools menu to create
the back side.

The 'Turn Front to Back' command rotates the sheet around the vertical center of the sheet.
With this command, the left edge of the sheet becomes the right edge of the sheet on the
back. The 'Tumble Front to Back' command rotates the sheet around the horizontal center of
the sheet. With this command, the top of the sheet becomes the bottom of the sheet on the
back.When the back side of the plate is created, the position of the stations is mirrored for
accurate front-to-back alignment. The back side of the stations is automatically inserted to
create the printing on the back side. If you move a station on the front side, the back side will
be updated automatically.

Any marks that you used on the front side of the plate are reapplied to the back side. When the
marks are reapplied, their ink usage and mapping are updated based on the inks used on the
back of the stations.

To create a back side from the front:

1. On the Tools menu, click 'Turn Front to Back' or 'Tumble Front to Back'.
2. The back side of the plate is automatically created. Plato's view changes to the back side of

the plate.

Two-sided plate tips:

• Changes made to the positions of the stations on the front will be automatically applied to
the corresponding stations on the back! This only applies to the station positions, all other
modifications (SmartMarks, geometry marks, adjust mask on the stations) will not be re-
applied on the back side. Please make sure the front side is as complete as possible before
using the ‘turn/tumble’ front to back commands.

• The marks from the front side are reapplied on the back and the ink usage and mapping
is updated to reflect differences in the inks used between the two sides. You may have to
adjust the positioning of marks on the back side.

• If you have used the Adjust Masks tool to create new masks on the front side, these masks
are included on the back side. If you do not want the same mask adjustments on the back,
select the Reset Masks command and run Adjust Masks on the back side of the plate, if
necessary.

6.3.2.  Two-sided stations

Esko Plato can create the back of a plate layout from the front for two-sided printing. When
Plato creates the back side of the plate, the back side of each station is inserted automatically.
You need to create a two-sided station in the Station View to create a two-sided plate for
printing.

To create a back side from the front:
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1. Open the Station dialog box
2. Click the ‘Add Station’ icon that is located on top of the ‘Back Side’ column.

You complete the back side the same way that you did the front: by importing a graphic,
creating a mask and adding marks.The die shape of the front is automatically mirrored to the
back.

Tip:

• If the graphic that you are using is multi-page, the back side will be created with the
subsequent page. If this is not the graphic that you want, delete it and import a different
graphic for the back side.

• Because the back side is created from the front, make sure that your front is complete
before using the Turn/Tumble Front to Back command. Changes to the front side will not be
made automatically to the back.

• If you have used the Create Bleed Mask tool to create a mask on the front side of the
station, this mask is included on the back side. If you do not want the same mask on the
back, use the Create Bleed Mask tool to create a different mask for the back side of the
station.

6.4.  Managing Inks

Esko Plato has several tools that help you manage the inks in your document. You can use
these tools to display the individual separations of the document, to add, modify or map inks,
and to calculate the ink coverage of a document.

Caution:

Note that it is impossible to edit or delete inks in Station View mode.

• ViewX

• Working with inks

• Using ink libraries

• Using ink mapping

• Using external file ink mapping

• Calculating ink usage

6.4.1.  Viewer

Use Viewer to display the separations of a document. You can view individual separations or
multiple separations together. To view the separations of a document:

1. From the View menu, click 'Viewer'. The Viewer dialog box appears:
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2. Click the Show/Hide buttons  to toggle on or off individual separations. Click the expand

icon  to show all the separations and options.

Please refer to the chapter ’Viewer’ for more information on the Viewer options.

6.4.2.  Working with inks

Use the Inks window to add and edit inks in a document. You can add inks, delete inks, set the
screen ruling, angle and dot shape of the inks, and set the order of the inks in your document.

See also Inks... on page 364

• Adding inks
• Changing the order of the inks in a document
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• Changing the screen parameters of an ink

• Cleaning up unused inks in a document

• Replace Ink on page 132

• Printing Method on page 135

Note:  Plato supports PantoneLIVE ink books. In the Replace Inks, an icon will show if an ink or

inkbook is (from) a Color Engine Ink Book  or a PantoneLIVE ink book .

Adding inks
You add and delete inks in the Inks dialog. You can have any number of inks, of any type in a
document. There are three groups of inks: Process Inks, PANTONE Inks and Designer Inks. The
way in which you add an ink depends on the ink that you want to add.

To add a Process ink:

1. Click in the ink name field for the empty ink.
2. Type the letter for the process ink you want to add. Type C for Cyan, M for Magenta, Y for

Yellow and K for Black.
3. Press [Enter].

To add a PANTONE ink:

1. Choose Inks > Open Ink Book... and select the appropriate ink book from the list.
2. Locate the PANTONE ink that you would like to add.
3. Drag the PANTONE ink onto the swatch of the empty ink.

To add a Designer ink:

1. Choose Inks > Open Ink Book... and select the appropriate ink book from the list.
2. Locate the Designer ink that you would like to add.
3. Drag the Designer ink onto the swatch of the empty ink.

You cannot delete inks that are used in external references, like stations. However, you can
map an ink in an external reference to another ink in the job. You can also choose not to print
the ink.

Changing the order of the inks in a document
The order of the inks in the document determines how an ink is displayed and the order in
which the separations are printed. For these reasons, you may want the inks in a particular
order.

To change the order of the inks:

1. Click and drag the ink to a new location.
2. Release the mouse button.

To set the order of the inks based on darkness:

1. Make sure that the Inks window contains all the inks you want in your document.
2. On the fly-out menu, click 'Sort Light to Dark...' or 'Sort Dark to Light...'. The inks are

reordered based on the option you choose.
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Changing the screen parameters of an ink
You can set the screening parameters for the inks in your document in the Inks dialog box.
These parameters include screen ruling, screen angle and dot shape. To set the screen ruling
for an ink:

1. Click the screen ruling field for an ink. The contents of the field are highlighted.
2. Enter a new screen ruling.
3. Press [Enter].

To set the screen angle for an ink:

1. Click the screen angle field for an ink. The contents of the field are highlighted.
2. Enter a new screen angle.
3. Press [Enter].

To set the dot shape for an ink:

1. Click the screen dot shape field for an ink. The contents of the field are highlighted.
2. Enter a new screen dot shape.
3. Press [Enter].

Cleaning up unused inks in a document
Your document may contain inks that are no longer being used. For example, you may have
replaced stations on the plate with stations that use different inks. The old inks from the
previous stations may still be contained in the document even though they are no longer being
used.

To clean up unused inks:

1. Open the Inks dialog box.
2. On the fly-out menu, click 'Remove Unused Colors and Inks'.

Replace Ink
To replace an Ink:

1. Open the Replace Ink by dialog by selecting Replace Ink... in the fly-out menu in the
Inksdialog.
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2. In the Current Inks and Colors, select the Ink you want to replace.

Inks defined in an Ink book will have a droplet icon next to their name

The Details window will show extra information on the selected ink.
3. Define the Replace by type:

• Replace by A Document Ink allows to select an Ink from the document inks. By
enabling Include Unused Inks, all spot color inks will be available, even the inks that
aren’t used in the job.

• Replace by CMYK Color allows to convert the selected ink into its CMYK equivalent. The
CMYK values that will be used are shown underneath.

Note:

When converting to CMYK:

• inks from the document will be replaced by CMYK

• Inks from linked CT files will be planemapped to CMYK paint

• inks from linked PDF files are NOT converted, as this is not supported.
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• Find Best Match will scan the selected Ink Book, and list the inks with the lowest dE

compared to the ink you want to replace. At the bottom, the New and the Current ink are
shown side by side.
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• Replace by Color from Ink Book allows to replace the ink by a new ink from an Ink
book.
 

 
4. Click the Replace Ink button.

Note:

If one or more objects can’t be converted, a description of the problem will appear in the
Messages dialog, and the converted ink will not disappear from the document.

Printing Method
You can set the Printing Method for every .

The Printing Method information can be used in SmartNames, or for Automation Engine task
that handle the printing method.

By default, the Printing Method column is hidden. in the fly-out menu you can make it visible.

You can select one of the predefined printing methods, or create a new printing method.

Presets
As from version 12.1.2, when connected to an Automation Engine Server, the list of Printing
Methods is loaded from the Automation Engine server.

Note:  This implies that Printing Methods saved in earlier versions of are no longer visible and
will need to be redefined.

135



6 Plato

Printing Methods can be saved in the Automation Engine Configure tool, or in by selecting
Save to presets

6.4.3.  Using ink libraries

Esko Plato uses a number of default ink libraries: the PANTONE libraries and the Designer
Book. Depending on your configuration, you may have additional ink libraries available. Select
the ink book you want to use by clicking Inks > Open Ink Book...

The PANTONE libraries are designed to look like the pages of the PANTONE formula guide.
Each column of inks represents one page in the guide. You can scroll through the inks using the
scroll bar at the bottom. You can also search for a particular ink by typing its number (or name)
in the search field at the bottom.

Non-standard (designer) ink books contain inks that are defined by you. Designer inks can
be created in two ways: they may be included in an imported graphic or you may define
them yourself by using a PANTONE ink. If you open or import a file that contains an unknown
designer ink, an information window will appear. In this case the file contains an ink that
currently is not in any of Esko Plato's ink libraries. You can add this ink to an ink book so that in
the future Esko Plato will recognize this ink.To add an unknown ink to an ink book:

1. Choose Inks > Open Ink Book... and select the ink book to which you want to add the ink.
2. Click the lock in the bottom-right corner to "unlock" the library so that you can add a new

ink.
3. Click and drag the ink swatch (not the name) of the unknown ink from the Inks dialog box to

any of the empty ink patches in the ink book.

6.4.4.  Using ink mapping

Your plate may use inks that need to be changed to other inks. For example, your plate
contains the ink "Logo Red" and that ink should be "PANTONE 485 CV". You use ink mapping to
"map" one ink to a different ink.

You can change ink mapping in the Ink Map dialog box by selecting 'Ink Map' on the Inks menu.
The Ink Map dialog box appears:

 

 

The Ink Map dialog box shows the current ink mapping of your document. Before any ink
mapping has occurred, all the inks are mapped to themselves, as shown above.
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On the left are the inks in your document; the existing inks. On the right are the new inks that
you want to use in place of the existing inks. To map an ink, you replace the new ink on the
right across from the existing ink.

To map an ink to a new ink:

1. On the Inks menu, click 'Ink Mapping...'.
2. Open the ink library that contains the new ink that you want to use.
3. Locate the new ink in the library.
4. Click and drag the color swatch (not the name) for the new ink into the new ink swatch that

is across from the ink you want to map.
5. Click 'Apply' to make the change.

Clicking 'Apply' applies the ink map but leaves the Ink Map window open so that you can make
more changes. Clicking 'OK' applies the ink map change and closes the Ink Map window. If you
click 'Cancel', any changes that you have made since the last Apply are deleted and the Ink
Mapping dialog box closes.

You might want to reset the ink mapping table before clicking 'Apply'. This can be done by
using the reset button.

Ink mapping will perform ink mapping on all objects on your plate - except for SmartMarks.

• Graphics (external files) will be mapped.
• Geometry marks will be mapped.
• SmartMarks will be regenerated after ink mapping has been applied (to reflect the new ink

set).

Ink Map Tips

• You will only see the ink change color if the display mode is set to Medium or High. (The
Display Image mode uses the display image contained in the file, not the actual data.)

• After ink mapping, the new inks on the right are the inks that are shown in other windows
and dialogs. The Inks window, the View by Ink window and the printing dialog boxes now
will show only the inks that appear on the right side of the Ink Map window.

• You can map more than one ink to the same ink. For example, you can map both "Logo
Red" and "Magenta" to "PANTONE 485 CV".

• If you have mapped an ink previously and now need to remap it to another ink, you can
simply replace the new ink on the right with another new ink.

• The Ink Map window does not show ink mapping used by SmartMarks. SmartMarks
automatically map and manage their own inks.

Examples of technical printing problems where Job Ink Mapping brings a solution:

• You have a file where the 4 process inks have a screen ruling of 120 lpi. After placing
a PostScript file, you notice that the DTP operator has defined the 4 process inks with
a screen ruling of 150 lpi. The result is that you have 2 x 4 process inks. With Job Ink
Mapping, you can easily map the screen ruling of 150 lpi to 120 lpi.
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• You have a file where the 4 process inks have a screen ruling of 120 lpi. You place a file
externally, with screen rulings of 150 lpi. With Job Ink Mapping, you can map all the inks
of the external file to 120 lpi, without changing the inks of the externally placed file.

6.4.5.  Using external file ink mapping

External file ink mapping is available in the Station View. It allows you to map inks for the
graphics that are referenced externally.

6.4.6.  Calculating ink usage

When your plate is complete, Esko Plato has all the information that is needed to calculate its
ink usage. You see this information in the Ink Coverage dialog box.

• Using Ink Coverage

• Saving ink coverage to a file

• Ink Coverage in the Station View

Using Ink Coverage
To calculate ink coverage:

1. On the Inks menu, click 'Ink Coverage'.
2. Select the Scan Options that you want to use.
3. Click 'Scan'. The Ink Coverage window shows the ink usage for each ink in the document:
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The inks in your document are listed at the bottom of the window. The amount of ink used is
provided in the current units and as a percentage of the entire document. If you make changes
to the document, these changes may affect the amount of ink used. To update the calculations,
click 'Update' in the Ink Coverage window. Esko Plato will scan the document again and update
the ink coverage.

Saving ink coverage to a file
You can save the results of the Ink Coverage calculation to a file that can be used later. The file
that you save can be used by others to estimate and order ink for printing. You save the ink
coverage results in a Report. To save the calculations as a report:

1. Click 'Save To File' in the Ink Coverage window. The Save Report dialog box appears:

 

 

2. Select the location where you would like to save the file.
3. Type a name in the File name field.
4. Select the type of report that you would like to save from the pull down list. You can save

the file as either a Text Report or a CSV Report. Both types of files can be opened in any text
editor. In addition, the CSV Report file can be opened in a spreadsheet application.

5. Click 'Save'.

Ink Coverage in the Station View
The Ink Coverage dialog box in Esko Plato calculates the ink usage for either the sheet or the
plate. In the Station View, there is no plate or sheet; instead the options in the Ink Coverage
dialog box are 'All Inside Die bounding box' and 'All'.

'All Inside Die bounding box' calculates ink usage inside the die only. Objects placed outside the
die are not considered.

The option 'All' calculates ink usage for everything in the station.
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6.5.  Trapping

Note:

This menu will only be enabled in the Station View.

Trapping creates overlapping areas to compensate for possible misregistration between the
different inks on the printed result. It is used whenever two adjoining colors contain different
inks in such a way that misregistration during printing results in a white gap or an undesirable
line of a different color at the border of the two colors.

There are two ways of looking at trapping:

• Spread trapping is used to trap a lighter area into a bigger darker area. The light object
overprints and spreads into the darker background of the darker object.

• Choke trapping is used to trap the lighter into a smaller darker area. The light object
overprints the darker area and chokes it.

Trapping can be applied both manually and automatically:

• With PowerTrapper, the user selects (in green) the objects that may need trapping. The
system scans these selected objects, indicates where trapping is needed and creates the
trapping areas. Here, the Trapping is executed automatically. See PowerTrapper on page
141

• Trap Red under Green... is the manual trapping method. The user defines which contours
need trapping.

Note:

The trapping areas are placed in a separate 'Trap' layer. This way, you can easily remove the
trapping area, without affecting your job.

This trap layer is part of the station definition and is thus embedded in the plate file. Note that
the external referenced graphics is not altered! In case you want to reuse trapped stations in
other plates, you might want to save your station in a (PDF)STA file (which will also contain the
trapping layer).

Another type of trapping is Keep Red Away from Green..., in which case the system introduces
an extra distance between two adjoining colors in such a way that when printed, the adjoining
colors do not overlap or mix. This is necessary for certain printing processes, in which the
nature of the inks or the printing surface cause an unwanted mixing of adjoining inks.

Together with the automatic trapping, you can also define the settings for Rich Black and White
Underprint.

• Rich Black creates a separate (choked) layer on top of the black object with the ink that you
defined (by default Cyan), to obtain a darker black.

• White Underprint places a background under your design, when working with transparent
or metallic material. The default ink is Transparent white, but you can select any ink of your
job. When printing Yellow on a metal can, for example, the result of the combination will
have a goldish appearance. To avoid this, apply White Underprint.
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6.5.1.  PowerTrapper

The Trap Dialog
The Trap dialog is where you define all your trapping settings.

1. Choose your trapping settings in the Distance & Direction, Color & Shape, and Processing
tabs.

2. If needed, define trapping rules.
3. Save your trapping settings as a trap preset to be able to reuse them on another document.

Note:  The Trap Preset List contains 6 default presets.

Distance and Direction Settings
Trapping

You can choose between two trapping modes:

• Normal Trapping: This selects adjoining color pairs, which are likely to cause registration
problems like ugly light gaps, and unwanted halo effects.

PowerTrapper Classic automatically chooses the most appropriate trap direction based
on the relative luminance of the adjoining colors. Lighter colors are generally trapped into
darker colors to minimize the visual effect of the trap.

• Reverse Trapping: This prevents overprint of adjoining color areas by trapping these color
pairs with a white knockout (erasing) trap. The white knockout trap is put on top of the
lighter of the two colors.

This is useful to prepare a job for Dry Offset printing (e.g. metal beverage cans) where
overprinting of inks is not allowed as the inks would contaminate each other on the blanket.

Trapping Distance

Enter the width you want to give your traps.

The default trap width is 0.2 mm (or equivalent in your chosen unit).

Minimum Ink Difference

Trapping is applied to two adjoining colors when either:

• The two colors each consist of at least one ink but they have no common inks.
• The two colors have common inks but there is a difference of at least the Minimum Ink

Difference percentage for two or more inks making up these colors.

These differences in ink percentages must be in opposite directions.

For example, with the default minimum ink difference percentage of 10%, the following two
colors will be trapped:

1st color: C 5% M 10% Y 50% K 15% (+10% K)

2nd color: C 5% M 10% Y 85% K 5% (+35% Y)

Increase the minimum ink difference to trap colors that are more different, lower it to trap
colors that are more similar.
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Image Trapping

• Automatic (default): this determines the most suitable trap direction automatically, by
comparing the average lightness of the CT image with the lightness of the adjoining area,
then traps the lighter color into the darker one.

• Always Towards Images: this always traps line art under adjoining CT images.

• Always Towards Line Art: this always traps CT images under adjoining line art.

Pull Back

An ink pull back keeps away all but the darkest ink of a color area composed of multiple inks
that borders to a very light background.

It prevents individual inks from the composed color to become visible on the background due
to registration errors during the printing process.

Ink pull back is also known as “Cutbacks” or “Keepaways”.

The example below shows an object with 100% dark blue and 50% magenta on an empty
background. 50% magenta is pulled back and a fine line of 100% dark blue remains. The color
that remains (dark blue) is the pull back ink.

 

 

• Automatic (default): this creates pull backs on rich black or rich colors, when the color left
in the pull back area is not very different from the composed color.

In the example below, the left color is composed of 100% purple ink and 20% cyan. The
darkest ink (purple) is not very different from the composed color, so using the Automatic
pull back option will create a pull back.

The right color is composed of 100% dark red ink and 20% blue ink. The darkest ink (dark
red) is very different from the composed color, so using the Automatic pull back option will
not create a pull back.
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• Only Pull Back Rich Black: this only creates pull backs on rich black.
• Do Not Pull Back: this never creates any pull back.

Advanced Settings

Click the triangle beside Advanced Settings to show the advanced settings.

Trapping Distance

If you want to use a different distance when trapping into black, spot colors or images or when
creating pull backs, enable the corresponding option and enter the trapping distance to use.

Image Trapping

If you don’t want images to be trapped with each other, disable Trap images to images.

Pull Back

If you chose to use Automatic pull back (see Pull Back), the Also pull back light inks option is
available. Enable it if you want to create pull backs even when the pullback ink (ink remaining
in the pull back area) is visibly different from the composed color.

Enable Pull back images and gradients if you want to create pull backs on images and
gradients.

Trap decision

• By default, PowerTrapper Classic uses the color luminance (Use Lightness) to define the
trapping direction, except for opaque inks, for which the Inks order is used.

• trap direction: from brightest to darkest
• If the Treat spot colors as opaque option is chosen, color luminance is used only for CMYK.

For opaque and spot inks, the trap direction is determined by the ink sequence.

• trap direction for spot colors only: towards the separation listed the lowest in the
Separations palette darkest

• trap direction goes from the process to the spot color if the spot color is below the
process color in the Separations list

• trap direction if the spot color is above the process color: from brightest to darkest
• By selecting Use separation order, the trap direction is determined by the ink sequence for

all inks, including CMYK.

• trap direction: towards the separation listed the lowest in the Separations palette darkest
• Use reverse separation order does the same, using the reversed ink sequence.

• trap direction: towards the separation listed the highest in the Separations palette
darkest
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Note:  Using the Separation Order option will give the same result as changing all inks
(including CMYK) to Opaque.

Overshoot Mode

You can choose between the following three overshoot modes:

• Automatic (default): The centerline behavior is according the rules determined in the color
pair list.

• Never on Dark Areas: The centerline is forced not to get beyond the center of dark areas.

• Never: The centerline is forced not to get beyond the center of any area.

An example:

During trapping, this example will generate the following color pairs:

By default (Automatic), this color pair list results in the following traps:

If the parameter is set to Never on Dark Areas, this will result into:

If the parameter is set to Never, this will result into:
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Color and Shape Settings
Trap Color Intensity

By default, PowerTrapper Classic uses the full color of the object to spread in the trap (100%
trap color intensity).

However, you can create a trap of a lighter color by reducing the trap color intensity
percentage.

Image Trap Color

Choose how to trap your images:

1. Use Original Image Data (default): when spreading an image, PowerTrapper Classic uses
the underlying image data (when the image is clipped) to create the trap (see example 1
below).

Note:  When there is no underlying image data (the image isn’t clipped), it will create an
empty trap.

2. Extend Image Data: PowerTrapper Classic will automatically extrapolate the image along
its clipping path edge to ensure the trap looks as expected even if there is no clipped image
data outside the visible image (see example 2 below).

3. Use an Approximate Flat Color: Instead of using existing or extrapolated image data in the
trap, PowerTrapper Classic will use a solid color. A suitable color is determined by averaging
the image’s colors along its boundary with the object to trap (see example 3 below).

 

 

Truncate Traps

PowerTrapper Classic can truncate the trap so that it doesn’t stick out on another color. There
are two truncation modes:
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•
On Center  (default): when a portion of a trap comes too close to the contour of
another object, PowerTrapper Classic limits it to half the distance between the trapped
object and the other object.

•
On Edge : when a portion of a trap comes too close to the contour of another object, it
is truncated on the other object’s edge.

 

 

End Caps

This option specifies how to shape the ends of an open trap.

•
Square  (default): this option ends the trap at right angle to the adjoining object.

•
Round : this rounds the ends of the trap. This option is typically only used in
combination with white knockout (reverse trapping).

Attention:

We recommend not to use Round End Caps together with Truncate Traps On
Center, as this can generate some artefacts (the round caps will be truncated).

•
Object Dependent : with this option, the trap is a logical continuation of the contour of
the spread object.
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Trap Corners

This option allows you to change how the traps’ sharp corners will be handled.

•
Round  (default): a round cap will be placed at all corners.

•
Beveled : this will cut sharp corners off.

•
Mitered : this option works with a miter ratio.

The miter ratio serves to limit the length of the sharp corner (the distance from the base of
the trap to the corner point).

The default miter ratio value is 4. This means that if the length of the sharp corner is more
than 4 times the Trapping Distance, then the corner will be cut off (beveled). If it is less
than 4 times the Trapping Distance, the corner will be left as it is.

 

 

Advanced Settings

Click the triangle beside Advanced Settings to show the advanced settings.

Truncate Traps

If you want to truncate traps into black differently, select Into black and choose the truncation
mode (On Center or On Edge). For more information about truncation modes, see Truncate
Traps.

Processing Settings
Color Pairs

PowerTrapper Classic can trap all hits (occurrences) of a color pair the same way, or recalculate
the trap direction for different hits.

• Each hit can have its own decision (default): this recalculates the trap direction for each
hit of a color pair.

• Same decision for all hits: this traps all hits of the same color pair in the same direction.
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• Same decision for objects smaller than: this uses the same trap direction for hits of a
color pair belonging to small objects, and recalculates the trap direction for hits belonging
to bigger objects.

Use the field next to the option to determine the maximum size of small objects.

The default size is 1 mm.

Restrictions

If the Respect existing traps is enabled, traps in the selection will be kept, and no trapping is
performed on these locations. If the option is off, selected traps will be removed, and will be
re-trapped. This only works for traps created by PowerTrapper Classic or Instant Trapper.

Small Gaps

Some input jobs contain very small unintentional gaps between neighboring objects,
preventing the correct trapping of these objects. Although it is better to clean up such jobs
before trapping, PowerTrapper Classic can ignore these gaps automatically.

To use this option, select Close when smaller than and enter the maximum size small gaps
can have.

The default size is 0.01 mm.

Attention:  If you set a big gap size, trapping may become slower, and small parts of
the job may be ignored during trapping.

Rules

Rules allow you to define custom trapping settings for specific trapping pairs.

When to Use Rules?

In most cases the general trapping settings you enter in the Trap dialog will give you excellent
results, but in some cases you will need to refine them using rules.

Rules allow you to specify exceptions to the general trapping settings for certain color pairs.
They are an advanced feature and should be used only by experienced users.

For example, you can use them in the cases below:

• To set a different trap distance for a specific spot ink.

Sometimes you need a larger trap distance for spot inks if there is no other ink to help cover
leaks on the press.

• To prevent trapping or ink pull back in specific cases.

Depending on the type of the adjoining colors, trapping and / or pull back may be
undesirable.

• To force a specific trap direction.

PowerTrapper Classic determines the trap direction based on the relative lightness of the
adjoining colors. If the colors have a similar lightness level, it selects an arbitrary direction.
You can use a rule to make it always use a particular direction for a color pair.

• To specify a different shape and / or truncation mode for certain color pairs.

For example you can choose to use “On Center” truncation when trapping under a 100%
black line and “On Edge” truncation on all other color pairs.
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Creating a Rule

1. Click the Add Rule button at the bottom of the Trap dialog.
 

 
2. In the pop-up that opens, choose the trapping pair to apply the rule to using the From and

To lists.

You can create a rule to trap from/to:

• any color,

• a particular ink (process, spot or opaque),

Note:

In this case, you can choose the ink name, from which Minimum Density the rule will
apply, and if the color must be pure (no other separation in the color object) to apply the
rule.

 

 

If Spot Ink is selected, the dropdown underneath will contain all Spot Colors used in the
document.

• A specific Printing Method

• a particular object (image, gradient or empty background),
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• the registration color.
3. Choose the contents of the rule.

Options Description

Trap • Automatic lets PowerTrapper Classic calculate the trapping
direction.

• Always Trap always spreads the “From” color/object on the
“To” color/object.

• Do Not Trap never traps the “From” and “To” colors/objects
together.

Trapping Distance Use this to define a special trapping distance for the trapping pair.

Trap Color Intensity Use this to define a special trap color intensity for the trapping
pair.

Pull Back • Automatic lets PowerTrapper Classic decide if there should be
a pull back on the trapping pair.

• Always Pull Back always creates a pull back on the trapping
pair. The darkest ink of the pair is the pullback ink (remaining
ink in the pull back area).

• Do Not Pull Back never creates a pull back on the trapping
pair.

Pull Back Distance Use this to define a special pull back distance for the trapping
pair.

Pull Back Fill Mode • Normal gives normal pull backs.

• Sharpen allows sharpening on pull backs. This sharpening
is used e.g. for white text on images, on CD's or DVD's.
Sharpening is done by pulling back the image, and adding
100% black in the trapping area.

Reverse • Automatic lets PowerTrapper Classic decide if the trapping
pair should have a reversed trap.

• Always Trap Reversed always generates a reversed trap for
the trapping pair.

• Do Not Trap Reversed never generates a reversed trap for the
trapping pair.

Truncate Traps Choose if traps generated for the trapping pair should be
truncated on center or on edge. See Truncate Traps for details.
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Options Description

End Caps Choose how to shape the ends of open traps for the trapping pair
(square, round or object dependent). See End Caps for details.

Trap Corners Choose how to shape the trapping pair’s trap corners (round,
beveled or mitered). See Trap Corners for details.

Direction Mode Select into both colors to use bidirectional trapping. In case of
bidirectional trapping, the trap will go half the trapping distance in
each direction.

Horizontal / Vertical
distortion

Set the percentage of the trapping distance to be used in vertical /
horizontal direction. In the example underneath, the trap was
generated with no vertical distortion (so 100%, i.e. using the
entered trap distance) and horizontal distortion set to 50% (i.e.
half the trap distance).

4.
If necessary, use the  button to add contents to your rule.
 

 

You can use the  button to remove contents.
5. When you are done defining your rule, click OK.

You can now see your rule at the bottom of the Trap dialog.
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When trapping your document, PowerTrapper Classic will trap the trapping pairs that match
rules according to those rules, and the rest of your document according to the main trapping
settings.

If necessary, you can add another rule, or remove a rule previously created. You can also edit a
rule by double-clicking it in the Trap dialog.

Trap Presets
With PowerTrapper Classic , you can save all your trapping settings as a preset to be able to
reuse them on other documents.

Trap Presets can be shared between different Esko Applications (PackEdge, ArtPro,
DeskPack, ...)

The Trap Presets list contains 6 default Presets that can't be changed or removed:

• Default
• Bi-directional (including a rule to trap into both colors)
• Combipress (including a rule based on Printing Method)
• Offset (optimized for offset printing)
• Reverse
• Sharpening (including a rule optimized for sharpening)

Defining a Trap Preset

1. Define your trapping settings in the Trap dialog. Add rules if you need to.

2. In the Trap Preset list, choose Save...
3. Give your preset a name and click OK.

You can now see your preset in the Trap Preset list. To reuse it in the future, just select it in
the list.

• To delete a preset, select it in the Trap Preset list then select Remove.

• To edit a preset, select it in the Trap Preset list, make your changes in the trapping settings,
then save it again with the same name.

The Trap Layer
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The Trap Select Tool

You can find the Trap Select tool  in the Tools panel. Use it to select trap areas in your job,
or double-click it to open the Trapping dialog.

You can:

• click between two adjoining color areas to highlight the edge and select the trap,
• make a rectangle selection to highlight all edges and select all traps in that rectangle.

Note:  Selecting one or more traps in your document using the Trap Select Tool also selects
the corresponding color pair(s) in the Color Pairs palette. See The Color Pairs Palette on page
153.

6.5.2.  The Color Pairs Palette

After trapping your document, the Color Pairs palette shows the trapping settings associated
with each of your document’s color pairs.

For each color pair, the palette shows:

• the number of Hits (occurences of that color pair) in the document,
•

the type of object in the pair (empty background , flat color , image  or gradient

),
• the type of trap performed on that color pair (normal trap , pullback , reverse trap

),
• the trapping Distance used,
•

the traps’ Shape (truncation , caps , corners ),
• the Intensity of the trap color,
• the Pullback Ink (when the trap is a pullback).

Viewing Traps
• To select all the traps of a color pair in your document, click that color pair in the Color

Pairs palette.

Note:  Use Shift to select several color pairs, and highlight all the corresponding traps in
your document.

• If the tool is active, use the arrow keys to browse through the color pairs. Activate the to
browse and visualize your traps one by one in your job.

Note:  Use Arrow left-right to expand or collapse the trapping pair list.

Viewing Trap Settings
You can hide trapping settings that you are not using to make the Color Pairs palette smaller.
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• To hide all color pairs that are not trapped with each other, select Hide Non-trapping Color
Pairs in the palette’s fly-out menu.

To show them again, select Show All Color Pairs in the fly-out menu.
•

To hide all color pairs that don’t have traps selected in your document, click  or
choose in the palette’s fly-out menu.

To show them again, click  again or select in the menu.
• To hide the Distance, Shape, Intensity or Pullback Ink column, select Hide Distance/

Shape/Intensity/Pullback Ink Column in the palette’s fly-out menu.

To show the column again, select Show Distance/Shape/Intensity/Pullback Ink Column
in the fly-out menu.

Refining your Traps
You can use the Color Pairs palette to select certain traps and change their trapping settings.

1. Select either:

• the color pair(s) to edit in the palette,
• the traps to edit in your document (if you want to only edit certain traps of a color pair).

2. Make your desired changes as explained below:

to change a color pair’s... do...

trapping direction
click Swap Trap Direction . Trap direction
can be from left to right, from right to left, or
bidirectional. In case of bidirectional trapping,
the trap will go half the trapping distance in each
direction.

Note:

When you change the direction for only certain
traps of the color pair, the color pair will be
duplicated in the palette (e.g. one entry for
spread and one for choke).
 

 

trap type choose Normal Trap , Pullback  or Reverse

Trap  in the Trap column.

You can also use this to trap a non-trapping color
pair.
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to change a color pair’s... do...

trap distance click the Distance value to edit it.

trap truncation
choose On Center  or On Edge  in the
Shape column.

end caps
choose Square , Round  or Object

Dependent  in the Shape column.

trap corners
choose Round , Beveled  or Mitered 
in the Shape column.

trap color intensity click the Intensity value to edit it.

pullback ink (for pull back traps
only)

click the pullback ink to change it to another ink.

3.
Click Update Traps  to apply your changes to your document’s traps.

Note:  To change several color pairs the same way, use Shift to select them, then make the
changes in one color pair. Clicking Update Traps will apply your changes to all selected color
pairs.

Saving and Loading Color Pairs
After trapping a document with PowerTrapper Classic, you can save its color pairs. This ensures
you won’t need to re-edit the color pairs if you need to change the traps later on.

When to Save Color Pairs?
You can save color pairs as soon as you are finished editing them.

If you haven’t saved your color pairs, doing the following will discard them:

• closing your document,

•

Note:  This doesn’t affect your document’s traps.

Where are Color Pairs Saved?
Your color pairs are saved in a file next to your document. This file has the same name as your
document and “.tcp” as extension.
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Note:

There can be only one color pairs file per document. If you make changes to your color pairs
and save them again, your color pairs file will be updated.

If for some reason you need another version of your color pairs file, first save your document
under a different name then save the color pairs again.

Saving Color Pairs

• To save your color pairs, select Save Color Pairs in the Color Pairs palette’s fly-out menu.

Note:  This is only available when you have unsaved color pairs.

Loading Color Pairs

• To load color pairs that you saved previously, select Load Color Pairs in the fly-out menu.

Note:

This is only available if you have saved color pairs for the current document.

You cannot load another document’s color pairs.

You cannot load color pairs if you have changed the document after trapping.

6.5.3.  Trap Red under Green...

To trap adjoining objects manually.

Trap Red under Green is the manual trapping mode. Adjoining objects (contours, text, CT's,
blend objects,...) need trapping to avoid the (white) gap that appears between the objects on
the printed result.

The adjoining objects, which need a fill attribute, have to touch or overlap. If they overlap and if
the color that lies on top masks out (cuts away) the colors below, a trapping area is generated
on the boundary of the objects.

To apply Trap Red under Green, you have to

• Select the objects in red that need to be trapped underneath an adjoining object.
• Select the objects in green under which adjoining objects selected in red are trapped.
• Indicate the distance.
• Indicate the truncation type.

The red objects are trapped underneath the green objects.

Note:

The trapping area is placed in a separate layer. This way, you can easily edit or remove the
trapping area, without affecting the rest of your job.
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DistanceDefines the trapping distance. Only positive values are allowed.

Truncate The trap area is truncated to avoid it exceeding the edge(s) of the color area under
which is trapped. There are two different truncation modes:

• On Edge
 

 
The trapping area is truncated on the object edge, even if a larger distance has been
defined. This is to avoid that the trapping area of an object exceeds the edge of the object
under which is trapped. This is the default truncation mode. (default)

• On Center
 

 
The system recalculates the trapping distance for the areas where a trapping area comes
too close to the contour of an object. In that case, the trapping area stops halfway the
object. In all the other areas, the complete trapping distance is applied.

 

 

End Caps This option specifies how the ends of an open trap area are constructed.

• Square
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When this mode is selected, the trapping areas are placed at right angles relative to the
boundaries of the abutting color areas.

• Object dependent
 

 
When this mode is selected the trapping areas are a logical continuation of the contour of
the object that is spread. (default)

• Round
 

 
When this mode is selected the trapping areas are ended with circular arcs. This mode is
typically used in combination with white knockout (= reverse trapping) or ink pullback.

 

 

Corners This option allows you to change the way sharp corners in the trap areas will be
handled.

• Mitered
 

 
If the distance from the base of the trap to the corner point is larger than the miter ratio
multiplied by the trap distance then the corner will be beveled otherwise it will remain
sharp. See also miter ratio option. (default)

• Round
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A round cap will be placed at all corners.

• Beveled
 

 
Similar to mitered, but with miter cut off with straight line (= mitered with miter ratio 1).

 

 

Trap buttonTo apply the trapping, following the parameters defined in the dialog box.

6.5.4.  Keep Red away from Green...

To introduce a distance between two adjoining contours in such a way that when printed, the
adjoining inks do not overlap or mix.

In certain printing processes, the nature of the inks or the printing surface cause an unwanted
mixing of adjoining inks. Keep Red away from Green compensates these effects.

Keep Red away from Green can also be used to create graphic effects, for example a white
outline around text. The red selected object is reduced with the defined distance, to keep it
away from the green selected object.

Note:

The reduced distance of the red selected object is in fact a trapping area that is placed in a
separate layer. This way, you can edit or remove it, without affecting your job.
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DistanceDefines the trapping distance. Only positive values are allowed.

Truncate The trap area is truncated to avoid that it exceeds the edge(s) of the color area
under which is trapped. There are two different truncation modes:

• On Edge:  The trapping area is truncated on the object edge, even if a larger distance
has been defined. This is to avoid that the trapping area of an object exceeds the edge of
the object under which is trapped. This is the default truncation mode. (default)

• On Center:  The system recalculates the trapping distance for the areas where a
trapping area comes too close to the contour of an object. In that case, the trapping area
stops halfway the object. In all the other areas, the complete trapping distance is applied.

 

 

End Caps This option specifies how the ends of an open trap area are constructed.

• Square:  When this mode is selected, the trapping areas are placed at right angles
relative to the boundaries of the abutting color areas.

• Object dependent:  When this mode is selected the trapping areas are a logical
continuation of the contour of the object that is spread. (default)
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• Round:  When this mode is selected the trapping areas are ended with circular arcs.
This mode is used typically in combination with white knockout (= reverse trapping) or ink
pullback.

 

 

Corners This option allows you to change the way sharp corners in the trap areas will be
handled.

• Mitered:  If the distance from the base of the trap to the corner point is larger than the
miter ratio multiplied by the trap distance then the corner will be beveled otherwise it will
remain sharp. See also miter ratio option. (default)

• Round:  A round cap will be placed at all corners.

• Beveled:  Similar to mitered, but with miter cut off with straight line (= mitered with miter
ratio 1)
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6.5.5.  Rich Black...

Use the Rich Black tool to obtain a darker black by overprinting all black areas with the ink that
you specify.

Note:

You can use this tool also to make other inks in your job richer.

 

 

AddChoose an ink from the ink list, define the percentage and the pullback distance ( the
distance between the edge of the defined ink and the edge of the black object).

Corners This option allows you to change the way sharp corners in the trap areas will be
handled.

•
Mitered:  If the distance from the base of the trap to the corner point is larger than the
miter ratio multiplied by the trap distance then the corner will be beveled otherwise it will
remain sharp. See also miter ratio option. (default)

• Round:  A round cap will be placed at all corners.

• Beveled: 
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Miter Ratio  Determines when a sharp corner is beveled. If the Distance from the base
of the trap to the corner point is larger than the miter ratio multiplied by the trap distance then
the corner will be beveled otherwise it will remain sharp. This option is only available when
mitered corners are selected. (default value 4)

ToSelect the ink you want to make richer. Also define the minimum density the destination ink
must have before the system may enrich it.

Click 'Create'. The system will generate a 'Rich Ink' layer which contains the added objects.

Note:

If you want to add more than one ink to make another ink richer, you could use the Rich Black
tool again, but that takes time. You can also opt to add inks to the ink used in Rich Ink layer
(you can do so in the Color Factory).

6.5.6.  White Underprint

To create a white background when printing on transparent or metal material. The White
Underprint area has the same shape but a smaller size than the object under which it is
printed.
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Direction:Do you want the White Underprint to be smaller  or bigger  than the original
object?

Define the distance between the edge of the White Underprint layer and the edge of the
object under which White Underprint is applied.

Define an ink for the white underprint area. You can define an ink name in the drop-down list.
The default ink for White Underprint is TrW (Transparent White).

Tip:

Objects selected in blue will be ignored by the white Underprint tool.

Corners This option allows you to change the way in which sharp corners in the trap areas will
be handled.

•
Mitered:  If the distance from the base of the trap to the corner point is larger than the
miter ratio multiplied by the trap distance then the corner will be beveled otherwise it will
remain sharp. See also miter ratio option. (default)

• Round:  A round cap will be placed at all corners.

• Beveled: 

•  

 

Miter Ratio  Determines when a sharp corner is beveled. If the Distance from the base
of the trap to the corner point is larger than the miter ratio multiplied by the trap distance then
the corner will be beveled otherwise it will remain sharp. This option is only available when
mitered corners are selected (default value 4).

Note:

Trapping output (the trap bananas) should be embedded in the station object, on top of the
external reference to the graphics. As a consequence, the graphics will not be changed. In case
you want to reuse certain graphics, then either trapping should be reapplied or the station
object should be saved as station file.
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6.6.  Staggered Cutting

Staggered Cutting is designed to facilitate seamless printing in non-sleeve workflows. This
means that when web fed flexo printing jobs are not using flexo sleeves the flexo material
is cut and wrapped around a cylinder. The unavoidable seam will be positioned in between
printable objects. Staggered Cutting is the tool to define the shape of the flexo plates, which
will later in the process be sent to a Kongsberg table on which the flexo plates are cut. A cutting
path can be used for all separations, or a cutting path per separation can be defined.

Next to these staggered cutting paths, Plato also stores all stroked lines which are in a technical
information, in special tags in a PDFPLA file. These tags follow the same track (are forwarded
by the FlexRIP into tags in a LEN file, allowing DFS to pick them up).

The workflow is as follows:

1. An operator defines the staggered cutting path in Plato.
2. When ripping the PDFPLA file to a LEN file via FlexRip, the path is copied into the LEN file.
3. The path is then picked up by the Digital Flexo Suite (DFS). From DFS, you can export an

ACM file which can be used to cut the plate on a Kongsberg table.

Note:

The staggered cutting workflow works only on PDFPLA files (PDF workflow).

The input of this module is a red selected (open) contour. Typically this contour will be created
using the Draw Polygon tool.

6.6.1.  Creating staggered cutting lines

To create staggered cutting lines:

1. Create a step and repeat layout, with staggering.
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A staggered layout will create a plate with a irregular seam which will avoid problems with
the press.

2.
Select the Draw Polygon tool  and draw a path.

If you are going to use the option 'Truncate on Center', the path does not have to be too
precise. Even a roughly drawn path can be used to create the ideal seam.

 

 
3. Make the appropriate settings in the Staggered Cutting dialog. See Staggered Cutting... on

page 392
4. Click Create

The Staggered Cutting line will be created.

 

 

When creating a Staggered Cut, a number of objects are created, based on the selected
parameters: the cut path itself, objects knocking out the pixels outside the cut path, a stroked
line to visualize where one needs to cut, etc. All these objects are grouped, in a separate layer
named "Staggered Path".
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The staggered cutting lines will get a stroke, colored in a technical ink. This ink is called
"Cutline" if the staggered cut line is used for all separations. If different cut lines are created for
different separations, the technical inks used will be called "Cutline <inkname>", e.g. "Cutline
Cyan".

When selecting one of these objects, the Staggered Cut dialog will show the parameters that
were used to generate it. You can change the parameters and click Modify: the staggered
cut path will be recreated using the new parameters, for example to apply Truncate on
Center. The path generated will run along the center line between the different die shapes.
See Staggered Cutting... on page 392 to get an overview of all the parameters.

 

 

6.6.2.  Changing a staggered cutting line

You can change the parameters of a staggered cutting line by selecting it, changing the
paramters and clicking the Modify button. However, for more elaborate editing, you can use
the Extract for Editing button.

1. Select the staggered cutting line you want to modify
2. In the Staggered Cutting dialog, click the Extract for Editing button.

A copy of the top part section of the staggered cutting line is created, and placed as a
regular open path in a layer called "Staggered Path Edit".

3. Edit the path using the transformation and path editing tools, e.g. the Redraw Path tool. See
Redraw Path Tool on page 309

4. Select the modified path, and create a Staggered Cutting line as described in Creating
staggered cutting lines on page 165

The newly created staggered cutting lines will replace the existing cutting lines. If you only
select one or a few separations when creating the new cutting lines, only the staggered cutting
lines for those inks will be replaced, while the cutting lines for other separations remain
unchanged.
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7.  Working with SmartMarks
• What are SmartMarks?

• Using SmartMarks

• Supplied SmartMarks

7.1.  What are SmartMarks?

SmartMarks are marks used as production controls that automatically update based on
changes to the sheet size, the plate size and the number of inks on the plate.

You add SmartMarks to your plate or station using the SmartMarks tool on the Production
menu. You can add as many marks as you like to your job. You can also add multiple copies
of a mark to the same job. If you have marks that you add to every job, you can save the
collection as a SmartMark Set. A set can be added to a job to place several marks all at once.

Marks and setsThe SmartMark framework uses two concepts that you should understand
when working with SmartMarks: Marks and Sets. The combination of these two concepts
enable you to create production controls efficiently and accurately.

What is a Mark? All of the SmartMarks that you add using the SmartMark tool are based on
mark macros. Macros are scripts that are executed to create the marks that you have specified.
So instead of simply drawing an object, you select a script (e.g. a rectangle mark) and specify
some parameter settings (e.g. draw in center of sheet in registration ink).The mark scripts
are executed at certain times to make sure that they are completely up-to-date with the
current job. For example, when you save or open a file containing SmartMarks, the marks are
executed. Other actions also cause marks to be executed, like adding an ink or changing an
ink's definition.

What is a Set? A set is a collection of marks that you save using the SmartMarks window. A set
can contain any number of SmartMark mark definitions. When you save a set, Esko Plato will
ask you for a name for the new set. In the future, you can apply all the marks in that set by
picking its name from a list of available sets. Like the marks themselves, you can create and
save as many sets as you like. This way, you can create a customized set of marks that are used
for different customers, different printing presses and different printing processes.

7.2.  Using SmartMarks

SmartMarks are easy to use. Click SmartMarks on the Production menu and can begin to add
marks.

• Adding a SmartMark

• Deleting a SmartMark

• Editing a SmartMark
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• Creating and saving a set

• Using a set

• Replacing and editing a set

• SmartMarks in the Station View

• Custom Color in SmartMarks

7.2.1.  Adding a SmartMark

Adding a SmartMark is easy. Even though each individual mark contains its own set of
parameters, the basic procedure for adding a mark to a job is the same.

To add a SmartMark:

1. On the Production menu, click 'SmartMarks'. The SmartMarks window will appear.
2. Select the desired reference point (general, plate, sheet, visible objects, Position Mark,...)
3.

Click the 'Add Mark' button  The Add SmartMark dialog box appears, listing the
available marks:

 

 

Note:

The list of available SmartMarks will change according to the 'object' you want to attach the
SmartMark to.

4. Click the name of the mark that you want to use. The options dialog box for the mark you
selected will appear.

5. Set the options as required for your job.
6. Click 'OK'.

You can use 'Apply' to preview the mark before clicking OK. If the mark is not exactly what you
want, you can make changes to the dialog box and click 'Apply' again.

The mark's name appears in the 'Current Marks' list. The name will be selected in the list.
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Whenever a mark name is selected in the SmartMarks window, the mark that is created by
that mark will also be selected in the document window. This helps you to identify which mark
definition creates a particular mark in the job.

7.2.2.  Deleting a SmartMark

You can delete a SmartMark in various ways. First, you can simply select it in the document
window and delete it like you would any other object. When you delete a SmartMark from the
document window, its definition is deleted automatically from the SmartMark list of Current
Marks.

You can also delete a SmartMark from the SmartMarks window:

1. In the SmartMarks window, click the name of the mark that you want to delete.
2. Choose 'Delete' from the fly-out menu.

Tip:

You can delete more than one mark from the 'Current Mark' list by holding [CTRL] to select
more than one name at a time.

Tip:

You can also delete the SmartMark directly by selecting the object and deleting it.

7.2.3.  Editing a SmartMark

After you have created a SmartMark, you may want to edit it later. There are two ways that you
can edit an existing SmartMark.

First, you can open the mark's options dialog box by double-clicking the mark in the document
window. The mark options dialog box will appear. Make any changes and click 'OK' to update
the mark in the document window.

You can also edit a SmartMark from the SmartMarks window:

1. Select 'SmartMarks' on the Production menu. The SmartMarks window appears.
2. In the SmartMarks window, click the name of the mark that you want to edit.
3. On the fly-out menu, click 'Options'. The mark options dialog box will appear.
4. Edit the parameters and click 'OK'.

You can also double-click a mark name in the SmartMarks window or the mark object in the
drawing window to open the option dialog box for that specific mark.

7.2.4.  Creating and saving a set

If you regularly create jobs that use the same marks, you can save time by creating a set that
contains all these marks. Each mark of a set can be applied in one step by selecting it from the
Mark Set list.
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To create and save a Mark Set:

1. In the SmartMarks dialog box, add all the marks that you would like to have included in your
set.

2. On the fly-out menu, click 'Save Set'.
3. Enter a name for the Set and click 'OK'.

Note:

Position Marks (except for SmartMarks objects) are not saved in a set.

7.2.5.  Using a set

Once you have defined a SmartMark set, its name will appear in the Mark Set list. To use
it, simply select its name from the list. The marks in that set will be applied to the current
job.However, it might occur that you want to keep existing marks that are already present in
the job while adding marks from a set. If this is the case, you should use 'Load Set' to add the
marks of a set to existing marks that are already in the job.

7.2.6.  Replacing and editing a set

Replacing a setIf you have used a set in a job and want to use a completely different set,
simply open another set. Opening a different set will remove all the marks from the previous
set and replace them with marks from the new set.

Editing a setEditing a set is done by loading the set, making the required changes, and saving
the set again. If you want to use an existing set as the basis for a new set, you can load the
existing set, make the required changes and use 'Save As' on the fly-out menu. Using 'Save As'
creates a new set with a different name.

7.2.7.  SmartMarks in the Station View

When using SmartMarks in Esko Plato, the reference point in the marks dialog boxes is based
on the plate or the sheet. In the Station View, there is no plate nor sheet; in this case the
reference point is based on the borders or the margins.

In the Station View, the borders are set to the bounding box of the current die. So, you can
attach SmartMarks to the die of the station.

The Margins of a station are set to the bounding box of all the objects in the station, including
those that are outside the die. So, if you have other elements, like Geometry Marks that
are located outside the die, the Margins are fit to include them. See Setting the location of a
SmartMark.

7.2.8.  Custom Inks in SmartMarks

Custom Ink allows to pick any number of inks, by name, number or attribute.

171



7 Plato

Click Select Inks... to seelct the Inks. You can select inks in three ways:

• Select Custom Ink by Name on page 172

• Select Custom Ink by Number on page 172

• Select Custom Ink by Attribute on page 173

Select Custom Ink by Name
To select Custom Inks by Name, select "Name" from the dropdown list.
 

 

Only the inks that are used in the current document are displayed. Activate an ink by clicking
the "check" area in front of the ink.

If the "Create if not present" option is selected, the ink will be created if it is not available in the
document you want to apply the mark in.

Select Custom Ink by Number
To select Custom Inks by number, select "Number" from the dropdown list.
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The inks that are used in the current document are displayed. Activate an ink by clicking the
"check" area in front of the ink.

When building SmartMarks using a custom color in an empty document, or in the list below the
used inks, the list shows the color "unknown [n]" whereas [n] is the number of the ink.

Select Custom Ink by Attribute
Selecting Custom Inks by Attribute allows to apply a filter on all inks.

You can select an Attributes Filter from the dropdown.

Note:

If no Attributes Filter is defined, Plato will make a "Default" filter, selecting all Inks.

 

173



7 Plato

 

Using the fly-out next to the Attributes Filter dropdown, you can create a new filter, edit an
existing filter or delete one.

 

 

A filter is defined by one or more "rules". You can add or remove rules by clicking the + or -
button. A rule can select inks based on the name, ink book, ruling, angle, dot shape, type or
printing method.

An ink will be selected if it matches all of the highest level rules (a logical "AND" function: the
ink is selected if rule 1 AND rule 2 is fulfilled).
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By holding down the ALT-key, the + button will change to "...". Clicking this button will add
a logical operator, allowing to combine rules using logical expressions: "All of the following
rules" (AND), "Any of the following rules (OR), or "None of the following rules" (NOT).

The top example will select inks with "Pantone" in their ink name, and that are either have
"Offset" as printing method, or come from an ink book which name begins with "Custom". The
second example will select inks with "Pantone" in their ink name, except if they have "Offset" as
printing method

The "Result" underneath shows what inks from the current document would be selected using
the current filter.

Note:  Filters are stored on the Automation Engine server (when connected), so they can be
used in all connected PackEdge / Plato stations, and in the SmartMarks Automation Engine
tasks.

7.2.9.  Custom Color in SmartMarks

When you select a Custom Color ink from the Ink dropdown list, you can define a color and use
it afterwards in a SmartMark. Custom color inks can be applied e.g. in text marks.
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Click 'Define Color...' to define a custom color. Custom colors can be defined in three ways:

• By Ink Number

• By Ink Name

• By Color Name

 

 

Ink Numbers
To define a Custom Color by means of an ink number, select 'Ink Numbers' from the dropdown
list. The inks that are used in the current document are displayed. Activate the ink by clicking
the "check" area in front of the ink and its value will be set to 100%. You can click the value if
you want to change the percentage. The color patch will show you the resulting color.
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You can drag a color swatch from the Colors palette to the color sample at the top right of the
dialog box and the list in the "Define Color" dialog box will be updated immediately.

 

 

When building SmartMarks using a custom color in an empty document, the color patch shows
the color "unknown".
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Ink Name
When you select Ink Name from the dropdown list, only the inks that are used in the current
document are displayed. Activate the ink by clicking the "check" area in front of the ink and its
value will be set to 100%. You can click the value if you want to change the percentage. The
color patch will show you the resulting color.

 

 

Color Name
All named colors are displayed in the list. Select one of them by selecting the button in front
of the color. To create a new color, you can simply drop a color from the Colors palette on the
patch. This color will be added to the list and gets a default name (Color 1, Color 2, ...). The
color name will also be displayed in the Colors palette. At any time you are able to change this
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name in the "Define Color" dialog box. When changing the name in the 'Define Color' dialog
box, the Colors palette will updated automatically.

 

 

7.3.  Supplied SmartMarks

SmartMarks are very easy to use. The mark Options dialog boxes allow you to set the location
and ink usage for the mark. This section describes each of the marks that are supplied with
Esko Plato.

• Setting the location of a SmartMark
• Span Area
• Image Mark
• Center Mark
• Corner Mark
• Crease Mark
• Dimension Line
• Gallus
• Gradation Strip
• MFG Text replace
• Rectangle
• Standard Mark
• Standard Strip
• Text Mark
• Trim Mark
• Bar code

179



7 Plato

• Ellipse
• Grid Mark
• Cell Numbering
• Grommet
• Position Mark
• GRQ Gallus
• GRQ Gradation Strip
• GRQ Grid Marks
• GRQ Image
• GRQ Marks
• GRQ Rectangle
• GRQ Strip
• GRQ Text
• GRQ Cellnumbering

Note:

If QuickStep was installed on your workstation, the list of registration marks that were available
in QuickStep will also be available as SmartMarks.

Note:

The list of available SmartMarks will depend on the chosen anchor point. Marks that do not
have an anchor point (like standard mark), will only pop up when ‘General’ is selected in the
SmartMarks dialog box.

7.3.1.  Setting the location of a SmartMark

You specify the location for most SmartMarks using a 9-point selector similar to the one that is
used in the Transform dialog box. Here is an example of the Standard Strip mark:

 

 

In the left half of the dialog box, you set the location for the mark. The red selector represents
the reference point on the mark; the blue selector represents the reference point in the job.

The reference point in the job is selected by position. In Esko Plato, a SmartMark can be
attached to a sheet, a plate, visible objects (= bounding box of all printable objects except
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SmartMarks), or 'Position Marks'. In the Station View, a SmartMark can be attached to the
borders, the margins, to visible objects' (= bounding box of all printable objects except
SmartMarks), 'Position Marks', or to the 'General' level.

You click and drag the mark's red selector to align any of its 9 points to any of the 9 points
on the job. In the dialog box above, the upper left corner of the mark will be aligned with the
upper left corner of the sheet.

Once you have set the reference point for a mark, you can specify an offset from this point
using the vertical and horizontal offset fields. Both positive and negative offsets are allowed.

You set the orientation of the mark by selecting one of the 5 orientation options.

7.3.2.  Span Area

The Span Area SmartMark allows to create new named objects which span a (rectangular) area
using the bounding box of two or more points.

This can be used to create named objects, that can be used as anchor points to position other
SmartMarks.

 

 

The SmartMark is defined by

• The Name for the named object

• The Position of the different points. Position is defined as for regular SmartMarks. See
Setting the location of a SmartMark on page 180

You can click the + to add an extra point, or x to remove a point.

If the Skip Missing Positions option is enabled, any missing position (e.g. because it's attached
to a non existing named object) will be ignored. If a position is missing and the option is off, or
if there are less than two positions defining the Span Area, the Span Area SmartMark will fail.

7.3.3.  Image Mark

The image mark allows you to enter a CT, LP, LC , GRS or Normalized PDF file as a mark.
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• Monochrome images:(Can be placed in one or all inks of the job, with or without step.)

• LP, LC, monochrome CT
• GRS files containing only one ink
• Normalized PDF files containing more than one ink

• Colored images:(Can be placed in their original inks, or can be inkmapped to the job's inks.)

• CMYK and multichannel CT files
• GRS files containing more than one ink

The Image Mark dialog box has three tabs:

• Image
• Inks
• Position

Tip:

The Image Mark can be moved in your job by simply using the Move tool  in the Tools
toolbar.

Image
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Name: Enter the name of the Image Mark you want to use or click the browse button to
browse to a Normalized PDF, GRS, LC or LP file.

Tip:

If you want to incorporate SmartNames in your file name, click the 'SmartNames' button.

Scale: You can scale the Image Mark. If the Image Mark is attached to a Position Mark, other
scale options are possible: Scale to fit, Downscale to fit, Autorotate and scale to fit.

To fit to the Sheet, Clip or Repeat the Image: This option will copy the image a number of
times so that its width and/or height matches the width and/or height of the anchor point
(sheet/plate/visible objects). If the size is too large, a clip path will be applied to make sure that
the image exactly matches the required size.

When placing [taskinputfile], you have the option to Hide trap layer(s) . This will remove all
trapping layers which were generated in PackEdge or Automation Engine. If this option is on,
the [taskinputfile] will no longer be placed as an external reference, so the resulting output file
can be larger.

Inks
 

 

Ink

• Registration
• Darkest
• Black or Darkest

Note:

Black or Darkest selects any black (process, pantone) if it exists. If they dont exist, the
darkest ink is taken. This option ensures that a black ink is used for the marks, even if the
job contains a (darker) ink like Reflex Blue

• Black
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Note:

This option will select any black (process or pantone). If no such ink exists, process black is
added to the ink table.

• Knock Out

• Custom Ink allows to pick any number of inks, either by name or by position (in the inks list).
• Custom Color allows you to pick a color, based on the ink name, ink number or color name.

Overprint

• Opaque
• Darken
• Postscript
• Add
• Reverse: Knocks out the selected ink in the underlying separation. If you select Magenta for

instance, it will be knocked out in the Magenta separation.

Ignore Similar Inks becomes available when you select Registration ink.

Tip:

This is useful when you have similar inks in your job, e.g. two cyans with a different angle, and
you want to step all the inks but you only want to have one cyan.

Ignore Technical Inks will not include technical inks in the SmartMark. This option becomes
available when you select Registration ink.

Ignore Varnish Inks will not include varnish inks in the SmartMark.

With Step is active when the ink is set to Registration or Custom. The mark object will be
repeated in each of the seleted inks. The repetition is done using the specified step parameters
(direction + step/gap).

Interleaved with can be used in combination with ‘With Step’. Inbetween each stepped
instance of the mark object, an additional instance of the mark object will be present in the
specified ink.

Start with can be used in combination with the ‘Interleaved with’ and ‘With Step’ options. It
determines if the extra objects generated by activating the ‘Interleaved with’ option are placed
before or after the stepped instances of the mark object.

Ignore Darkest Ink is used in combination with ‘With Step'. It determines whether or not the
darkest ink should be excluded from the stepped instances of the mark object.

Use isolated blending group will put the mark in a group with the Isolated blending option
enabled. This will ensure that blend modes used in the mark will not affect underlying objects

The Preserve Screening option allows to place the mark in all separations of the current job,
but keep the screening (dot shape, lpi, angle) from the original image.

White underprint allows you to add white underprint to the mark. Click the 'Setting' button,
the White Underprint Settings dialog box pops up.
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Select Keep original inks if you want to use the original inks of the image when placing this
mark. Image inks that do not yet appear in the job's ink list will be added to that list. Inks that
do appear in the job's ink list, but which have different ink settings will also be added to that
list.

Select Map inks if you want the inks of the image mark to be mapped to the job's inks.

Keep ink names is almost the same as 'Keep original inks' except that image inks that already
appear in the job's ink list with the same name (but with a different ruling, angle or dotshape)
will be replaced by the corresponding ink from the current job. Inks that do not yet appear in
the job's ink list will be added.

Position
The Position tab allows you to select the position of the mark by moving the red rectangle (the
mark) in the blue rectangle (the job borders).

 

 

Attach to: Plate, Sheet, Visible Objects, Objects.

Use the offset options  to apply an extra offset to the chosen position using
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OrientationClick one of the buttons to obtain the desired orientation for your image.

 

 

Angle  allows you to specify an angle in case you selected the rotation button in the
'Orientation' group.

7.3.4.  Center Mark

A center mark places marks at the centers of the 4 sides of the anchor point (plate/sheet/
visible objects/ Position Mark).

The Center Mark dialog box has two tabs: Mark and Inks.:

 

 

Mark
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There are four kinds of Center Marks:

• Center mark 1 on page 187
• Center mark 2 on page 188
• Center mark 3 on page 189
• From file:

Center mark 1

 

 

Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.

 

 
 

 
Define the vertical and horizontal dimensions .
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Define the diameter.

 

 
Define the thickness of the mark's lines.

 

 
Defines the distance between the mark and the object the Center Mark is attached to.

Center mark 2

 

 

Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.

 

 
 

 
Define the vertical and horizontal dimensions .
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Define the diameter.

 

 
Define the thickness of the mark's lines.

 

 
Defines the distance between the mark and the object the Center Mark is attached to.

 Center mark 3

 

 

Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.

Every aspect of this Center Mark can be defined.

From file:

If you really have specific needs, you can always design your own mark and use this option to
place it as a Center Mark.

 

 

Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.
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Defines the distance between the mark and the job borders.

Inks
 

 

Ink

• Registration
• Darkest
• Black or Darkest

Note:

Black or Darkest selects any black (process, pantone) if it exists. If they dont exist, the
darkest ink is taken. This option ensures that a black ink is used for the marks, even if the
job contains a (darker) ink like Reflex Blue

• Black

Note:

This option will select any black (process or pantone). If no such ink exists, process black is
added to the ink table.

• Knock Out

• Custom Ink allows to pick any number of inks, either by name or by position (in the inks list).
• Custom Color allows you to pick a color, based on the ink name, ink number or color name.

Overprint

• Opaque
• Darken
• Postscript
• Add
• Reverse: Knocks out the selected ink in the underlying separation. If you select for instance

Magenta, it will be knocked out in the Magenta separation.

Ignore Similar Inks: This option becomes available when you selected Registration ink
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Tip:

This is useful when you have similar inks in your job, e.g. two cyans with a different angle, and
you want to step all the inks but you only want to have one cyan.

Ignore Technical Inks: Technical inks will not be used in the SmartMark. This option becomes
available when you selected Registration ink.

Ignore Varnish Inks: Varnish inks will not be used in the SmartMark.

7.3.5.  Corner Mark

A corner mark places marks at the 4 corners of the anchor point (plate/sheet/visible objects/
Position Mark).

The Corner Mark dialog box has two tabs:

• Mark
• Inks

 

 

Mark
There are five kinds of Corner Marks:

•

Corner mark 1 on page 192 
•

Corner mark 2 on page 192 
•

Corner mark 3 on page 193 
•

Corner mark 4 on page 194 
• From file:
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Corner mark 1

 

 

Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.

 

 
 

 
Define the vertical and horizontal dimensions .

 

 
Define the thickness of the mark's lines.

Vertical and horizontal Offset allows you to change the position of the mark.

Corner mark 2
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Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.

 

 
 

 
Define the vertical and horizontal dimensions .

 

 
Define the thickness of the mark's lines.

Vertical and horizontal Offset allows you to change the position of the mark.

Corner mark 3
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Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.

 

 
 

 
Allows you to define the vertical / horizontal distance between multiple corner lines.

 

 
Define the thickness of the mark's lines.

Bleed: Enter the bleed distance where you want to position the marks.

Corner mark 4

 

 

Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.

 

 
 

 
Allows you to define the vertical / horizontal distance between multiple corner lines.
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Define the thickness of the mark's lines.

Bleed: Enter the bleed distance where you want to position the marks.

From file:

If you really have specific needs, you can always design your own mark and use this option to
place it as a Corner Mark.

 

 

Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.

Vertical and horizontal Offset allows you to change the position of the mark.

Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.

 

 

7.3.6.  Crease Mark

A crease mark places registration lines which line up with the crease lines in the layout..

The Crease Mark dialog box has three tabs:

• Mark

• Inks

• Position
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Mark
 

 

Enter the settings for the crease marks:

• The Length and Width define the size of the crease lines

• The orientation: either on Rows (horizontal) or on columns (vertical)

• On what stations to base the crease marks : All Stations will generate crease marks for
every crease line in every station. By setting to Left Column, Right Column, Top Row or
Bottom Row, only the crease lines from the corresponding stations will be used.

• The line type: Creases, Cuts or Creases and Cuts

• The minimum length of a crease or cut line to be taken into account. Crease or cut lines
below the minimum length will be disregarded.

Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.
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Position
The Position tab is identical to the Position tab of the Image Mark dialog box.

7.3.7.  Dimension Line

The Dimension Line measures and displays the horizontal and/or vertical dimensions of an
(named) object, job borders and/or margins.

 

 

The Dimension Line dialog box has four tabs:

• Text
• Inks
• Position
• Value

Text
Allows you to define the font, weight, size, style.

 

 

Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.
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Position
 

 

The area on the left allows you to indicate where you want to place the Dimension Line. Click
the white arrow to position the Dimension Line, the arrows turn black.

Enter the Name of the object you want to attach the mark to.

Attach to: Sheet, Plate, Visible objects, Objects.

 Define the distance between the Dimension Line and the border, margin, object.

Check Relative to Borders if you want to position the dimension line relative to the border.
The distance specified above will be taken into account.

 Define the thickness of the mark's lines.

Value
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Expressed in defines the units that you want use to to express the lenght of the dimension
line.Decimals defines the number of decimals you want to put behind the comma.Select Add
Unit if you want to put the unit behind the value.

7.3.8.  Gallus

The gallus mark allows you to define the positioning of gallus strips left and right with your
specific values.

 

 

The gallus marks can be put in two directions. On the left you see that the gallus mark starts
with a square box and on the right with a triangle. If you click the white marks, they turn black,
indicating they have now become active.

Tip:

Enter negative values if you want the gallus marks to appear inside the borders.

7.3.9.  Gradation Strip

The Gradation Strip allows you to create a strip for all the inks in the job.

Tip:

The Gradation Strip can be moved in your job by simply using the Move tool  in the Tools
toolbar.
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The Gradation Strip dialog box has four tabs:

• Gradation

• Numbers

• Position

• Inks

Gradation
The size of the boxes can be specified as well as the gradations for each ink. The different
gradations have to be separated by a comma.

 

 

LengthChoose the length of your mark from the drop-down list.

• Specific: define the specific length of the strip
• Fit: the strip fits in your job. You can add an extra length.

• Single copy: puts the strip once in your job, no matter how big the job is.

GradationsAllows you to specify the list of comma separated percentages and at the same
time the amount of gradations boxes per ink.

In the menu the sizes of the gradation boxes are 5x5 and the gradations are 3, 25, 50, 75, 98,
99, 100.If the job has 4 inks this will generate a strip with 4 parts, a part for each ink, and per
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part you will have 7 gradation boxes. These 4 parts will be repeated until the length of the
strip specified in the menu is reached.

Gradation specifications  To specify the height of your gradation box.

 To specify the width of your gradation box.

Enable Stroke to be able to specify a stroke width for the box.

Enable 'Add Gradation Numbers' to be abe to change the settings for gradation numbers.

Note:

As long as 'Add Gradation Numbers' is not enabled, the Numbers tab will appear dimmed.

Numbers
 

 

When you activate the 'Add Gradation Numbers' toggle in the Gradation tab you can access the
'Numbers' tab where you can define the Gradation Numbers' position, font and ink.

PositionThe buttons allow you to position your text to the left, on top or to the
right of the gradation boxes and make it possible to select the correct orientation.

 The distance input field allows you to
specify a distance from the gradation boxes.

StyleSelect the Font from the drop-down list.Select the weight: 'Roman' or 'Bold'.Select the font
style: 'Upright' or 'Italic'. Specify the point size.

InkYou can choose the color of the ink an the overprint mode.

The color of the ink:

• Follow ink and gradation: the number has the same percentage of the ink of the
corresponding gradation box.

• Follow ink: the number has 100% of the ink of the corresponding gradation box.
• Registration
• Darkest Ink
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The Overprint Mode:

• Opaque
• Darken
• Postscript
• Add

Position
The Position tab allows you to select the position of the mark by moving the red rectangle (the
mark) in the blue rectangle (the job borders).

 

 

Attach to: Plate, Sheet, Visible Objects, Objects.

Use the ffset options  to apply an extra offset to the chosen position using
 

 

OrientationClick one of the buttons to obtain the desired orientation for your image.

 

 

Angle  allows you to specify an angle in case you selected the rotation button in the
'Orientation' group.

Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.
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White underprint allows you to add white underprint to the mark. Click the 'Setting' button, the
White Underprint settings dialog box pops up.
 

 

7.3.10.  MFG Text replace

MFG Text Replace scans an ArtiosCAD MFG file for text objects with a specific content. This
content will then be replaced by a station’s number, or by user defined SmartName enabled
text string.

When scanning for ArtiosCAD text objects, the position and rotation angle of the text is kept,
and will be used for the replacement text.

The MFG Text Replace dialog box has two tabs:

• Number

• Inks
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Number
 

 

• Set the Search string to define the MFG text that needs to be replaced

• Set Replace by Station Number to replace the found text by the Station’s number, or
Replace by text to replace it by user defined text. When defining the text, you can use
Smart Text by clicking the button.

• Set the Font, Weight, Size and Orientation for the text.
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Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.

7.3.11.  Rectangle

A rectangle mark generates a rectangle with the specified dimenions in the required ink(s).

 

 

The Rectangle Mark dialog box has three tabs:

• Rectangle
• Inks
• Position

Tip:

The Rectangle can be moved in your job by simply using the Move tool  in the Tools toolbar.

Rectangle
Enter the Rectangle's vertical and horizontal dimensions.
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Enter the height and width of the ellipse.Select the Fit to Trim Box (Borders) toggle if you
want the width and height to be fitted to the trim box dimensions. This will activate the Extra
Height/Length input boxes and will allow you to make the mark as long (or wide) as the
anchor object (borders, margins, Position Mark,…) of your job.You may opt to give the mark a
stroke instead of a fill. Select the Stroke toggle and enter a width.Tint: Enter a percentage. If
you enter 50 %, the mark will be shown using 50 percent of the inks.

Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.

 

 

Position
The Position tab is identical to the Position tab of the Gradation Strip Mark dialog box.

 

 

7.3.12.  Standard Mark

The Standard Mark dialog box allows you to define the display of cutting marks, centermarks,
bleed, ink squares and other job information.

The Standard Mark dialog box has two tabs:

• Marks
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• Settings

 

 

Marks
To activate a specific mark, just click it and the mark will turn black. Only the marks displayed in
black will be added to your repetition. This is not the case for marks displayed in white. You can
insert (black) text in the text field.
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Settings
The Settings tab allows you to define size, fonts, distances of the Standard Marks.

 

 

General:Define the 'Distance to borders'.

Cut/Bleed Marks:  To select the size of cut/bleed marks.  To select the thickness of the
cut/bleed marks.Enter a Bleed value if you want to change the distance between the marks and
the job borders.

Center Marks  To change the size of the center marks.  To change the diameter of the

center mark.  To define the thickness of the cut/bleed marks.

Gradation Strip  To specify the height of your gradation box.

 To specify the width of your gradation box. Start: define the percentage of the first (top)
grayscale box. The default value for the start is 100%.Stop: define the percentage of the last
(bottom) grayscale box.Step: define the percentage step between two grayscale boxes.

StyleSelect the Font from the drop-down list.Select the weight: 'Roman' or 'Bold'.Select the font
style: 'Upright' or 'Italic'. Specify the point size.

7.3.13.  Standard Strip

A Standard Strip mark generates an Esko-defined strip containing adjustable gradation patches
in a selectable set of inks.
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The Standard Strip dialog box has three tabs:

• Strip

• Inks

• Position

Tip:

Note that the Strip can be moved in your job by simply using the Move tool  in the Tools
toolbar.

Strip
 

 

If the 'Fit to Trim Box (Borders)' box is checked, you can define extra length.Gradations allows
you to specify the list of comma separated percentages and at the same time the amount of
gradations boxes per ink.

In the menu the sizes of the gradation boxes are 5x5 and the gradations are 3, 25, 50, 75, 98,
99, 100.If the job has 4 inks this will generate a strip with 4 parts, a part for each ink, and per
part you will have 7 gradation boxes. These 4 parts will be repeated until the length of the
strip specified in the menu is reached.

Resolution allows you to specify the resolution of the mark in ppi.
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Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.

 

 

Position
The Position tab is identical to the Position tab of the Gradation Strip Mark dialog box.

 

 

7.3.14.  Text Mark

The Text dialog box allows you to create additional text on a specified position and a certain
orientation. The additional text fields will be put next to each other on the specified position.
Text fields can contain any additional information that you type in and will be created in the ink
selected.
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The text Mark has three tabs:

• Text
• Inks
• Position

Text
To create additional text on a specified position and orientation.

Tip:

The Text Mark can be moved in your job by simply using the Move tool  in the Tools toolbar.

 

 

Check the Mirrored box if you want your text to appear mirrored.When choosing 'Automatic
Size', quadding modes will be ignored and the size of the box will depend on the size of the
text.Deselect 'Automatic Size' to be able to enter text box dimensions yourself.

Click 'Style' to format your text.Click 'Smart Text...' if you want to use smart text.

Style...

Clicking 'Style...' opens the Text Style dialog box:

 

 

It allows you to change the:

• Font
• Font Weight
• Leading
• Size
• Style
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• Horizontal Quadding
• Vertical Quadding
• Text Orientation

When you select 'Advanced', the Text Style dialog box expands.  and 'Apply Fully' become
available.

Note:

In 'normal' mode, style changes are always applied to the complete text. In 'Advanced' mode,
style changes are inserted at the current cursor position, except when you click 'Apply Fully'.
When 'Apply Fully' is clicked, the settings are applied to the mark.

When you click the envelope, you are presented with a number of extra formatting options.

 

 

•
 Superscript

•  Subscript
•  Underscore
•

 Slant
•

 Distort
•

 Track

Smart Text...

Smart text fields are text codes that correspond with certain attributes of the job. During text
lay out, these text codes are replaced by their value. If during editing these values should
happen to change, the smart text field will be recalculated.

Select a category from the left column and a topic from the right column.

The categories are:

• Ink/Color
• Document
• Date/Time
• Typographic
• User information
• ReportMaker is used when creating ReportMaker templates (Esko PackEdge).
• SmartNames: Lists all the SmartNames known on the Automation Engine server
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• Output Parameter

• CAD data

• Job SmartNames: lists all the SmartNames which are defined in the Automation Engine job
on which the editor is currently working.

• XMP data

Ink / Color

Ink name Inserts ink names, you can select the inks by the ink colors.

All ink names Inserts the names of all the inks in your job

Ink attribute Inserts attributes of inks. You select the ink by the ink number.

Available attributes are

• name: the name of the ink as shown in the inks dialog box

• shortname: e.g. Reb for Reflex Blue

• fullname: the full ink name

• angle: the angle of the ink

• lpi / lpmm / lpcm: the lineature of the ink

• inkbook: (only fo rPantone Ink books) returns C, M or U for coated,
matte and uncoated inkbooks.

• dot: the dotshape of the ink

• group: the group (Process, PANTONE) to which the ink belongs

• type: the type of ink (Normal, Opaque, Varnish, Technical)

• number: the number of the ink

• LAB values: the LAB value of the ink

Attributes of all inks Inserts attributes of all the inks.

Ink coverage Inserts the Ink coverage. Select the ink by entering the number. Choose
a unit (percent, mm, cm, inches).

Document

Job name Inserts the name of the job.

Job V size Inserts the vertical size of the job.

Job H size Inserts the horizontal size of the job.

Job sizes Inserts the vertical and horizontal job sizes
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Page number Inserts the page number.

Localized
Modification Date

Inserts the job's localized modification date. Choose a format: date, long
date, time, ...

Date / Time

Date Inserts the current date (dd-MMM-yy)

Time Inserts the current time (hh:mm:ss)

Localized Date and
Time

Inserts localized date and time. Choose a format: date, long date,
time, ...

Typographic

Superscript Puts text in superscript.

Subscript Puts text in subscript.

Normal Makes text normal (without characteristics).

Underline On Underlines the text.

Underline Off Counters the Underline On option.

Elastic Inserts an elastic whitespace.

Space Inserts an fixed white space. You can define the fixed space.

Vertical space Inserts a vertical fixed space. You can define this space yourself.

User Information

User Name Inserts the user name.

Workstation Name Inserts the workstation name.

Output Parameter

These strings of information are derived from the output settings in the editor, or from the
ticket used on the server. these work only when applied in a set used during output (PostScript
or PDF output or during Esko FlexRip output.)

Resolution Inserts the resolution.

Color Strategy Inserts the used color strategy .

Source Profile Inserts the source profile in case it is used in the marks set that is
applied during proofer output.

Destination Profile Inserts the destination profile in case it is used in the marks set that
is applied during proofer output.

Screen Based DGC Inserts the used color strategy.

DGC Inserts the DGC settings.
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Dotshape Inserts the dotshape used in the job.

V /H Distortion Inserts the used vertical/horizontal distortion settings used.

V/H Scale Inserts the used vertical/horizontal scale settings used.

Device Inserts the device name.

Configuration Inserts the color strategy used.

Emulsion Inserts the emulsion settings.

Image Inserts the used image settings..

Screen Angle Direction Inserts "CCW" (counterclockwise) when used in an expose ticket on
imaging engine when screen angles are set to counterclockwise. In
all other situations, it will be "CW" (clockwise).

CAD data

CAD data SmartMarks allow you to add CAD-related design, customer or board information.

Design Inserts data from the CAD design (if available): Description, Name,
Length, Width, Depth

Customer Inserts customer information (if available): Name, Adress1, Adress2,
City

Board Inserts data from the CAD database (if available): Code, Description,
Flute, Caliper

XMP data

Artwork Inserts Artwork information, choose from the drop-down list.

Bar codes Inserts bar code xmp information, toggle the ones you need: type,
code, bar width reduction, device compensation, magnification,
magnification in percentage, X- dimension, ratio.

External References Inserts all external references, choose what information you want
(File Name, File URL, Count, Page, SmartID) a separator: dash, space,
new line.

Fonts Inserts all font names, choose a separator: dash, space, new line.

Inks Inserts XMP ink data, toggle the ones you want: name, group, lpi,
angle, dotshape, type. also choose a separator: dash, space, new
line.

Layers Inserts all layer names, choose a separator: dash, space, new line.

Job Inserts XMP information on a Job, choose between Description,
Order ID, SubOrder ID.

Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.
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Position
The Position tab is identical to the Position tab of the Image Mark dialog box.

 

 

7.3.15.  Trim Mark

The Trim Mark places itself only around externally placed jobs (GRS, PLA, STA). The Trim Mark
has the same features as the Corner Mark.

 

 

When you select the second type of corner mark  an extra option becomes available.
Check the left option to put trim marks around the stations, taking into account only the outer
stations. Check the right option to put trim marks around the stations, but taking all stations
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into account. Trim marks will be put outside the bounding box, aligned to the outer edge of the
stations..

7.3.16.  Bar code

A Bar Code mark generates a bar code object.

Please check the barX manual (on the Documentation DVD or via Help) for more information
on the different bar code types.

The Bar code dialog box has four tabs:

• Bar Code

• Box

• Inks

• Position

Bar Code
 

 

TypeSelect a bar code type from the list.

CodeTo enter the digits of the bar code.

Note:

When entering a wrong number of digits or wrong begin or end digits, the system displays a
warning message, informing you on the required number of digits or displaying the correct
code. The code is corrected automatically.

Bar Width ReductionTo adapt the bar width of the bar code. This is necessary to adapt the
bar code to printing processes where the ink tends to 'bleed'. To compensate for this ink
bleeding, the bars have to be a little thinner. The exact value will be provided by your printer
or customer. If the printer specifies for example that the line width will increase with 0.01mm,
then specify a bar width reduction of 0.01 mm. By default, the value 0 is entered for all bar
codes. This means that the bar width is not adapted. A negative value in this input box results
in thicker bars, a positive value in thinner bars.
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Device CompensationThe in/decrease in bar width has 2 causes: the printing process (printed
line is wider than what is on the plate) and the plate-making process. Here you can enter a
device compensation value, The net compensation is the sum of both the device compensation
and the Bar Width Reduction. You can leave on '0' if you do not want to compensate.

MagnificationRepresents a reduction or enlargement factor for proportional reduction or
enlargement of the bar code. Entering "1" creates a 100% bar code. Entering "1.5" creates a
150% bar code. The value is an absolute factor which is automatically rounded depending on
the type of bar code. As bar codes are magnified or reduced in size, the relationship between
the bars remains constant The widths of individual bars and spaces however, are increased or
reduced.

Note:

Since all the values in this dialog box are related proportionally, specifying a number in the
Magnification input box will influence the other values in the dialog box.

HeightThe height of the bar code. The height covers the height of the bars and the digits
(if any). Although the height does not contain information, it has to be sufficient to allow an
efficient reading of the code.

Caution:

Do not change the height of the bar code before entering a Magnification value. The
height will change again according to the Magnification factor that you define.

Characters per unitDefines the number of characters that you want to print. It is necessary
to specify the number of characters per unit, because the character width depends on the
printing process and the surface on which the bar code is printed.

RatioDefines the ratio between the narrowest bar, which is used as reference unit, and the
other bars in the bar code.

Narrow barIndicates the width of the smallest unit of the bar code.

Wide BarDetermines the width of the wide line within the symbol.

GapDetermines the distance between lines within the symbol and interacts with the ratio: gap
value = (1 + ratio) * narrow bar width / 2.

Output resolutionDefines the resolution for the exposure of the bar code. The unit is ppi. If
you unlock the chain, the system will no longer take the Output resolution in account.

Add CharactersBy default, the characters are added underneath the bar code when it is
created. If there is no need to add them, uncheck the box.

Light Margin IndicatorCheck the box to have a greater than (>) or less than (<) character
printed in the human readable field of the bar code symbol, with the tip aligned with the outer
edge of the light margin.

The SmartMark bar code can get (part of) its parameters from an external source through
SmartNames. If this is the case, then the parameter is no longer editable and the value is
preceded by a green SmartMarks icon 

You have two options for using SmartNames in the SmartMark bar code dialog box:
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1. If the code field in the bar code SmartMark is SmartName enabled, you can immediately
make this field dependant of external data sources.

2. If you want to vary other settings (bar code type, magnification...) as well, you have to use
the bottom field in the bar code SmartMark dialog box. You can enter an XML line which
will transfer its values to the different other fields of the bar code dialog box. The field is
SmartName enabled, so you can get your XML information from an external data source.

Make sure that the syntax of this piece of XML is correct. The syntax is the same as used
when specifying bar code parameters in JDF tickets. E.g. to specify type 'datamatrix'
and code string 'abcdef', your data source has to return the following XML string:
<eg:BarcodeParam egBarc:Type=”DATAMATRIX” egBarc:Code=”abcdef”>

 

 

Box
Check the Box checkbox to automatically create a box behind the bar code. The box has the
size of the required light margin around the bar code. After creating the bar code with the box,
they both appear selected in red. The bar code and the box can have different color properties.

 

 

Inks
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Ink

• Registration
• Darkest
• Knock Out
• Custom Ink allows to pick any number of inks, either by name or by position (in the inks list).
• Custom Color allows you to pick a color, based on the ink name, ink number or color name.

Overprint

• Opaque
• Darken
• Postscript
• Add
• Reverse: Knocks out the selected ink in the underlying separation. If you select Magenta for

instance, it will be knocked out in the Magenta separation.

Ignore Similar Inks: This option becomes available when you selected Registration ink

Tip:

This is useful when you have similar inks in your job, e.g. two cyans with a different angle, and
you want to step all the inks but you only want to have one cyan.

Ignore Technical Inks: Technical inks will not be used in the SmartMark. This option becomes
available when you selected Registration ink.

Ignore Varnish Inks: Varnish inks will not be used in the SmartMark.

With Step repeats the mark in various inks with a step between each repetition.

Position
The Position tab allows you to select the position of the mark by moving the red rectangle (the
mark) in the blue rectangle (the job borders).

 

220



7Plato

 

Attach to: Plate, Sheet, Visible Objects, Objects.

Use the ffset options  to apply an extra offset to the chosen position using

OrientationClick one of the buttons to obtain the desired orientation for your image.

 

 

Angle  allows you to specify an angle in case you selected the rotation button in the
'Orientation' group.

7.3.17.  Ellipse

An Ellipse mark will generate an oval shape (or circle when height equals width).

The Ellipse dialog box has three tabs:

• Ellipse
• Inks
• Position
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Ellipse
Enter the Ellipse's vertical and horizontal dimensions.

 

 

Enter the height and width of the ellipse.Select the Fit to Trim Box (Borders) toggle if you
want the width and height to be fitted to the trim box dimensions. This will activate the Extra
Height/Length input boxes and will allow you to make the mark as long (or wide) as the
anchor object (borders, margins, Position Mark,…) of your job.You may opt to give the mark a
stroke instead of a fill. Select the Stroke toggle and enter a width.Tint: Enter a percentage. If
you enter 50 %, the mark will be shown using 50 percent of the inks.

Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.

 

 

Position
The Position tab is identical to the Position tab of the Gradation Strip Mark dialog box.
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7.3.18.  Grid Mark

Places marks on the vertical sides of external references. Is meant mainly for repetition blocks
(microdots…).The Grid marks has three tabs:

• Mark

• Inks

• Position

Mark
Select the shape of the grid mark: a circle, square or an image from file.Enter the diameter, the
dimensions or the scale.

 

 

When using an image from file, you can define the name for the file and the Preserve
Screening option.

The Preserve Screening option allows to place the mark in all separations of the current job,
but keep the screening (dot shape, lpi, angle) from the original image.

Inks
The Inks tab is identical to the Inks tab of the Center Mark dialog box.
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Check Add White Halo to create a white halo effect around the grid mark.

Position
 

 

1. a. Define the horizontal or vertical copies. Select 'On Rows' or 'On Columns' from the
drop-down list. Depending on what you select, the appearance of the other options will
change.

b. Indicate if the mark should be put on the left/ right and / or middle stations.
2. Indicate how frequent the mark should be repeated. Should it appear on every row, or only

every every x rows?
3. Specify the position of the marks. Define the horizontal or vertical shift. The interface will

change according to the selection in the 'Copies' group.

 only affects the marks attached to the left and right stations.

 a shift is also applied on the marks on the middle stations.

4. The vertical position of the marks: attach them to the left station/column, to the right
station/column, to each station relative to the bounding box of each individual station
(particulary useful in the case of staggered grids) or to the sheet, in the scan direction
relative to the sheet..

Select the relative position of the mark by moving the red rectangle (the mark) in the blue
rectangle (the stations). Define an offset if needed.
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You can define the Offset from center of the mark to the edge of the station (default), or
from the edge of the mark to the edge of the station.
 

 

Tip:

Check the box to be able to specify an offset in percentage.

7.3.19.  Cell Numbering

Places station numbers on the position defined by the Position Mark.The Cell Numbering has
three tabs:

• Number

• Numbering

• Inks

Number
Select the Position Mark (Named Object) to define the position o fthe Cell Number. The info
button allows to scan all placed external references for Position Marks, and all the names of
the Position Marks will become available in a dropdown list to easily select the correct Position
Mark..Enter the font, weight, size, alignment and orientation for the number..
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Numbering
Define the Format and start value for the Cell numbering. Use the buttons to define the start
point and direction.

You can add a Prefix and a Suffix.

 

 

Inks
Use the Inks tab to define the color of the Cell Numbering. The Inks tab is identical to the Inks
tab of the Center Mark dialog box.
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Check White Underprint  to create a white underprint underneath the Cell Number.

7.3.20.  Grommet Mark

Places marks around the anchor point (mostly the plate) by dividing the height and width..The
Grommet Mark has three tabs:

• Marks

• Inks

• Position

Marks
Select the type of mark, and its settings. The Marks tab is similar to the Marks tab of the Center
Mark dialog box..

Inks
Use the Inks tab to define the color of the Cell Numbering. The Inks tab is identical to the Inks
tab of the Center Mark dialog box.

Position
Define the position of the marks:
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1. Define the “hem” (the width of the border)
2. Define the distance of the marks to the edge
3. Define the Maximum interval.

Grommet Marks can be used to print marks where to put grommets on a poster. These
grommets can be used to mount a poster on a frame.

7.3.21.  Position Mark

A Position Mark generates uncolored objects which have a name assigned (Position
Marks). It generates a placeholder object that will be used as an anchor point for other
SmartMarks.Position Marks can be positioned by means of formulas. In other words, any
SmartMark can be positioned using formulas in a 2 step approach:

1. Create a Position Mark using the requested formulas.
2. Place the requested SmartMark relative to this Position Mark.

Note:

Position Marks will only appear in Esko Plato.
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1. Click the "Add SmartMark" icon
 

 
2. Select the "Position Mark" SmartMark. The Position Mark dialog box will appear.
3. A default name is suggested but you are prompted to specify a meaningful name.
4. A default size is specified.
5. Define the vertical position of the Position Mark (default is 0).
6. Define the horizontal position of the object (default is 0).

7.3.22.  Fill Placeholder

The Fill Placeholder SmartMark will search for placeholders in a CAD based layout, and
generate objects, either a SmartMark set or Station Numbers, on the locations of these
placeholders.

The Placeholder Types
• Named Objects inside the PDF graphics used in the stations.

• The Object Name is used to search the Placeholder. The name of all Named Objects
used in the PDF graphics in one or more stations will be shown in the dropdown list.

• The bounding box of the Named Object is used as frame for the placeholder. In case
the object is a text object or a SmartMark object, the rotation angle will be used for the
placeholder.

• Text Objects in the MFG CAD object.

• The Text Content is used to search the Placeholder. The content of all text objects from
the embedded designs will be shown in the drop down list.

• The frame of the placeholder will be a single point, the anchor point of the text, with a
frame size of zero. The rotation angle of the ArtiosCAD text object will be used.

• Artwork Panels in the embedded designs of the MFG CAD object.

229



7 Plato

• The Panel Name is used to search the Placeholder. All the artwork panels from the
embedded designs will be shown in the drop down list.

• The bounding box of the Artwork Panel is used as frame for the placeholder, taking in
account the offset for the artwork pale, and the orientation of the artwork panel.

• Dynamic Art in the (embedded designs of the) MFG CAD object.

• The Dynamic Art name is used to search the Placeholder. A concatenation of both text
labels used in the properties of all dynamic art object will be shown in the drop down list.

• The bounding box and rotation of the Dynamic Art object will be used for the frame and
rotation of the placeholder.

Fill with Station Numbers
The color and text format of the station number can be set in the Inks and Number formats
tabs, using the same settings as for the cell numbering SmartMark. See Cell Numbering on page
225

The sequence of the station numbers can be set in the Numbering tab. These settings are also
the same as for the Cell Numbering SmartMark.

The 'Default Ordering" is the station sequence as set in the current layout. When Use
Sequence from MFG Layout is enabled, the sequence as defined in the MFG file is used.

Note:  If certain stations don't have a matching placeholder (e.g. the PDF doesn't contain the
Named Object), no text object will be generated, but the station number sequence will include
those stations, so the corresponding station numbers will be missing.

Fill with SmartMark set
When filling the placeholder with a SmartMark set, you can select any of the existing
SmartMark sets from the dropdown list.

The SmartMark set is loaded on the location of each of the selected placeholders. The frame
of the placeholder is used as borders for the SmartMark set, using all inks and SmartNames of
the complete document.

Note:  When using text objects as placeholder, there is no frame, so the borders as seen by the
SmartMark Set will be zero.

For SmartNames, the SmartMark set will use the context of the graphic in which the mark is
placed. This means that for example the "File" SmartName will resolve into the name of the
graphic of each station, and not the name of the PDFPLA file.

7.3.23.  GRQ Gallus

The Barcogallus mark allows you to define the positioning of gallus strips left and right with
your specific values. Barcogallus marks can be applied on Sheet and Plate level.

The gallus marks can be put in two directions. On the left you see that the gallus mark starts
with a square box and on the right with a triangle. If you click the white marks, they turn black,
indicating they have now become active.
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If you click the Barcogallus envelope the menu extends and gives you the possibility to change
the values.

The numbered list is explained by the drawing next to it.

Distance objects to Trim Box (Border) allows you to define the distance of all the objects
displayed to the borders.

Tip:

Enter negative values if you want the gallus marks to appear inside the borders.

7.3.24.  GRQ Gradation Strip

The Barcogradationstrip allows you to create a strip for all inks in the job.The size of the boxes
can be specified as well as the gradations for each ink. The different gradations have to be
separated by a comma.The Barcogradationstrip can be customized. Enter your values and
enter a name for it in the Customized name input box.
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Position  Puts the top of the mark against the vertical origin of your repetition, providing
the orientation is set to zero.

 Puts the center of the mark on the vertical origin of your repetition, providing the
orientation is set to zero.

 Puts the bottom of the mark against the vertical origin of your repetition, providing the
orientation is set to zero.

Use the Vertical offset input box to define the vertical offset distance from the borders of the
repetition

 Puts the left side of the mark against the horizontal origin of the repetition, providing the
orientation is set to zero.

 Puts the center of the mark on the horizontal origin of the repetition, providing the
orientation is set to zero.

 Puts the right side of the mark against the horizontal origin of the repetition, providing the
orientation is set to zero.

Use the Horizontal offset input box to define the horizontal offset distance from the borders of
the repetition

OrientationThe Horizontal and Vertical option buttons allow you to position the mark
horizontally or vertically.
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Gradation specifications  To specify the height of your gradation box.

 To specify the width of your gradation box.

Specify the 'Lenght' of the gradation strip.Use 'Gradations' to specify a list of comma separated
percentages and at the same time the amount of gradations boxes per ink.

In the menu the sizes of the gradation boxes are 5x5 and the gradations are 3, 25, 50, 75, 98,
99, 100. If the job has 4 inks this will generate a strip with 4 parts, a part for each ink, and per
part you will have 7 gradation boxes. These 4 parts will be repeated until the length of the
strip specified in the menu is reached.

Enable 'Add Gradation Numbers' to be abe to change the settings for gradation numbers.

Note:

As long as 'Add Gradation Numbers' is not enabled, all options for gradation numbers appear
dimmed.

Gradation NumbersSelect the correct Text Orientation. Text Position: The buttons allow you
to position your text to the left, on top or to the right of the gradation boxes. The distance
input field allows you to specify a distance from the gradation boxes. To specify the gradation
numbers Color.

• Follow ink + %: the number has the same percentage of the ink of the corresponding
gradation box.

• Follow ink: the number has 100% of the ink of the corresponding gradation box.
• Registration Black
• Darkest Ink
• Custom Ink: an ink that is used in the file.

Paint ModeSelect 'Normal' to set the paint mode for the image to normal (overprint).Select
'Erase' to set the paint mode for the image to erase (erase=knocking out white).

Tip:

Use 'erase' in combination with the Text Position button on top.

Character StyleSelect the Font from the drop-down list.Select the weight: 'Roman' or
'Bold'.Select the font style: 'Upright' or 'Italic'. Specify the point size.

7.3.25.  GRQ Grid Marks

Grid marks allow you to define the display of cutting marks, centermarks, bleed, ink squares
and other job information. To activate a specific mark, just click it and the mark will turn black.
Only the marks displayed in black will be added to your repetition. This is not the case for
marks displayed in white. You can insert (black) text in the text field. If you click the envelope
the Extended marks dialog box appears, which allows you to influence the settings for the
marks that are displayed in black.
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Bleed  Click the 90 degree corner mark to display bleed marks on your job. The marks
displayed in black will be added to you repetition. This is not the case for white marks.

Cutting marks  Click the Cutting marks to display the cutting marks on your job. The
marks displayed in black will be added to you repetition. This is not the case for white
marks.Click the Barcomarks envelope to display the Extended Barcomarks dialog box which
allows you to influence the settings for Cutting Marks. You can define the length and thickness
of the cutting marks and specify the distance from the cutting marks to the borders.

Centermarks  Click the Centermarks to display the centermarks on your job. The marks
displayed in black will be added to you repetition. This is not the case for white marks.Click
the Barcomarks envelope to display the Extended Barcomarks dialog box which allows you
to influence the settings for Centermarks Marks. You can define the length of the rules of the
centermarks as well as the the rule thickness. You can also specify the diameter of the circle of
the centermarks.

Click Job Name to add the Job Name to the repetition. The mark turns black. The marks
displayed in black will be added to you repetition.

Click Date to display the Date on your job. The mark turns black. The marks displayed in black
will be added to you repetition.

Use the Information Input box to add any extra information you want to display on your job.

Inks  Click the white ink strip (left) to display a 100% color box of all the inks
used in the job. Only if the strip displays color information it will be added to the repetition
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Grayscale  Click the white grayscale strip (right) to add it to your
job. Only if the strip dislays grayscale information it will be added to the repetitionClick the
Barcomarks envelope to display the Extended Barcomarks dialog box which allows you to
influence the percentages of the grayscale strip.

Specify the height and width of the grayscale boxes. Start allows you to define the black
percentage of the first (top) grayscale box. The default value for the start is 100%. Stop allows
you to define the black percentage of the last (bottom) grayscale box. The default value for the
stop is 10%.Step allows you to define the percentage step between two grayscale boxes.

Distance objects to Trim Box (Border) allows you to define the distance of all the objects
displayed to the borders.

7.3.26.  GRQ Image

The Barcoimage dialog box allows you to specify an image as a mark and to define amongst
others, its position and orientation.

 

 

Name Enter the name of the file that you want to use as a mark.

• Type the file name of the image directly, provided that the file exists in the current directory.
• Right-click the input box to open the file selector, allowing you to select the path and the

name of your image.

An lp, lc, grs, gro, grc and gra file can be used. If you want to use gr* files in this menu, the inks
from the gr* files will be the inks for this marks, no matter what you specify in the inks part of
the menu. If the gr* file has no ink, the inks from the Barcoimage menu will be taken.

If you want a different image name for all inks, create as many images as there are inks: e.g.
test1.lc, test2.lc, test3.lc, ... .Then enter in the Name input box 'test*.lc'. The first ink will get
test1.lc, the second ink gets test2.lc, the third ink gets test3.lc,... Keep in mind that 'test.lc' has
to exist. If not, it is not possible to enter test*.lc in the Name input box.
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Position  Puts the top of the mark against the vertical origin of the repetition.

 Puts the center of the mark on the vertical origin of the repetition.

 Puts the bottom of the mark against the vertical origin of the repetition.

Use the Vertical offset input box to define the vertical offset distance from the borders of the
repetition.

 Puts the left of the mark against the horizontal origin of the repetition.

 Puts the center of the mark against the horizontal origin of the repetition.

 Puts the right of the mark against the horizontal origin of the repetition.

Use the Horizontal offset input box to define the horizontal offset distance from the borders of
the repetition.

Scale  Enter a scale factor in the corresponding input box to scale your image vertically.

Note:

1 is equal to 100% of the image size. 0.5 is equal to 50% of the image size.

 Enter a scale factor in the corresponding input box to scale your image horizontally.

Note:

1 is equal to 100% of the image size. 0.5 is equal to 50% of the image size.

RepeatUse the Repeat options to specify the repeat count and step value for the Barcoimage.
The Esko Plato parameters and formulas of the calculator can be used.

 To specify the vertical count of your image.

 To specify the vertical step distance between the stepped images.

 To specify the horizontal count of your image.

 To specify the horizontal step distance between the stepped images.

GradationGradation allows you to specify the ink percentage for the Barcoimage.

OrientationClick one of the buttons to obtain the desired orientation for your image.

InksThe 'Ink input box' option button allows you to select one ink by its name or ink number.
The drop-down list displays all inks available in the QuickStep file. When you select ink number
1, the first ink of the ink menu of QuickStep is chosen.The 'All on Top' option button allows you
to specify the selected image 'All on Top' in all inks.The 'All with Step' option button will force
QuickStep to first execute the menu settings and then step the complete ink block.
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 To specify the vertical step distance between the stepped colors.

 To specify the horizontal step distance between the stepped colors.

Paint ModeSelect 'Normal' to set the paint mode for the image to normal (overprint).Select
'Erase' to set the paint mode for the image to erase (erase=knocking out white).

Use the Customized Name Input box to give a customized name to the Barcoimage mark.
Enter the customized name, click 'Apply' and the new mark name appears in the list of marks.

7.3.27.  GRQ Marks

GRQ marks allow you to define the display of cutting marks, centermarks, bleed, ink squares
and other job information. To activate a specific mark, just click it and the mark will turn black.
Only the marks displayed in black will be added to your repetition. This is not the case for
marks displayed in white. You can insert (black) text in the text field. If you click the envelope
the Extended marks dialog box appears, which allows you to influence the settings for the
marks that are displayed in black.

 

 

Bleed  Click the 90 degree corner mark to display bleed marks on your job. The marks
displayed in black will be added to you repetition. This is not the case for white marks.

Cutting marks  Click the Cutting marks to display the cutting marks on your job. The
marks displayed in black will be added to you repetition. This is not the case for white
marks.Click the Barcomarks envelope to display the Extended Barcomarks dialog box which
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allows you to influence the settings for Cutting Marks. You can define the length and thickness
of the cutting marks and specify the distance from the cutting marks to the borders.

Centermarks  Click the Centermarks to display the centermarks on your job. The marks
displayed in black will be added to you repetition. This is not the case for white marks.Click
the Barcomarks envelope to display the Extended Barcomarks dialog box which allows you
to influence the settings for Centermarks Marks. You can define the length of the rules of the
centermarks as well as the the rule thickness. You can also specify the diameter of the circle of
the centermarks.

Click Job Name to add the Job Name to the repetition. The mark turns black. The marks
displayed in black will be added to you repetition.

Click Date to display the Date on your job. The mark turns black. The marks displayed in black
will be added to you repetition.

Use the Information Input box to add any extra information you want to display on your job.

Inks  Click the white ink strip (left) to display a 100% color box of all the inks
used in the job. Only if the strip displays color information it will be added to the repetition

Grayscale  Click the white grayscale strip (right) to add it to your
job. Only if the strip dislays grayscale information it will be added to the repetitionClick the
Barcomarks envelope to display the Extended Barcomarks dialog box which allows you to
influence the percentages of the grayscale strip.

Specify the height and width of the grayscale boxes. Start allows you to define the black
percentage of the first (top) grayscale box. The default value for the start is 100%. Stop allows
you to define the black percentage of the last (bottom) grayscale box. The default value for the
stop is 10%.Step allows you to define the percentage step between two grayscale boxes.

Distance objects to Trim Box (Border) allows you to define the distance of all the objects
displayed to the borders.

Enable Marks inside plate to put the marks inside the plate.

7.3.28.  GRQ Rectangle

The Barcorectangle dialog box is similar to the barcoimages dialog box. You can specify the size
of the rectangle or ellipse. The Esko Plato parameters and formulas of the calculator can be
used in all relevant input boxes.
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Position  Puts the top of the mark against the vertical origin of the repetition.

 Puts the center of the mark on the vertical origin of the repetition.

 Puts the bottom of the mark against the vertical origin of the repetition.

Use the Vertical offset input box to define the vertical offset distance from the borders of the
repetition.

 Puts the left of the mark against the horizontal origin of the repetition.

 Puts the center of the mark against the horizontal origin of the repetition.

 Puts the right of the mark against the horizontal origin of the repetition.

Use the Horizontal offset input box to define the horizontal offset distance from the borders of
the repetition.

Size  Enter the vertical and horizontal size of the rectangle.

 Press the ellipse button if you want to use an ellipse instead of a rectangle.

Repeat Use the Repeat options to specify the repeat count and step value for the Barcoimage.
The Esko Plato parameters and formulas of the calculator can be used.

 To specify the vertical count of your image.

 To specify the vertical step distance between the stepped images.

 To specify the horizontal count of your image.

 To specify the horizontal step distance between the stepped images.

GradationGradation allows you to specify the ink percentage for the Barcoimage.
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Background InkSelect an ink by its name or its number in order to define a background color
for each rectangle that you create.

InksThe 'Ink input box' option button allows you to select one ink by its name or ink number.
The drop-down list displays all inks available in the QuickStep file. When you select ink number
1, the first ink of the ink menu of QuickStep is chosen.The 'All on Top' option button allows you
to specify the selected image 'All on Top' in all inks.The 'All with Step' option button will force
QuickStep to first execute the menu settings and then step the complete ink block.

 To specify the vertical step distance between the stepped colors.

 To specify the horizontal step distance between the stepped colors.

Paint ModeSelect 'Normal' to set the paint mode for the image to normal (overprint).Select
'Erase' to set the paint mode for the image to erase (erase=knocking out white).

Use the Customized Name Input box to give a customized name to the Barcorectangle mark.
Enter the customized name, click 'Apply' and the new mark name appears in the list of marks.

Example: Enter the new name for the Barcorectangle, e.g. Ellipse. When the dialog box closes,
the original name in the list of marks has changed to: Ellipse [barcorectangle].

7.3.29.  GRQ Strip

The Barcostrip dialog box allows you to position a predefined control strip.

 

 

Position  Puts the top of the mark against the vertical origin of the repetition.

 Puts the center of the mark on the vertical origin of the repetition.

 Puts the bottom of the mark against the vertical origin of the repetition.

Use the Vertical offset input box to define the vertical offset distance from the borders of the
repetition.

 Puts the left of the mark against the horizontal origin of the repetition.

 Puts the center of the mark against the horizontal origin of the repetition.
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 Puts the right of the mark against the horizontal origin of the repetition.

Use the Horizontal offset input box to define the horizontal offset distance from the borders of
the repetition.

OrientationThe Horizontal and Vertical option buttons allow you to position the mark
horizontally or vertically.

Length allows you to specify the lenght of your gradation strip.

Expppi allows you to specify the Expose resolution.

Use the Customized Name Input box to give a customized name to the Barcostrip mark.
Enter the customized name, click 'Apply' and the new mark name appears in the list of marks.

Example: Enter the new name for the Barcostrip name, e.g. Mycontrolstrip. When the dialog
box closes, the original name in the list of marks has changed to: Mycontrolstrip [barcostrip].

7.3.30.  GRQ Text

The Barcotext dialog box allows you to create additional text on a specified position and a
certain orientation. The additional text fields will be put next to each other on the specified
position. Text fields can contain any additional information that you type in and will be created
in the ink selected.

 

 

Position  Puts the top of the mark against the vertical origin of the repetition.

 Puts the center of the mark on the vertical origin of the repetition.

 Puts the bottom of the mark against the vertical origin of the repetition.

Use the Vertical offset input box to define the vertical offset distance from the borders of the
repetition.
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 Puts the left of the mark against the horizontal origin of the repetition.

 Puts the center of the mark against the horizontal origin of the repetition.

 Puts the right of the mark against the horizontal origin of the repetition.

Use the Horizontal offset input box to define the horizontal offset distance from the borders of
the repetition.

ContentsThe Contents input boxes allow you to use predefined settings or simply enter any
text that you want to see displayed as additional information. This information will be created
in the selected ink. Predefined names can be selected from the drop-down list.The following
predefined names are available:

• #jobname# will display the name of the GRQ file in all inks.
• #jobinfo# will display the Document Info of the file (as in File menu > Document Info).
• #inks# will display all inks that are present in the job. The order of the inks in the mark is

based on the order of the ink palette.

Caution:

Note that technical inks will not be included in this list.

Tip:

#inks# can be used to put your additional text information in erase mode on a 100% bearer
bar that you previously created. As a result, only the ink name of the corresponding film will
be in erase mode in the bearer bar.

• #inks_lin_ang# will display information about screen ruling and angle.

• #ink_1#... will display individual inks.
• #date# will display the date in all inks.
• #time# will display the time in all inks
• #format# will display the plate size in all inks.

Inkname for additional info Select the ink by name or number in which your additional text
should be created.This ink setting is applied on all 5 contents fields. The drop-down list displays
all inks present in the QuickStep file and an extra ink, Registration Black. Registration Black
puts your additional text in all the inks of your QuickStep file.

Example: When you choose another ink like Cyan, the additional text will only be visible on
your Cyan film.

Orientation/mirrorClick one of the buttons to obtain the desired orientation or mirroring for
the image.

Character StyleSelect the Font from the drop-down list.Select the weight: 'Roman' or
'Bold'.Select the font style: 'Upright' or 'Italic'. Specify the point size.

Paint ModeSelect 'Normal' to set the paint mode for the image to normal (overprint).Select
'Erase' to set the paint mode for the image to erase (erase=knocking out white).
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Tip:

If you want all the inks in the bearer bar, provided the bearer bar is 100% and in all inks, you
can give in : ?#inks#. As paint mode you choose 'Erase'. As a result you will only see C on the
cyan film, Y on the yellow film, etc. Be sure that your text is positioned on the bearer bar, which
has to have a 100% gradation.

Use the Customized Name Input box to give a customized name to the Barcotext mark. Enter
the customized name, click 'Apply' and the new mark name appears in the list of marks.

Example: Enter the new name for the Barcotext Mark name, e.g. Mytext. When the dialog box
closes, the original name in the list of marks has changed to: Mytext [barcotext].

7.3.31.  GRQ Cellnumbering

You can use the GRQ Cellnumbering mark to add a number to each stepped element.

 

 

Position  Puts the top of the mark against the vertical origin of the repetition.

 Puts the center of the mark on the vertical origin of the repetition.

 Puts the bottom of the mark against the vertical origin of the repetition.

Use the Vertical offset input box to define the vertical offset distance from the borders of the
repetition.
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 Puts the left of the mark against the horizontal origin of the repetition.

 Puts the center of the mark against the horizontal origin of the repetition.

 Puts the right of the mark against the horizontal origin of the repetition.

Use the Horizontal offset input box to define the horizontal offset distance from the borders of
the repetition.

GridsEnable All to select all grids of the QuickStep fileUse the Input box to select 1 or more
grids to which you want to add the cell numbers. The different grids have to be separated by a
comma.

NumberImage To use images for your numbering instead of digits. When Image is activated
Name becomes available. Type the name of your image or use your right mouse button to
select the image from the file selector. If you select Num.lc the system will look for Num1.lc,
Num2.lc, Num3.lc,... . Each image used for numbering will have a different name.

Prefix If you want to add something more before the number then enter the text here.
Example: When you enter A then the numbering is: A1, A2, A3, ...

Suffix If you want to add something more behind the number then enter the text
here.Example: When you enter z then the numbering is: 1z, Az, Az, ...

Use Start to define the starting number.Example: When you enter3 then the numbering starts
with 3 and then 3, 4, 5 ,...

Step When Continuous is activated and you defined a number in the input box next to it, the
vertical and horizontal numbering will increase with that value.

Note:

e When Continuous is not activated, a different Vertical and Horizontal step can be defined.

Example: Put Start on 0, activate Continuous and put its value to 5. Your first stepped element
gets the number 0, the second element gets 5, the third element gets 10, ... .

Use Vertical to define the Vertical Step numbering when it has to be different to the horizontal
step.Use Horizontal to define the Horizontal step numbering when it has to be different to the
vertical step.

Use the Customized Name Input box to give a customized name to the Barcotext mark. Enter
the customized name, click 'Apply' and the new mark name appears in the list of marks.

Enter the a name for the Barcocellnumbering, e.g. Mynumbering. When the dialog box closes,
the original name in the list of marks has changed to: Mybumbering [Barcocellnumbering].

OrientationClick one of the buttons to obtain the desired orientation for the image.

OrderTo define the direction for the cellnumbering. There are 8 available predefined directions
buttons. Click the corresponding button to select the requested direction. If the available
directions do not correspond to what you want, click the question mark button  The
Barcocellnumbering dialog box expands and allows you to define the complete cellnumbering
for the selected grid(s) yourself.
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On the left side of the grid you can see a number. This is the grid indication. The grey boxes
represent the vertical and horizontal count of the grid. By clicking the squares, you can assign
numbers and so determine the order. The numbers that appear are a result of the values set
for Start and Continuous. Click the minus button to remove the number that was assigned last.
Click Reset to clear all numbers.

Character StyleSelect the Font from the drop-down list.Select the weight: 'Roman' or
'Bold'.Select the font style: 'Upright' or 'Italic'. Specify the point size.

InksThe 'Ink input box' option button allows you to select one ink by its name or ink number.
The drop-down list displays all inks available in the QuickStep file. When you select ink number
1, the first ink of the ink menu of QuickStep is chosen.The 'All on Top' option button allows you
to specify the selected image 'All on Top' in all inks.

Paint ModeSelect 'Normal' to set the paint mode for the image to normal (overprint).Select
'Erase' to set the paint mode for the image to erase (erase=knocking out white).
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8.  Printing and Exporting
Print your plates and stations or export them to other file formats.

You can use the printing and exporting features to create proofs, films or printing plates for
your production process. The station and plate files that you create in Plato can be printed to
a variety of PostScript output devices. Station and plate files can be exported to e.g. PostScript,
EPS and GRS file formats for proofing or printing at a remote site.

• Printing Esko Plato Files

• Exporting Esko Plato Files

8.1.  Printing Esko Plato Files

You can print to a PostScript output device directly from Esko Plato. Both composite and
separated PostScript can be used. Typically, a composite PostScript file is used for proofing.
A separated PostScript file is used typically for exposing films or plates on a PostScript
imagesetter or platesetter.

• Using PostScript

• Printing to a PostScript device

8.1.1.  Using PostScript

Before discussing the printing and exporting options of Esko Plato, you should know some
things about Esko file formats and their conversion to PostScript file formats. Esko file formats
may contain advanced features that are not directly supported in the PostScript model.
Examples of these features include the Esko Overprint modes and Translucency.

For example, an Esko file may have objects that overprint one another in one separation.
Printing or exporting such a file to a PostScript or EPS format could result in the loss of the
overprint due to the known PostScript limitations.

Esko Plato uses the Esko OutRight Technology to overcome this limitation. This technology
pre-rips these objects into images that can be rendered accurately in PostScript. OutRight
guarantees that what you see in Esko Plato is what you get when you print.

8.1.2.  Printing to a PostScript device

To print to a PostScript output device:

1. On the File menu, click 'Print'. The Print dialog box appears:
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2. Select the printer and the options you need.

Note:

Click 'Setup' to open the Setup dialog box. For more on these options, please refer to the
chapter 'Exporting to a PostScript File'.

3. Click 'Print'.

8.2.  Exporting Esko Plato Files

You can export Esko Plato files to other file formats for remote viewing, proofing and printing.
Click 'Export' on the File menu to choose an output format and to specify options.

When you export PostScript and EPS file formats, the options contain many of the same
options used for printing. The differences between exporting and printing will be indicated
in the sections below. If a format uses the same options as for printing PostScript, you will be
referred to the appropriate section for Printing.

• Exporting to a PostScript File

• Exporting to an EPS File

• Exporting to a PDF File

• Export to an MFG file

• Exporting to a CFF2 File

• Exporting to a Normalized PDF File

• Exporting to a PLA File

• Exporting to a PDFPLA File

• Exporting to a GRS File

• Exporting to a JDF Layout File

• Exporting to a CIP3 File

• Exporting to a Polar File

• Exporting to a JDF Cutting file
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• Digital Converting Export on page 277

8.2.1.  Exporting to a PostScript File

You can export your station and plate files to a PostScript file. You can indicate whether the
PostScript file is either a Composite or Pre-Separated file.

 

 

The PostScript Export ticket has the following tabs:

• Output

• Device

• Inks / Separations

• Color Management

• Rasterize

• Compression

• Advanced

Output
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Device typeTo select the output device you want your design to be exported to or printed to,
the corresponding PPD is chosen and will be used.

Output typeTo export or print your design as CMYK Composite, Separated or Composite.

• CMYK Composite: Activate this option to generate a composite PostScript file for proofing.

Note:

Remark that a CMYK composite PostScript file will proof correctly but separations will not be
correct since all spot colors are converted to CMYK.

• Pre-separated: Activate this option to generate separations. Multiple pages will be
generated, corresponding to the inks in the job.

• Composite: this output type can only be selected for PostScript 3 devices since they
support deviceN color space to produce high-fidelity colors. These colors are combinations
of the standard CMYK process colorants and/or spot colorants, guaranteeing perfectly
separatable PostScript code which can also be proofed on a composite PostScript 3 device.
The generated PostScript file will proof correctly and separate correctly. Color management
for spot color objects must be handled by the device.

Emulsion UpTo obtain Right Reading (= emulsion up) or Wrong Reading (=emulsion down).

ImageTo specify Positive or Negative print mode.

Note:

Image and Emulsion up becomes unavailable (appears dimmed) when CMYK Composite
Output was chosen.

Enter the Vertical and/or Horizontal distortion in percentages

Select SmartMarks from the drop-down list.
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Account for Media Box (margins)To select the margins of the job as the true boundary. If you
deselect this toggle, the borders of the job are taken as the true boundary. When you want to
output everything that is placed within the margins too, leave the option activated.

Hide trap layer(s) in outputTrap layers will not be included in the output.

Page range

• Output all pages.
• Output a number of pages. Enter page numbers or page ranges separated by commas, e.g.

1,3,5-8.

Scale & Tile

• Enter a Scale factor (percentage).
• Fit job on page scales the job so it fits the selected paper size.
• Shrink oversized jobs to paper size.
• Select 'Tile Job' to obtain a tiled output if the job is too big to fit on the selected paper size.

The tiling option which can be used to export a large job to a series of smaller pages (tiles)
allows the user to cycle through the tiles which will be produced and see just how many tiles
there are. Overlap X mm/inches: To specify a tiling overlap. The value you enter here, is the
amount of overlap in all four directions between adjacent tiles. It defaults to 5 mm.

Page Setup

• Select a paper size from the drop-down list. The list that appears here is based on the page
sizes supported by the selected ppd.

• Orientation: Auto, None, 90° cw, 90°ccw, 180°. The orientation options are disabled when
'Tile job' is selected.

• Alignment: Bottom left, Top left, Top right, Bottom right, Centered. The alignment options are
disabled when 'Tile job' is selected.

• Enter the number of copies.

Device
 

 

The Resolution depends on your output device and on the purpose of the PostScript file. For
proofing for example, a lower resolution might be sufficient.
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Select the Dotshape.

HalftoningIf you select CMYK Composite or Composite as Output type, you can choose to
include screen information when outputting (lpi and angle).

• Use Printer Defaults: the output device's default screen info will be used.
• Take over from job
• Some devices offer other dotshapes if they are available in the PPD.

Dot Gain CompensationYou can select Dot Gain Compensation (DGC) curves made with
IntelliCurve or IntelliCurvePro.

Note:

A screen-based DGC file was the format written by the two DGC Editors (DGC Editor and
Screen-based DGC Editor). These two editors have been replaced by IntelliCurve, which writes
DGC Strategies. However, a screen-based DGC file can still be applied.

• Single curve: Allows you to select one DGC curve (.dgc file) that will be applied to all your
data.

• Automatic: Allows you to select a screen-based DGC table (.scrdgc file) or a DGC Strategy
(.icpro file). The former allows you to apply dot gain compensation selectively depending on
the dot shape, screen ruling, angles and even Contone or Linework properties. The latter
does the same but also offers ink based dot gain compensation.

Note:

You can also apply both single curve and automatic DGC simultaneously, resulting in a
cumulation of both effects.

Roll Fed DevicesAccount for Media Width allows the conversion program to find the best
printing orientation. For roll-fed devices, mostly imagesetters, a Media Width (film width) can
be specified. The conversion program finds the best printing orientation in order not to waste
paper or file if Rotation is set to Auto. The Media Width value is expressed in mm.The option
'Extra Gap' allows you to specify extra width for the film or paper feed. The Extra Gap value is
expressed in mm. By default, no Extra Gap is set.

For Device specific options please refer to the manual of your output device.

Inks / Separations
The Inks / Separations tab depends on the output type you selected in the Output tab. If you
choose CMYK Composite or Composite, the Inks tab will be visible, if you choose separated, the
Separations tab will be visible.

Inks Tab

Use technical inks in outputNormally technical inks are hidden when you save a job in an
Esko editor. But, there's a possibility to save the Technical inks as visible. This toggle here
makes it possible to output the visible (non hidden) technical inks.

The Inks are listed. You can deselect the ones you want to exclude from export by clicking the

print icon 
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Separations Tab

Use technical inks in outputNormally technical inks are hidden when you save a job in an
Esko editor. But, there's a possibility to save the Technical inks as visible. This toggle here
makes it possible to output the visible (non hidden) technical inks.

The inks and separations are listed. You can deselect one or more inks, the according
separation will disappear from the Plates list.
 

 

Use the 'Convert to CMYK' button  to convert PANTONE inks to CMYK values.

Color Management
 

 

Convert to
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• CMYK: all inks are converted to CMYK values
• Gray: all inks are converted to Gray values.

Use link profile: Link profiles describe a transformation from 1 device dependent color space
to another. This is actually a concatenation of a forward transformation of 1 profile and a
backward transformation of another profile. This means that all other options will be grayed
out as the Link Profile takes complete care of the color management.

Source profile: If any CMYK objects are to be converted, choose a source profile. The list
shows all CMYK print profiles in the color database. The source profile defines the target that
the destination profile is supposed to match.

Destination profile: Choose a color profile for your destination color space. The list shows
all print profiles in the color database. These profiles are either measured in Kaleidoscope or
imported ICC-profiles.

Rendering intent

• Relative (No Background): Use this option if you do not want any background simulation.
The white point of the source will be mapped on the white point of the destination process.
This rendering intent takes into account the ability of the human eye to adapt to the
surrounding white.

• Absolute (Background): Use this option if you want background simulation and you want an
exact color match, including the paper simulation.

Map black on blackWhen toggled on, the CMY-part of the composite colors are converted
separately from the black component. As a result, the type of black separation (Skeleton, UCR,
GCR,...) is preserved by the conversion. (It is still possible that the black percentage changes
slightly due to different dot gain in the color profiles.) When toggled off, the converted CMYK
colors are completely re-separated into the black behavior that is built into the destination
profile.

Use the document profile as source profile if availableIf there is a document profile
defined, that will be used as a source profile. The one chosen from the Source Profile drop-
down list will be overruled.

Embed the Destination profile as an intermediate color space

If this toggle is off, the colors in the PDF file will not be tagged with an ICC color profile. The
document is device dependent and its colors will only be reproduced accurately if the PDF file
is output on the device that is specified in the Destination Profile. This choice is preferable if we
are sure the PDF file will be sent to the device specified in the Destination Profile.

If this toggle is on, the color in the PDF file will be tagged with an ICC color profile. The
document then becomes device independent, and its colors will be reproduced accurately even
on devices with a color space different from the one specified in the Destination Profile. In this
case, the Destination Profile is an intermediate color space between the Source Profile and the
color profile of the device that will eventually process the PDF file.This method is preferable
when the PDF file will be sent to an unknown device.

Embed the document profile as PDF Output intentThe output intent is an ICC profile that
specifies the intended output device.If this option is toggled on, the document profile will be
saved as the PDF output intent. For certain PDF flavors (PDF-X/3) an output intent is mandatory
and this option is always on. If no document profile was set explicitly, the default document
profile (crom_offs) is used instead. If the document profile is a Kaleidoscope profile, it will first
be converted to an ICC profile.
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Rasterize
 

 

Output as imageWhen this toggle is activated an image is made of the job. Enter the
resolution.

Anti-aliasing is relevant for the line-art objects in your design, that need pre-processing and
for which images are generated. Anti-aliasing smoothens the staircase effect you get in the
generated images of lineart objects that need pre-processing.

Tip:

This option increases the readability of small text that is pre-processed to image.

Convert vignettes to imageTo avoid banding in the vignettes when exporting. Exporting
vignettes to a PostScript Format, may result in blends and banding due to restrictions in
PostScript. However, to obtain a nice result in your export file, activate Convert Vignettes to CT.
All the vignettes present in your design will be converted to images.

Vignette noiseWhen exporting to PostScript, some vignettes or parts of vignettes will be
converted to images. This happens when the vignettes overlap other objects with translucency
or overprint between the vignette and the other objects. When the option 'Convert Vignettes
to Image' is activated all vignettes are converted to images regardless of overlap with other
objects. Vignettes that are converted to images may have tone jumps in the final result. To
reduce this banding effect, noise is applied on the image. The amount of noise can be specified
in the field Vignette Noise.

Compression
 

 

Encoding
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• Binary: The image data is represented as binary data. This results in compact files that
are not editable in a common ASCII editor however. Nor can these files be sent over a
communication line using a communication protocol that relies on control characters in the
data stream itself.

• Hex: In this way, the PostScript file remains editable with an ASCII editor at all times. They
can also be sent over a communication line using whatever communication protocol is
available. The drawback, however, is that hexadecimal image data may take up to twice as
much size as binary data.

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly
all of the printable ASCII character set. The resulting expansion factor is 4:5, making this
encoding more efficient then hexadecimal.

Compression: None, LZW or Flate (PostScript3 devices).

DownsamplingThe images referenced in your design are subsampled approximately to the
specified value. Activating this option, allows you not only to reduce the size of the generated
PostScript file, but also to speed up generation of the PostScript file. Select the unit for
subsampling from the drop-down list: lpmm or ppi. You can subsample both bitmaps and
contones.

Advanced
 

 

Fonts

• Contourize fonts.

Note:

Protected CID fonts will be referenced by name.

• Embed BG and Type1 fonts: Allows you to include the used BG and Type 1 fonts of your
design in your PostScript file.

Split Complex Paths

Caution:

These are workarounds for typical PostScript level 1 path limitations. Only use these
when really necessary.
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• Use Filled and stroked paths at X points to split linework with more than x points into several
smaller linework parts. This option decreases the complexity of the linework. A suitable
value for the selected device type is calculated for this option.

• Use Clip paths at X points to split linework masks for images with more than x points into
several smaller linework parts. This option decreases the complexity of the masks.

Workaround

• Ignore varnish inksVarnish inks will not be included while outputting to PostScript.

• Resolve once identical one-ups in Step & repeat fileInstead of resolving the complete Step &
Repeat file, identical one-ups will be resolved only once.

• Resolve once identical external filesInstead of resolving the complete file and all its external
references, identical external files will be resolved only once.

• Resolve pure black overprintOverprints are normally resolved, but default, pure black is
left alone, if you want Rich Black to be resolved too, select this toggle. This toggle is only
available when the Color Management options in the Color Management tab are activated.

• Limit filename size to 31 charactersCheck this toggle if you want to make sure your imported
files can be seen/read from/by all Apple operating systems.

• Split separated output into multiple filesInstead of writing one file containing all separations,
the system will write one file per separation.

• Split multi page jobs into multiple filesEvery page will be output as a separate file.

• Suppress Hairlines At ClipsDue to the PostScript limitation of maximum points allowed for
a path, complex paths will be cut into smaller pieces. When the PostScript file is printed/
exposed on some older PostScript Rips, hairlines may become visible. To avoid this
problem, activate Suppress Hairlines at Clips.

• Image To Paper EdgeTo move the origin of the converted job to the lower left corner of the
paper or film. Activate this toggle to align your job to the edge of the paper or film to use
the full area.

Caution:

Exporting to a paper PostScript device: For most of these devices, there is always a
border on the output page where nothing can be imaged. Parts of your design in
that border will be lost.

• Avoid Tabular Number ProblemsWhen digits are written as tabular numbers, exporting to
some PostScript Rips may result in bad positioning of the numbers. The tabular numbers
are not correctly placed at the text base line. To avoid this problem, activate Avoid Tabular
Number Problems.

• Disable path clippingBy default, paths are clipped by the borders of the job, but there are
instances where you do not want the paths to be clipped, if so, select this toggle.

• Map spot color separations to CMYKThis option is intended to export a job containing spot
colors to pre-separated PostScript for systems which are limited to handling process color
separations only (e.g. Scitex Brisque Workflow). This option is available when Pre-Separated
was selected. Spot color separations can be handled only on such systems by remapping
them to a specific process separation. When this toggle is checked, spot colors will be
exported as a C, Y, M or K separation. The mapping is done based on the lpi and angle of
the spot color.
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If the process Cyan ink has a given lpi of 120 and angle of 15, a spot color Reflex blue may
be mapped to Cyan, if in the Paint menu it is given the same lpi and angle of process Cyan.

• Suffix for PANTONE ink namesEnter a suffix, the default is C.

• Maximum deviation of resolved curvesDuring the resolving process Bezier curves are
sometimes approximated by vectors. The maximum allowed deviation of the curves can be
entered here.

Note:

When a Esko native file is exported to PostScript, certain elements in the job which cannot
be translated into PostScript will be resolved in order to get an exact result. The same
happens when exporting to PDF. PDF files however have several destinations and don't
always need the high quality resolving because they may only serve as soft proof. If you
want to obtain even smaller files than what you can get with the "PDF for RGB/CMYK
proofing" settings, then this workaround option might help. When we resolve objects
splines are converted to vectors (e.g. line mask). The spline only has a 2 points but you need
a lot of vector points to describe a curve. The resolver default deviation is 0.002 mm but you
can reduce the amount of vector points by raising the deviation value and thus reducing
the size of the PDF. Which values? When comparing the default (0.002 = 1360 kb PDF) with
0.02 (326 kb PDF) you will end up with an acceptable result but it is clear that high values
will alter the PDF too much. Keep in mind that this option will only modify resolved vector
curves, it will not "straighten" any other objects while exporting.

8.2.2.  Exporting to an EPS File

You can export your station and plate files to an EPS file.

 

 

The EPS Export Setup dialog box has five tabs.

• Output

• Color Management
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• Rasterize
• Compression
• Advanced

Output
 

 

PostScript versionChoose between PostScript 3 or PostScript level 2.

Output typeChoose between an EPS, a Single DCS and a Multiple DCS file.EPS: This will create
an EPS file with an RGB preview. When the selected PostScript version is PostScript 3 and the
color management toggle in the Processing Tab is switched off, this will be and deviceN EPS,
in all other cases a CMYK composite EPS will be created.Single DCS file This will create one EPS
DCS file containing multiple separations. The DCS file always contains an RGB preview used
when placing the EPS DCS file. In addition a composite grayscale or color CMYK preview may
be added for composite printing.Multiple DCS file This will create a master EPS DCS file referring
to multiple separations (one file per ink). These separations may contain linework as well as
images. The names of these files consist of the output filename followed by the name of the
ink. The master DCS file always contains an RGB preview used when placing the EPS DCS file. In
addition a composite grayscale or color CMYK preview may be added for composite printing.

• EPS
• Single DCS file, no composite
• Single DCS file, grayscale composite
• Single DCS file, color composite
• Multiple DCS file, no composite
• Multiple DCS file, grayscale composite
• Multiple DCS file, color composite

Preview ResolutionThe default resolution is set on 72 ppi. This option can change the
resolution of the RGB preview used when placing the EPS DCS file. A higher value will produce
a finer, more detailed preview but will also increase the files size of the EPS DCS. The minimum
value is 72 ppi.

ResolutionThe default resolution is set on 16.000 ppi. If you do not know where the EPS will be
placed, you might want to make the resolution a high one.

Page Number: To select the page of the job you want to export.
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Scale, you can scale using percentages.

Add SmartMarks sets by selecting one from the drop-down list.

Account for job marginsSelects the margins of the job as the true boundary. Normally the
borders of the job are taken as the true boundary of the job. Sometimes however you may also
want to convert everything that is situated within the margins too.

Hide Trap Layer in output: Allows you to export your file with or without the trap layer.

Color Management
The Color Management tab is identical to the Color Management tab of the PostScript Export
dialog box.

 

 

Rasterize
The Rasterize tab is identical to the Rasterize tab of the PostScript Export dialog box.

 

 

Compression
The Compression tab is identical to the Compression tab of the PostScript Export dialog box.
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Advanced
The Advanced tab based on the Advanced tab of the PostScript Export dialog box.

 

 

8.2.3.  Exporting to a PDF File

Exporting to PDF 1.4 will use PDF forms to represent the different one-ups. This should result
in compact PDF representations of PLA files.
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The PDF Export dialog box has the following tabs.

• Output

• Device

• Inks

• Color Management

• Rasterize

• Compression

• Advanced

Output
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PDF VersionSelect a PDF version from the drop-down list.

• PDF for Illustrator 10 or higher: Select this version if you want to open the generated
PDF 1.4 file in Adobe Illustrator 10 or higher. Because Adobe Illustrator only supports a
(undocumented) subset of PDF 1.4 features some objects and/or color spaces must be split
up, transformed and/or preripped in order to correctly represent them in Illustrator.

• PDF/X-1 a:2001 (ISO /DIS 15930-1)
• PDF/X-1:2001 (ISO /DIS 15930-1)
• PDF 1.4: the Acrobat 5 file format.
• PDF 1.3: the Acrobat 4 file format.

Output typeTo export or print your design as CMYK Composite, Separated or Composite.

• Separated: Activate this option to generate separations. Multiple pages will be generated,
corresponding to the inks in the job.

• Composite: this output type can only be selected for PostScript 3 devices since they
support deviceN color space to produce high-fidelity colors. These colors are combinations
of the standard CMYK process colorants and/or spot colorants, guaranteeing perfectly
separatable PostScript code which can also be proofed on a composite PostScript 3 device.
The generated PostScript file will proof correctly and separate correctly. Color management
for spot color objects must be handled by the device.

Emulsion UpTo obtain Right Reading (= emulsion up) or Wrong Reading (=emulsion down).

ImageTo specify Positive or Negative print mode.

Note:

Image and Emulsion up becomes unavailable (appears dimmed) when CMYK Composite
Output was chosen.

Enter the Vertical and/or Horizontal distortion in percentages
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Select SmartMarks from the drop-down list.

Account for Media Box (margins)To select the margins of the job as the true boundary. If you
deselect this toggle, the borders of the job are taken as the true boundary. When you want to
output everything that is placed within the margins too, leave the option activated.

Hide trap layer(s) in outputTrap layers will not be included in the output.

Page range

• Output all pages.
• Output a number of pages. Enter page numbers or page ranges separated by commas, e.g.

1,3,5-8.

ScaleDefine the scale in percentages. You might want to scale your job to make it easier to
softproof via e mail.

Select SmartMarks from the drop-down list.

Put marks with ink coverage on a hardcopy proof (or view it in Acrobat).

Account for job marginsTo select the margins of the job as the true boundary. Normally the
borders of the job are taken as the true boundary of the job. Sometimes however you may also
want to convert everything that is situated within the margins too.

Output range

• Output All pages.
• Output a number of pages. Enter pagenumbers or page ranges separated by commas. e.g.

1,3,5-8

Device
 

 

Dot Gain CompensationYou can select Dot Gain Compensation (DGC) curves made with
IntelliCurve or IntelliCurvePro.

• Single curve: Allows you to select one DGC curve (.dgc file) that will be applied to all your
data.

• Automatic: Allows you to select a Screen-Based DGC table (.scrdgc file) or a DGC Strategy
(.icpro file). The former allows you to apply dot gain compensation selectively depending on
the dot shape, screen ruling, angles and even Contone or Linework properties. The latter
does the same but also offers ink based dot gain compensation.
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Note:

You can also apply both single curve and automatic DGC simultaneously, resulting in a
cumulation of both effects.

Inks

The inks are listed, you can (de)select them by clicking the print icon 

Check the box to use technical inks in the output job.

Note:

The inks tab becomes available when esporting to a separated file. The separation tabsheet
becomes available when exporting to CMKY and Composite. The Separation tab offers the
possibility to put multiple inks on the same separation/plate.

 

 

Color Management
The Color Management tab is identical to the Color Management tab of the PostScript Export
dialog box.
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Rasterize
The Rasterize tab is identical to the Rasterize tab of the PostScript Export dialog box.

 

 

Compression
 

 

Encoding:
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• Binary: The image data is represented as binary data. This results in compact files that
are not editable in a common ASCII editor however. Nor can these files be sent over a
communication line using a communication protocol that relies on control characters in the
data stream itself.

• Hex: They can be sent over a communication line using whatever communication protocol is
available. The drawback however is that hexadecimal image data takes up to twice as much
size as binary data.

• Ascii 85: Encodes binary data in an ASCII base-85 representation. This encoding uses nearly
all of the printable ASCII character set. The resulting expansion factor is 4:5, making this
encoding more efficient than hexadecimal.

Compression

Bitmaps

• None
• CCITT group 3 and CCITT group 4
• Run Length
• LZW
• LZW Diff
• Flate
• Flate Diff

Contones

• None
• LZW
• LZW Diff
• JPEG Compressions (from Limited over Standard to Low compression)
• Flate
• Flate Diff

Text and Lineart

• None
• LZW
• Flate

Downsampling The images referenced in your design are subsampled approximately to the
specified value. Activating this option, allows you to reduce the size of the generated PDF file.
Select the unit for subsampling from the drop-down list: lpmm or ppi. You can subsample both
bitmaps and contones.

Check Crop images on clip mask to crop the image(s) on the clip mask. All information located
outside the clip mask will be lost.

Advanced
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Fonts

• Contourize fonts: protected CID fonts are embedded.
• Embed BG and Type1 fonts: Allows you to include the used BG and Type 1 fonts of your

design in your PDF file. A subset of the font will be embedded, not the whole font.

Note:

In case the BG font does not have a corresponding PostScript Name, it will be included in
the PostScript file automatically.

Caution:

When you switch off these functions, take into account that the font downloaded on
the PostScript device may be different from the font used in your job. Consequently,
the output result can be different to your design.

Split Complex Paths

Caution:

These are workarounds for typical PostScript level 1 path limitations. Only use these
when really necessary.

• Filled and stroked paths at X points. Use this option to split linework with more than x
points into several smaller linework parts. This option decreases the complexity of the
linework. A suitable value for the selected device type is calculated for this option.

• Clip paths at X points. Use this option to split linework masks for images with more than
x points into several smaller linework parts. This option decreases the complexity of the
masks.

Workaround

• Ignore varnish inks in outputVarnish inks will not be included while outputting to PostScript.
• Add ruling, angle and dotshape information in PDF Data section
• Resolve once identical one-ups in Step & repeat fileInstead of resolving the complete Step &

Repeat file, identical one-ups will be resolved only once.
• Resolve once identical external filesInstead of resolving the complete file and all its external

references, identical external files will be resolved only once.
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• Resolve pure black overprintOverprints are normally resolved, but default, pure black is
left alone, if you want Rich Black to be resolved too, select this toggle. This toggle is only
available when the Color Management options in the Color Management tab are activated.

• Limit filename size to 31 charactersCheck this toggle if you want to make sure your imported
files can be seen/read from/by all Apple operating systems.

• Split multi page jobs into multiple filesEvery page will be output as a separate file.

• Suffix for PANTONE ink namesEnter a suffix, the default is C.

• Maximum deviation of resolved curvesDuring the resolving process Bezier curves are
sometimes approximated by vectors. The maximum allowed deviation of the curves can be
entered here.

Note:

When a Esko native file is exported to PostScript, certain elements in the job which cannot
be translated into PostScript will be resolved in order to get an exact result. The same
happens when exporting to PDF. PDF files however have several destinations and don't
always need the high quality resolving because they may only serve as soft proof. If you
want to obtain even smaller files than what you can get with the "PDF for RGB/CMYK
proofing" settings, then this workaround option might help. When we resolve objects
splines are converted to vectors (e.g. line mask). The spline only has a 2 points but you need
a lot of vector points to describe a curve. The resolver default deviation is 0.002 mm but you
can reduce the amount of vector points by raising the deviation value and thus reducing
the size of the PDF. Which values? When comparing the default (0.002 = 1360 kb PDF) with
0.02 (326 kb PDF) you will end up with an acceptable result but it is clear that high values
will alter the PDF too much. Keep in mind that this option will only modify resolved vector
curves, it will not "straighten" any other objects while exporting.

8.2.4.  Export to an MFG File

Exporting to MFG will export the die shape of each station to ARD format and place all these
designs into a layout (MFG) file.Similar exports are: Export to layout CFF2 file and Export to
layout DDEs3 file. In these cases, the die shapes are exported to CFF2/ DDDES3 file.

8.2.5.  Exporting to a CFF2 File

CFF2 is short for the Common File Format version 2.

CFF2 Export allows to export one or more separations to a CAD system. This can be used to
export varnish or embossing shapes to a CAD system.
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Use the drop-down list to select whether you want to export the whole 'job', the 'red selection'
or the 'current layer'.

You can also (de)select which ink you (do not) want to output by clicking the tick: .Define
the CFF2  LineType: Setting the CFF2 linetype allows the CAD operator to distinguish between
objects in different separations. Common CFF2 linetypes: 1 normally used for cutlines, 2 for
crease lines

Determine the Mode:

• Output as Contours.

Two objects (filled with Cyan) will be outputted as two squares:
 

 

• Output as Regions.

Two objects (Cyan) will be outputted as one 'region'
 

 

8.2.6.  Export to a Normalized PDF File

Note:

This option is only available in case of a PDF Job.
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External References: External references have to be converted.

• Reconvert if recently updated: only updated references will be reconverted, all other
conversions will be used as they were.

• Use previous conversion: the existing conversions will be used, potential updates will not be
considered.

• Always reconvert: all external references will be converted at all times.

Put External References / Images into Output Folder: Referenced files in GRS Job File
Format will be converted to referenced external files in Normalized PDF mode, but where will
they end up? There are two options:

• External Normalized PDF files will be written in the output folder, next to the main
Normalized PDF file.

• External Normalized PDF files will be written in the original folder, next to the original
external GRS files.

• Always: the converted external files will be saved next to the main file.
• Never: the converted external files will be saved in the folder of the original files.
• If relative: if the external GRS files were close to the main GRS file (subfolder, neighboring

folder) the converted files will be saved in the output folder. If the external GRS files were
not 'close' to the main file (central smartmarks, logos, ...) the converted files will be saved
next to the original files.

Display image: You can save the file with 'no display' image, 'thumbnail' (200 x 200 pixels) or
low-resolution 'display image' (To save the file with a 72 dpi image. This image can be used
when the file is placed as an external file).
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Composed text: Composed text is non-editable text. It can be converted to editable text by
clicking it when you are in text edit mode.

Export to Scope 3 Compatible file: Check this box if you want your Normalized PDF file to be
Scope 3 compatible.

8.2.7.  Exporting to a PLA File

Can be used to export a PDFPLA file (which can only be processed by a BackStage 7.0 or Flexrip
7.0) to a Scope 3.0 compatible file.

Note:

This option is only available in case of a PDF Job.

 

 

Display ImageThis option allows you to set the type of display image that will be included in
the GRS file. Choices are: No Display , Thumbnail (200 x 200 pixels) or Display Image (72 dpi),
which creates a low resolution preview that can be used when the file is placed as an external
file.

Hide Technical InksWhen selected, technical inks will be stored in the file but will not be
visible as exposable inks for the Esko FlexRip.

SelectYou can export your entire job or a part of it.

• All - saves the entire job
• Red Selection - saves objects selected in red only
• Current Layer - saves the currently active layer only
• Current Page - saves the current page

Inks and Colors

• 'Clean up unused colors' automatically removes all unused inks.
• 'Clean up unused inks and colors' automatically removes all colors and inks that are not

used in the job.
• 'Save unused inks and colors' saves unused inks and colors.

ResetThe Reset button resets all the options that you may have changed to their default
values.

Customized SettingsThe Customized Settings button allows you to save the current settings
so that they can be used later or can be set as your own defaults. The feature is very useful for
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those export file types that have many options that you modify each time you export to that
file type.

8.2.8.  Exporting to a PDFPLA File

Note:

This option is only available in case of a GRS Job.

 

 

External References

• Reconvert if recently updated: only updated references will be reconverted, all other
conversions will be used as they were.

• Use previous conversion: the existing conversions will be used, potential updates will not be
considered.

• Always reconvert: all external references will be converted at all times.

Put External References / Images into Output Folder: Referenced files in GRS mode will be
converted to referenced external files in Normalized PDF mode, but where will they end up?
There are two options:

• External Normalized PDF files will be written in the output folder, next to the main
Normalized PDF file.
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• External Normalized PDF files will be written in the original folder, next to the original
external GRS files.

• Always: the converted external files will be saved next to the main file.
• Never: the converted external files will be saved in the folder of the original files.
• If relative: if the external GRS files were close to the main GRS file (subfolder, neighboring

folder) the converted files will be saved in the output folder. If the external GRS files were
not 'close' to the main file (central smartmarks, logos, ...) the converted files will be saved
next to the original files.

Display image: You can save the file with 'no display' image, 'thumbnail' (200 x 200 pixels) or
low-resolution 'display image' (To save the file with a 72 dpi image. This image can be used
when the file is placed as an external file).

Composed text: Composed text is non-editable text. It can be converted to editable text by
checking this box.

Export to Scope 3 Compatible file: Check this box if you want your Normalized PDF file to be
Scope 3 compatible.

8.2.9.  Exporting to a GRS File

You can export your station and plate files to a GRS file.

Note:

This option is only available in case of a GRS Job.

 

 

The options for exporting to a GRS file are: Display ImageThis option allows you to set the
type of display image that will be included in the GRS file. Choices are: No Display, Thumbnail
(200 x 200 pixels) or Display Image (72 dpi), which creates a low resolution preview that can be
used when the file is placed as an external file.

Hide Technical InksWhen selected, technical inks will be stored in the file but will not be
visible as exposable inks for the Esko FlexRip.

SelectYou can export your entire job or a part of it.
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• All - saves the entire job
• Red Selection - saves objects selected in red only
• Current Layer - saves the currently active layer only
• Current Page - saves the current page

Save Unused Colors saves any unused colors with the job. If some colors in the file are no
longer used, by default they will be removed when saved. To save unused colors, check this
option.

ResetThe Reset button resets all the options that you may have changed to their default
values.

Customized SettingsThe Customized Settings button allows you to save the current settings
so that they can be used later or can be set as your own defaults. The feature is very useful for
those export file types that have many options that you modify each time you export to that
file type.

8.2.10.  Exporting to a JDF Layout File

This task makes it possible to export a JDF Layout file. Stations, masks and marks are exported
to PDF 1.5 files. A JDF file containing references to all these files will be generated. You can
select whether you want to generate a JDF version 1.2 or 1.3 file.

Check 'Create MIME file' to put the JDF and the referenced PDF files together in a MIME packed
file.

 

 

8.2.11.  Exporting to a CIP3 File

A CIP3 file contains information that can be used on press, pre-press and post-press systems.
CIP3 file generated from PackEdge will only include information regarding the ink key settings
on the press. A low resolution image of all separations will be stored in the file. A CIP3 file has
a PostScript syntax, but cannot be opened as a PostScript file. A stand-alone Plato will benefit
most of CIP3 export, because there is already a CIP3 export module on the FlexRIP.
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The General tab allows you to define some general settings regarding the generated PPF file.

 

 

The Administration tab offers the most commonly used keys in PPF files. You can enter data
depending on what your press actually needs.
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Caution:

Exporting to CIP3 files only works for single page documents.

8.2.12.  Exporting to a Polar File (Optional)

It is now possible to export cutting information to Polar CompuCut stations. This speeds up the
setup times of guillotine cut sheets. When the bounding box stations overlap, the stations will
be exported as 1 block, so no cutting errors occur.

Click the Setup button to open the Export to Polar dialog box.
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Use the drop-down lists to define the position of the Side Guide (left/right) and Gripper (top/
bottom).

8.2.13.  Exporting to a JDF Cutting file

This task makes it possible to export a CIP4 JDF cutting file. This file contains cutting
information for guillotine cutting, saved in a CIP4 JDF file format.

8.2.14.  Digital Converting Export

Digital Converting Export is an optional module for Plato users that wish to export cut files
for digital finishing on a Kongsberg table, for sample making or short run production purposes.

Note:

To place i-cut marks around the layout, the file "icutmark.dtl" should be copied manually
from X:\Esko\bg_prog_marks_v010\dtl\gmf2k_optional to X:\Esko\bg_data_marks_v010\dtl
\gmfk2_v013
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It allows to save all files needed to produce the current layouts:

• a PDF file which will be sent to the proofer or digital press

• a cutting file which will be sent to the cutting table.

The Digital Converting Export dialog contains different parts:

• The Inks export type

• Export PDF File: to create the PDF files containing all graphics for the layouts

• Export Cutting File: to create the file (i-cut file, HPGL, PDF, MFG or ACM file) containing all
cutting information

Inks
The Inks shows all inks used in the layouts.

The first column lists the name of all inks

The second column shows how the inks are assigned:

•
: these inks need to be printed, so they will be included in the PDF file

•
: these inks contain cutting information, and thus will be included in the cutting file

•
: these inks will be excluded from export.

You can change the assignment of an ink by clicking the icon.
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Note:

If you only want to output the PDF file, you can switch the cutting inks to "exclude". If you want
to output only the i-Cut file, you can switch all printing inks to "exclude". When e.g. outputting
PDFPLA to a FlexRip, the PDF is not needed, so all print separations can be excluded.

The third column is only available for inks assigned to the Cutting file. What you can define
depends on the selected cutting file type (see below).

If the Cutting File type is set to i-Cut file or PDF file, you can enter (or change) the name of the
layer the ink will be placed in.

If the Cutting File type is set to HPGL, you can define the HPGL line type to be used.

If the Cutting File type is set to MFG, you can select the ArtiosCad line types . If an ArtiosCAD
file was imported for the cut shape, the complete ARD file will be put in the MFG file.

If the Cutting File type is set to ACM, you can either select ArtiosCad line types, or you can
select the native line types (P1, P2, P3, ...). When selecting ArtiosCad line types, the conversion
from MFG to ACM will include a number of optimizations and manipulations. When using P1,
P2, ..., the cut lines are dumped straight into the ACM file.

Export PDF File
• Set the File Name

• Define in what folder the file must be saved, either by entering the path, or by clicking the
Select Folder button and browse to it.

• Click the Export Settings to set extra PDF options

Note:

In the Settings, you can choose to output as a multipage PDF. This will result in one PDF
file containing one page for every layout needed, instead of one PDF for every layout. This
option is only available if all layouts have the same dimensions.

Export Cutting File
• Select the File Type: i-Cut file, HPGL file, PDF file, MFG file, or ACM file.

• Set the File Name

• Define in what folder the file must be saved, either by entering the path, or by clicking the
Select Folder button and browse to it.

Note:

When exporting to i-cut, HPGL or ACM, common line removal is applied, avoiding double lines
in the output.

Depending on the selected cutting file type, you can add information in the third column of the
Inks list:

• If the Cutting File type is set to i-Cut file or PDF file, you can enter (or change) the name of
the layer the ink will be placed in.

• If the Cutting File type is set to HPGL, you can define the HPGL line type to be used.
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• MFG is the native ArtiosCAD file type. If the Cutting File type is set to MFG, you can select the
ArtiosCad line types . If an ArtiosCAD file was imported for the cut shape, the complete ARD
file will be put in the MFG file.

• ACM is the native language of a Kongsberg table. If the Cutting File type is set to ACM, you
can either select ArtiosCad line types, or you can select the native line types (P1, P2, P3, ...).
When selecting ArtiosCad line types, the conversion from MFG to ACM will include a number
of optimizations and manipulations. When using P1, P2, ..., the cut lines are simply copied
into the ACM file.

Presets
Presets can be used if you want to store and reuse the settings you make.

To save a preset:

1. Enter the settings (folder, file type, settings) you want to save.
2. Click the Actions button and select Save Preset
3. Enter a name for the preset, and click Save

in the Presets dialog, which can be opened by clicking Actions > Manage Presets, you can load
a preset, or delete an existing preset.

Report
• Export XML report will generate an XML file describing which graphics are placed on which

layout.

• Export JPEG thumbnail will generate an RGB JPEG image of each layout. The resolution for
the JPEG file can be defined.
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9.  Menus and Toolbars
This chapters describes all toolbars and menu items.

• Menus
• Toolbars

9.1.  Menus

The menu bar contains commands available in the current module. Not all commands on all
menus may be available; availability depends on the options purchased and the active tool.

• File
• Edit
• View
• Arrange
• Station
• Inks
• Tools
• Production
• Trapping
• Window
• Help

9.1.1.  File menu

The File menu contains following items:
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• New Layout... offers you the possibility to create a Grid-based Layout, a CAD Layout or a
SmartLayout. You can also set up a new layout with the help of the Layout Assistant.

• Open Layout... allows you to open an existing layout.

• Close closes the job you are currently working on.

• Save Layout saves the layout you are currently working on.

• Save Layout as... saves the layout under another name.

• Save and Select in Automation Engine Pilot automatically selects the open file in the
Automation Engine Pilot. When the document has been changed, you will be prompted to
save the changes.

Note:

The Automation Engine Pilot needs to be running.

• Save Red Selection and Select in Automation Engine Pilot: saves the red selection and
automatically selects the open file in the Automation Engine Pilot. When the document has
been changed, you will be prompted to save the changes.

• Import CAD Data... allows you to import a CAD layout.

• Export Layout... allows you to export a layout.

• Digital Converting Export on page 277 allows you to export both a print file and a cut file.

• Layout Setup... opens the Layout Setup dialog box.

• In the Document Info dialog box you can enter all (administrative) information related to the
job. The info can also be used as smart text in a text mark.

• XMP Property Info... opens the XMP Metadata Properties dialog box.

• Print... allows you to proof or expose the design opened in Esko Plato.

• Exit: Closes the application.

Note:

The history list of file names provides fast access to recently used files. Simply click one of the
names to open the file.

9.1.2.  Edit menu

The Edit menu contains following items:
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• Undo: To cancel the last editing function (or a series of editing functions) you performed.

The editing functions are undone one editing function at a time, starting from the most
recent one. The last modification you made is undone and the job appears as it was before
you performed the editing function.Continue to choose Undo to cancel other modifications
that you made to the job.

Note:

The number of undos you can perform depends on the number of Undo Levels entered in
Preferences.

Notice that 'remembering' the previous actions consumes memory that cannot be used
for your current job anymore. If you are working with extremely complex jobs, it may be
necessary to enter a lower number of undo levels.

• Redo: To cancel the last undo (or series of undos) you performed.

Redo cancels one undo at a time, starting from the most recent occurrence and displaying
the job as it was before you performed an undo.Continue to choose Redo to cancel other
undos that you made to the job.

Note:

The number of redos you can perform depends on the number of Undo Levels entered in
Preferences.

If you change something to your job after an undo action, you cannot redo it anymore, or -
in other words - redo only works immediately after an undo action.

• Delete: To delete an object or a group of objects.
• Cut: To delete selected red objects from their current position in order to paste them into

another position.
• Copy: To copy objects selected in red in order to paste them into another position.
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• Duplicate: To duplicate any (group of) object(s) at it exact location. You can move the
duplicate to a new location. The original object is kept.

• Paste: To paste cut or copied objects from the clipboard.
• Select All: To select all objects within a job. The objects are displayed in red to indicate

selection, and can be manipulated or modified.
• Notes: see Notes on page 430
• Preferences...: To define standard settings to be used by the application as you work on a job.

9.1.3.  View menu

The View menu gives access to commands that determine how the imposition job is previewed.

 

 

The View menu contains following items:

• Zoom In: To zoom in (by a factor of 2) on the displayed job in the active window.
• Zoom Out: To zoom out (by a factor of 2) on the displayed size of the job in the active

window.
• Zoom to Selection: This function allows you to automatically zoom in on the selected area

in your job.
• Total View: To display the entire job, including objects outside the plate, after you have

used any of the other View options.
• Plate View: To zoom to the plate.
• Previous View: To display the previous view of the active window after you have used any

of the other View options.
• Repaint: To repaint the active window to remove stray pixels or to finish painting a large file

on screen.
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• Preview opens the Preview menu.

 

 

Tip:

The Preview Mode buttons also appear in the Preview Selector toolbar that can be added to
the work environment via Window > Toolbars > Preview Selector.

• View Mode opens the View Mode submenu.

 

 
• Side allows you to switch between the front and back side of the plate.
• Show Technical Inks allows you to view the Technical inks in the job window.
• Viewer opens Viewer, a very accurate separation viewer with a lot of extra production tools.

9.1.4.  Arrange menu

The Arrange menu contains following items:
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• To Front: To move an object on top of all other objects within the current layer.

• To Back: To move an object underneath all other objects within the current layer.

• Forward: To move an object one step up within the current layer.

• Backward: To move an object one step down within the current layer.

• Group: To group objects selected in red.

• Group into Grid: Tries to recognize individual stations as grid blocks.

• Ungroup: To ungroup objects after they have been grouped.

• Snap Crosshair: To make the crosshair jump to the last selected point.

9.1.5.  Station menu

The Station menu contains following items:

 

 

• Edit Graphics File... opens the selected file in PackEdge.

• Select Die Shape... allows you to select a die shape.

• Place Station... allows you to place a station in the layout you are currently working on.

• Replace by... allows you to replace a station.

• Assign Station to Design... allows you to assign a station to a CAD design.

• Import CAD Design... allows you to import a CAD Design.

• Replace by Graphics File... allows you to replace a graphic.

• Save Station... allows you to save the selected station.
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• Export Station... allows you to export the station.

• Station XMP Info... shows you the XMP info of the station.

9.1.6.  Inks menu

The Inks menu contains following items:

 

 

• Inks...: To add, modify or remove Inks and to display the current inks in your job with their
properties.

• Ink Mapping...: To map inks in the job.

• External File Ink Mapping...: To replace the ink separations of a external job by any color from
the color palette or by any ink from the Inks dialog box.

• Ink Coverage...: To estimate the needed ink coverage for the job.

• Create Ink Histogram...: To add an Ink Histogram to the plate.

• Create Ink Eater Areas...: To create areas which you can use for ink compensation.

• Fill Ink Eaters...

• Open Ink Book: To open the ink book of your choice.

• Manage Ink Books...: To manage the content of the ink books.

9.1.7.  Tools menu

Note:

This menu will only be enabled in the Sheet View.
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The Tools menu contains following items:

• Number Stations...: opens the Number Stations dialog box .

• The Adjust Masks tool is used to adjust overlapping stations.

• Reset Masks removes all masks that were generated using the ‘Adjust Masks’ tool.

• Turn Front to Back will rotate the sheet around the vertical center of the sheet and create
the back of the file. With this command, the left edge of the sheet becomes the right edge
of the sheet on the back.

• Tumble Front to Back will rotate the sheet around the horizontal center of the sheet and
create the back of the file. With this command, the top of the sheet becomes the bottom of
the sheet on the back.

• Delete Back deletes the back side of the sheet.

• Flip CAD to Print Side

You may have CAD designs that show Die Side. If this is the case, you will need to "flip" the
CAD design over so that you can work with the Print Side.

For more information, please refer to the chapter 'Flipping a CAD Layout to Print Side'.

• Release CAD Layout removes the CAD layout but keeps all associated stations. After
releasing the CAD layout, the stations no longer are tied up together and can be moved
individually.

• Create Varnish... creates a varnish layer.

• Manage Plates... opens the Manage Plates dialog box.

9.1.8.  Production menu

The Production menu contains following items:
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• SmartMarks...... opens the SmartMarks dialog box .

• i-cut Marks... opens the i-cut Marks dialog box.

• Staggered Cutting facilitates seamless printing in non-sleeve workflows.

• Check Job Parameters allows you to check the inks in your files for inconsistencies regarding
Job parameters that are predefined for a Automation Engine Job and allows you to correct
them (if necessary).

9.1.9.  Trapping menu

Note:

This menu will only be enabled in the Station View and requires a dedicated trapping licence
for Esko Plato.

 

 

Trapping creates overlapping areas to compensate for possible misregistration between the
different inks on the printed result. It is used whenever two adjoining colors contain different
inks in such a way that misregistration during printing results in a white gap or an undesirable
line of a different color at the border of the two colors.

Please refer to the chapter 'Trapping' for more information.

The Trapping menu contains following items:
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• PowerTrapper...

• Trap Color Pairs...

• Trap Red Under Green...

• Keep Red Away From Green...

• Rich Black...

• White Underprint...

9.1.10.  Window menu

The Window menu contains following items:

 

 

• Workspace allows you to create predefined workspaces.

• Toolbars allows you to view and hide individual toolbars.

• Align opens the Align dialog box.

• CAD opens the CAD dialog box.

• Calculator opens the Calculator.
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• Colors opens the Colors dialog box.

• Effects opens the Effects dialog box.

• Grids opens the Grids dialog box.

• Info Window opens the Info Window.

• Layer Browser opens the Layer Browser.

• Pan Window opens the Pan window.

• SmartLayout opens the SmartLayout dialog box.

• Stations opens the Stations dialog box.

• Style opens the Style dialog box.

• Transform opens the Transform dialog box.

• Hide all Dialogs will hide all opened dialog boxes.

9.1.11.  Help menu

 

 

While you are learning or working with Esko Plato, you may want to consult other Help
features.

Balloon Help

Esko Plato has Balloon Help to get you up and running as quickly as possible. Balloons appear
when you point the cursor at an icon or command. If a keyboard shortcut is available for the
item, it will also be shown in the balloon help.

Formula-enabled fields also have balloon help: it shows both the formula and the
corresponding value.

Balloon Help is turned on by default. As you become more familiar with Esko Plato, you may
want to turn the balloons off. Simply click the Help menu and select Balloon Help. The balloons
can be turned on and off with this command.

Esko Plato's Online Help contains the entire contents of the User's Guide in electronic form.
You access Online Help by selecting 'Online Help' on the Help menu. Selecting a topic will jump
directly to that section of the User's Guide. You also open Online Help using the keyboard
shortcut F1.

Presentations leads you to the What's new in Esko Plato and the SmartMarks presentations.
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9.2.  Toolbars

All toolbars can easily be shown or hidden easily via the toolbars list in the Window menu:

 

 

• Crosshair Position

• File & Edit
• Layout Type

• Preview Selector

• Station Selector

• Status Bar

• Tools

• View Selector

All toolbars can docked around your drawing window.

Tip:

The Workspace Manager allows you to make some predefined workspaces of the user interface
dialog boxes and switch from one to another in one single click.

Note:

For information on the Shuttle toolbar, we refer to Shuttle on page 26

9.2.1.  Crosshair Position

This toolbar indicates the vertical and horizontal position of the crosshair and the rotation
angle. It also allows you to set the position or rotation of the crosshair numerically. Simply
enter the requested position or angle in the proper field.
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Note:

Manual crosshair manipulations, such as moving and rotating, are also possible whenever the
Select or Transform tool is activated.

9.2.2.  Preview Selector

The Preview Selector contains a number of elements that offer a different visualization of the
job.

 

 

• Preview selector buttons

• Zoom: indicates and sets the zoom factor.

• Show Trim & Media box: allows you to switch the visualization of the trim and media box
(respectively sheet and plate edge) on or off. Switching off the blue or black lines indicating
the trim/media box can sometimes be useful to verify objects that are placed near or on the
trim/media box.

• Show values / formulas: adjusts the visualization of formula-enabled fields. You can opt to
either show the formula definition or the corresponding value.

9.2.3.  Layout Type

Layout type indicates the selected workflow: grid-based, CAD, SmartLayout, or manual.

Tip:

Click the layout button to open the appropriate Layout dialog box (Grids, CAD, or SmartLayout).

 

 

9.2.4.  Station Selector
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The Station Selector is active in the Station View. It lists all available stations for the current job.
Selecting a station (from the drop-down list or using the arrows) opens the selected station in
Station View.

Tip:

Click the station button to open the Station dialog box in the Sheet View.

9.2.5.  Status Bar

 

 

The Status Bar indicates the position of the cursor and displays the unit in which your job is
set.The server icon
 

 
indicates to which Esko Automation Engine server you are connected.

Note:

You cannot change units while working in a job.

In order to change units, select 'Preferences' on the Edit menu and select the correct unit in the
Defaults tab. Changes will become effective when creating a new layout.

9.2.6.  Tools

These tools are the interactive tools that you use to build a plate. You can open and close the
toolbar via the Toolbars > Tools selection on the Window menu.

The toolbar contains following tools:

 

 

• Select Tool

• Transform Tool

• Create Layout Tool

• Place Station/Strip Number Tool
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• Geometry Marks Tool
• Redraw Path Tool on page 309
• Modify
• Crosshair Tool
• Draw Die Shape Tool
• Create Bleed Mask Tool
• Zoom Tool
• Pan Tool
• Measure Tool
• Densitometer Tool
• Notes tool
• Working with tools and dialog boxes

Select Tool
Use the Select tool to select objects in the document window. You must select objects before
you can transform them. Selected objects are always highlighted in red. If you select objects
but they are not highlighted, make sure that the "Show Selection in Preview" box is checked in
Preferences.

Esko Plato supports two types of selection: red selection and green selection. Objects selected
in red can be transformed and modified. Objects selected in green cannot be transformed or
modified. Esko Plato's Align window uses green selections to align objects to one another.

• Selecting an object
• Selecting an object in green
• Selecting multiple objects
• Selecting all objects
• Deselecting an object

Selecting an object

To select individual objects:

1. Click Select on the toolbar. The Select button changes to a blue button showing that it is the
active tool.

2. Click the object you want to select.

The object is selected in red, indicating that it can be transformed or modified.

Selecting an object in green

Use green selection to select an object while keeping it from being transformed or modified. To
select an object in green:

1. Click Select on the toolbar.
2. Click the object that you want to select.
3. Press the INSERT key to change the selection from red to green.

If you have some objects selected in red and some selected in green, pressing the INSERT key
will toggle the objects between the two selections. That is, objects selected in red become
selected in green and objects selected in green become selected in red.
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Caution:

The Insert key is an Esko shortcut. If you are using DTP shortcuts, or created your own
shorcuts, the key could be different.

For more information about shortcuts, please refer to the chapter 'Shortcuts'.

Selecting multiple objects

To add an object to the current selection:

1. Click Select on the toolbar and click the first object.
2. Hold SHIFT and click each additional object that you would like to add.

Caution:

The Shift key is an Esko shortcut. If you are using DTP shortcuts, or created your own
shorcuts, the key could be different.

For more information about shortcuts, please refer to the chapter 'Shortcuts'.

To select all objects within an area:

1. Click Select on the toolbar.
2. Position the cursor outside the objects you want to select, and click, hold and drag the

mouse to create a box around the objects. Release the mouse button.

You must entirely enclose an object with the selection box for it to be selected.

Selecting all objects

To select all objects in the document:

On the Edit menu, click 'Select All'.

Deselecting an object

You can only deselect objects that are selected in red. To deselect objects selected in green,
you must first change them to objects selected in red by pressing the INSERT key.

Caution:

The Insert key is an Esko shortcut. If you are using DTP shortcuts, or created your own
shorcuts, the key could be different.

For more information about shortcuts, please refer to the chapter 'Shortcuts'.

To deselect every object in the red selection:

1. Click 'Select' on the toolbar.
2. Click anywhere in the document window outside the selected objects. All objects selected in

red become deselected.

To deselect a single object: right-click the object.
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Tip:

There is a preference setting for reversing the selection of an object: SHIFT+select the object by
dragging.

Transform Tool
Use the Transform tool to interactively move, scale or rotate a selected object. You can also
transform objects numerically using the Transform dialog box. Some objects in Esko Plato
cannot be transformed or can be transformed only partially. The following table shows the
objects that may be in your document and their transformation properties:

Object Type Move Scale Rotate

CAD Layout Yes No No

Grid blocks Yes No No

Stations Yes No Yes

SmartMarks Yes * No No

Geometry Marks Yes Yes Yes

Note:

* Certain SmartMarks cannot be moved, e.g. the grid mark.

Click the Move tool to activate the fly-out toolbar. Select the appropriate tool and to enter a
step value if needed.

 

 

• Using the Transform Reference box

• Moving the point of origin

• Using constrain

• Moving an object

• Scaling an object

• Rotating an object
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• Transforming an object by a step value
• Transforming an object numerically
• Transforming in the Station View

Using the Transform Reference box

When you use the Transform tools, a red reference box with selection handles appears around
the objects that have been selected in red. The individual objects in this Transform reference
box are modified as one object with the Transform tools.

You can make transformations using the selection handles or the outline of the reference box.
If you select one of the handles or the outline of the reference box, this becomes your point of
reference , the point that you are transforming. The point of reference does not have to be on
the reference box; you can also pick any location on a selected object too.

Moving the point of origin

The point of origin is the point around which transformations will occur. When you select an
object, the point of origin is in the center of the object. It is shown as a small circle with a point
in it.

You can move the point of origin for the scale and rotate transformations. For example, when
you rotate an object, it rotates around the point of origin, or the center in the default case. If
you move the point of origin to some other location, Esko Plato will rotate the object around
the new point of origin.

If you cannot locate the point of origin when you use the Transform tools to modify objects
(for example, if you zoomed in on the document window and the origin is located outside the
display area), press [F11] and click a point. The point of origin appears where you clicked.

Using constrain

The transform tools can be set to constrain their transformations. For example, you might
want to constrain rotations to 45 and 90 degrees. Or you may want to move an object
vertically. These are examples of constraints on the Transform tools.

Once you turn constrain on, it is active until you turn it off again. This is important to
remember because some tools, like the Geometry tool, also use constrain.

To turn constrain on (or off), press F3 .

You can also hold the Shift key whilst dragging.

Moving an object

Use the Move option of the Transform tool to move an object to a new location.

To move an object:

1. Select the object or objects you want to move.
2. Click Transform on the toolbar. The fly-out toolbar appears.
3. Click the Move button.
4. Click and hold on the reference box (not one of the handles) and drag the box to a new

location.
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Scaling an object

Use the Scale option of the Transform tool to scale an object relative to its point of origin. To
scale an object proportionally:

1. Select the object or objects you want to scale.
2. Click Transform on the toolbar. The fly-out toolbar appears.
3. Click the Scale button.
4. Move the point of origin to the appropriate location, if necessary.
5. Click and drag one of the four corner points on the Transform reference box.

To scale an object horizontally:

1. Change to the Move button on the fly-out toolbar.
2. Click and drag one of the horizontal points on the Transform reference box.

To scale an object vertically:

1. Change to the Move button on the fly-out toolbar.
2. Click and drag one of the vertical points on the Transform reference box.

Rotating an object

Use the Rotate option of the Transform tool to rotate an object relative to its point of origin. To
rotate an object:

1. Select the object or objects you want to rotate.
2. Click Transform on the toolbar. The fly-out toolbar appears.
3. Click the Rotate button on the fly-out toolbar.
4. Click and hold on the reference box or on one of the objects in the reference box and drag it

to a new rotation.

Transforming an object by a step value

You may want to transform an object in a number of steps. This is nudging. You use the arrow
keys on the keyboard to nudge objects by a step amount. To transform an object by a step
value:

1. Select the object or objects you want to modify.
2. Click Transform on the toolbar. The fly-out toolbar appears.
3. Click the appropriate transform button (Move, Scale or Rotate).
4. Enter a step value in the Step Amount field.
5. Use the arrow keys on the keyboard to transform the selected objects by the step value.

You can apply the step value to transform the objects in the following ways:

• Press CTRL+ [an arrow key] to apply 0.1 times the step value.
• Press CTRL+ ALT+[an arrow key] to apply 0.01 times the step value.
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Transforming an object numerically

With the Transform tool, you interactively transform objects by selecting them and applying
the transformation yourself. You can also transform objects numerically, using the Transform
window. The Transform window allows you to enter exact values for the placement, scaling and
rotation of selected objects. See Using the Transform Window.

Transforming in the Station View

The Transform tool in the Station View works the same way as in the Sheet View. Remember,
however, that the measurements for position are relative to the current origin. Since the
borders of the station are always fit to the current die, the Transform window's position
measurements usually are relative to the die. If the origin of the station has been moved
manually, the measurements in the Transform window will be relative to the new origin, which
may not be the die.

 Create Layout Tool
This tool is subject to a dedicated license. If you do not have the full license for this tool, only
the first tool of the fly-out toolbar will be available.

The distance, or gutter, between stations is set to zero by default. You can change it before
using the Create Layout tool. When reversing rows or columns, it is possible to specify
secondary gutter values. This option is only supported in CADX 7.17 or higher.

Alternatively, you can change it while using the Layout tool by specifying different step values
between the rows and columns in the edit boxes on the Status bar.

Click the Straight Nest tool or choose one of the other tools from the fly-out toolbar shown
below.

 

 

The first tool on the fly-out toolbar is the Straight Nest tool, which performs no rotation or
alignment on the single desings as it arranges them.

The second tool on the fly-out toolbar is the Reverse Second Row Nest tool, which flips the
design horizontally every other row.

The third tool on the fly-out toolbar is the Reverse Second Row Align Nest tool, which works
similarly to the Reverse 2nd Row Nest tool, except that it butts each row of designs against the
edge of the first station instead of nesting them as close together as possible.

The fourth tool on the fly-out toolbar is the Reverse Second Column Nest tool, which flips the
design vertically every other column.

300



9Plato

The fifth tool on the fly-out toolbar is the Reverse Second Column Align Nest tool, which
works similarly to the Reverse 2nd Column Nest tool, except that it butts each column of
designs against the edge of the first station instead of nesting them as close together as
possible.

Once you select a Nest tool, as you move the drag with the mouse, ghost images of the design
appear. Next to the mouse pointer, the total number of nested stations is indicated.

Please refer to the chapter 'Nesting stations'.

Place Station/Strip Number Tool
This tool is active only in Station View mode. Click the tool button to activate the Strip/Station
Number dialog box.

The Place Station/Strip Number tool will create station or strip number placeholders for your
station. A Station Number is a small number that is often placed on a hidden area of the
package to identify the location of the package on the sheet. Station Numbers are often called
die numbers or cell numbers. The placeholder specifies attributes such as position, font, size
and the ink(s) in which the number is to be printed. If multiple station numbers are placed on a
single station, they all get the same value.Strip numbers on the other hand are numbered in a
continuous way. If multiple strip numbers are placed on a single station, they all get a different
value.

In the Station View you can define the position and appearance of the station/strip number.

 

 

Expansion will happen in the Sheet View.
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Geometry Marks Tool
Use the Geometry Marks tool to create marks that are simple rectangles, ovals and polygons.
Unlike SmartMarks, Geometry Marks do not update automatically. However, Geometry Marks
that are designated as Registration color or darkest color will update when inks are added to
the plate. You can use Geometry Marks to add new inks to the plate. Geometry Marks can be
transformed like any other object. There is no limit to the number of geometry marks in one
plate.

• Choosing the shape of Geometry Marks

• Setting the style of Geometry Marks

• Adding Geometry Marks

• Geometry Marks in the Station View

Choosing the shape of Geometry Marks

Click the Draw Rectangle button on the Tools toolbar to activate the fly-out toolbar. Select the
appropriate tool; draw rectangle, draw ellipse or draw polygon.

 

 

Setting the style of Geometry Marks

The Style window allows you to set the parameters for the mark that you create. You can
choose whether your mark has a Fill, a Stroke or both. You can choose the colors of the fill and
stroke as well as the line width for the stroke. You can also set colors in Geometry Marks to
overprint other objects. Finally, you can choose for the color to be Registration color, which
means that the color contains 100% of all inks in the document.

To set the Style of a Geometry Mark, use the Style dialog box:
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Please refer to the chapter 'Style' for more information on the various options.

Adding Geometry Marks

To add a Geometry Mark:

1. Click the 'Draw Rectangle' button on the toolbar.
2. Select the type of mark you would like to create.
3. Set the parameters for the mark in the Style dialog box.
4. Draw the mark.

The way that you draw the mark depends on the type of mark you are creating.

To draw a rectangle:

1. Click the 'Draw Rectangle' button on the toolbar.
2. Starting where you want the top left corner of the rectangle, click, hold and drag to create

the rectangle. You can also simply click where you would like the top left corner of the
rectangle and the bottom right corner of the rectangle. Holding the ALT key while dragging
will draw the rectangle from the center. You also use the rectangle tool to create a square.
You constrain the rectangle to a square by turning on constrain. See Using constrain.

Tip:

Note that a preference setting allows you to draw a rectangle in a single click.
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To draw an ellipse:

1. Select the 'Draw Ellipse' button from the fly-out toolbar.
2. Starting where you want the top left corner of the ellipse, click, hold and drag to create the

oval. You can also simply click where you would like the top left corner of the ellipse and the
bottom right corner of the ellipse. Holding the ALT key while dragging will draw the ellipse
from the center. You also use the ellipse tool to create a circle. You constrain the ellipse to a
circle by turning on constrain. See Using constrain.

Tip:

Note that a preference setting allows you to draw an ellipse in a single click.

To draw a polygon:

1. Select the 'Draw Polygon' button from the fly-out toolbar.
2. Click where you want the first point of the polygon.
3. Click to create each additional point in the polygon.
4. Type 2 to close and end the contour. Type 3 to end the contour without closing it.

Note:

The Geometry Marks tool also allows you to draw splines. A simple click will create a new line
segment. If you click, hold and drag the mouse spline segments will be added.

Geometry Marks tool tips

• Once you have set the parameters for the Geometry Mark tool, you can close the Style
dialog. All marks that you create with the tool will use the parameters that you set in the
dialog.

• Geometry Marks can be transformed using the Transform tool on the toolbar or the
Transform window.

• If you want to change the parameters for a Geometry Mark that you have created already,
double-click it. The Style dialog box for the selected mark will appear.

Geometry Marks in the Station View

Geometry Marks also work in the Station View. However, remember that the available inks
shown in the Geometry Marks Style window include inks used on the current side of the
station as well as any unused inks.

If you have a two-sided station with graphics placed on both sides, the inks for the graphic on
the current side are available for use in your Geometry Mark. If you need another ink, add the
ink in the Inks dialog box before creating the Geometry Mark. See Geometry Marks tool.

Modify (toolbar)

To determine the modification you want to execute.
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Tip:

Modify in combination with Numbers.

If the Modify tool is activated, you can move points numerically. In the absolute value part, only
the input boxes for vertical, horizontal and diagonal distance and for rotation are present. In
the relative value part, the values for diagonal distance, rotation and vertical and horizontal
move are present. All Modify actions are performed immediately (no Apply).

Click Modify on the toolbar. The Modify Rosette appears. The highlighted button indicates
which Modify tool is activated.

Click another Modify tool in the Modify Rosette or press the corresponding numeric keypad key
(with [NumLock] activated) to activate the desired Modify function.

You can hide the Modify Rosette while you are working with Modify. To toggle between
displaying and hiding the Modify Rosette press the [Enter] key while Modify remains activated.

• Press z to convert to Bézier mode
• Press x to convert to free curve mode
• Press c to convert to frame mode

Modify Rosette

Move Point

 

 

To move points and anchor points on a segment or an object. When
you move the points, you can change the size and shape of the
segment or object.

Slide Anchor

 

 

To slide anchor points along the lines of a frame (on a curved
segment), or along a line (on a line).

Trim Line

 

 

To move the segment, if you are working in frame mode. The corners
with the adjacent segments remain the same.

Cut by Cursor

  To divide a segment or object. The divided pieces of the segment or
object can be manipulated or modified individually.
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  Attention:

• You must click a point on the segment or object, not a
point on the frame or bounding box.

• The newly created objects have no properties.

Make Corner Smooth

 

 

To change a curve into a corner, and vice versa.

Attention:

When you click a point, it toggles between Make Corner and
Corner Smooth.

Delete Point

 

 

To delete points from a segment or object. By deleting the points, you
can change the shape of the segment or object.

Direction Points

 

 

To display all handles on the selected segment or object when you use
the Modify tools.

Handles can be displayed (in red) to enable you to easily move and
manipulate the tension of the curve.

The type of handle depends upon the Digitize tool that was used to
create the segment.

For example:

• If you created the segment with Add Segment, anchor points and
handles display.

• If you created the segment with Add Arc or Add Curve, only points
display.

• In frame mode extra handles appear on the frame to manipulate
the tension of the curve.

Crosshair Tool
The sixth button on the Tools toolbar activates the Move Crosshair tool. Click to activate the
Crosshair fly-out toolbar.

Move 
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When you click this button , you can move the crosshair manually. You can move the vertical or
horizontal axis by clicking and dragging either one of them. If you want to move the crosshair
vertically and horizontally at once, you click and drag the center. If you click the left mouse
button anywhere in your job, the center of the crosshair jumps to that point. With the right
mouse button you can rotate the crosshair manually by clicking and dragging it. If you click the
right mouse button anywhere in your job, the crosshair is rotated to that point.

You can align the crosshair on a rotated object (in this case, NOT on the bounding box of the
rotated object). To align the vertical axis, you click a point on the object with the left mouse
button. To align the horizontal axis, you click a point on the object with the right mouse button.

Note:

Even if the object is not selected, there is gravity.

Rotate 

When you click this button, you can rotate the crosshair manually by clicking and dragging it.
When you click anywhere in your job, the crosshair will be rotated to that point.

Note:

Manual crosshair manipulations, such as moving and rotating, are also possible whenever the
Select or Transform tool is activated.

Tip:

To position or rotate the crosshair numerically, use the crosshair toolbar.

Note:

The rotation angle strictly refers to the rotation of the crosshair itself and is in no way related
to the distance by nor to the direction in which it was moved. Click Apply to perform the
Crosshair action.

Note:

Objets snap to the crosshair. Please find the adjustable value in the preferences.

Draw Die Shape Tool
In Station View mode, use the Draw Die Shape tool to draw die shape contours for your
station. The Station View's default die is a rectangle (or a square, if the height and width are
the same). But some jobs are not this shape. You can use the Draw Die Shape tool to create die
contours that are rectangular or square, oval or round, or a polygon. You are not limited to a
single die contour; you can create multiple contours to create a more complex die. All contours
created with the Draw Die Shape tool are die cut lines. Die contours can be transformed with
the Transform tools to create the exact shape and size that you need.

• Choosing the shape of the Draw Die Shape tool

• Drawing Die Shape contours
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Choosing the shape of the Draw Die Shape tool

The seventh button on the Tools toolbar activates the Draw Die Shape fly-out toolbar.

 

 

Drawing Die Shape contours

To add a die shape contour:

1. From the toolbar, click 'Draw Die Shape'.
2. Select the shape of the contour you want to create from the fly-out toolbar.
3. Draw the die contour.
4. The way that you draw the contour depends on the shape of the contour you are creating.

To draw a rectangle:

1. Select the 'Draw Die Shape - Rectangle' button from the fly-out toolbar.
2. Click where you want the top left corner of the rectangle.
3. Click, hold and drag to create the rectangle. You can also simply click where you would

like the top left corner of the rectangle and the bottom right corner of the rectangle.
Holding the ALT key while dragging will draw the rectangle from the center. You also use
the rectangle tool to create a square. You constrain the rectangle to a square by turning on
constrain. See Using constrain. Note that a preference setting allows you to draw a rectangle
with a single click.

Tip:

Note that a preference setting allows you to draw a rectangle in a single click.

To draw an ellipse:

1. Select the 'Draw Die Shape - Ellipse' button from the fly-out toolbar.
2. Click where you want the top left corner of the ellipse.
3. Click, hold and drag to create the ellipse. You can also simply click where you would like the

top left corner of the ellipse and the bottom right corner of the ellipse. Holding the ALT key
while dragging will draw the ellipse from the center. You also use the ellipse tool to create a
circle. You constrain the ellipse to a circle by turning on constrain. See Using constrain. Note
that a preference setting allows you to draw an ellipse with a single click.

Tip:

Note that a preference setting allows you to draw an ellipse in a single click.
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To draw a polygon:

1. Select the 'Draw Die Shape - Polygon' button from the fly-out toolbar.
2. Click where you want to the first point of the polygon.
3. Click to create each additional point in the polygon.
4. Type 2 to close and end the contour. Type 3 to end the contour without closing it.

Tip:

• Die contours can be transformed using the Transform tool on the toolbar or the Transform
window.

• Be aware of the number and complexity of die contours that you create. Since the Create
Bleed Mask tool is used to create a mask from the die contours, you may see unexpected
results in a station with many overlapping and complex die contours.

• For masking purposes, it is sometimes useful to create additional die contours to force the
mask to be a certain shape or size. After the mask is created you can then select and delete
the die contours that you no longer need.

• The color settings for manually drawn die contours can be set as a preference (Edit menu >
Preferences > View > ‘Show Manual Cut Lines’ and 'Line Width').

Redraw Path Tool

 Redraw Path Tool

To cut away the "smallest" part of the contour and to add the contour segment(s) that you
draw to the "largest" part. Click to indicate a point on or close to the die shape (it will snap) and
redraw a segment (which can consist of different points). The end point has to be on or close to
the contour so it will snap again.

Tip:

When you want to put an intermediate point of your line or curve segment near a contour,
click the middle mouse button instead of the left mouse button, to prevent that contour from
being affected.

Repeat

When editing a Staggered Cutting Path, you can do an automatic redo of the redraw operation
on all top labels using the Repeat button. This Repeat only works if the redrawn section is
inside the width of 1 label. It moves the start and end point of the redrawn section with an
offset equal to the distance between 2 labels on the top row, so these 2 points have to match
with points on the currently selected path.

Contour Cleanup Tool
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 Cut Path and Redraw Shortest PartTo cut away the "smallest" part of the contour and
to add the contour segment(s) that you draw to the "largest" part.Click to indicate a point on
or close to the die shape (it will snap) and redraw a segment (which can consist of different
points). The end point has to be on or close to the contour so it will snap again.

Tip:

When you want to put an intermediate point of your line or curve segment near a contour,
click the middle mouse button instead of the left mouse button, to prevent that contour from
being affected.

 Move PointTo move points and anchor points on a segment or an object. When you move
the points, you can change the size and shape of the segment or object.

 Delete PointTo delete points from a segment or object. By deleting the points, you can
change the shape of the segment or object.

 Change Start Point and DirectionClick a point to define it as the starting point. Click the
point again if you want to change the direction of the curve.

Nick Tool
Nicks are small pieces of substrate that are not cut by the table and thus create interruptions
in the die shape when exporting to i-cut. As a result, the cut design will stay attached to the
substrate. Nicks may be present in the design, but the nick tool allows you to add or remove
extra nicks that guarantee tiles to stay connected. You can specify the size of the nick in the
box.Click the die shape and add or remove nicks as you wish. When exporting, the position and
size of the nicks will be saved in the .cut file.

 

 

Tip:

Press the Alt key to switch between the Add Nick and Remove Nick tools.

Create Bleed Mask Tool
Use the Create Bleed Mask tool to create a mask for the graphic. The mask is based on the
station die. You can add a bleed amount to the mask. If the die in your station includes panels,
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you can also specify which panels to include in the mask to create non-printing areas on the
graphic.

Masks created with the Create Bleed Mask tool are applied to the graphic only; other objects,
like marks are not masked by the Create Bleed Mask tool.

The Create Bleed Mask tool includes an option window:

 

 

The option window allows you to specify the Bleed amount that you would like on the mask.
The value that you enter is the amount of bleed outside the die. The option window also
includes an Undo button. You use the Undo button to undo any panel selections that you have
made.

When you use the Create Bleed Mask tool, the mask is displayed in a transparent color over
the entire station. The color of the mask is the same as the color used for the Die Cut lines. By
default, the Die Cut lines in Esko Plato are red, so the mask usually appears as a transparent
red that simulates RubyLith masking material:

 

 

The transparent red area indicates the part of the station that will not be shown. Any part of
the graphic that is under the red transparent area will be not be visible or printable. The inside
of the mask will allow the graphic to show through.
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You can add specific panels to the mask by clicking on them. Each time you click inside a panel,
it is added to the mask.

The selection of a panel can be undone by clicking the Undo button on the Create Bleed Mask
window. The selection of panels is undone in the reverse order in which they were selected.
When there are no panels to undo, the Undo button is disabled.

In the following example, the glue flap and the two dust flaps at the bottom of the package
have been included in the mask:

 

 

To complete a mask, click the close box of the Create Bleed Mask options window or simply
click any other tool in the toolbar. You can redo the mask at any time by selecting the Create
Bleed Mask tool again. The previous mask will be discarded and a new mask will be created.

• Drawing a mask

• Deleting a mask

• Replacing a mask

Drawing a mask

To mask the graphic:

1. Click the 'Create Bleed Mask' button on the toolbar.
2. Enter a bleed amount.
3. Click in the document window on any panels that you want to exclude from the mask.
4. Click the Close button in the title bar.

You can use the Create Bleed Mask tool at any time, even if you have not imported a graphic
into your station. In the example above, there is no graphic in the station. If you import a
graphic later, the mask will be applied automatically to the imported graphic.

312



9Plato

Deleting a mask

Because the mask is an unfilled and uncolored contour, it is difficult to select and delete it in
the color view modes. However, you can easily identify and select the mask when you set the
preview mode to 'Cross'. Masks are always displayed as blue outlines in Cross and Contour
modes, making them easy to identify and select.

To delete a mask:

1. Set the display mode to Cross.
2. Locate and select the blue mask outline.
3. Press [Delete].

Replacing a mask

If you have an imported CAD die in your station and then use the Draw Die Shape tool to
create a new die, the imported CAD die is replaced with the contours that you create with
the tool. This also applies if the die shape is on the trim box of the job. If the die is created
in another way (e.g. by extracting contours in a specific ink), this die is kept and should be
deleted manually if it is no longer wanted.

Zoom Tool
Use the Zoom tool to magnify a portion of your workspace at an increased scale.

To zoom in, click with the left mouse button. To zoom out, click with the right mouse button. Or
you can move the mouse cursor to a corner of the area to zoom in upon, hold down the mouse
button, and drag to the diagonally opposite corner.

Tip:

Use the Zoom In and Zoom Out commands in the View menu to zoom one zoom level at a
time.

Pan Tool
Use the Pan tool to move around the document. You can change your view of the current
document by using the Pan tool or the Pan Window (see Using the Pan Window). The Pan tool is
located on the Tools toolbar; the Pan Window is opened from the Window menu.

To use the Pan tool, select the tool and use the cursor to drag the document around in the
document window. You can also pan around the document using the window scroll bars.

Use the Pan Window to see an overview of your document and the current view. The document
is displayed as a thumbnail with a rectangle indicating the current view.

1. On the Window menu, click 'Pan Window'. The Pan Window opens:
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2. You change the view area by dragging the red view rectangle to other locations on the

thumbnail.

You can also set the four Memory buttons at the bottom of the dialog box to remember
previous views. To store the current view in a Memory button:

1. Click and hold one of the memory buttons. The button will turn pink.
2. An Info dialog box will be displayed to inform you that the current view has been stored.

The envelope in the Pan Window is used to expand the dialog box to show more options. Click
the envelope to expand the dialog:

 

 

The expanded Pan Window dialog box contains other features. You can use the arrow buttons
to move the view rectangle over the document. You can also force the application to repaint
the display by clicking the Repaint button.
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Measure Tool
Use the Measure tool to measure one or two points in the document window. The
measurements for the points are shown relative to the current origin of your document.

• Measuring a single point

• Measuring the distance between two points

Measuring a single point

To measure a single point:

1. Click the Measure icon on the toolbar. The Measure window appears.
2. Click in the document window on the point that you want to measure.

The point you clicked is highlighted in the document window. The location of this point is
shown in the Measure window:

 

 

Measuring the distance between two points

The Measure window shows the location of the two points, and the midpoint and the distance
between them. To measure two points:

1. Click the Measure icon on the toolbar. The Measure window appears.
2. Click in the document window on the first point that you want to measure.
3. Click in the document window on the second point that you want to measure.

The two points that you clicked are highlighted in the document window. The location of the
two points, the midpoint between them and their distance are shown in the Measure window:
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When you selected two points, the values for the first point you clicked were entered into the
top line of the Measure window. The values for the second point you clicked were entered into
the position for the second point (the third line of the window).

Measure tool tips

• If you click another point, the values for the new point are entered into the second point
position and the previous values are moved up to be the first point.

• The Measure tool will "snap" to contours when in Contour Display mode, allowing you to
accurately measure the distance between two objects. When in Cross or Dummy color
mode, it will snap to the bounding box of the stations.

• The values in the Measure tool are copied to the Measure Window. You can open the
Measure Window to use these values in other dialog boxes or windows.

Densitometer Tool
Use the densitometer tool to view ink percentages for locations in your document. You may
want to use the measured values from the densitometer tool to create other objects, such as
Geometry Marks. You can also use the densitometer tool to check the ink values for stations
and SmartMarks to make sure that the correct values are assigned to them.

To measure ink percentages in your document:

1. Click Densitometer on the toolbar. The densitometer window appears:
 

 
2. Click in the document window to display ink percentages for a specific location.

Densitometer tool Tips

• TAC (Total Area Coverage) is the sum of the dot percentages of the different inks that will be
found on the paper after printing.

• The display mode must be set to Medium or High for the densitometer to measure
correctly.

• If you click and then drag the densitometer, the values in the densitometer dialog box will
continuously update.

• The fly-out menu offers the possibility to choose between exact (92.2%) and rounded (92%)
readings. you can also set the color of the densitometer's cursor.

• To close the densitometer dialog, click the close box on the dialog box or select another
tool.
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Working with tools and dialog boxes
Esko Plato contains some unique tool features and icons that you may not have seen before.
These features are designed to provide you with just the right degree of productivity and
simplicity.

Some tools can be used as "one-shot" tools. A one-shot tool is a tool that can be used once
during other commands. After this one-time use, the current tool is reset to the tool that you
were using originally. One shot tools are highlighted in red instead of blue, as shown below:

 & 

 Envelope: Some dialog boxes contain an envelope icon. The envelope is used to expand a
dialog box to show more options. Clicking on a closed envelope will expand the dialog box to
show more options for the particular feature. Clicking an open envelope will collapse a dialog
box to show fewer options.

 Link: In some dialog boxes you will see a link. You use the link to enable or disable
immediate refreshing of the screen. When the link is broken, as shown above, you can make
several changes or selections in the dialog box without waiting for the document window to
refresh the display after each change. When the link is intact, each change to the dialog box is
immediately displayed. Clicking the icon toggles between these two settings.

Tip:

A quick and easy way to hide or show all dialog boxes is to select Hide / Show All on the
Window menu.

9.2.7.  View Selector

 

 

The View Selector indicates or sets:

• The View in which you are working: Sheet or Station View.
• The side of the sheet on which you are working: front or back.

Tip:

Click the 'Show Trim and Media box' button  in the Preview Selector toolbar to switch the
visualization of the trim and media box on or off.
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10.  Function after function
• New Layout...
• Open Layout...
• Import CAD Data...
• Export Layout...
• Layout Setup...
• Document Info...
• XMP Properties Info...
• Print...
• Preferences...
• Preview
• View Modes
• ViewX...
• Select Die Shape...
• Place Station...
• Replace by...
• Assign Station to Design...
• Import CAD Design
• Replace by Graphics File...
• Save Station
• Export Station
• Station XMP Info...
• Inks...
• Ink Mapping...
• External File Ink Mapping
• Ink Coverage...
• Create Ink Histogram...
• Create Ink Eater Areas...
• Fill Ink Eaters...
• Open Ink Book
• Manage Ink Books...
• Number Stations...
• Adjust Masks...
• Create Varnish
• Manage Plates
• SmartMarks...
• Staggered Cutting...
• Check Job Parameters
• Workspace
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• Toolbars

• Align

• CAD

• Calculator

• Colors

• Color Factory

• Effects

• Grids

• Info Window

• Layer Browser

• Pan Window

• SmartLayout

• Search Options

• Stations

• Style

• Transform

• Color Picker

• Grid Settings

• Station Properties

10.1.  New Layout...

New Layout creates a new document. There are 3 subitems under the 'New Layout' command.
These correspond to the different workflows that Esko Plato offers. The only difference
between these subitems is that they will open the appropriate workflow dialog automatically.
In other words: there are no different flavors of (PDF)PLA documents. For example, even after
choosing ‘New SmartLayout’, one can still add a step and repeat grids.

 

 

• Layout Assistant...

• Grid based Layout...

• CAD Layout...
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• SmartLayout...

• Manual Layout...

Tip:

If you always use the same workflow, you can configure the Ctrl-N shortcut to start your
favorite new operation immediately.

10.2.  Open Layout...

Open Layout opens an existing Esko Plato document. If the document is created by Plato 5.0 or
lower, it will automatically be converted into an Esko Plato 7.0 structure. Opening of GRQ files
and CAD files is also supported.

 

 

10.3.  Import CAD Data...

Import CAD Data opens a CAD layout file, extracts the sheet size and the position and
orientation of the stations.

The CAD information can be retrieved from a CAD file such as ArtiosCAD, or from a PDF file.
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There are different ways to import CAD designs (1-Up). When importing CAD data in the Sheet
View, empty stations are being created which will have the 1-up CAD design as die shape.For
more information, please refer to the chapter 'Using a CAD file to create a station'.

Esko Plato can open a CAD file to define the plate layout. When you open a CAD file, you
are using the CAD Layout Workflow. This workflow defines the number and locations of the
stations that are on the plate. It may also contain a sheet size and masks with bleeds for the
stations. If these features are in the CAD file, Esko Plato will use them in your layout.For more
information, please refer to the chapter 'Using a CAD file for plate layout (optional)'.

Setup opens the CAD Import dialog box that allows you to do mappings, select or create a
certain CAD style or search for print items.

Note:  When importing an MFG file, you can choose to import it as "Reference Lines" in the
CAD Import setup window. By doing so, the MFG file will not be imported as CAD but only as
reference lines, in a separate "CAD Reference " layer. Importing the MFG file will have no other
influence on your open document.

10.4.  Export Layout...

Export Layout allows to export to various formats: PS, EPS, PDF files. All conversions take the
complete layout (graphics + die shapes) and convert the information to the selected format.
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Tip:

Note that even for PDFPLA files, exporting to PDF makes sense. Esko PDFPLA files contain
references to PDF files. When exporting a PDFPLA file to PDF, an all-in-one PDF file will be
created (embedding the referenced PDF files).

 

 

Click 'Setup' to open the Setup dialog box. For more on these options, please refer to the
chapter 'Exporting to a PostScript File'.

• Normalized PDF: Only available if the current format is a PDFPLA file. It allows you to
export an Esko Software Suite 7 PDFPLA file into a Scope 3 compatible Normalized PDF file.

• PLA or PDFPLA: Only available if the current format is PDFPLA or PLA. It allows you to
change the format from Esko native PLA to Normalized PDFPLA and vice versa.

• Polar (requires a dedicated license) allows you to output to Polar Compucut cutting
stations.

• CFF2 allows you to export to CFF2 format, based on separations. You can either export the
contour lines or the outline of a region. This option is mainly intended to export data to cut
varnish blankets, embossing or foil stamping areas.

• JDF Layout exports the graphics into PDF files and links these PDF files together through a
JDF layout ticket.

• MFG, Layout CFF2, Layout DDES3 converts die shapes into a layout CAD file of the
requested format (ArtiosCAD MFG, CFF2 or DDES3).

• CIP3 exports the file to a CIP3 compatible .PPF file.

• JDF Cutting File: see Exporting to a JDF Cutting file on page 277
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10.5.  Layout Setup...

The Layout Setup dialog box allows you to set layout settings. It is the dialog box that appears
when you intend to start creating a new layout.For more information on creating a new layout,
please refer to the chapters on grid-based, CAD, or SmartLayout workflows.

The Layout Setup dialog box consists of two tabs:

• General

• Plate and Sheet

 

 

10.5.1.  General

The General tab of the Layout Setup dialog box offers you the possiblity to determine some
general settings.

• If Esko Plato is connected to an Esko Automation Engine server, you can specify in which
Automation Engine Job the new layout will be created. Specifying the Job is important to:

• set up SmartNames
• determine the default file format (important when normalizing foreign file formats)

• It indicates the Job File Format in which your job will be created: PDF or GRS.

• You can enter a name for your new plate in the Layout Name field. If you don't enter a
name, Esko Plato will ask for a name when you save the file.If you want to use a template
file that you created previously, you can click the check box next to "Use Template" and
select one from the drop-down list. If you haven't created any plate templates, the check
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box and field will be disabled, as they are in the dialog box below. See Using Templates for
more information about using templates. If you have QuickStep templates on your system,
these will also show up in the list.When selecting an Esko Plato template (not for QuickStep
templates), the template will be searched for information like plate and sheet size and these
values will be shown in the corresponding fields in the Plate & Sheet tab.

• Units and Origin can be changed in the Defaults tab of the Preferences dialog box.

• For some printing processes, like flexo printing, the plate must be distorted to compensate
for the expansion of the plate when it is wrapped around the cylinder of the press. The
Shrink fields allow you to set a distortion factor that is used when printing or exporting. You
can enter Shrink values between 90 and 110. The default Shrink value is 100; the plate will
be printed at 100%. If you enter a value other than 100, the Distortion option in the Print
dialog box is disabled.

• Screen registration is relevant only to Esko FlexRip users. When activated, the origin of
the screening will be reset for each station. In doing so, it is garanteed that exactly the
same screening will be applied for each station. When deactivated, screening will be done
continuously throughout the complete job.

 

 

10.5.2.  Plate and Sheet

The Plate and Sheet tab allows you to specify the dimensions of your plate and sheet.
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To facilitate this procedure, you have a number of formulas at your disposal, which you can
activate by clicking the ‘fx’ symbol to the right of each entry field. When you click ‘fx’, the
Calculator pops up. Right-clicking in the entry field will make the calculator pop us as well.

Note:

You can toggle 'Show Formulas' to either work with formulas, or with numeric values.

Plate Size - Enter the height and width of the plate in the Size fields. You can create a plate
with any dimensions; the plate can be wider than it is tall, taller than it is wide, or square.

Sheet Size - Enter the height and width of the sheet in the Size fields. You can create a sheet
with any dimensions; the sheet can be wider than it is tall, taller than it is wide, or square. You
cannot set the sheet to be larger than the plate but the sheet and plate sizes can be equal.

Fit - Use the fit buttons to fit the sheet size (vertically and horizontally) to the current red
selection. The 'Plate Fit' button will fit the plate size around all current objects.

Note:

There is a big difference between using the fit buttons and using the plate and sheet fit
parameters (V/HPlateFit and V/HSheetFit). The fit buttons will do a one time fit. They measure
the current objects and store the corresponding values as sheet or plate settings. The fit
parameters on the other hand will make sure that the plate or sheet settings are automatically
updated whenever the station grids are updated (V/HSheetFit parameter) or whenever the
bounding box of all objects changes (V/HPlatefit parameter).

Margins allows you to indicate which zones on the 4 sides of the sheet should not be used
to place stations. The sheet minus these margins equals the available area (available to place
stations).
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Gripper Edge allows you to specify the width of the gripper zone (in sheetfed offset). The value
specified here will be used to define the parameter called ‘Gripper’.

Sheet Position on Plate allows you to indicate how the sheet should be positioned on
the plate. You can use the 9-point selector and/or specify an offset.The small, blue square
represents the outline of the sheet. The large, black square represents the plate. The
parameters you enter in the vertical and horizontal offset input box are added to the position
of the sheet on the plate. Drag or click to position your sheet on the plate.The offset value is
based on the current origin. See the Defaults tab in the Preferences dialog box for information
about origin.

10.6.  Document Info...

The Document Info dialog box can be used to write job-dependent production information.
The info can also be used as smart text in a text mark. The 'Document Info' dialog opens after
clicking 'Document Info...' on the File menu.

10.7.  XMP Property Info ...

XMP stands for eXtensible Metadata Platform, it is a standard for metadata. The editor
understands and works with XMP.

When you create a file, all general job information will be stored the moment you save the file.
Additionally ink information (name, lpi, dotshape, inkcoverage), bar code information, fonts,
CADfiles, etc… used in the file is listed in the XMP.

Choosing 'XMP Property Info' from the File menu opens the XMP Metadata Properties dialog
box.
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10.8.  Print...

Print allows you to proof or expose the design opened in Esko Plato.

Clicking 'Print' on the File menu opens the Print dialog box.

 

 

Click 'Setup' to open the Setup dialog box. For more on these options, please refer to the
chapter 'Exporting to a PostScript File'.

10.9.  Preferences

All Esko Plato modules have various preferences that you can set. You set or change your
preferences by clicking 'Preferences' on the Edit menu.

1. On the Edit menu, click 'Preferences'.
2. Select the tab that contains the settings that you would like to change.
3. Click 'OK' to save your changes.

Selecting 'Cancel' will discard any changes you have made since the last 'OK' and will close
the Preferences dialog box. Selecting 'Reset' will reset all settings in all tabs to the application
defaults.

The Preferences dialog box has seven tabs:

1. General
2. Defaults
3. View
4. Color
5. Editing
6. Files
7. Shortcuts
8. Licenses
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9. Server and Resources on page 336

10.9.1.  General

To define general standard settings to be used by the application as you work on a job.

 

 

Language Setting: You can change the language of the user interface by selecting one of the
following languages from the list box: English, French, German, Spanish, Japanese, Chinese
Simplified or Chinese Traditional. You no longer need to install the language packs from the
DVD to have a non-English user interface. In case you prefer to have the localized online help
documentation, however, you still need to install the language packs.

Note:

The editor needs to be restarted before the changes will be effective.

Number of Undo Levels: Defines the minimum number of steps the system remembers for
Undo and Redo. Enter a value between 0 and 1000.

Tip:

For complex jobs, it is best to keep the number low to save memory.

Number of visible Decimals in Input Boxes: Defines the number of decimals displayed in the
input boxes.

Enter a value between 0 and 8.

Values are rounded when you enter more digits (into an input box) than the number defined in
this Decimals input box.
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Save automatically every : Defines how often you want the application to save your work
automatically. The interval between 2 automatic saves is expressed in minutes. Your work is
saved in a file called 'autosave.pla' or 'autosave.pdfpla' in the Temporary directory you have
selected in the Files tab sheet.

A value of 0 disables automatic save.

Maximum Image Pool Memory Size: Defines the amount of RAM allocated for storing Image
display images.

The higher the value, the more RAM the system has at its disposal for display image(s),
reducing the need to reload display images from the hard disk.

The default value is 25% of the available RAM, the minimum value is 16 Mb, the maximum
value is 80% of available RAM.

Note:

In general, the system performs quicker when the application can hold Image display images in
memory; note, however, that the memory allocated for Image caching, reduces the amount of
memory available for other purposes.

Use data resources from : If Plato is connected to a Automation Engine server, the resources
will be taken by default from the Automation Engine server. Other options are Local computer
or Remote Computer. This can allow multiple Plato seats to share resources even when no
Automation Engine server is available, for example to exchange SmartMark sets. Use the Select
button to define the location of the remote computer.

10.9.2.  Defaults

Use the Defaults tab to set the units and the default origin for new documents.
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Units Specify whether you want your measurements and calculations displayed in millimeters
or inches.

Origin Choose the orientation of the axes in your document. Your preference will be stored
inside the file. Opening the file later will set the orientation in the same situation as in which
the file was created.
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Caution:

It is not possible to change the units or orientation while working at the job. New
preference settings will only be applied when creating a new job.

Adjust Masks is used to adjust overlapping stations. The command searches the plate for
overlapping stations and presents each overlap to you as an overlap record. You choose how
these overlap areas should be adjusted: manually or quick.'Manual masks' allow you to make
a decision on the priority of overlapping flaps and panels per case. 'Quick masks' always split
overlapping masks halfway between the two selected die shapes.

If the layout is by default meant for web printing, you can enable the Quick Masks for
Continuous Printing option. The Quick Adjust of the stations at the top and bottom of the
layout will take into account that the layout is repeated, using the vertical sheet size as Repeat
Length.

Formulas Select the format in which the formulas are visualized: technical formulas or localized
formulas. Technical formulas correspond with the way in which formulas were visualized in
QuickStep. Localized formulas provide a more readable format.

Default Die Ink In case you always use the same die ink, you can specify it here and it will
automatically be detected as the default die ink in the file.

10.9.3.  View

The View tab changes the way that your document is displayed. Changes made here do not
affect the structure of your document.

 

 

Image Display Quality defines the resolution used by the application to display images.

• Very High: the application creates a display image at the highest possible resolution,
regardless of the display information in the image file itself.

• High: the application creates a display image at a high resolution (72 dpi), regardless of the
display information in the image itself. This can take very long since all data of the images
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are read. If you have, however, a large job that takes more than half of the CT Cache Size,
the display image will be displayed at a resolution lower than 72 dpi.

• Default: the application uses the display image of the CT file itself or, if none is available,
creates a display image;

• Low: the application uses a display image only if it is available in the CT image itself. If you
choose this possibility, the CT will not be visible in the Extended Preview mode.

Caution:

The option Very High is introduced to try to enable real resolution views of CTs. Due
to the large amounts of data this involves, setting the Image Display Quality to Very
High will considerably slow down the visualization. Consequently, we would like to
recommend you not to play with it and only use these possibilities when you really
need them.

Show Manual Cut Lines defines color and width of the manual cut lines. Manual Cut Lines
are cut lines drawn with the 'Draw Die Shape' tool in the Station View, or created by applying
'Outline of all objects' in the Select Die Shape dialog box. All other lines follow the CAD styles.

Anti-aliasing is relevant for the line-art objects in your design, that need pre-processing and
for which images are generated. Anti-aliasing smoothens the staircase effect you get in the
generated images of lineart objects that need pre-processing.

Tip:

This option increases the readability of small text that is pre-processed to image.

Text Greeking defines the minimum size of the text before it is displayed as a filled box rather
than readable text. The boxes will turn into text again when zooming in.

Show Selection in Preview: When objects are selected, they are displayed with a red outline.
You can choose not to show the selection in the three "color" display modes by clearing this
box. (Selections are always shown in Cross and Contour display modes, regardless of this
setting.)

10.9.4.  Color

Default Document Profile: choose the default profile from the list.

Monitor Profile: choose a monitor profile from the list.

Check Warn when placing files with another document profile to have the system display a
warning when placing PDF files that have other document profiles embedded.
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10.9.5.  Editing tab

The Editing tab sets Esko Plato's defaults for editing. These defaults do not change the
structure of your document; they only change your interaction with the application when
editing files.

 

 

Gravity defines the distance in screen pixels where gravity (or snap) is in effect. The higher the
value, the easier an object will snap to guides or other objects. Enter a value between 0 and 16.

Cursor Drag Delay defines the minimum distance in screen pixels the cursor must be moved
before any transformation of an object takes place. Enter a value between 0 and 16.

Pan Overlap defines the percentage of overlap between the previous and new view when
panning. For example, with the Pan Overlap set to "75", the new view after panning contains
75% of the previous view and 25% of a new view.

'Shift and drag-select' reverses the selection: Dragging a selection over an object while
holding SHIFT actually deselects selected objects and selects unselected ones.

Create polygons by:
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• One mouse click: click the top-left corner of the polygon (depending on the chosen
orientation) and draw a polygon of the desired size.

• Two mouse clicks: click both the top-left and the bottom-right corner of the polygon.

10.9.6.  Files tab

Use the Files tab to define file settings to be used by Esko Plato as you work on a document.

 

 

Temporary Files: The default temporary files directory is the \temp folder on your home
folder. Click the Browse icon to choose another directory. Select a directory on the fastest hard
disk of the workstation.

Show file options in file selector dialog: Checking this checkbox will open the File Options
dialog box every time you open or import a file.

Show thumbnail preview in file selector dialog: The file selector shows File Info. Check the
checkbox to turn the preview on or off.

Create backup file (.bak) in same folder: Creates a backup file in the same folder. Indicate
whether you want to create a backup file before saving or before loading.You need to change
the .bak into .pla in order to be able to read the file into the editor.

Update external files when they are modified checks whether the referenced files were
changed since the file has been loaded. Only happens when the workstation is idle (e.g. when a
GRS is placed in Esko Plato, but is edited in Esko PackEdge at the same time).

Place PDF files without normalization It is possible to place non-normalized PDF files, using
this preference option. When placing non-normalized PDF files, this will result in a non-rippable
PDFPLA file. This means that such a file will need pre-processing when further operations
are applied (expose to FlexRIP / Automation Engine operations) – during pre-processing a
normalization ‘on-the-fly’ will happen. As such, this workflow is only advisable when working in
a standalone PDF environment (placing PDF files, exporting to PDF). Furthermore, this option
is only allowed, if Plato is not connected to a Automation Engine server (running in standalone
mode). When switching to a mode where the real data is needed (for example switching to
extended preview, applying trapping,…), a normalisation ‘on-the-fly’ is done..
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Check Job Parameters It is possible to define Job Parameters on the Automation Engine
server. Job Parameters are settings (type of bar code, inks, certain RIP parameters,... ) that
are predefined for a Automation Engine Job.The Check Job Parameters options allows you to
check your files for inconsistencies and to correct them (if necessary) when opening or saving a
document.

10.9.7.  Shortcuts tab

There are 2 sets of shortcuts: Esko shortcuts and DTP applications shortcuts. You can switch
between both sets by selecting the appropriate set from the Shortcut Key drop-down list.

 

 

You can, however, modify whichever set of shortcuts to fit your personal needs.

1. Select the right set of shortcuts, if it is not yet selected.
2. Select the 'Category' (e.g., 'File') of which you want to personalize a shortcut.
3. Select the command you wish to personalize (e.g., 'New')
4. Now personalize your shortcut. Enter a key and click 'Assign'.

Note:

If you want to remove a shortcut , click 'Remove'.If you want to return to the original shortcuts,
click 'Reset All'.

10.9.8.  Licenses tab

The Licenses tab allows you to activate the licenses that you want to enable.For more
information, please refer to the appendix: License Management.
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10.9.9.  Server and Resources

To define the Automation Engine server to connect to, and the Data Resources to be used by
the application as you work on a job.

Note:

In case the application is connected to an Automation Engine or BackStage server, the Data
Resources are always used from this server. You can use the emote or local Data resources if
the application is not connected to an Automation Engine or BackStage server.
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Automation Engine Server
You can set the Server Name, User Name and Password to connect to Automation Engine.

The connection to an Automation Engine Server has an influence on the following features in
the application:

• Submitting to Shuttle: you can only submit to the Automation Engine server the application
is connected to

• The user name for the Track Edit Session task on the Automation Engine server
• The list of Jobs and Products in the File Selector dialogs
• The parameters for the ’Check Job Parameters’ as available on the Automation Engine

server

Note:

If you are connected to an Automation Engine, a green notification will be shown.

Data Resources
The common Data Resources used by the application are Color Engine Database, Marks, Fonts,
Custom and DGC.

By default, these Data Resources are taken from the Automation Engine server. However, it
is possible for 2 or more stand-alone applications (without an Automation Engine server) to
share the same data resources. This requires that the Data Resources are shared on a remote
computer.

Note:

Changing the Data Resource settings requires a restart of the application.
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10.10.  Preview

The Preview menu makes it possible to easily switch between the different preview modes.

 

 

Cross: Cross mode shows all external files as a box displaying the file name. This mode
displays your sheet very quickly but shows no detail.

Contours: Contours mode shows all objects as outlines. This mode is useful for aligning two
contour edges precisely.

Dummy Colors: This mode is particularly useful if complex layouts needs inspection (e.g.
the ones generated by SmartLayout). When placing a station, a dummy color is assigned
automatically. This color can be modified from within the station properties. In case of ‘real’
stations, this representation color is used only for this visualization mode!The color picker in
the station properties dialog box also allows to assign a color to empty stations. When doing
so, a designer ink is added to the ink list representing the chosen color. When replacing a
station, the inks (from the dummy station) are cleaned up automatically (if no longer used).
As such, the dummy inks created when assigning colors to empty stations will be cleaned up
automatically when the empty stations get replaced by the actual stations.

Display Image mode displays all objects in color. External files, like stations and image marks,
will be shown using their Display Image. If an external file does not have a display image, it will
be shown as a color cross.

Medium mode shows the true objects in color. It does not use the display image so the detail
is very good.

High mode shows all objects in color and with ink-based color management applied. This
mode is extremely accurate. However, the display speed may be slow due to the high level of
detail being calculated and displayed.

Please refer to the chapter 'Preview Selector' for additional information.
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10.11.  View Modes

The View mode menu makes it possible to easily switch between the two different view modes

 

 

The Sheet View shows the plate, the sheet, and all stations that have been placed. In this view,
you can switch between the front and the back of a plate.

The Station View shows individual stations.

Tip:

Click the 'Show Trim and Media box' button  in the Preview Selector toolbar to switch the
visualization of the trim and media box on or off.

Please refer to the chapter 'View Selector' for more information.

10.12.  Viewer

10.12.1.  Welcome to Viewer

Benefits of using Viewer
Viewer is a very accurate separation viewer with a lot of extra production tools. It eliminates
the need for separated proofs and will help you to avoid bad plate-making.

Fly-out menu options
A number of settings can be found in the Fly-out menu, by clicking the arrow at the top right of
the dialog.

Show in All Windows

Use this to apply the Viewer preview settings to all the open windows (when you used several
windows).

Merge Similar Inks

This option affects how a separation containing objects with different halftone information is
displayed in the separation list.
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Leave it off to display a separate entry for each different halftone setting (as shown below at
left), or select it to display different halftone settings of the same separation as one entry (as
shown below at right).
 

 

Default

Click Default to use the Default Press Setting. For more information, see Define Press Settings
on page 340

Manage Press Settings...

Click this option to create, duplicate, edit or delete Press Settings. See Define Press Settings on
page 340.

10.12.2.  Define Press Settings

Before you can start working with Viewer in a meaningful way, you should define your Press
Settings. Without basic information on the properties of the press you are using, Viewer
cannot simulate accurately.

You can open the Press Settings window by selecting Press Settings... in the fly-out menu

The Default Press Settings
In the list of Press Settings, there is always one Press Setting called Default, which you can edit
but not delete.

You can select it by clicking on Default in the Viewer dialog’s fly-out menu, and edit it using
Press Settings...

Creating a Press Setting
To create a Press Setting in Viewer:

1. Select Press Settings... in the fly-out menu .
2. Click New... in the Press Settings dialog.
3. Enter the name of the new press setting in the New dialog.
4. Click OK

Copying a Press Setting
To copy (duplicate) a Press Setting:

1. Select it in the Press Settings dialog.
2. Click the Copy... button.
3. Give it a new Name.
4. Change its parameters as you wish (see The Press Settings in Detail on page 341).
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5. Click OK.

Editing a Press Setting
To edit a Press Setting:

1. Select it in the Press Settings dialog.
2. Click the Modify... button.
3. Change its parameters as you wish (see The Press Settings in Detail on page 341).
4. Click OK.

Deleting a Press Setting
To delete a Press Setting:

1. Select it in the Press Settings dialog.
2. Click the Delete button.
3. Confirm that you want to delete it.

Attention:

Deleting Press Settings might also affect other workstations.

Choosing a Press Setting
• To select a Press Setting, click on it in the Viewer dialog’s fly-out menu.

The Press Settings in Detail

First Dot (%)
Specifies which minimal gray value (expressed in %) in the file still will yield a dot on the plate,
provided the RIP and platemaking occur under normal conditions.

Note:

Normal conditions indicate that the DGC must have been set up completely. The value does
not correspond with any measurement that has been made prior or during DGC set up, nor
does it correspond with any densitometer measurement on plate or on print. In fact, this value
is (implicitly) chosen by the person who set up the DGC and plate-making. Typical values range
from 0.4% to 1.6%.

Plato uses 8-bit precision, yielding 256 different possible gray values. A single gray value in
an image may make the difference between a dot or no dot on a flexo plate. To allow for this
precision, Viewer uses percentages with one decimal digit.

8-bit gray value in Plato Percentage

0 0.0%

1 0.4%

2 0.8%
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8-bit gray value in Plato Percentage

3 1.2%

... ...

254 99.6%

255 100%

Note:

If you do not specify a first dot, you will not be able to use the following Viewer view modes for
this press setting:

• The Flexo Plate Preview

• The Flexo Print Preview

Dot Gain in Highlights
When you have specified a First Dot job percentage, you can also specify how dark it should
actually print. Enable Dot Gain In Highlights and specify the dot gain parameters:

• First Dot Prints As: indicates the dot gain for the first dot. Typical values range from 5% to
15% depending on the substrate. The value is a job percentage, that will print on an ideal
reference press as dark as the first dot prints on this press.

• Range: while the previous value measured the amount of dot gain in the highlights, this
value expresses how far this effect penetrates into the midtones. Typically plate making is
configured in such a way that the mid-tones print like an offset press.

Note:

If you do not specify Dot Gain In Highlights, you will not be able to use the following Viewer
viewing mode: Flexo Print Preview.

Limited Total Area Coverage
The Total Area Coverage is the sum of percentages of the different channels on the same
location. A higher total area coverage means more of the various inks is printed on top of each
other.

If you want, you can specify the Maximum Total Area Coverage to specify the maximum
amount of ink that the substrate can take on the same spot on your press.

Note:

Exceeding the Maximum Total Area Coverage for the press may cause drying problems,
unexpected color results, and other problems.

Registration Error
Specifies the average maximum Registration Error on your press.

If you enable this option in the Press Settings, you can use the Registration Errors preview
in Viewer to check whether your trapping is sufficient to compensate for possible registration
errors on the press.
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Moiré Settings
In the Moiré Detection settings of the Press Settings, you can define the default values for the
settings in the Moiré Detection window.

For more info on the different settings, see Moire Detection on page 350

10.12.3.  The Viewer window

Viewing options
Options particular to certain Viewer previews are grouped under View Options. You can
expand or collapse them using the triangle beside View Options.

The following options are available in all Previews:

Separation visibility
In the Ink list, you can:

• Click the eye icon in front of a separation/color name to show or hide it.
• Click the eye button above the separations/colors list to show or hide all separations/colors.
• Click the ink name (not the eye button) to quicly hide all other separations and go in single-

separation mode.

Reverse Printing Order

Use the Reverse Printing Order button  to view how your file would look like with its ink
order reversed.

When Reverse Printing Ink Order is enabled ( ), it is always used in all windows, and a red
arrow icon is visible in the title bar of all the windows.

Orientation
The orientation buttons allow to change the orientation of the Preview of the job.

This is applied to all windows when Show in All Windows is active, or only to the current
window when Show in All Windows is inactive.

Note:

Keep in mind that this only changes the rotation of the preview, it does NOT actually rotate the
job.

Separations
The first viewing mode shows a list of all used inks.
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Mode
By default a separation is displayed in color. In order to see a separation as it would appear on
film, you can switch to “Show as Film: Positive”.

By switching to “Show as Film: Negative”, the visible separation will be shown in negative.

Note:

As both “Show as Film: Positive” and “Show as Film: Negative” are more useful on a single
separation, switching to one of those will show only one separation.

Highlight
Traps

This is not available in Plato

Transparency

This will highlight all objects that have an opacity percentage, a blend mode or an opacity mask
(regardless of what is underneath).

Overprint

Highlight Overprint will highlight the areas where an “overprint” setting in the paint style takes
effect.

Screening Conflict

The Screening Conflict checkbox highlights areas where a screening conflict can occur.
They can occur if an object with transparency (opacity mask, opacity percentage or blend
mode) is overlapping on an object with another screening. The PDF definition clearly states
that screening is always taken from the topmost object, even if that object is completely
transparent in some areas. In most cases, this is not what you would expect.

In the example underneath, you can see a cyan rectangle, and a circle on top, with an opacity
mask. The objects have a different screening. Where the circle is on top of the cyan rectangle,
the cyan will take the screening of the blended circle. Therefore, as shown on the right, these
areas will be highlighted as Screen Conflict.
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Dim Artwork

When you enable an Highlight option, the document artwork is faded to the percentage you
choose in Dim Artwork

Color

When you enable a Highlight option, the objects are highlighted in the color you chose in the
Color Picker.

Color
This viewing mode shows a list of used colors.

 

 

Click the eye-icons in front of the colors to show or hide them.

Click the eye button above the colors list to show or hide all colors.
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Total Area Coverage
The Total Area Coverage (TAC) is the sum of all separation-densities at a certain point in your
document.

TAC Limit
The TAC Limit is the maximal Total Area Coverage that your document may contain. This value
depends on the press and the substrate your design will be printed on. Your printer should
provide you with the TAC Limit value to use.

Defining the TAC Limit

The TAC limit is defined in the Press settings. See Define Press Settings on page 340). By
default the TAC Limit is set to 270%.

Viewing areas over the TAC Limit

When you switch to the Total Area Coverage preview, the image in the preview pane will be
dimmed and all areas where the sum of the densities is higher than the TAC limit specified in
the current Press Setting will be displayed in 100% black.

 

 

Note:

You can press the “D” key to activate the Densitometer Tool, and measure the actual TAC
amount in a specific area (see Measure Ink Densities).

To quickly see the maximum TAC in your document, use the TAC Limit slider.

Move the slider to the right to use a TAC Limit value higher than that used by your current
Press Setting. The more you move the slider to the right, the less pixels will typically be over the
TAC Limit.
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Flexo Plate
If you change the Viewer Preview mode to Flexo Plate, a single separation (by default the first
in the list) will be shown as a simulated flexo plate.

Note:

In this Preview mode, only one separation can be viewed at a time.

Note:

Viewer uses the same technology as the Esko Flexo Tools for Photoshop.

 

 

First Visible Dot
The Flexo Plate preview will use the First Visible Dot percentage from the press settings (see
Define Press Settings on page 340).

Pixels with a percentage lower than the First Visible Dot percentage will be shown as areas
without dots.

Pixels with a percentage equal or higher than the First Visible Dot percentage will be shown as
areas with dots.
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Plate Color
The Flexo Plate preview predicts how clean your flexo plates will be. Especially in very light or
very dark areas, you could end up with isolated dots or holes on the flexo plate, and those
areas are difficult to hold on the plate or the substrate.

You can choose the plate color (Cyrel Red, Blue, Green or Safran Yellow, or a High Contrast
Blue&White) to match the type of plate you are using.

Flexo Print
This Viewer preview mode shows the effect of highlight dot gain on the image.

 

 

This effect is equivalent to a curve adjustment. To determine this curve, the Flexo Print Preview
will use the First dot and the Dot gain in highlights settings from the Press Settings (see
Define Press Settings on page 340).

Going from light to dark:

• The Flexo Print Preview will display percentages below the First visible dot percentage as
0%.

• The First visible dot percentage will be shown using the First Dot Prints as percentage.

• Percentages above the First visible dot percentage will be shown darker.

• Towards the midtones this darkening effect will fade out until the Range value.

• Percentages above the Range value are displayed unchanged.
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Registration Error
The Registration Error Preview is a simulation of a design printed with registration errors of a
specific press (defined in the Press Settings, see Define Press Settings on page 340). It can be
very helpful to see if trapping is applied sufficiently and correctly.

The Registration Error value is taken from the Press Setting you selected.

The separations are randomly shifted. In fact, all separations are moved exactly the distance of
the Registration Error, but all under a random angle.

If you want to see another random registration error simulation, click the Simulate Again
button.

 

 

In the example above, you can see a small area of a job in regular preview (left) and with
registration errors (right). In this case, you can clearly see no trapping was applied, so white
lines appear at the registration shifts.

Breakout
A Breakout is an area where the percentage of a single separation is lower than the First
Visible Dot value. This can be used to track areas that won’t show up on print because the
values are too low.

Your printer should provide you with the First visible Dot value. The First visible dot is set in
the Press Settings: see Define Press Settings on page 340.When switching to Breakout mode,
the preview will be dimmed and all areas where a single separation has a value lower than the
First Visible Dot value (but higher than 0%), will be displayed in highlight color.

You can measure the actual percentages in that specific area using the densitometer (see
Measure Ink Densities).
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Moire Detection
Moire Detection allows to detect possible screening problems (Moire) in the file.

You can set the options to highlight overlapping areas, to detect situations in which Moire
might occur:

• when the two overlapping areas have screening angles that do not differ 30 degrees.
• when the two overlapping areas have the same angle
• when the two overlapping areas have different rulings
• when the two overlapping areas have different dot shapes.

You can use the Ignore inks option to ignore inks that have

• a density lower than a certain value,
• a density higher than a certain value
• a Luminance higher than a certain value

as in all those cases, the Moire patterning will hardly be visible.

All these Moire Detection options are stored in the Press Settings. See Define Press Settings on
page 340

10.12.4.  Viewer Compare Tool

You can use the Viewer Compare tool to compare the active document with another
document.
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To compare the active job:

1. Go to Window > Esko > Viewer > Compare...

The Compare dialog opens, and the name for the Current Document is shown.

 

 
2. Select the file you want to compare the active document to:

• If you want to compare it to an open document, select its file name from the dropdown
list

• If you want to compare it to a document on disk, click the browse button and select the
file

3. Define what to compare:

• all artwork
• the current Artboard
• only Trim Box or Media Box (if they are defined)
• only the selected area.

4. Click OK

A Viewer Compare window will open, showing a comparison between the two jobs.

Note:

If you have a Trim Box defined in the Illustrator job, the Viewer Compare tool will only show
what’s inside the trim box.

The Viewer Compare window
The Viewer Compare window shows the two jobs and their differences, and contains a number
of tools and buttons to inspect these differences in various ways.

Move over a button with the cursor and the tooltip will indicate what it stands for.

Buttons with a triangle in the lower right corner contain additional options: Control-click
(Windows) or Command-click (Mac) the button, or click and hold the button to see the extra
options.
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Navigating the Viewer Compare window
The Viewer Compare window contains different ways to navigate:

The Inspect tools
 

 

• The Zoom tool. Under the zoom tool you find

• Zoom out

• Fit document in view

• Fit document width / height

• Zoom to 1:1 view

• Show Zoom Options (showing all these options as individual buttons)

• The Zoom out tool
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• The Pan tool

The Navigator
By dragging the red rectangle (when zoomed in), you can navigate through the job.

 

 

The View options
The View options allow to go back to the previous view, or use additional settings, such as
rotate, invert or mirror the view.

 

 

Compare modes
Using the Compare butons, you can choose different Compare modes / views

 

 

• View Current version only
• View Reference version only
• View Both documents on top of each other.

Additional options:

• View Both in their original colors
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• View Both - Show difference: the differences will be shown in the "Added" and
"Substracted" highlight colors.

• View Both - highlight difference: same as above, but the identical parts are dimmed.
• View Both - only difference: same as above, but the identical parts are hidden.
• Change "Added" Highlight Color, Change "Substracted" Highlight Color and Change

Both Highlight Color, to change the colors in which differences are shown
• Reset Difference Highlight Colors to reset the default colors
• Channel Matching, to match corresponding channels/inks for the two documents.

• View Both - side by side shows both versions next to each other. You can choose between

• Automatic tiling
• Horizontal tiling
• Vertical tiling.

• View both - mirror reference shows the current document on top of the mirrored
reference document.

Alignment
Comparing files with different sizes may seem like a challenge as they are not aligned in the
Viewer Compare window, but it provides some tools that make it very easy.

 

 

• Alignment

• on one of 9 corner / center points
• Align From Ruler: see Align from Ruler on page 354
• Auto Align From Ruler: see Auto Align from Ruler on page 355
• Auto Align: see Auto Align on page 356

• Auto Align: see Auto Align on page 356
• Use trim box for alignment
• Offset, Horizontal and Vertical

Align from Ruler
The ruler tool works by defining two points (one in each file) that have to be aligned.

1.

Select the reference version of the file by clicking the  icon.
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2.

Select the Ruler tool 
3. Indicate the ruler anchor point

 

 
4.

Switch to the other version by clicking the  icon (or use Ctrl + S).

The anchor point, here in the red circle, will be in a different location in the second file
version.

5. Indicate the point that should be positioned on the ruler anchor point (here in the blue
circle)
 

 
6.

Click the Alignment button and select Align From Ruler. The files are now aligned.

Note:  Depending on how precisely you defined the second ruler point, you may have to
zoom in and repeat the alignment procedure to align your files with more precision.

Auto Align from Ruler
Auto Align from Ruler is used the same way as the Align from Ruler tool, but is more accurate
at high resolution.

If the details of the alignment points match, the viewer will be able to increase the alignment
precision (and have a good alignment with fewer iterations).
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Auto Align
Auto Align does not use the ruler, but rather the currently visible view of the two compared
images to attempt an automatic alignment.

For convenience, a separate tool button is available to perform an Auto Align operation
without having to open the Alignment pop-up menu. Clicking this button will perform an Auto
Align from Ruler if a ruler selection is active, otherwise an Auto Align (from view).

Viewer Compare Preferences
You can open the Compare Preferences by choosing Illustrator > Preferences > Esko >
Viewer Compare Preferences (on Mac OS) or Edit > Preferences > Esko > Viewer Compare
Preferences (on Windows).

You can define the resolution for the Viewer Compare previews: either based on the document
size, or at a fixed resolution. "Based on Document Size" will result in a low resolution for big
documents, so e.g. aligning will become more difficult when zooming in. On the other hand, a
"Fixed Resolution" can result in a very heavy preview calculation if the fixed resolution is high
and the document is large.

You can define if anti-aliasing should be applied.

10.13.  Select Die Shape

Select Die Shape allows you to create a new die shape contour based on specific settings.

Note:

This option will only be enabled in the Station View.

• Custom size creates a rectangular die shape with an adjustable size.

• Graphic's Trim Box (Borders) creates a die shape that matches the trim size of the graphic.

• Objects marked with annotation 'Die' will use the contours that have the Esko PackEdge
annotation "Die".

• Objects using ink will use the contours that are placed in a specific separation in the
graphic.

• Outline of all objects is perfect for creating a die shape around objects that have no
die shape in the original file. The new die shape will be created around the union of all
objects in that particular file.The Grids dialog box will indicate this die shape by indicating
“Manual” in the column Die Shape.The ink and stroke width that will be used to indicate the
new die shape are the ones that are selected in the 'Show Manual Cut Lines' option of the
Preferences' View tab.

All choices except 'Objects using ink' will copy the stroked contours from the graphic into the
station and assign them the Plato Cut ink. ‘Objects using ink’ will simply copy the contours from
the graphic into the station but keep the original separation.
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For more information, please refer to the chapter 'Using Select Die Shape'.

10.14.  Place Station...

Place Station allows you to open a graphics file and convert it into an internal station.
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Depending on the selected file type, clicking Setup... opens a dialog box with additional file
type related settings.

10.15.  Replace by...

The Replace Station dialog box offers you the possibility to select a station that will replace the
selected station.

 

 

You may want to replace certain stations on your plate with a different station. For example,
you might want to replace stations in a plate layout that you did earlier with a new version. Or
you may want to replace specific stations to create a combination layout .

Please refer to the chapter 'Replacing a station' for additional information.

10.16.  Assign Station to Design...

The Assign Station dialog box offers you the possibility to select a station and assign it to the
selected CAD layout.
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When assigning a station to a layout, the station is analyzed for a die objective in a CAD
structure (the CAD file loaded in a STA or GRS file). A dialog box is displayed indicating whether
the CAD files match.

Please refer to the chapter 'Assigning a station' for additional information.

10.17.  Import CAD Design...

Import CAD Design allows you to import 1-up CAD designs (ARD files) in the Station View.

Also DXF, CFF2, DDES, PDF and LC masks are supported.
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Setup opens the CAD Import dialog box that allows you to do mappings, select or create a
certain CAD style or search for print items.

If the selected file turns out to be a layout file (MFG file), an extra dialog will pop up to enable
you to select the CAD design from the layout.

 

 

If the selected file turns out to be a PDF file, an extra dialog will pop up to enable you to select
the separation(s) that contain the cutting lines.
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10.18.  Replace by Graphics File...

Replace by Graphics File allows you to replace the existing graphics from a station.

 

 

Click Setup to open the Import Setings dialog box.

10.19.  Save Station

Saves the current station as (PDF)STA file. Saving stations is usefull if a station needs to be used
in other layouts. The (PDF)PLA layout will still refer to the embedded internal station.
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Caution:

Note that a (PDF)PLA file never keeps a reference to a station file, but does keep its
reference to the underlying GRS or PDF file. When placing a (PDF)STA file, this file is
embedded as an internal station.

10.20.  Export Station

Export Station allows you to export the station data to an external format (PS, PDF,…)

For more information on the different export formats, please refer to the chapter 'Exporting
Esko Plato Files'.

 

 

10.21.  Station XMP Info...

The XMP Info dialog box provides an overview of all XMP information that is stored inside the
station file.
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10.22.  Inks...

Click 'Inks' to add, modify or remove inks and to display the current inks in your job with their
properties.

See also Working with inks on page 130

Note:

The Inks dialog box in the Station View is purely informative.
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1. Ink Number

This number, which appears automatically in front of the Ink box when the ink is defined,
identifies the ink by its place in the inks table.

Tip:

If you want to change the order of the inks in the table, drag the number of the ink towards
the number where you want to insert it.

Ink Patch

Displays the ink.

When you define an ink by entering its name, the Ink patch automatically displays the
defined ink.

When you create new inks, they are added immediately in the Color Palette of the Color/
Style box as a color swatch with 100% of that ink.

When you double-click an empty ink box, the PANTONE Book appears, from which you can
select inks.

2.

Allows you to add an ink. You can give the name or the number of the ink.

Allows you to remove an ink.
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Caution:

You cannot delete inks that are used in external references, nor are you allowed to
remove the Plato Cut and Plato Crease inks.

3. Ink Book: Lists to which ink book the ink belongs. Information on the Ink Book is
automatically assigned by Esko Plato and is for your information only.

4. Ruling: To define the screen ruling for the ink (to obtain the appropriate printing quality).

The default value is 120 lines per inch. For more specific information on screen ruling, we
refer you to the manual on Screens.

5. Angle: To define the screen angle for the ink (to avoid moiré patterns, especially when using
process inks). For more specific information on screen angles, we refer you to the manual
on Screens.

6. Dotshape: To define the dot shape for the ink.

M for Monet, E for Elliptical, ...

For more specific information on dot shapes, we refer you to the manual on Screens
7. The Inks Type: choose Normal, Opaque, Varnish or Technical from the drop-down list.

• Normal - Normal inks are inks that appear transparent when printed over other inks.
Normal is the default type for all inks.

• Opaque - Opaque inks are inks that appear opaque when printed over other inks. Setting
an ink to the Opaque type affects only the display of the ink.

• Varnish - Varnish inks are inks that are used to create varnish plates. An ink set to
Varnish does not display its color. Setting an ink to the Varnish type affects only the
display of the ink.

• Technical - Technical inks are inks that are used for layout purposes only. Plato's Cut
Ink and Crease Ink are examples of Technical inks. Setting an ink to the Technical type
affects the display (always shown as opaque ink) and affects their use in marks. Station
Numbers, Geometry Marks and SmartMarks ignore technical inks.

8.  Opens a new menu:

 

 

• Show Options: displays / hides the options at the bottom of the Inks dialog box.
• Columns: select the columns you want to see.
• Remove Unused Inks - removes inks that no longer are used in the document.
• Remove Unused Colors and Inks - removes inks and colors that no longer are used in the

document. This option will combine colors in Esko Plato's internal palette that are the
same and then remove inks and colors that no longer are used.
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• Sort Light to Dark - sorts the inks in the document so that the lightest is first and the
darkest is last.

• Sort Dark to Light - sorts the inks in the document so that the darkest is first and the
lightest is last.

• Change Dotshape and ruling of All Inks... opens a dialog box which allows you to define
the ruling and dotshape for all the inks.

9. Default values when adding a new ink: define the default settings for ruling, angle and
dotshape, these settings will be used when new inks are added.

Note:  If enabled in the fly-out menu, you can also see (and define) the Printing Method. See
Printing Method on page 135

10.23.  Ink Mapping...

Note:

Ink mapping is applied on the complete document and therefore it is only available in Sheet
View.

The Ink Map dialog box shows the current ink mapping of your document. Before any ink
mapping has occurred, all the inks are mapped to themselves, as shown below.

On the left are the inks in your document; the existing inks. On the right are the new inks that
you want to use in place of the existing inks. To map an ink, you replace the new ink on the
right across from the existing ink.

Your plate may use inks that need to be changed to other inks. For example, your plate
contains the ink "Logo Red" and that ink should be "PANTONE 485 CV". You use ink mapping to
"map" one ink to a different ink.

To open the Ink Map window, click 'Ink Map' on the Inks menu.

 

 

The Job Ink Mapping dialog box displays the current inks of the job. These are not only the inks
of the job objects, but also the inks of the external jobs, for example externally placed Esko
native files or CT files.
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Note:

After you have applied Job Ink Mapping, the inks that are not used anymore in your job are
cleaned up automatically.

Caution:

It is possible to map two inks to the same destination ink. If, however, the mapped file
contains patches in Postscript overprint where the color is defined by both inks, make
sure the percentage of the inks is not 0%. If this is the case, due to known limitations,
the 0% wins over the other value.

Please refer to the chapter 'Using Ink Mapping' for additional information.

10.24.  External File Ink Mapping...

External file ink mapping is only active in the Station View.It is used to replace the ink
separations of the external graphics of a station by any ink from the Inks dialog box.

 

 

Ink Map rows: To map the original ink in the left column to the destination ink in the right
column.

Name input box: Instead of dragging an ink to an ink box in the right column, you can also fill
out the name of an ink in the name input box.

Select Similar: Allows you to select all External Files, this feature makes it easier to perform
inkmapping on all externally placed files at once.

 Allows you to reset.

10.25.  Ink Coverage...

The Ink Coverage dialog box gives you an estimate of the area that the inks on a particular
sheet side will cover. The accuracy of the result depends on the calculation procedure
you choose from the drop-down list. Either you'll select Fast or you'll opt for an Accurate
calculation.
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If you open the Ink Coverage dialog box and there is no data in the list, select the calculation
procedure and click the Scan button. If the ink coverage of this job has been calculated before,
you can ask for a more recent overview by clicking the Update button.

 

 

• Fast / Accurate

Fast indicates that the calculation is faster but you only get a rough estimate of the ink
coverage.

Accurate indicates that the calculation might take a while but you get an accurate estimate
of the ink coverage.

• Scan / Update: The first time, the ink coverage will be scanned. A message, saying:
“Calculating Ink Coverage. Please wait.” appears. The information in the Ink Coverage dialog
box is now updated.

• All Inside Sheet (Sheet View) scans the area inside the sheet only. Objects that are
outside the sheet are not included.

• All Inside Plate (Sheet View) scans the entire plate. All objects on the sheet and plate are
included. If you have objects that extend or are outside the plate, they are not included.

• All (Station View)
• All inside Die bounding box (Station View)

• Merge Similar Inks allows you to display all objects with the same ink but different ruling
and dotshape.

• Calculate Ink Coverage on all pages will scan both the front and the back of the plate. The
total ink coverage for both sides is then displayed in Ink Coverage.

• Only selected objects scans only in selected objects.
• Update allows you to re-calculate the ink coverage after some changes have been made in

the design to update the values or another type of scan was asked for.
• mm² indicates the area that the ink will cover.
• % indicates what percentage of the plate is covered with a particular ink.
•

 Informs you about the number of inks in your job or it displays the message 'Database
has changed'. Click Update to get a new estimation after the changes.
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Note:

If the message 'Database has changed' is displayed, you will notice that the 'Save To File'
button can be unavailable and/or the separations are dimmed as well. It means that either
the design and/or the number of inks has changed.

• Save To File... Allows you to save the results of the calculation to a Text Report or a CSV
Report which can be printed or edited. The dialog box allows to select a destination
directory, to specify a file name and the type of file. The drop-down list allows to choose
between Text Report or CSV Report. Both types can be opened in any text editor (e.g.
Wordpad, Notepad...) A CSV file can be opened in a spreadsheet program.

Please refer to the chapter 'Calculating Ink Usage' for additional information.

10.26.  Create Ink Histogram...

By selecting Create Ink Histogram you can calculate the ink key histogram from the current
document and add it as a database object in the document.

The ink key histogram is an important factor in setting up the press. It allows you to regulate
the ink consumption in each printing zone before printing. This will significantly reduce the
press setup time. It is also useful to help you to decide whether or not to modify the layout of
your designs on to plate or to have a more homogeneous distribution of the ink consumption
along the plate.

This ink key histogram is a database object and will be saved in the file. Position, orientation,
number of ink keys and scan borders/margins can be defined.

You can adjust the ink consumption by manually creating ink eater areas in Plato, based
on the ink key histogram. Use the Fill Ink Eater Area tool in Plato to automically adjust the ink
distribution.

 

 

Create Ink Histogram dialog box
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Scan: Determine the area the scan has to cover.

• All inside Trim box will take into account all information within the trim box.

• All inside Media Box will take into account the information inside the media box.

Merge Similar Inks: the Ink Histogram tool merges the results for inks that are the same but
have different ruling and/or dotshape.

Position: specify the position of the ink histogram with respect to the trim box. To do so, select
the Ink Histogram object and click on the Position control to align the Ink Histogram on the top,
bottom, left or right side of the document. The Ink Histogram object in your document will be
updated automatically.

Tip:

When the Ink Histogram is aligned on the top or bottom, the ink histogram zones are
calculated in vertical zones of the document. In case the Ink Histogram is aligned on the right
or left size of the document, the histogram is calculated in horizontal zones.

Orientation: specify the orientation of the ink histogram bars in the ink histogram object.

Histogram Height: specify the height of the ink histogram object in the document.

Ink Key Width: specify the width of a single ink key bar in the histogram. The Ink Key Width is
normally set to the same width as the width of a single ink key zone on the press.

Number of Ink Keys: specify the number of ink histogram bars or ink key zones on the press.

Caution:

The ink key histogram will not be updated automatically when the Ink Histogram
Object is moved, or when the document is changed or saved. You have to select the Ink
Histogram Object and click on the Update button to update the Ink Histogram.

The Ink Histogram in the image below is attached to the bottom of the plate. It displays 40 ink
keys of 12.5 mm each. This represents the settings in the Create Ink Histogram dialog box.
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Caution:

The ink key histogram will not be updated automatically when the document is changed
or saved.

10.27.  Create Ink Eater Areas...

In Plato you can automatically create Ink Eater Areas. These areas are the non-printed areas
that are not part of the printing jobs. These can be left-overs that will be cut off or the white
spaces next to and in between one-ups. Choose Inks > Create Ink Eater Areas to do so.

 

 

In the Start from the Station's field you can determine the edge of the Ink Eater object. Choose
one of the following:
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• Die Shape: when the Die Shape is defined in the Station's dialog and when it can be used as
edge for the Ink Eater object.

• Trim Box: when the edge of the Ink Eater object is defined by the Trim Box of the one-up on
the plate.

In the Keep Away field you can set the offset for the Ink Eater object in relation to the Die
Shape or Trim Box.

By enabling or disabling the Exclude SmartMarks option you can set whether or not existing
SmartMarks are included in the Ink Eater object or not.

Click Create to create the Ink Eater object. This is an empty contour that is placed in the
document and can be used by the Fill Ink Eater functionality.
 

 

You can clearly see that the created Ink Eater object (red selection) has an offset in relation
to the used Die Cut of the one-ups (blue). The SmartMarks are excluded from this Ink Eater
object. You can now use the zone in this object to compensate the ink key histogram.

Tip:

When you select an contour object that already exists, this contour is used as the maximum
surface from which the Ink Eater Area can be created.

Determine the zone where you want to compensate by creating a contour object. In the case
below we are only going to compensate the upper part of the plate.
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Click Create to turn the selected object into a compensation zone. The Die Shape is set as edge
for the ink eater object. The SmartMarks are excluded in this case.
 

 

10.28.  Fill Ink Eaters...

Fill Ink Eater Areas is an ink eater adjustment tool that allows you to compensate the ink key
histogram for all separations based on the visualization of the ink key histogram.

The ink consumption on the press is determined by the design of the plate: the design of the
plate dictates which ink percentages are used where. Ink consumption is regulated by ink keys
on the press. Every ink key determines the flow of ink to a specific zone on the press. The goal
of the Ink Eater Areas feature is to achieve a constant ink consumption over the width of the
plate. This makes it easier for press operators to set the ink keys, and results in a faster setup
time for the press.

Avoiding "peaks" and "lows" in the ink key histogram also avoids an excess of ink building up
on the press cylinders, which might otherwise spill onto non-printed zones. Adding and filling
Ink Eater Areas to your plate flattens the ink key histogram by filling non-printed zones
with a vignette (gradient). A gradient is used to avoid hard edges in the compensation object,
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and extra options are available to set a minimum ink density, minimum ink key value and to
indicate when the maximum total area coverage (TAC) is too high.

Note:

Total ink consumption on the press will be higher when using ink eaters.

Note:

In PackEdge, you have to create Ink Eater Areas manually with contour objects. The Create Ink
Eater Area tool in Plato can automatically determine suitable areas for use as ink eater areas.

10.29.  Fill Ink Eater Areas wizard

1. Select a contour object or a group of contour objects in the document that can be used for
the compensation. Note that a group of contour objects are linked to one object when using
the Fill Ink Eater Area tool.

2. Choose Fill Ink Eater Areas from the Paint menu to start the wizard.

 

 
3. Select the approprate options:

• Scan: Determine the area the scan has to cover. "All inside Trim box" will take into
account all information within the trim box. "All inside Media Box" will take into account
the information inside the media box.

• Direction: indicate the direction for the compensation. Horizontal means the ink
zones are vertical on the plate and the ink histogram is on the horizontal base of the
document. The direction of the compensation gradient in the ink eater area is horizontal.

• Resolution: indicate the number of intermediate steps of the gradient to be used as
compensation. Use ‘Very Low’ for 5 steps, ‘Low’ for 15 steps, ‘Medium’ for 30 steps, ‘High’
for 45 steps and ‘Very High’ for 60 steps. The compensation is more local when using
fewer steps.

• Merge Similar Inks: the Ink Histogram merges the results for inks that are the same but
have different ruling and/or dotshape.
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4. Click Next.

 

 
5. In Step 2, define the compensation parameters:

• Preset: indicate the intensity of the compensation gradient.

• Minimum Ink Density: set the minimum ink density of the ink separation in the ink
eater area.

• Minimum Inkkey Value: indicate the minimum ink key histogram value for each ink
key zone. The ink density of the gradient is adjusted to make sure the ink key histogram
value is higher than this settings. Keep in mind that it is not possible to have this
minimum inkkey value for all ink key zones when the ink eater area is not large enough.

• Details: click to open the Compensation Details dialog. Modifying the Preset, Minimum
Ink Density and Miminum Inkkey Value settings in Step 2 of the Fill Ink Eater Areas wizard
will adjust these settings for all separations. Use the Compensation Details dialog to
adjust the individual separations.

6. Click OK to fill the ink eater area.

The Compensation Presets in detail

• Choose the Preset "Small" when you want a light compensation to softly smoothen the Ink
key historgram in a local zone.
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The dark magenta area in the compensation graph is the current ink histogram of the
(uncompensated) document. The white area in the graph is the area that can be used
for the compensation as defined by the ink eater area(s). Light magenta areas have been
compensated by the ink eater.

• Choose the Preset “Medium” to fill the compensation area with a gradient, resulting in a
smooth ink histogram.

 

 

The light magenta area indicates the zones that have been compensated. The ink eater area
would look as follows:

 

 

• Choose the Preset “Very Large” to fill the ink eater area with with a gradient to egalize the
ink histogram as much as possible. It is clear that doing this will use more ink.
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As you can see, the compensation is quite strong in this example. The ink eater area is filled
with an ink-heavy gradient.

 

 

10.30.  Compensation Details dialog

Use the Compensation Details dialog to adjust how the ink eater area is filled for individual
separations.
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Tip:

Turn on the Preview option

To fine-tune the gradient in the ink eater area, do one or more of the following:

• Click a separation in the Separations list to view the ink histogram and compensation
room for that separation.

• Select a Compensation Preset to apply one of the standard compensation algorithms to the
ink histogram.

• Set the minimum ink density and/or ink key values for every separation.
• Drag the handles on a bar in the ink histogram to manually tweak the ink key value. The

white bars in the histogram show the allowed compensation room for every bar. You cannot
drag a bar higher than the white area, or below the original uncompensated artwork value.

• Enable the option Maximum TAC and enter a maximum total area coverage (for example,
270%) to display warnings in those areas of the histogram where the total ink coverage
exceeds your limits. The offending bars in the histogram will be highlighted with a blinking
effect.

Tip:

You can select multiple separations to apply the same compensation to multiple separations
simultaneously.
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Tip:

Select multiple separations to apply the same compensation to different separations.

 

 
 

 

When there are more separations selected with conflicting settings, the read out of the
Compensation user interface is not defined.
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10.31.  Open Ink Book

Opens the selected ink book.

Note:

Inks in standard ink books (PANTONE, Toyo, HKS, NCS,...) or PantoneLIVE ink books cannot be
altered. In custom ink books you can rename or delete inks and you can create new inks based
on Lab or RGB values.

Tip:

It is advised not to create custom ink books that contain standard inks as those will not be
recognized as being an ink from the custom ink book, but from the standard ink book.

 

 

The info icon provides extra information on the number of pages, rows and columns of the
selected ink book. Empty ink patches in the book are left open, which implies that the layout of
the ink book appears unaltered the Ink Books dialog box. You can remove empty ink patches
by clicking Remove Empty Patches from the fly-out menu.

You first have to unlock the ink book before you can do certain modifications, like removing
empty ink patches or renaming inks. Creating a New Ink will automatically unlock/lock the ink
book. You can either specify the ink by entering Lab values or RGB values.

Enter a value in the Search box to search for a specific ink in the selected book.

New Ink... allows you to create a new ink by entering Lab or RGB values.
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You can remove inks by selecting the ink patch and selecting Clean Ink from the context menu.

10.32.  Manage Ink Books...

Shows you an overview of all ink books that are installed on the system and allows you to
create, delete and view individual ink books.

 

 

The selected ink book is regarded as the preferred ink book and will be checked first when inks
are entered in the Inks dialog box.

Click New... to create a new ink book on the CMS data tree. All you have to do is enter a name.

Please refer to the chapter 'Open Ink Book' for additional information on how to add and create
inks.

Note:  Plato supports PantoneLIVE ink books. In Manage Ink Books, an icon will show if the

inkbook is a Color Engine Ink Book  or a PantoneLIVE ink book .

10.33.  Number Stations...

Use the Number Stations command to assign station numbers to the stations in your layout.
You must have a station number definition in your station for the numbers to be displayed on
the plate. You can add a station number to a station at any time (in Station View mode). The
actual numbering of the stations takes place in Esko Plato's Sheet View.
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Exactly the same mechanism is used for strip numbers. A strip number is defined in Station
View, the actual numbering is done in Sheet View. The Number Stations dialog box allows to
determine how the actual numbering will be executed (format, sequence, … )

 

 

Numbering

• Format: indicate the number format; numbers or lower or upper case latin characters.
• Start with: indicate the number or character that will be used for the first station.
• Order: select either automatic (by setting start position and direction) or custom (define the

order of the stations by clicking in each station).
• Start: indicate the starting point for automatic numbering.
• Direction: indicate the direction in which the automatic numbering should be carried out.
• Restart numbering every row/column: This applies to automatic numbering. Whenever a

new row (or column, depending on the chosen direction) is started, the numbering restarts
using the starting number (defined under ‘start with’).

• Restart numbering every Grid: This applies to automatic numbering. The chosen sequence
will be applied to each grid individually.

Prefix / Suffix

• Type:

• Fixed: prefix/suffix will be used for each station number.
• Variable: prefix/suffix will change for each new row (or column, depending on the chosen

direction).

• Prefix/Suffix: in case of fixed prefix/suffix, type in the prefix/suffix that should be used.

Please refer to the chapters ' 'Numbering stations' and 'Station/Strip Number tool' for additional
information.
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10.34.  Adjust Masks

The Adjust Masks tool is used to adjust overlapping stations. It will create new masks that are
applied to the stations on the plate. The stations' original masks are not altered. The newly
applied masks will further reduce the bleed of the stations in areas where there is overlap
between two stations.

 

 

After scanning, the Adjust Masks dialog box looks like the one above. All the overlapping
stations have been located and these overlaps have been grouped into records. Each record
represents one kind of overlap which may occur any number of times on the plate. All overlaps
of the same "kind" are grouped together into one record. Choosing a mask decision for a
record will apply that decision to all instances where that overlap occurs. While a plate may
contain many records, only one record is shown at a time in the Adjust Masks dialog box.

1. Quick Adjust splits overlapping masks halfway between the two die shapes.
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If the layout is meant for web printing, you can enable the Continuous Printing option. The
Quick Adjust of the stations at the top and bottom of the layout will take into account that
the layout is repeated, using the vertical sheet size as Repeat Length.

If you do not wish to use the Quick Adjust option, you work in manual mode. This allows
you to make a decision on the priority of overlapping flaps and panels per case.

2. Scan - Click the Scan button to scan the stations on your plate. The Scan button is disabled,
if scanning was done already.

3. Forward/Back - Use the Forward/Back buttons to see each record. The first button moves
to the first record in the list. The second button moves to the previous record in the list. The
third button moves to the next record in the list. Finally, the fourth button moves to the last
record in the list of overlaps. Some of the buttons may be disabled depending on which
record you are currently viewing.

4.
Split Overlap tool  The Split Overlap tool allows you to cut the current record into two
records, each of which can have a different mask decision. This is particularly useful for
plates that contain folding cartons where two flaps on the same carton must be masked
differently. See Splitting an Overlap Record.

5. Record Number - The Record Number show you where you are in the list. In the dialog box
shown above, you are looking at the second record in a list of five records. The overlap
represented by this record occurs twice on the plate (2 Instances).

6. Mask Decision - The Mask Decision Buttons determine how the masks are created. Each
button performs a different specific action on the current record:

•
 A over B - The station marked "A" will overlap the station marked "B". The mask

from station A will be used to cut back station B. If station A does not contain a mask, the
bounding box of station A will be used.

•
 B over A - The station marked "B" will overlap the station marked "A". The mask

from station B will be used to cut back station A. If station B does not contain a mask, the
bounding box of station B will be used.

•

 Split - The masks of both stations will be split between the dies. This is Esko Plato's
default Mask Decision. After scanning, all records will be set to Split initially.

•
 Ignore - A record set to "Ignore" will not be altered by the Adjust Masks tool. This

overlap will be ignored and will remain the way that it is now in the plate.

As you view each Overlap Record, you can choose one of these four Mask Decisions. The
currently selected Mask Decision is displayed in the document window so that you can see
the result of this decision. This way, you can view the effect of all the choices to make the
right decision.

7. Limit Bleed - Check the Limit Bleed box and enter the maximum distance over wich one
station 'bleeds' into the adjacent station.

Please refer to the chapter 'Adjusting overlapping stations' for additional information.
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10.35.  Create Varnish

Create Varnish loads a varnish layer. When a CAD layout is loaded, the function ‘Create Varnish’
will be enabled. This allows to create varnish areas based on the loaded CAD layout. If the CAD
layout contains coating free areas, these can be taken into account.

Note:

The varnish ink must be defined in the ink table already.

 

 

The varnish areas can be assembled by creating a contour that defines the outer limits of the
varnish. This contour can be:

• From Graphics: Present in the graphics.

• On Sheet: Based on the boundaries of the sheet.

• On Die Bounding Box: Based on the bounding boxes of the individual dies.

• On Die Outline: Based on the union of all die lines.

Excluding from the above mentioned contour, are the areas defined in the CAD layout as
‘varnish free’ areas (Artios MFG files only).

Note:

The 'Load Varnish Free Areas for CAD' becomes available only when the file contains varnish
information.
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Note:

The 'From Graphics' option becomes available only when the CAD file contains varnish (or
rather 'coating free') areas.

When this option is selected, no real varnish area will be created (as the varnish info is already
part of the graphics). Only the varnish free areas from the CAD file are used to selectively knock
out areas in the varnish separation.

You can define an offset.

Note:

The offset direction depends on whether you create a varnish based on sheet (offset to the
inside, a negative offset) or based on die shape (to the outside, a positive offset).

10.36.  Manage Plates

'Manage Plates' allows you to set up a collection of pre-defined plate sizes. The list of plate
sizes will be available in the Layout Setup.

 

 

10.37.  SmartMarks

Note:

While marks are common to Esko PackEdge and Esko Plato, a certain number of SmartMarks
are specific for Esko Plato (and are not supported in Esko PackEdge): the ‘Position Marks’ and
the complete range of QuickStep regmarks. The QuickStep regmarks are only available if the
QuickStep license is active.

The SmartMarks dialog box allows you to create, save, open and edit sets of SmartMarks. Sets
can be saved to disk and can be used during output. SmartMarks are regenerated as soon as
something in the job changes: job size, ink definitions...
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SmartMarks can be attached to

• the general level
 

 

• a sheet
 

 

• a plate
 

 

• visible objects
 

 

• a grid
 

 

• Position Marks (objects in your job which have an object name)
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Click the black arrow
 

 
to activate the fly-out menu.
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• Options...: Opens the SmartMarks dialog box for the selected mark. Please refer to the
chapter 'Supplied SmartMarks' for an elaborate explanation of the individual marks.

• Turn: Relocates the SmartMark, using the vertical axis of your job.
 

 

• Tumble: Relocates the SmartMark, using the horizontal axis of your job.
 

 

• Convert to Objects: This converts the selected SmartMarks to objects. These objects will
look like marks in your job, but they are in fact dynamic objects and will behave like ordinary
objects: they can be edited, rotated, scaled...

• Delete Removes the selected mark from your list.
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• Clear Object Name: If the SmartMark has an object name, you can clear it here.

• New Set...: empties your list of marks.

• Open Set...: opens a saved set.

• Load Set...: adds a saved set to your list.

• Save Set...: saves your list.

• Save as Set...: saves your list under a new name.

• A list of recently used sets.

Tip:

To change the name of a SmartMark, click it in the list and edit the field.

Tip:

An easy way to identify the elements in your job is to use Position Marks.Select the object. The
SmartMarks dialog box highlights 'Untitled'.

 

 

Click and hold this item, the field will become editable, enter a new name.

Note:

It is important to know that all sets will be saved in the data directory of Esko Plato:
bg_data_marks_v010/dat.

Note:

Although the extension of a SmartMark set is .GRS, sets can both be used in PLA files as in
PDFPLA documents.

For additional information on how to work with SmartMarks, please refer to the chapter 'Using
SmartMarks'.
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10.38.  Staggered Cutting...

For more information on the concept of Staggered Cutting and how to use it, see Staggered
Cutting on page 165

 

 

Path Shape Options define how the shape of the cutting path will be generated from the red
selected contour.

• Repeat Length specifies the circumference of the cylinder. In normal situations, this equals
the height of the sheet (which is also the default value). Note that formulas can be used.
Basically, the cutting path will contain two identical horizontal segments (generated by
taking the red selected input contour) which will create the seam. The distance between
these two segments is the ‘Repeat Length’. These 2 segments are connected through
vertical segments which correspond with the plate edges.

• Truncate on Center will modify the shape of the red selected object so it is pulled to the
nearest centerline between the die shape of the stations. When calculating the center
line, stations are virtually copied over the repeat length. Stations that are heigher than the
repeat length are ignored (typically these stations contain an overlay layer with marks).
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If there are any other objects that should be taken into account when calculating the
centerline (ex bearer bars), select these in green.

• Extend to Plate Edge: will extend the selected path to the width of the Plato plate (default
this option is on). If this option is deselected, the left and right point from the red selected
contour are important – these will determine the width of the staggered cutting path..

• Specify a Gap at Seam when it is wishful to make the flexo plate a bit smaller than the repeat
length. The distance between the two identical segments will be the Repeat Length minus
the Gap.

• If the Different value outside sheet option is enabled, the Gap at Seam is not applied outside
of the sheet. This can be used e.g. to apply no gap in between bearer bars. By using a
positive Extra Size (outside sheet) value, you can make the flexo plate a bit larger outside
of the sheet, e.g. to make bearer bars overlap, so these can be cut with a knife when
mounting. When setting an Extra Size, you can choose to add this extra size at the top or the
bottom.

• If you enable Slide at Bearer, the staggered cut module will recognize bearer bars (elements
the same height of the sheet, outside of the sheet) and cut through these by a diagonal line
instead of a horizontal line. This is to avoid a hard gap, that could result in bouncing effects
on the press. Use Amount to define how much the cut is slanted.

• Round Corners will modify the red input contour so that corners are rounded to the
specified radius. Rounded corners facilitate cutting and damaging the plate when taking it
off the cylinder.

Separation Options allows to define if the cutting path is to be used for every separation
or for the selected separation(s) only. If an existing staggered cutting path is selected, the
Separation Options are updated to reflect in which separations this path is active.

Cutting Options specify how the staggered cutting path will be cut on the Kongsberg table.

• Tile Plate will generate a number of additional vertical cutting lines. The horizontal positions
where these cut lines are created is defined by vertical markup lines. These markup lines
can be adjusted manually or numerically. The number of vertical cutting lines is defined by
the selected number of Tiles.

• Add Nicks leaves small interruptions (nicks) in the cutting path to make sure the flexo
material remains connected (and is better kept by the vacuum on the cutting table). The
nicks are added on the 4 corners of the cutting path.

• Cut to Edge will split up the cutting path so that the 2 horizontal segments are cut first,
followed by the vertical segments. Each vertical segment is cut in 2 parts, each time starting
from the center going to the corner.

• Blank Pixels Under Path will generate a knockout stroke on the staggered cutting line, to
make sure there is no imaged area under the staggered cutting line. Since cutting can
slightly increase the thickness of the plate around the edges, cutting through imaged areas
could cause problems on the press.

• Blank Pixels Outside Path will generate a knockout area which covers all objects that lay
outside the cutting path. This object can be used to knockout excessive bleed.

• Visualize cutting line will generate a small stroked line indicating the cutting path. This can
provide a visual indication for an operator to manually cut the plate. The width of the stroke
and the offset from the actual cutting path can be set.

Extract for Editing creates a regular path that can be edited, in order to modify the staggered
cutting line. See Changing a staggered cutting line on page 167

The Create button becomes active when there is one contour selected in red (the input
contour). It will create a cutting path in a dedicated layer (named ‘Staggered Path’).
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If an existing cutting path was Selected, the button changes to Modify. In that case, the existing
cutting path will be replaced by the new one as there can only be 1 cutting path at a time.

See Staggered Cutting for a workflow example.

If the Cylinder preview option is selected, an extra row of graphics above and below the layout
is shown, simulating the graphics from the previous or next cylinder impression. Note that this
is only a visual aid for drawing cutting lines. When cutting through graphics above or below the
layout, you should use the Continuous option in the grid dialog.

10.39.  Check Job Parameters

In Esko Automation Engine, 'Check Job Parameters' allows you to check your files for
inconsistencies regarding Job parameters (type of bar code, inks, certain RIP parameters,... )
that are predefined for a Automation Engine Job and allows you to correct them (if necessary).
Esko Plato only checks the ink job parameters.

Note:

'Check Job Parameters' will only be active if your Esko Plato station is connected to an Esko
Automation Engine server.

The Check Job Parameters function lists all conflicts. For example:

 

 

Job Parameters are automatically checked when opening or saving a file. Information regarding
Job Parameters is also displayed in the Info window.
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10.40.  Workspace

It is possible to save, for each opened dialog box and palette, its position, size and some dialog-
specific settings like e.g.the width and visibility of the columns in the Grid dialog box. This kind
of information is saved in a ‘workspace’.

• [Default]: switches back to the factory default.
• Save

• Manage

10.40.1.  Save Workspace

Save a workspace and use Manage to rename or delete previously saved workspaces.Saving
stores the positions of all open palettes and dialog boxes when exiting the application.

After starting up Esko Plato, all user interface dialog boxes will take the position they had when
exiting.
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Tip:

All toolbars on the Window menu can either be used as docked tools or as proper dialog
boxes.

10.40.2.  Manage Workspace

The Workspace Layout Manager allows you to make some predefined workspaces of the user
interface dialog boxes and to switch from one to another with a single click. The positions of
all open palettes and dialog boxes are saved when exiting the application. You can start with
default palette positions or restore default positions. You can also save multiple layouts as
different workspaces.

 

 

10.41.  Toolbars

All toolbars can easily be shown or hidden easily via the toolbars list on the Window menu:

• Crosshair Position

• Preview Selector

• File & Edit

• Layout Type

• Station Selector

• Status Bar

• Tools

• View Selector

Tip:

All toolbars on the Window menu can either be used as docked tools or as proper dialog
boxes.

For a detailed overview of the various tools and toolbars, please refer to the chapter 'Toolbars'.
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10.42.  Align

Click 'Align' on the Window menu to open the Align dialog box.

 

 

Align to Sheet - The Align to Sheet section aligns the center of a red selection to the center of
the sheet. These options do not use green selection.

 Center horizontally on Sheet - Aligns the center of the red selection to the center of the
sheet from top to bottom.

 Center vertically on Sheet - Aligns the center of the red selection to the center of the
sheet from left to right.

Align by Attribute - The Align by Attribute section aligns the attribute of the red selection to
the same attribute of the green selection. The attributes that can be aligned are: left, right, top
and bottom edges, and the center (vertical alignment) and middle (horizontal alignment) of the
objects.

 Align Left - Aligns the left edge of the red selection to the left edge of the green
selection. Movement is horizontal only; vertical position of the red selection remains
unchanged.

 Align Center - Aligns the center of the red selection to the center of the green selection.
Movement is horizontal only; vertical position of the red selection remains unchanged. Align
Right - Aligns the right edge of the red selection to the right edge of the green selection.
Movement is horizontal only; vertical position of the red selection remains unchanged.

 Align Top - Aligns the top of the red selection to the top of the green selection.
Movement is vertical only; horizontal position of the red selection remains unchanged.
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 Align Middle - Aligns the middle of the red selection to the middle of the green
selection. Movement is vertical only; horizontal position of the red selection remains
unchanged

.  Align Bottom - Aligns the bottom of the red selection to the bottom of the green
selection. Movement is vertical only; horizontal position of the red selection remains
unchanged.

Align Edge to Edge - The Align Edge to Edge section is used to align the nearest opposite edge
of the red selection to the green selection. For example, the Align Left to Right button on the
top aligns the left edge of the red selection to the right edge of the green selection. The Align
Edge to Edge commands can also be used with a Gap. Entering a gap, aligns the opposing
edges with the specified gap in between them.

 Align Left-to-Right - Aligns the nearest opposite left or right edge of the red selection
to the right or left edge of the green selection. The opposing edges are aligned leaving the
Gap amount specified between them. If the Gap amount is zero, the opposing edges abut.
Movement is horizontal only; vertical position of the red selection remains unchanged.

 Align Top-to-Bottom - Aligns the nearest opposite top or bottom edge of the red
selection to the bottom or top edge of the green selection. The opposing edges are aligned
leaving the Gap amount specified between them. If the Gap amount is zero, the opposing
edges abut. Movement is vertical only; horizontal position of the red selection remains
unchanged.

For all information on how to use the Align tool, please refer to the chapter 'Using the Align
Window'.

10.43.  CAD

The CAD dialog centralizes all functionality needed in a CAD-based workflow.
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The CAD dialog box is built up of a number of columns: Design and Station.

If CAD data is loaded the name of the CAD file will be indicated on the first line of the CAD
dialog. Click the 'Select' button to import or replace the CAD layoutThe Import CAD Data dialog
box will pop up. If CAD data is loaded, this will replace the current CAD data.

Using the Orientation buttons or by entering an angle, you can define the rotation angle of the
CAD layout.

Click the 'Assign/Replace Stations' icon  to replace the selected station(s).The Replace
Station dialog box will pop up, together with an extra dialog box that indicates whether or not
the selected station matches the selected design.

 

 

Click the 'Info' button  to view or adjust the properties of the selected station.For more
information about the options in the Properties dialog box, please refer to the chapter 'Station
Properties'.

Click the arrow in the top-right corner to select one of the following items from the fly-out
menu.
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• 'Import CAD Data...' has the same function as Import CAD Data on the File menu.
• 'Remove CAD Data' removes that CAD layout and all associated stations.
• 'Release CAD Layout' removes the CAD layout but keeps all associated stations. After

releasing the CAD layout, the stations no longer are tied up together and can be moved
individually.

 

 
• Replace Station... opens the Replace Station dialog box.
• Assign Station to Design... opens the Assign Station dialog box.
• Station Properties... opens the Station Properties dialog box.

For more information on creating a CAD workflow, please refer to the chapter 'CAD workflow'.

10.44.  Calculator

The Calculator allows you to create, modify or remove parameters.
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For more information on formulas and working with the calculator, please refer to the chapter
'Calculator and Parameter Formulas'.

10.45.  Colors

In the Colors dialog box you define, add or modify colors and vignette colors to be applied to
objects.

Note:

The Colors dialog box can only be used in combination with the Geometry Mark tool.

 

 

Color swatchesTo define, add or modify colors or vignette colors to be applied to objects.

When you click a color swatch to add a color, it is automatically filled with an empty color
(white).

Note:

You can also resize the Style Bar horizontally, to display more color swatches.

Color Name input boxTo define a “work” name for the selected color swatch in the Color
Palette, to help you to identify the color for a category of objects.

You created a drawing with a blue color for the sky and a blue color for the ocean. For the
first blue color, you can enter the name “sky” and for the second blue color, you can enter
the name “Ocean”.

When you select the name, the color with that name becomes selected in the Color Palette.
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Caution:

The name you enter in the Color Name input box is job related and is only a tool to
quickly retrieve colors. It is NOT a designer ink that you create here.

There are 2 special entries in the color palette:

•
registration color 

•
darkest color 

Vignette

To change the selected color from a plain color to a vignette color or vice versa. The vignette
options display in the Color factory. For more information about the vignette options, we refer
you to the Vignette Color Factory. The highlighted button indicates that a vignette color is active
for the selected color swatch in the Color Palette.

Caution:

White, which is the empty color that automatically appears in the color swatches when
you click them, is also a color. When making a vignette from a color to the empty color
white, be aware that white is 100% opaque.

10.46.  Color Factory

Use the Color Factory to display or modify the selected color.

Open the Color Factory by:

• Ddouble-clicking a color swatch in the Color palette,
• activating Vignette in the Color palette.

 

 

You can display or modify the selected color in the Color Factory.

1.

Color Factory

You can modify the percentages of inks with the slider or the spin boxes. You can add an ink
by entering the initial of the ink name in the input box, next to the ink value input box. This
adds a new ink (if still non-existing) to the Inks dialog box.
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2.

Ink Factory

To display or modify the inks that will be used to print a color when a job is printed or
processed.

Vignette Color FactoryTo create color vignettes.

When you select an (empty) color swatch in the Color Palette and then click the vignette
button, the Vignette Color Factory appears. The Vignette Color Factory is an extension of the
Color Factory.

Vignette Points and CurveTo determine how the color will be averaged between the colors
assigned to the points on both sides.

• The vignette points are used to determine the color for the vignette, and the vignette curve
is used to determine how the colors (between two or more points) will be graded.

• Two curves (and their corresponding points) are displayed by default for the vignette. You
may add curves and points by clicking the intersecting points and dragging the points to the
top of the vignette curve, or by dragging and dropping additional colors to the intersecting
points.

• Delete colors from the vignette by clicking the point that represents the color you want to
delete and dragging it downward, outside of the Vignette dialog box

Vignette EnvelopeThe envelope in the vignette Color Factory contains the Color Factory or the
Ink Factory.

Smooth Vignette Button Essentially, the smooth vignette button activates an
automatic mechanism that determines the course of the colors in such a way that banding is
no longer visible in the vignette.

Position of Vignette Color

Enter a numeric value in the input box to change the position of the vignette color.

The default is 50 for intersecting points and 100 for starting and ending points. The
intersecting point remains between 13 and 87.

The icon  before the input box will change, depending on the vignette point you clicked
on, into an intersecting point or a beginning or ending point.

Opacity

Determine the opacity of the selected vignette color by entering a value in the input box.

Vignette Direction

Click this button to indicate the starting and ending point for the vignette in the job. The point
you click first is the point where the vignette starts. The second point you click is the point
where the vignette ends. The points can be selected and replaced. If you replace the points
within the vignette the color for this vignette will also be adapted. Consequently also, the color
swatch in the Color Palette, displaying the vignette color, will be adapted.
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10.47.  Effects

The Effects dialog box can appear when setting the style of a geometry mark and allows
you to add more advanced transparency settings. In the Fill and Stroke tab entry you can
apply transparency settings on the fill and stroke attribute of the selected objects from the
document, in the Group tab entry (when a group or combi-object is targeted) you can apply
transparency effects to the object or group it self.

Fill and Stroke tab entry contain the same options.

 

 
 

 

The Object/Group tab contains specific transparency options for PDF Transparency groups.
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Opacity & Mask Define Knockout Shape checkbox keeps a knockout effect proportional to
the masking object’s opacity. The knockout effect will be strong in areas of the mask that are
close to 100%; the knockout effect will be weaker in areas with less opacity.

The Isolate Blending checkbox prevents blending modes applied to objects within a group
from being applied to objects beneath the group. This option is only useful when used on
groups that contain at least one object with a blend mode other than Normal applied to them
or when used on individual objects that have a blending mode other than Normal applied on
the stroke and fill attribute of the object.

Check the Inherit Knockout Group from Parent checkbox if you want to group objects
without interfering with the knockout behavior determined by the enclosed layer or
group. Clear the option and check the Knockout Group checkbox to prevent transparency
from revealing underlying objects within the group.To make sure that a layer or group of
transparency objects will never knock each other out, clear both the 'Inherit Knockout Group
from Parent' and 'Knockout Group' checkboxes.

10.47.1.  Changing the Opacity Gradient

The Opacity Gradient offers a wide range of opacity gradients to be applied to the object, fill
and/or stroke attribute of an object. The Opacity value lets you vary the transparency with a
constant value, but the Opacity Gradient tool allows you to set varying levels of transparency.

The Opacity Gradient dialog still contains the alpha modes that were available in PackEdge
5.0 and earlier versions, but make them clearly visualized by a small thumbnail preview:
linear, linear updown, conical, conical updown, elliptical, elliptical updown, elliptical eccentric,
elliptical updown eccentric, rectangle, rectangle updown, rectangle eccentric, rectangle
updown eccentric, parallellogramic, parallellogramic updown, parallellogramic eccentric,
parallellogramic updown eccentric, edge, softmask and CT mask.
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10.47.2.  Creating and Editing PDF Opacity Masks

The Opacity Gradient dialog allows you to create and edit PDF Opacity Masks in PackEdge
6.0. Any object in a document, even linked files, can be used as a mask for another object.
The mask overlays the selected object, covering entirely where the mask is solid or partially
showing through based upon the shades of colors on the mask. The level of opacity is based
on the difference of the luminance from the colors of the mask and the object: white is 100%
opaque, black is 100% transparent and grays (colors change to grayscale on a mask) have
varying levels.

 

 

Create a PDF Opacity Mask by double-clicking on the Opacity Gradient icon in the Effects
dialog to open the Opacity Gradient dialog. Select the opacity mask into a green selection
and the object on which the opacity mask has to be applied into the red selection. Press the

Opacity Mask button ( ) to apply the green selected object as an opacity mask to the targeted
object(s). When the green selection contains more than one object (a group with all individual
objects selected is considered as one object), the objects of the green selection will be grouped
before to be applied as an opacity mask.
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The Clip checkbox makes an opacity mask double as a clipping mask, which caused the masked
objects to be invisible outside the boundaries of the masking object.

The Invert Mask checkbox reverse the luminosity values of the masking object, which reverse
the opacity of the masked object. For example, areas that are 15% transparent become 85%
transparent after inversion.

By using the Transform Opacity Gradient tool you are able to transform the mask object.
The mask object can be moved to another position relative of the masked object, scaled
and transformed. Press a tool from the toolbar dialog to stop modifying the Opacity Mask
transformation (or press the spacebar to make the selection tool active).

Release the Opacity Mask from an object by selecting the object mask object into the red
selection and clicking on the Release Opacity Mask button in the Opacity Gradient dialog. The
Opacity Mask object will be put into the green selection.

Edit the Opacity Mask by first releasing the Opacity Mask from the masked object. After you
have modified the masked object, you have to recreate the Opacity Mask by clicking on the
Opacity Mask button to apply the green selected object as an opacity mask to the red selected
object(s).

Note:

when an object having an opacity mask is transformed (moved, scaled, rotated, shear) in the
document, you have the choice to determine how the opacity mask has to behave:

• Check the Scale Vignette toggle in the Transform tool options dialog to apply the same
transformation on the mask object.

• Uncheck the Scale Vignette toggle to only transform the masked object. The mask object will
not be transformed

10.48.  Grids

The Grids dialog box allows you to create step and repeat blocks set their numeric parameters.
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1. Grid Number
2. Station Name
3. Add Station / Add Empty Station

 Click the 'Place Station' icon to add stations to the sheet.

 It is possible to place so-called empty stations by clicking the 'Place Empty Stations'
icon. You would do so when you are designing a layout before having received the actual
graphics. However, in that case, you would need the exact measurements of the future
graphics, as Esko Plato will ask for them in the Place Empty Station dialog box:

 

 

Use the ‘based on File’ option together with the the ‘Select File’ button if you want to create
an empty station based on an existing file. This offers 2 possibilities:

a. select an existing graphics file (grs or normalized PDF). In this case, the size of the
selected graphics will be used as the size of the empty station.

b. Select a CAD file. In this case, the CAD data will be used to define the die shape of the
empty station and the size of the station will match the bounding box of the CAD data.

You can change the standard color by clicking the color patch, which will make the Color
Picker pop up. Simply click in the color area that you wish to use for your empty station.
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 Click the 'Remove Grid' icon to to delete the selected grid.

Tip:

Stations that were used previously in the current layout can be recovered by clicking the
little arrow in the Station Name column.

4. You can view or adjust the Grid Settings in a number of ways:

•
Click the Info button 

• Double-click the grid number.

• Select Grid Settings from the top-right fly-out menu.
• Select Grid Settings from the fly-out menu in front of the station.

5. Die Shape
6. Bleed
7. Advanced Settings indicate if stagger, geometry or distribute settings have been changed.
8. Vertical / Horizontal Offset from Sheet (formula-enabled)
9. Vertical / Horizontal Count (formula-enabled)
10.Vertical / Horizontal Gap / Step (formula-enabled)
11.Rotation Angle (formula-enabled)
12.fly-out menu

The Grids dialog box is built up of a number of columns.To show or hide columns, click the
arrow in the top-right corner and select 'Select Columns' from the fly-out menu.
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Tip:

The width of the different column can be adjusted by dragging the vertical separators between
them.

Tip:

Stations that were previously used in the current layout can be recovered by right-clicking an
empty cell in the ‘Station Name’ column. By repeating the previous steps, you can add, delete
or modify the stations that you intend to use in the current layout.

For more information on creating a grid-based workflow, please refer to the chapter 'Grid-
based workflow'.

10.49.  Info Window

The info window displays information that the editor generates about the job.
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Warnings are displayed in orange, errors are red.

 

 

You can define the Info window's behavior. Click the black arrow and a the different
possibilities pop up.

• Always pop up Info window
• Pop up info window only for errors/warnings
• Pop up info window only for errors.

Clear Info, clears all messages in the dialog box.

 

 

10.50.  Layer Browser

You work with layers with the Layer Browser. Click 'Layer Browser' on the Window menu.
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The features of the Layer Browser are detailed below.

Print Layers can be set to be printable or non-printable. Click the Print icon next to each
layer to toggle between the two choices. Clicking the icon at the top of the Print column toggles
all the layers to printable.

Visibility Layers can be displayed or hidden. An eye icon in the box indicates the layer is
turned on. Click the box to turn the layer on or off. The eye button at the top of the column
turns all layers off except the current layer. A layer that is not displayed cannot be edited and is
locked.

Lock Layers can be locked or unlocked. A padlock icon indicates the layer is locked and its
contents may not be selected or changed. Click the box to lock or unlock the layer. The padlock
button at the top of the column locks or unlocks all layers.

Add/Delete Layer Layers can be added or deleted from the document. From left to
right, these icons are add a grid layer, add a markup grid layer, add an object layer and delete
a layer. The delete layer button can be used to delete any layer in the list. Deleting a layer
deletes the layer and all the objects on the layer.

Allows you to add a new Grid Layer.

Allows you to add a new Markup Layer.

Active LayerThe Active Layer is the layer to which all new objects will be added. The current
Active Layer is shown with a black triangle at the top-right corner of the layer. To make a layer
the active layer, click its name in the layer list. There is a difference between a layer being
selected and a layer being the active layer. For example, you can select a grid layer but it will
not become the active layer because objects cannot be placed on grid layers.

 A little red square indicates the layer contains red selected objects. A big red square
indicates that all objects of a layer are selected in red.

A double ring ( ) indicates the object is targeted (or is the current active). The Style and
Effects dialog boxes show the properties of the object that is targeted.

Snap On/Off Snap can be turned on or off for grid and markup layers. Click the 'Snap
On/Off' icon for the layer to toggle between the two choices. In the window shown above,
objects will not snap to the layer named 'Markup Grid' but will snap to objects on the layers
named 'Grid Layer'.
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Note:

Clicking the object name in the Layer Browser does not select the object in the document, but
selects the object in the list from the Layer Browser.

• The drag and drop functionality to move object to another position or into another group
works on the objects selected in the list.

•
Clicking the remove button  will delete the objects selected in the list and not the
objects that are selected in the document.

Setting up several grid layers and then choosing which ones to snap to is useful when creating
a complex layout. See below for details about creating grid and markup grid layers.

10.51.  Pan Window

Use the Pan Window to see an overview of your document and the current view. The document
is displayed as a thumbnail with a rectangle indicating the current view.

 

 

You can program views that you intend to use more than once with this job. The job is
represented as a thumbnail over which lies a representation of the viewport rectangle.If you
select another job that is on the screen, the dialog box will be updated.

Viewport rectangle (selection of the thumbnail view)The viewport rectangle lies over the
thumbnail view.

You can see the viewport rectangle in the image window and follow its movements in the
thumbnail view. The viewport rectangle will be updated each time you make a change to your
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window view, and conversely, if you move this small viewport rectangle over the Pan box
thumbnail view, the view within your current window will be updated at the same time.

To move the viewport:

• Press the arrow keys on the keyboard.
• Press the buttons that appear in the envelope.
• Drag the viewport rectangle in the thumbnail view of the image.

If you click and hold the cursor over the thumbnail view, the viewport rectangle follows the
point of the cursor until you release the mouse button and drop the viewport rectangle at
the desired part.

• Or click the program buttons (if they have been programmed yet).

Program buttonsTo preset some view selections for each image on the screen. These settings
will be saved, to reuse them during your current session. The settings are kept as long as the
image for which they were programmed stays on the screen.

RepaintTo refresh the thumbnail view. If you moved the viewport rectangle in the thumbnail
view and you click Repaint, the thumbnail view is resized until it contains the complete
viewport rectangle and the image in total view. Use the Repaint plug to automatically repaint
the thumbnail view each time your job changes.

Please refer to the Pan tool chapter for more information on how to use the tool.

10.52.  SmartLayout (Optional)

Thanks to the SmartLayout option you can optimize the distribution of different labels on
your sheet automatically and it takes but a few seconds. It uses different optimizing methods
depending on your workflow, it offers dynamic feedback on suggested layouts and operator
(inter)actions, e.g. run length, waste, overrun, …

 

 

The SmartLayout dialog box is built up of a number of columns.
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• The 'Check' column indicates whether or not the station is indicated in the SmartLayout
search. If a station is ignored, it will not be taken into account when creating the optimal
layout.

• Front Side short name
• Front side graphics
• Click the 'Ordered' edit field to enter number of stations. This number is expressed in

thousands (‘K’).
• 'Placed' indicates the number of times this station is placed in the current layout. This

number is read-only.
• 'Overrun' indicates the amount of overrun in actual numbers and in percentage of the

ordered quantity.

You can show and hide columns by clicking the top-right arrow and selecting 'Select Columns...'
from the fly-out menu.

Add stations by clicking the 'Add Station' icon 

Add empty stations by clicking the 'Add Empty Station' icon Please refer to the chapter
'Adding a station' for more information.

Click the 'Info' button  to view or adjust the properties of the selected station.For more
information about the options in the Properties dialog box, please refer to the chapter 'Station
Properties'.

Find Optimal Layout

Keep current layout: Keeps the current layout but replaces the stations from the layout by
taking matching stations from the list of selected stations in the SmartLayout dialog. While
replacing, the ordered quantities are taken into account to optimize the run length.

Click Search. The SmartLayout tool will order the selected stations on your sheet in the best
possible way in terms of ordered quantity, overrun, waste... The amount of overrun is indicated
in actual numbers and as a percentage of the ordered quantity.‘Search’ creates a new layout ,
removing all stations that were placed on the layout before activating the function. Esko Plato
will suggest a number of layouts. The one that is visualized is regarded as the most optimal
one. Of course, you can at any time opt for another layout by using the step buttons.

Click the ‘Options' button to further refine your layout.

Click 'Load All Products...' from the fly-out menu to load all Products of the Job in which you
are working.

For more information on creating a SmartLayout workflow, please refer to the chapter
'SmartLayout workflow'.

10.53.  Search Options

The Search Options dialog box appears when you click the 'Options' button in the SmarLayout
dialog box.
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Fill Settings

• Fill Direction: defines the fill direction. You basically choose the corner from which the
SmartLayout starts the repetition.
 

 

• First Cut: define the direction of the first cut: horizontal and vertical

• Fill Mode: Choose a fill mode

• Minimal Overrun: this option will try and place stations on a plate so that the requested
number will be matched as closely as possible.

• Minimal Waste: this option will try to keep the waste as low as possible. Waste is the
combination of overrun and those parts of your paper you did not print on.

• Strips Only: the fill will be as such that one strip will contain the repetition of only one
Station

• Complete Strips: this mode is the same as Strips Only, but the strips will be full. The
Overrun parameter will be ignored.
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• Maximum Waste: define the maximum allowed waste in percentages.
• Sort jobs for better fit: if this option is disabled, the order of stations from the

SheetInspector will be replaced when placing stations on the sheet.
• Gutter Height and Gutter Width: define the gutter dimensions.

10.54.  Stations

The Stations dialog gives an overview of all currently defined stations. It shows:

• the station's pseudo name
• the graphics used on the front side
• the graphics used on the back side
• the die shape. You can select a different die shape by clicking the arrow.
• the bleed mask. The bleed field is editable.
• the total number of copies placed on the layout
• Removing a station (only possible if station is not used on a layout)

You can show and hide columns by clicking the top-right arrow and selecting 'Select Columns...'
from the fly-out menu.

1. Add stations by clicking the 'Add Station' icon 2. Add empty stations by clicking

the 'Add Empty Station' icon Please refer to the chapter 'Adding a station' for more
information.

3. Click the 'Info' button  to view or adjust the properties of the selected station.For more
information about the options in the Properties dialog box, please refer to the chapter 'Station
Properties'.

4. You can remove a station by clicking  You can only remove a station if the station has not
been used on a layout.

 

 

10.55.  Style

The Style window allows you to set the parameters for the mark that you create. You can
choose whether your mark has a Fill, a Stroke or both. You can choose the colors of the fill and
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stroke as well as the line width for the stroke. You can also set colors in Geometry Marks to
overprint other objects. Finally, you can choose for the color to be Registration color, which
means that the color contains 100% of all inks in the document.

To set the Style of a Geometry Mark, use the Style dialog box:

 

 

The Style dialog allows you to add a color for the fill and stroke and to apply some
transparency effects to the Fill and Stroke attribute. Additional stroke options can be set when
the Stroke group is expanded in the user interface. New in the Style dialog is the possibility
to apply a blend mode or opacity to an object or group. With the latter you create the so
called PDF Transparency groups. A PDF transparency group is a group of objects that have a
transparency effect (blend mode or opacity). These PDF transparency groups are treated as a
single object relative to underlying objects.

A shaded circle in the title bar of the groups indicates when a Fill, Stroke or Object has a
transparency applied. Double click his icon to show the Effects Dialog in which you can apply
more transparency to the object.

Specifying default settings for transparency features: if you change transparency settings when
no objects are selected, the settings are applied to newly created objects.
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Note:

When 2 or more objects in the document with a different value for the same attribute are
selected, an unknown state is displayed in the user interface. In this example 2 objects with
a different blend mode for the fill are selected in the document. Also the title bar shows an
unknown state because one of the selected objects still has the default transparency settings
(blend mode “Normal”), while the other object has a blend mode different from “Normal”.

 

 

10.55.1.  Fill

 

 

1. The color swatch shows the current color for the fill of the selected mark or one that you
are about to create. The color displayed is based on the settings of the Color Factory. Check
the box to activate the Fill attribute.

2. Click the Clipping path icon to knock out all data outside the borders of the path.

A clipping path is a vector path which allows part of an image to show while hiding the rest
(usually its background) effectively rendering part of the image transparent. It is a means
to make parts of an image opaque and parts of an image transparent. Usually it is used to
"knock out" the background. It is also a way of changing the rectangular-shaped boundary
of a bitmap image into a shape of your choice.

3. Click the arrow to select a blend mode from the list.
4. Click the arrow to adjust the opacity using a slider.
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5. Turn overprint on or off by using the overprint checkbox.

The shaded circle
 

 
indicates that certain attributes have a transparency applied.

Tip:

Clicking the arrows
 

 
expands or contracts specific parts of the Style window.

Tip:

Clicking the Fill title bar opens the Effects dialog box.

10.55.2.  Stroke

 

 

The Stroke Color box shows the current color for the stroke of the selected mark or one that
you are about to create. The color displayed is based on the settings of the Ink Sliders.

The Stroke Width field shows the stroke width in the current units.

Click the arrow to adjust the transparency using a slider.
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Turn overprint on or off by using the overprint checkbox.

10.55.3.  Group

Adjust the opacity, click the arrow to adjust the transparency using a slider.

10.56.  Transform

Click 'Transform' on the Window menu. The Transform Window appears:
 

 

9-point Selector - Use 9-point Selector to see information about a particular point in the
current selection. The nine points that you can select are the four corners, the midpoints
between the four corners and the center. The current point is highlighted with a black line
around it; in the window above, the center point is the current point.

Location - The Location fields show the vertical and horizontal location of the current point. In
the above window, changing the values in these fields will place the center of the selection at a
new location.

Size - The Size fields show the height and width of the current selection. Changing values
in these fields will scale the object so that it should have the height and/or width that you
entered.

Angle - The Angle field shows the angle of the current selection.

Scale - The Scale fields show the vertical and horizontal scale of the current selection.

Transform Window Tips

• Depending on the current selection, some of the fields may be disabled. See Transform tool
for transformations that are allowed on Esko Plato objects. If no object is selected, all fields
are disabled.

• The Location and Size fields display information about the die if either a CAD layout or a
station are selected. For example, if a station is selected, the size in the Transform Window
will display the location and size of the die, regardless of any bleed included in the station.
The same is true for a CAD layout. This functionality makes it easy to accurately locate the
first cut of the die at a specific location.

• If the current selection includes multiple objects, some that contain dies and some that do
not, the location and size fields display values for the bounding box that encloses all the
selected objects.

• SmartMarks can be moved, either interactively or numerically. However, the rotation (angle)
of SmartMarks cannot be changed with either of these methods. However, the orientation
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of most SmartMarks can be determined by means of their parameters. If you need to rotate
a SmartMark, double-Click the mark and change its parameters in the corresponding dialog.

Please refer to the chapter 'Using the Transform Window' for more information on how to use
the Transform options.

10.57.  Color Picker

The Color Picker allows you to pick a color to represent a station in ‘dummy color’ mode.

 

 

10.58.  Grid Settings

The Grid Settings dialog box offers all options to create your ideal step-and-repeat layout.
You can enter numeric values, but you can also opt to work with formulas. Right-click an edit

field and the Calculator will pop up.In the Grids dialog box, click the 'Grid Settings' icon  or
double-click the grid number. The Grid Settings dialog box appears:
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Geometry

The Geometry section allows you to specify settings regarding head turns, offset from sheet,
number of repetitions, angle and gaps.

Head Turn 

The default is a step with no head turns (180 degree rotations). The choices, from top to
bottom, are: No Head Turn, Head Turn on Row, Head Turn on Column, Head Turn on Row and
Column.

Horizontal Offset 

Enter the horizontal offset of a grid block relative to the sheet edge.

Vertical Offset 

Enter the vertical offset of a grid block relative to the sheet edge.

Number of Repetitions 

Set the number of repeated objects you want vertically and horizontally. Entering 1 in either
field means that the object will not be repeated in that direction.

Rotation Angle 

Enter a degree to specify the rotation angle of the station.

Mirror allows to mirror the station.

Gap Gap sets the parameters for stepping the current selection. You can step by gap or by
step.Click the arrow to switch from step to gap and vice versa.
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Vertical Gap 

Horizontal Gap 

The default is a step based on a gap. For Gap, the value specifies a gap between the stepped
objects. If Gap is selected, Esko Plato determines how far to step the selection so that the
requested gap is created between the objects. A gap of zero makes the stepped objects abut
one another.

Vertical Step 

Horizontal Step 

For Step, the value specifies the distance between the centers of the stepped objects. If Step
is selected, Esko Plato steps the selection by the distance entered into the 'Step Amount' field.
The value that you enter must be a positive number that is at least the size of the object. This
option is useful if you know exactly how far apart the objects need to be but do not want to
figure out the step gap yourself.

Stagger

Select the Direction  in which you want to stagger the selected object.
From left to right, the choices are: No Stagger, Stagger Columns, and Stagger Rows.

The Stagger Distance  field indicates how much to stagger the object on each repeat.
You can enter a value in the current units or you can enter a percentage of the object's size.
In the dialog box shown above, the stagger distance is 50% of the height of the object. The
amount to stagger that must be applied will be calculated on-the-fly. To use a value as a
percentage, enter the percent sign (%) after the value.

Use the Stagger by setting to add the Stagger distance every n rows or columns. By default,
this is set to 1, so that every row or column is offset from the previous.

In the example underneath you see a vertical stagger, restarting after 3 columns, with the
Stagger by set to 1 (left) and 2 (right)
 

424



10Plato

 

Activating Continuous will add 1 extra station per row/column to fill the ‘hole’ created by
making the indent.

The stagger will be repeated for a number of rows or columns as defined in Restart after n
columns. After that, the next object will be at the begin position again. By setting the Up and
down option, after reaching the number of columns, the next object will be staggered in the
opposite direction.

In the example underneath you see a vertical stagger, restarting after 3 columns, with the Up
and down option disabled (left) and enabled (right)
 

 

Distribute sets the method used to fill the sheet.The Distribute option offers you the possiblity
to fill a sheet in an automated way with a single station. Esko Plato calculates the number
of stations that will fit on the sheet on the basis of the size of the station. The station size
is determined by its die; objects outside the die are ignored. Stepping-and-Repeating via
'Distribute' is based on the sheet size. You can fill the sheet horizontally, vertically or in both
directions. You can also use gap and stagger to create a seamless repeat.

 

 
Single Cuts - Fills the sheet with as many stations as will fit with no gaps between the dies of
the stations. The filled repeat is centered both vertically and horizontally on the sheet. The
extra space around the repeat is equally divided between the top and bottom and the left and
right of the sheet. Gap and stagger cannot be used.

 

 
Distribute Gaps between Stations - Fills the sheet with as many stations as will fit with no
gaps between the stations and the borders of the sheet, but with equal gaps between the
stations themselves.
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Distribute Gaps - Fills the sheet with as many stations as will fit with equal gaps between
the dies of the station. The extra space is evenly divided between the stations; the dies of the
outermost stations align with the edges of the sheet. Gap and Stagger cannot be used.

 

 
Continuous Around - Fills the sheet horizontally like Distribute Gaps but makes the around
(vertical) repeat continuous. This creates a continuous and seamless repeat in the around
direction. Gap can be set in the across direction; stagger can be set in the around direction.

 

 
Continuous Across - Fills the sheet vertically like Distribute Gaps but makes the across
(horizontal) repeat continuous. This creates a continuous and seamless repeat in the across
direction. Gap can be set in the around direction; stagger can be set in the across direction.

 

 
Continuous Around and Across - Fills the sheet so that the stations are continuous in both
the across and around directions. This creates a completely continuous and seamless repeat
in both directions. Gap cannot be used, stagger can be set in either the across or around
direction.

Check Automatic gaps and Esko Plato will automatically determine the gap.

10.59.  Station Properties

You can check the properties of the selected station by:

• Clicking the info button
 

 
in the Grids/CAD/SmartLayout dialog box.

• Clicking right on the selected station and selecting 'Station Properties' from the popup
menu.

The Station Properties dialog box provides you with some elementary information about the
station in question.

• Front/Back
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• Trimming

• SmartLayout

 

 

10.59.1.  Front/Back

The Front and Back tab sheets provide information about the type of station (either a file or an
empty station), its color, name, height, and width.

 

 

Click the 'Select Graphics' icon  to assign a different station to the design. The Assign
Station to Design dialog box will appear.

Click the info icon  for more information about the file, transformations, and inks. The
Image Properties dialog box will appear:
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10.59.2.  Trimming

In the Trimming tab sheet, you can determine the die shape that should be taken into account
and the amount of bleed for the selected station.

 

 

10.59.3.  SmartLayout

The SmartLayout tab sheet allows you to set the parameters regarding overrun, orders,
maximum waste, … This tab also allows you to determine orientation and gutter. These values
will only be taken into account in the SmartLayout algorithm and not for instance when
creating step-and-repeat grids.
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Orientation: Indicate the orientation of the station.

 Click to indicate how the stations should be placed in respect to one another. Possible
options are:

• No Head Turn
• Head Turn on Row
• Head Turn on Column
• Head Turn on Row & Column

Ordered: enter the number of Labels you need (in thousands).

Maximum Overrun: enter the percentage of overrun (waste) you're willing to allow for.

Gutter distance can be entered in the 'Search Options' dialog box (SmartLayout dialog box >
Options button).

• Always
• Between Other Stations (puts white between the selected station and every where it

touches other stations).
• None
• Customized: You can create a customized gutter setting that inserts a gutter e.g. every

second or third station.

Fixed grouping: Use the toggle to get extra settings:

 

 

If you activate the fixed grouping options, then every time SmartLayout places this station
it will be placed in a group as indicated in this option (i.e. with the given number of copies
in vertical/horizontal and with the given step distances). You can define the geometry of
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the group, enter the amount of station in horizontal and vertical directions and specify the
distance or gap between them.

Note:

Rotation angle, head turn, grouping, etc … are all parameters which are only used by the
SmartLayout algorithm. These settings have no effect when a station is used in a grid-based
workflow.

10.60.  Notes

Using the Notes tool and Notes function in the Edit menu, you can add and edit notes in the
Plato document.

Notes are saved in the Normalized PDF file as regular PDF Comments, and will show up as
"Sticky notes" in Adobe Acrobat. Sticky notes created in Acrobat will also show up in Plato,
while other types of comments (text corrections, highlights, ...), and note properties or
statusses are disregarded when opening a PDF file in Plato.

 

 

A note consists of two parts: the Note itself, the yellow balloon indicating the location of the
note, and the Note Pop-up, containing text, the name of the user that created it, and the time
of creation.

 

 

• To create a note, select the Note tool and click in your document, or select Edit > Notes >
Add Note, or select Add note from the contextual menu using the Note tool

• To move a note, click and drag the note pop-up
• To delete a note, select it and choose Edit > Notes > Delete Note or select Delete Note

from the contextual menu using the Note tool.
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• To delete all notes, choose Edit > Notes > Delete all Notes or select Delete all Notes from
the contextual menu using the Note tool.

• To hide or show all notes, choose Edit > Notes > Hide/Show all Notes or select Hide/Show
all Notes from the contextual menu using the Note tool.

Note:  When using Hide all Notes, both the notes and the note pop-ups will be hidden.
Only Show all Notes makes notes visible again. Using Show all Note Pop-ups will not have
any affect.

• To hide a note pop-up, click the X in the top right corner. This doesn't affect the note itself, it
only hides the pop-up

• To hide all note pop-ups, select Edit > Notes > Hide all Note Pop-ups or select Hide all
Note Pop-ups from the contextual menu using the Note tool

• To show all note pop-ups, select Edit > Notes > Show all Note Pop-ups or select Show all
Note Pop-ups from the contextual menu using the Note tool
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11.  Server and Resources
To define the Automation Engine server to connect to, and the Data Resources to be used by
the application as you work on a job.

Note:

In case the application is connected to an Automation Engine or BackStage server, the Data
Resources are always used from this server. You can use the emote or local Data resources if
the application is not connected to an Automation Engine or BackStage server.

 

 

Automation Engine Server
You can set the Server Name, User Name and Password to connect to Automation Engine.

The connection to an Automation Engine Server has an influence on the following features in
the application:

• Submitting to Shuttle: you can only submit to the Automation Engine server the application
is connected to

• The user name for the Track Edit Session task on the Automation Engine server

• The list of Jobs and Products in the File Selector dialogs

• The parameters for the ’Check Job Parameters’ as available on the Automation Engine
server
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Note:

If you are connected to an Automation Engine, a green notification will be shown.

Data Resources
The common Data Resources used by the application are Color Engine Database, Marks, Fonts,
Custom and DGC.

By default, these Data Resources are taken from the Automation Engine server. However, it
is possible for 2 or more stand-alone applications (without an Automation Engine server) to
share the same data resources. This requires that the Data Resources are shared on a remote
computer.

Note:

Changing the Data Resource settings requires a restart of the application.
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12.  Appendix
• QuickStep Compatibility

12.1.  QuickStep Compatibility

12.1.1.  Opening QuickStep GRQ files

Esko Plato allows you to open QuickStep GRQ files which are converted into an Esko Plato
compatible format. While special attention was payed to maximize the compabitility, this
import conversion has some pitfalls, which are outlined in this section.

12.1.2.  Conversion of GRQ data

The grid-based workflow of Esko Plato closely resembles the QuickStep approach of creating
step-and-repeat layouts. When opening a GRQ file (or a Plato 5.0 file containing QuickStep
objects) the following conversions happen:

1. QuickStep library objects (graphics) are converted into stations.
2. Plate and sheet settings are copied into the Esko Plato layout setup.
3. Formulas are preserved, including the user variables (if any).
4. QuickStep grids are converted into Esko Plato grids.
5. Registration marks are kept

1. Converting graphicsThe QuickStep graphics are converted into stations tjat preserve the
die shape and bleed settings. In doing so, each QuickStep grid line is converted into an Esko
Plato station. If the same graphics is used in multiple grid lines, these will result in multiple
stations refering to the same graphics. When an external LC or GRS file is used as die shape,
the contour data is read and embedded inside the Esko Plato station resulting in a ‘manual’ die
shape.

2. Plate and sheet settingsThere is a fundamental difference in the notion of plate between
QuickStep and Esko Plato. In Esko Plato the plate and sheet correspond with respectively
the media box and trim box (PDF terminology).The QuickStep sheet was also the trim box
(borders) of a GRQ file, which is a perfect match. The QuickStep sheet is translated into the
Esko Plato sheet. The plate definition poses a problem. Inherent to the definition of media
box, no visible graphics can be positioned outside the media box. This implies that graphics
are always clipped on the plate edges. This was not the case in QuickStep, where you could for
instance have marks outside the plate. QuickStep had a notion of margins (media box) which
were fitted around all graphics. As a consequence, mapping the QuickStep plate onto the Esko
Plato plate is not always possible.The following approach is taken during conversion:

1. The sheet definition is taken over.
2. If the sheet and plate definition in the GRQ file are identical:
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a. the plate definition is set to VPLATEFIT and HPLATEFIT.
b. all marks attached to the plate are moved to the sheet. In all formulas, the parameters

VPLATE/HPLATE are replaced by VSHEET/HSHEET. By doing so, the marks should keep
their exact positions (sheet and plate were identical in QuickStep) and the Esko Plato
plate will be fitted around all objects (and will thus correspond to the QuickStep media
box).

Esko Plato has no notion of ‘clip on sheet’. If you used this feature in QuickStep, it will be lost
during conversion. If, during conversion, the sheet or plate size changes, a message will be
displayed after conversion.

3. FormulasFormulas are preserved, including user variables (if any). Note that plate
parameters might be replaced by sheet parameters (see previous topic).

4. GridsGrids and grid parameters exist in both QuickStep and Esko Plato. All QuickStep grids
are simply converted into Esko Plato grids.

5. Registration marksThe QuickStep set of registration marks is available under SmartMarks
(Esko Plato and step-and-repeat tasks only - not available in Esko PackEdge). This means
that QuickStep registration marks are converted into SmartMarks while preserving their
functionality, including customised QuickStep registration marks (if any). If the GRQ data is still
using old GRR macros, these are not converted and a message will be displayed.

 

 

• The plate definition is set to 'platefit'.
• All marks are converted into SmartMarks.
• Plate parameters using formulas used in grids/marks,… are replaced by the corresponding

sheet parameters.
• As the plate is now fitted around all objects, the plate size of the Esko Plato file no longer

matches the plate size of the QuickStep file (but it should match the margins).

12.1.3.  Inks marked as 'Tech'

QuickStep allowed to mark inks as technical but it does not completely match with the notion
of technical inks in Esko Plato. In Esko Plato, technical inks are mainly used for die shapes and
special non-printing separations. Technical inks are always rendered as opaque. Marking inks
as ‘Tech’ in QuickStep was merely used to exclude inks from registration marks. Inks marked
as ‘Tech’ will be converted into technical inks but note that this is not always possible (for
instance, process inks can not be set to technical in Esko Plato). Whenever such a situation is
encountered during conversion, a message will appear.
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12.2.  Studio

Studio offers a 3D viewing environment where designers can see their artwork applied
instantly on the packaging. It also includes navigation and alignment tools, and by writing a 3D
PDF file from Studio, designers can share their ideas with clients for review and approval.

Studio reduces time-consuming mock-ups, spots design-errors faster and takes away the
guesswork from 2D flats.

For folding carton or corrugated packaging, the shapes can be supplied by ArtiosCAD or Score!.

The Studio tools in Plato can be found in Production > Studio Designer

12.2.1.  Introduction

Welcome to the Studio Designer documentation.

This documentation describes Studio Designer as a plugin in Illustrator as well as Studio
integrated in other Esko applications such as PackEdge. Although the documentation is based
on Studio Designer in Adobe Illustrator, the functionality is the same in other versions.

About Studio Designer
Studio Designer is a plug-in for Adobe Illustrator, ArtPro, PackEdge and Plato, for interactive
3D packaging design which helps designers make graphic designs or do pre-press for folding
carton, bag files, cans, corrugated boxes, flexible packages and so on. Studio Designer works
with structural design files, created in ArtiosCAD or Studio Toolkit. These can be ARD files, .bag
files or .dae/.zae files (Collada files with a printable part defined). Once a structural design
file is placed in a document, Studio Designer can display a three-dimensional preview of the
packaging with the artwork rendered on it. This allows designers to see how their graphics
will look on the final package. Studio Designer also lets you load a multi-part structural design
file as a scene. Each part of the scene can get its graphics from another document. Studio
Designer also contains productive tools for quick and accurate aligning and duplicating graphic
elements.

Studio Designer is able to export a three-dimensional package to PDF and it can export
snapshots of the three-dimensional package to an image file.

About Structural Design files
A structural design file should always contain 2D information, and possibly even 3D
information. If the structural design file contains 3D information, Studio Designer can show a
folded 3D representation of the structural design file.

A structural design file (2D and 3D) contains all the cut and crease lines for a specific type of
package. A structural design file may also contain folding angles that define how the package
is to be folded into its final shape. The structural design file does not contain the graphics, only
the structural lines. To bring the structural design and the graphic design together, a structural
design file can be placed or opened.
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Supported structural design file formats:

• ArtiosCAD or Studio Toolkit for Boxes (.ard files) for boxes
• Studio Toolkit .bag files
• Collada files with a printable part (.dae or .zae files)

In case a Collada file is placed, a check is performed to see if the Collada file has a printable
part defined. A printable part is an Esko extension to the Collada format.

Collada files with one or more printable parts can also be created in Studio Toolkit and
ArtiosCAD.

You can also load a structural design file as an extra scene in the Studio window. Each part
of the scene can get its graphics from another illustrator document. See Scenes and Multiple
Documents

Licenses
This software is protected against unauthorised use.

To purchase a license or a subscription, please visit http://www.esko.com/store or contact your
Esko sales representative

If you have a license for Studio Designer in PackEdge, ArtPro or Plato, this license is included in
the PackEdge, ArtPro or Plato licensing. For more information, see the licensing chapter in the
corresponding manual.

12.2.2.  Studio Designer Basics

To get started with Studio Designer, you need a document with a structural design file placed
into it.

If the current document does not contain a structural design file, the Studio window will look
like this:
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Above you can see how a structural design file is show as a 2D representation. Open the Studio
window to see the 3D view.

The Studio Window
The Studio window is the heart of Studio Designer. It is a floating palette where you can see the
three-dimensional shape of the package.

To view the Studio window, choose Production > Studio Designer...
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1.

The Maximize button . Click it to make the Studio window options panel visible. See The
Studio Window options panel

2. The Scene. This can be the structural design file used in the current document, or a scene
combining multiple documents. See Scenes and Multiple Documents

3. The View dropdown. You can select a View preset from the dropdown, or click View to open
the View settings. See View on page 441

4. The Orientation. See Changing the Document Orientation
5. The Fly-out button, opening the fly-out menu.
6. The 3D preview of the current document or scene.
7. The Refresh button. See Refreshing on page 440
8. The Full Screen Preview button. This will open the Studio Window in full screen preview,

until you hit the esc key. See Full Screen Mode on page 440
9. Show/Hide transparent panels. See Working with Panels on page 443
10.The Show/Hide Outlines button adds the outlines of the structural design to the 3D

preview.
11.The Show/Hide 3D Guides button. See 3D Guides on page 450
12.The Zoom Slider. See Changing the viewing Angle and Distance on page 440

Note:  If the placed ARD file does not contain folding angles, the plug-in cannot know how the
box has to be folded. In that case 90-degree foldings are assumed on all folding lines. If the
resulting shape is not the intended one, the proper folding angles need to be added to the ARD
file, for example using ArtiosCAD or Studio Toolkit for Boxes.
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Refreshing
By clicking the Refresh button in the bottom-left corner of the Studio Window, the graphics will
be drawn on the box. Every time the graphics change, the Studio Window will only update if
you click the Refresh button.
 

 

Refresh is also available via refresh in the fly-out window.

If Auto-Refresh is enabled in the fly-out window, the Studio Designer window will
automatically be refreshed every time your document is changed.

Changing the viewing Angle and Distance
In the Studio Window, you can look at the package from different angles.

• You can click and drag to rotate the 3D object.
• You can hold the shift key and click and drag to move the 3D object left, right, up or down

(Panning).
• By moving the slider in the bottom-right corner you can look at the box from a closer or

further distance. Another way to do this zooming, is by using the mouse wheel.
• You can reset the camera position by double-clicking while holding the shift key.

To indicate that the package is not floating in mid-air, the floor concept was introduced. A
package in the Studio Window is always positioned relative to the floor, giving the package a
top and bottom definition. If the package (currently only boxes) is showing the wrong panel as
top panel, then you can use the Turn Box option. See Turn Box on page 446

Note:

When your box is facing the wrong way and when you have difficulty to turn your box upright,
try using Turn Box... The turning around functionality has been designed in such a way that it
works fine if you have selected the right bottom panel.

Full Screen Mode

There are different ways to switch your Studio window to full screen mode:

•
By clicking the "Full Screen Mode" button  at the bottom of the Studio window

• By choosing Enable Full Screen Mode from the Studio Window fly-out menu
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• By choosing Window > Esko > Studio Designer > Enable Full Screen Mode
• By using the shortcut F11 on Windows or Cmd+Alt+- (minus) on Mac

When full screen mode is activated, you can only change the camera rotation, panning and
environment rotation. You can get out of full screen mode by pressing the esc key.

Scene Settings
In the Scene Settings you can finetune the way your work looks in the Studio window.

You can open the Scene Settings dialog by choosing Scene Settings from the fly-out menu, or
by clicking the Scene Settings link in the Studio Options.

If the Preview option is enabled, the Studio window will immediately reflect the changes you
make in the Scene Settings.

All settings from the Scene Settings dialog are used in the Export dialog, except Floor Reflection
and Background Image for PDF file with 3D design and UD3.

Environment

In the Environment tab you can set the Lighting Environment, the amount of Shadow
Contrast, and the background, either a color or an image.

Floor Reflection

The second tab of the Scene Settings defines the Floor Reflection by setting the amount of
Reflection Opacity and the Fade effect.

Note:  Lighting Environment and Floor Reflection Fade can only be set when using Visualizer
Quality. See Studio Visualizer in Studio Designer on page 442

View

In the View settings tab you can numerically set the view angles, pan and camera distance.

• Set the Object Heading and Object Tilt to define the position of the object
• Set the Pan and Camera Distance to define the position of the camera, or click Fit in

Window to reset the pan to zero and automatically adjust the camera position so that the
3D view fits in the Studio Window.

• Set the Perspective by either defining the Focal Length (in mm) or Field of view (in
degrees) of the camera.

• Enable Keep vertical lines parallel if you want to get the effect of a tilt shift lens. If
enabled, the vertical lines in the pack shots remain vertical (without vantage point). You can
use this to create images that are easier to combine afterwards in a 'line-up' image. If the tilt
angle is very large it can lead to very unrealistic distorted perspective.

The View Preset dropdown allows to select one of the default settings, or any previously saved
Preset.

You can save the current settings as a new preset by selecting Save as in the dropdown.

Select Manage... to open a separate dialog in which you can delete unnecessary presets.

The Scene Presets and View Presets folders can be found here:
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• On Macintosh: Macintosh/Users/user/Library/Application Support/Esko/
Studio/

• On Windows: C:\Users\user\AppData\Roaming\Esko\Studio\

You can exchange the Presets between different operators by copying the files to another
computer.

If you remove all Presets and restart Adobe Illustrator, the default Presets will be recreated.

Scene Presets

The Scene Preset dropdown allows to select one of the default settings, or any previously
saved Preset.

Note:  Scene Settings contain the Environment, Floor Reflection and View.

You can save the current settings as a new preset by selecting Save as in the dropdown.

Select Manage... to open a separate dialog in which you can delete unnecessary presets.

The Scene Presets and View Presets folders can be found here:

• On Macintosh: Macintosh/Users/user/Library/Application Support/Esko/
Studio/

• On Windows: C:\Users\user\AppData\Roaming\Esko\Studio\

You can exchange the Presets between different operators by copying the files to another
computer.

If you remove all Presets and restart Adobe Illustrator, the default Presets will be recreated.

Selecting Parts and Panels
You can select parts and panels by clicking on them in the Studio window.

By holding the alt key and clicking a panel or part one or several times, you can select a panel
or part that is behind another one.

A Printable part or panel will be selected in red. When selecting a non printable part, all
non printable parts sharing the same material will be highlighted in orange. For multiple
instances (e.g. multiple cans on a tray), only the printable parts of the original instance will be
highlighted.

See also:

• Zooming in on Panels in the document window on page 445

• About Hidden Panels on page 444

• Scenes and Multiple Documents

Studio Visualizer in Studio Designer
Besides the Studio Designer functionality, the Studio window contains a number of functions
and options that are related to Studio Visualizer for Adobe Illustrator. These options require a
Studio Visualizer license.

By default, Studio Designer shows a preview in its own Studio Designer quality. You can switch
to the enhanced Visualizer Quality preview, by selecting Visualizer Quality in the fly-out menu
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of the Studio palette, or by selecting Visualizer Quality in the Studio Window settings panel, if
no part is selected.

If Visualizer Quality is checked, a number of extra options, such as changing the lighting
environment, will also become available.

Next to these options in the Studio window, Visualizer for Adobe Illustrator also contains
specific palettes such as the Substrate and the Finishing Operations. For more information
on these, we refer to the Studio Visualizer for Adobe Illustrator documentation: http://
help.esko.com/products/Studio%20Visualizer%20for%20Adobe%20Illustrator

12.2.3.  Working with Panels

A box design and a bag design consist of a set of panels which are folded relative to each
other.

Selecting Panels
In the Studio Window you can select a panel, simply by clicking on it. The selected panel is used
by certain Studio Designer features and does not affect the selected artwork.
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Tip:

Show Face Outline (in the fly-out menu) ensures that the selected panel is also shown in the
your document as a blue solid line.

Note:

Sometimes a dotted line appears next to the solid one. This is the case when you select a panel
that is also part of a composed face.

About Hidden Panels
Some panels cannot be seen in the Studio Window because they are covered by another panel
no matter which angle you are viewing the package from. To see those panels, you can choose
Show Transparent Panels, which is available at the bottom and from the Studio Window fly-
out menu. In this mode the package is drawn in a semi transparent way, allowing you to see
covered panels. This will help you to understand how the package's 2D unfolded view and the
3D view relate to each other.
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By holding the alt key and clicking a panel one or several times, you can select a panel that is
behind another panel.

Zooming in on Panels in the document window
If you double-click a panel (or if you select Fit Panel in Document Window from the Studio
Window's fly-out menu), the document window will zoom in on the corresponding part of the
graphics.

If your graphics are in another document, then this document will become active.

Since only one document can be open at once, this will close the open document. If the open
document was changed, you will be asked if you want to save the document first.

Furthermore, the orientation of the document window will change to match the orientation in
the Studio Window as closely as possible.

You can also zoom in by holding down the Ctrl key and dragging a rectangle around the area
you want to zoom in on.
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By spinning the package and double-clicking the different panels, the Studio Window can be
used to navigate through the document.

Turn Box
When working with designs for folding carton or corrugated boxes, you might not be able to
position the box in the desired viewing angle in the Studio Window. This happens when the
package has the wrong panel(s) facing up. You can change this e.g. in the structural design
file (by selecting another Base Panel in ArtiosCAD or Studio Toolkit for Boxes), but you can
also turn the box in the Studio Window. Just select a panel that should be facing up or down
and select Turn Box from the Studio fly-out menu. The Turn Box functionality is linked with
the Floor concept, so e.g. The selected panel facing up means that the selected panel will
become the top panel relative to the floor.

Note:

The Turn Box option is only available for boxes (ard files)

 

 

Bring Panel Forward and Send Panel Backward
This functionality is only available for boxes and composed faces of which the panels are all
in the same plane. Overlapping panels in the same plane can occur in any file. Sometimes the
order of these overlapping panels is incorrect. Most of the time, this will happen when the
panels have been folded 90 degrees on top of each other. With Bring Panel Forward and
Send Panel Backward, you can correct this order.

If you wish to view another panel on top, you can select the panel, select Bring Panel Forward
from the Studio fly-out window and bring it forward.
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Creating Copies with the Distribute command
Most of the faces of a package consist of a single panel. So there is just one rectangular area
in the document that will make up this face. However, sometimes a face is made of several
panels. The panels of such a “composed face” are spread across the document. They can even
have a different orientation. So for composed faces it is very difficult to create graphics that
run continuous from one panel into the other. Studio Designer can help you in this process
with a feature called Distribute.

Note:

You can use Distribute on .bag and .ard files but not on Collada files.

Composed Faces

This is an example of a box with composed faces.-

 

 

This is an example of a bag.

 

447



12 Plato

 

Viewing the Composed Face
If you select Show Face Outlines in the Studio fly-out menu and you click one panel that is
part of a composed face, 'ghost’ outlines will be drawn of the other panels of that face. These
ghost outlines can give you a good impression of the size and shape of the composed face.

 

 

Distribute
If you draw some art within the boundaries of such a composed face, it will only appear on
one panel, since the other panels are actually somewhere else in the Illustrator document.
However, with Distribute, you can create copies of the art over several panels that are
perfectly aligned to make it look continuous on the folded composed face.

This is how the folded package will look without applying Distribute.

448



12Plato

 

 
Distribute is available from Studio's fly-out menu. First you need to select art in the document
and you need to select the corresponding panel in the Studio Window. The selected art is
supposed to be positioned correctly on the selected panel. If you choose Distribute, copies
will be made of the selected art for the other panels (of the same composed face). In the
Studio Window (which is automatically refreshed after a Distribute) you can see how the
graphics are running seamless from one panel into another.

Normally, distribute will make a copy of the selected objects for every panel in the composed
face (unless there is no overlap). If you do not need all these copies, you can simply delete the
ones you do not need.

This is how the folded package will look when having applied Distribute.
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Making Clipping Masks
It is very likely that one or more of the copies lay partially outside of the panel they were
created for. Sometimes this is a desired effect (having the graphics run continuously over a
folding line). Sometimes this is not a desired effect and you will have to create a clipping mask
to contain the copy within its panel.

 

 

Working With Distributed Art
You can update the copied distributed art, for example after you have edited the original art; or
you can undistribute and expand distributed art if you want to delete the copies.

Undistribute and Expand

The options Undistribute and Expand, which can be found in Studio's fly-out menu also apply
to distributed art. If you select distributed art and you Undistribute, all other (non-selected)
copies are deleted. If you have distributed art selected and you Expand, nothing will change
visually yet the selected art will loose its 'intelligence' and become regular artwork, insensitive
to actions like Update Copies or Undistribute.

You will need to use Expand if you start copying and pasting distributed art. The copy will
still be considered as part of a distribution, by expanding it, it will no longer be seen as a
distribution, but as an ordinary object.

Note:

When the distributed art is a group, ungrouping it is equivalent to applying Expand. The art
does not longer know that it was distributed, even if you group it again.

12.2.4.  3D Guides

In Illustrator, PackEdge, ... you can create horizontal and vertical Guides to align art. Studio
Designer offers another type of guides: 3D Guides for boxes and Collada files.

3D guides appear both in the document window and in the Studio Window.

Note:  3D guides are temporary visual aids, and are NOT saved.

You can hide or show the 3D guides in the document window by switching the visibility of the
3D Guides layer on or off in the Layer window.
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Select Show/Hide 3D Guides from the Studio fly-out menu (or click the button at the bottom) to
hide or show the 3D guides in the Studio Window.

In the Studio Window, the 3D guides appear like a horizontal or vertical plane that is
intersecting the shape. In the document, a 3D Guide appears like a set of horizontal, vertical or
even slanted line segments clipped inside panel boundaries. These line segments show where
the plane is intersecting with the panels. Graphics can snap to these segments just as with
regular guides.

This is how the 3D guides are presented in the 2D and 3D view:

 

 

For Collada files made with Studio Toolkit For Labels, you can get curved 3D Guides in the
document if your printable part is a conical label:
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Creating and Editing 3D Guides
To create or move a 3D guide, use the 3D Guide tool (in the applications toolbar). Click and
drag somewhere in the shape in the document to create or move a guide. By holding the
option (alt) key, you can switch between vertical and horizontal guides.
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To delete a 3D guide, use the 3D guide tool and simply drag it outside the shape in the
document.

To delete all 3D guides, you can delete the “3D Guides” layer that contains all 3D guides.

12.2.5.  Exporting

Studio Designer offers a variety of export options to a number of common formats.

The background color and other settings defined in the Scene Settings will show up in your
exported file.

Note:  If you have the WebCenter Connector plug-in installed, you can use Save to
WebCenter to upload the exported file directly to WebCenter. See Using Studio Designer and
WebCenter Connector

Writing TIFF Images
Studio Designer can export the 3D design to an RGB TIFF image with the graphics on top (much
like the Studio window but at higher resolutions).

1. Choose Export… from Studio's fly-out menu. Choose TIFF Image as file type.
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2. Define the Width, Height and Resolution for the image that you want to export.
3. Define the Artwork Quality. Depending on what the image is needed for, you can choose

between 4 presets for the level of detail. Choosing Low (fast) will export to an image fast but
with less detail, while choosing Medium, High or Highest (slow) will produce greater detail
but will take more time.

Tip:

The "Low" and "Medium" presets correspondent to the "High" and "Very High" Image
Quality found under "Model" in the "old" Studio Visualizer 14 application.

4. The Transparent Background option allows you to set the background transparent instead
of the background (color or image) defined in the Scene Settings.

5. Click Save As... to save the TIFF file.

The Scene Settings are used in the exported TIFF image: Object heading and Tilt, Pan,
Perspective, etc. See Scene Settings on page 441

Export to a 3D PDF File
In Adobe Reader or Acrobat Professional (version 8.0.1 or later) you can view / rotate 3D
objects in PDF files. Studio Designer can write such PDF files that can be used to view a
package in 3D on a computer that does not have Illustrator or Studio installed.

Choose Export… from Studio's fly-out menu. Choose PDF File with 3D Design as file type.

You can define the Size of the PDF file. Since the PDF file is only meant for on-screen viewing,
this size is of little importance.

The Add Footer toggle allows you to switch on or off the footer text. Instead of the default
EskoArtwork text you can also personalize the footer text and include your own message.
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Note:

To avoid z-fighting problems in the exported PDF files, you can use the Avoid Artefacts option.
This will make sure that whenever it is unclear which panel is on top (resulting in flickering
graphics), a calculated choice will be made, cutting out the underlying part and giving the top
part carte blanche.
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Export to a U3D File
U3D is a common exchange format for 3D objects. For example, in Acrobat Professional 8.0.1
or higher you can place U3D files in PDF files.

Choose Export... from Studio's fly-out menu. Choose U3D File as file type.

 

 

Note:

To avoid z-fighting problems in the exported U3D files, you can use the Avoid Artefacts
option. This will make sure that whenever it is unclear which panel is on top (resulting in
flickering graphics), a calculated choice will be made, cutting out the underlying part and giving
the top part carte blanche.

Export Collada File
Studio Designer can also export to a Collada file (*.zae), a common exchange format for 3D
models.

1. Choose Export... from Studio's fly-out menu.
2. Choose Collada File (*.zae) as file type.

 

 
3. Select Include Graphics at… to include the graphics at the desired resolution.
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4. If you want to further use the Collada file in Studio Designer you need to select Keep
Printable Parts.

If Keep Printable Parts is enabled, the artwork is always exported at the default resolution.
5. Click the Save As button, and define name and location for the file.

Note:

The exported Collada files (.zae) can be further used in other EskoArtwork Studio applications
like Studio Visualizer, Studio Toolkit for Shrink Sleeves or Esko Store Visualizer and ArtiosCAD
or uploaded to the online Esko Studio Viewer.

Save Graphics Preview as PNG...
From within the Studio window, you can save a graphics preview file as a .png file, mainly for
use in Studio Toolkit for Flexibles.

 

 

12.2.6.  FAQ

This section contains the answers to a number of Frequently Asked Questions.

There is no overlap between the selected objects and the selected panel
I try to distribute a logo, and I am getting the error message There is no overlap between
the selected objects and the selected panel. Please select a panel that
overlaps with the selected objects.
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Whenever distributing for the first time, you will need to select two things: the graphics that
you want to distribute in the 2D view AND the source panel in the Studio window. The 'no
overlap' error message indicates that you did select a panel in the Studio window, but in 2D
there is no overlap between the selected panel and the selected art.

It is a good idea to switch on Show Face Outlines in Studio's fly-out menu.

 

 

When Show Face Outlines is switched on, the selected panel in the Studio window will be
shown in the 2D View:
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You will immediately see that there is no overlap between the selected panel (the blue
rectangle) and the selected art (the star), so you basically selected the wrong panel. You need
to select a panel that has an overlap with the selected art:

 

 

Now you see that there definitely is an overlap between the blue rectangle and the star. You
will notice that Distribute Selection will work, which will give you the following result:
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Please note that you never had to specify to which ‘target panel’ you had to distribute, so how
can you know which target panels will be taken?

In this version of Studio Designer, the distribute functionality only works on coplanar panels.
The bottom face consists of four panels coming together: two glue panels and two larger
panels. The selected panel is drawn with a solid blue line in the 2D View, the other panels that
are coplanar with it are drawn with dashed lines. Distribution happens from the panel drawn
with a solid blue line to the panels drawn in dashed blue lines.

That is why Show Face Outlines is so interesting, as it immediately gives you an indication
whether or not distributing is at all possible and to which panels the distribution will happen.

If we move one of the stars and do an update, you will notice that the three other stars need
to move as well. It is now enough to select the moved star and click Update Copies. You will
notice that Distribute Selection is now called Update Copies. There is no need anymore to
select a panel in the Studio window.

The selected art knows that it has been distributed before. An indication that you have selected
“distributed art” is given in the info message in the Studio window: The selection contains
distributed art. This piece of distributed art has become a smart object that knows to
which panel it belongs and which other art belongs to the same distribution. When clicking
Update Copies, the other art that belongs to the same distribution (in our example, the other
stars) will be replaced with a new updated copy of the selected distributed art.

In the layer browser, you also have an indication which art is “distributed art” and hence smart.
The name of distributed art is always “Distribution”.
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What can I do if the distribution looks wrong?
The graphics have been distributed to the correct coplanar panels, but the result of the
distribution in the Studio window is still not correct.

 

 

In this case it is not that the distribution has positioned the copies in the wrong place, but
that in the 2D document window, the different copies are overlapping one another. This can
happen whenever the graphic that you want to distribute is rather large.We will need to make
clipping masks in this case, using the standard tools.

If we do this for every distributed copies and then refresh the Studio window, we will get the
correct result:

You only need to make the clipping masks once. Assume you would like to move the frog
a little, then simply move one copy and click Update Copies. The other copies will also be
updated and they will keep their position under their clipping masks.

How can I distribute around a corner?
In this version of Studio Designer, distributing is only possible to other coplanar panels.
Sometimes a distribution appears to go around the corner, but this only works if a panel that is
attached to the panel around the corner is coplanar with the selected panel.

This is not the case with the box in the next example.
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In this version of the software, we are not capable of doing this with the automatic distribute.
We have limited the distribution functionality to panels that are coplanar. A face in the Studio
window can be made up of different panels coming together. A beautiful example is the
bottom of the box in the picture below.

 

 

The bottom of this box consists of four panels coming together. If you select Show Face
Outlines in the Studio's fly-out menu, you will see blue lines showing up in your 2D Document
Window. The solid blue line is a reflection of the selected red panel in the Studio Window. The
other panels that are coplanar with the selected panel and that together form the bottom
face, are drawn on top of that in dashed lines. If you were to draw some graphics and click
Distribute Selection then the graphics would be copied and pasted to the three other panels
that are coplanar with the selected one. Those three panels are shown with dashed blue lines
in the 2D Document Window.

In the following example, we would like a distribute from one panel to another that is adjacent
to the first in the Studio Window, but they are not at all coplanar. On the contrary, the angle
between the two panels is 90 degrees. As automatically distributing will be impossible in this
case we will have to do the copying, rotating and pasting of the graphics ourselves. The Create
3D Guide option can be a solution.

You could create a 3D Guide in the back inner panel and that is immediately going to create
extra guides in the other panels that the guide plane intersects with.

You could now design your graphics in the back inner panel. You do not need to do this upside
down as double-clicking on the panel in the Studio Window will rotate the whole job. You
can also rotate your job manually using the orientation buttons in the right top of the Studio
Window.

We will add some text to this panel that also needs to extend into the other panel.
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We will now copy the text, double-click the other panel in the Studio Window where you would
like the text to be pasted, paste the text, rotate it and position it correctly on the guide:
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